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Introduction

I believe this book represents the most foundational aspects of Sitecore that everyone needs to understand,
no matter your role—whether you're a marketer, content administrator, power user, developer, or
administrator. This book is where you start when you need to learn Sitecore. What will you learn? For
starters, you'll learn Sitecore “out-of-the-box,” meaning, you'll learn how to use Sitecore's core features

and capabilities, such as content management and personalization configuration, and you'll learn how to
configure Sitecore's marketing analytics capabilities.

The book starts with the very basic, answering “what is Sitecore?” in the very first chapter, all the way to
an appendix that breaks all stereotypes. This appendix is chock full of fairly advanced concepts for those who
are especially ambitious. In between, you'll notice a progression of core concepts, to the more theoretical
concepts around security best practices and governance concepts.

Most chapters include “Strategy Bits” as well. The goal is to balance the technical how-to with the
more theoretical, strategy of why. This is done through the use of several contributing authors who bring a
core marketing background into the discussion. I believe this, paired with the theoretical chapters stated
previously and thorough how-to, makes this a robust, broad, and thoroughly helpful and practical book for a
broad Sitecore audience.

The core audience this book targets includes the marketers who administer Sitecore on a daily basis,
such as those managing content and viewing analytics reports. Developers also will benefit from some
foundational understanding, but the book does steer away from the depths of Sitecore’s internals; those
topics are best covered separately so to not throw a less technical audience off track. However, I don't totally
shy away from more advanced topics. Marketing technologists, aka “Sitecore Power Users” as I call them, will
wet their whistles throughout the book (and in the appendix especially). As such, this book has a little bit for
everyone, while not losing the less technical marketer in the process.

How This Book Is Structured

The book is divided into nine chapters and an appendix with some advanced topics.

e Chapter 1, “Introduction to Sitecore 8,” seeks to level the playing field by providing a
high-level overview of Sitecore’s core features and capabilities.

e Chapter 2, “Managing Content,” one of the most foundational chapters of the book,
helps readers understand the Content Editor and the Experience Editor; two core
tools used throughout the book.

e  Chapter 3, “Experience Personalization,” walks the reader through personalization
strategy and configuration techniques.

e Chapter 4, “Experience Optimization,”" demonstrates how to configure A/B testing
and other optimization techniques to ensure your content is best suited to your
customer’s needs.
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INTRODUCTION

Chapter 5, “Marketing Campaigns,” describes how to set up marketing automation
and campaigns within Sitecore, no doubt a critical read for marketers seeking to get
the most out of their installation.

Chapter 6, “Web Forms for Marketers,” is a fun little tool to help marketers spin up
quick and easy forms for lead capture, etc., and this chapter walks them through
this process.

Chapter 7, “Experience Analytics,” provides an overview of the out-of-the-box
reporting built into Sitecore, as well as how to set up some self-service reporting for
more advanced decision support.

Chapter 8, “Security,” is the token security chapter; you'll learn how to set up users,
roles, and access rights to secure your installation.

Chapter 9, “Governance,” seeks to enable you to maintain a happy, healthy Sitecore
installation for years to come.

Chapter 10, “Appendix,” brings a host of more advanced topics, such as data
templates, custom workflows, architecture, and the Federated Experience Manager
for those looking to go a bit deeper.

Contacting the Author

You can reach Phil Wicklund at http://sitecoreconfig.comand/or phil@sitecoreconfig.com.
Also, connect with Phil on LinkedIn at https://www.linkedin.com/in/philwicklund.
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CHAPTER 1

Introduction to Sitecore 8

My goal for this book is to pave a yellow brick road for Sitecore end users, such as marketers and content
administrators. There is a ton of information on the Internet about Sitecore, but its vastness often leaves you
wondering where to begin. This book begins with an overview of Sitecore. Later chapters will dive into the
details. For now, however, it is important to understand Sitecore’s potential more broadly so you know where
your destination is.

Finding the wizard of oz begins with knowing some WCM history and, specifically, how Sitecore is helping
to redefine what a WCM should be doing for you. We begin this discussion by considering Sitecore’s solution
architecture. Next we will discuss all the great high-level features and capabilities of Sitecore. This exploration
will help set the stage for what'’s possible with Sitecore, or in Dorothy’s case, what'’s “over the rainbow.”

Sitecore’s content management system is one of those key capabilities, thereby allowing non-technical
marketers the ability to change content across all channels without the need for a developer. Sitecore’s analytics
engine is another key capability. Analytics and data are the powerhouse behind the rich personalization and
engagement optimization capabilities within Sitecore that marketers so often salivate over.

In the end, Sitecore is just one tool among a myriad of tools and systems that make up what an
enterprise uses to run its business. Systems such as ERP systems, CRM systems, authentication systems, and
so forth are all critical adjuncts within the enterprise that Sitecore often needs to integrate with. Some of the
most prevalent integration points will be described at a high level later in this chapter so you can understand
at the broadest scope what the potential for Sitecore can be.

Finally, this chapter will conclude by offering a brief tutorial of the graphical user interfaces (GUI) that
end users, marketers, and administrators work in. For those who may be on a previous version of Sitecore
and looking to upgrade (version 7.5 and earlier), the chapter will conclude with a discussion on new features
and capabilities specifically with the eighth version of Sitecore so you can know what to look forward to
when you upgrade.

Web Content Management—A Brief History

Sitecore, a Danish company, was founded in 2001 at the peak of Web Content Management (WCM)
hype. Sitecore, however, is one of the very few in the market who transformed itself as digital marketing
waxed and waned, and here, in the “age of the customer,” Sitecore is certain to remain a horse worth
betting on. Sitecore provides the data, in real time across all channels, needed to maximize experience
value. Additionally, Sitecore utilizes deep analytics to drive better decisions and uncover valuable
insights. Sitecore also integrates deeply into external business systems to help create a single picture

of your customers. These capabilities take WCM well beyond its original definition, paving the way for
the modern Customer Experience Platform (CXP), of which Sitecore is a clear leader. Sitecore exceeds
expectations for each key priorities for a modern enterprise-class CXP solution. But what is a CXP? For
that matter, what is WCM?
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It makes sense to dig a bit into the background of Web Content Management (WCM) solutions
themselves and their history, and then discuss how CXP has evolved to be the new standard. This backdrop
will set the right context before covering each capability of Sitecore, feature by feature. Let’s begin in 1995!

Web 2.0

The WCM concept was born out of the late 1990s, not long after Al Gore invented the Internet. Al, like
other web site owners, was frustrated that he needed a developer every single time the web site needed to
be updated. WCM, born out of this frustration, paved a way for richer, more frequent updating of web site
content, which helped facilitate more and more Internet use.

This notion of end-user updatable content became the catalyst for the term “Web 2.0,” which became a
meme for the concept of user-driven content, rich usability, and stronger web standards. In those early days,
Web 2.0 became the high bar that WCM systems aspired to. The core capabilities of a WCM system could be
described as the following:

Content Management—The ability to administer content apart from the
involvement of a developer is the most basic requirement of a WCM solution.
This might involve updating copy on the web site, adding imagery, or rich media
such as video content.

Collaboration—Administering content takes the blending of many minds. Some
create content, some approve that content, while others may take the action to
actually publish that content so it’s live for users to consume. This process of
collaborating with peers involves locking content so others can’t override your
changes, versioning content in case you need to revert to a previous version

or test an alternate version, and even the initiation of complex publishing
workflows to handle the various levels of approval needed before it goes live.

Content Visualization—Some demand that content always be separate from

its presentation details. However, as a marketer, it sure is nice to see what the
change will look like before you press the publish button. A core feature of many
WCM solutions is the ability to change content inline, within its presentation to
get real-time feedback on what that change will look like when you press Save.
This is often referred to as a what-you-see-is-what-you-get (WYSIWYG,
whi-zee-whig) editor.

A basic WCM is expected to have these basic capabilities, if not many, many more. However, even
though these features were innovative at the time, today they are table stakes. Twenty years after the
first WCM solutions started becoming popular, the demands marketers have on their digital experience
platforms have all but transformed what a WCM needs to enable.

R.I.P. WCM—Long Live CXP

Unfortunately for the WCM legacy, we are no longer in the digital age. Rather, we have entered the “age

of the customer” (a phrase first coined by Forrester: https://solutions.forrester.com/age-of-the-
customer/cio-cmo-strategy-31150-3763IK.html), where the customer is in control. Most buying decisions
are made before the customer ever interacts with your brand. In ages past, the marketer had far more control
to dictate the customer’s impression of the product, brand, and even the market. Nowadays customers do
their own research and engage a web site 70% into their buying journey. As Forrester said in its seminal
article, “technology has tipped the balance [of power] in the favor of the customer”


https://solutions.forrester.com/age-of-the-customer/cio-cmo-strategy-3115Q-3763IK.html
https://solutions.forrester.com/age-of-the-customer/cio-cmo-strategy-3115Q-3763IK.html

CHAPTER 1 * INTRODUCTION TO SITECORE 8

Must Read The CIO’s and CMO'’s Blueprint for Strategy in the Age of the Customer,
https://solutions.forrester.com/age-of-the-customer/cio-cmo-strategy-31150-3763IK.html

The Internet is really what has turned the tide for marketers. Customers today have infinite knowledge
at their fingertips via the Internet. They are doing their homework, and in the age of the customer your job
as a marketer is far more challenging. In the age of digital marketing, you were allowed to put your Facebook
hat on and create campaigns that pushed bait into individual channels. Now however, customers cross
channels constantly, hence the coining of the term ‘Omnichannel’. How do you understand user behavior
when you only look into individual channels? Take note of this mind-shift, as seen in Figure 1-1.

Digital Experience
Marketing Marketing

Age of the customer

Age of digital All about
Personalization
All about channe|

optomization Anticipate ;ustomer
needs

WCMs satisfied Data-drj
a-driven

Figure 1-1. Digital marketing is rapidly losing steam to a more wholistic marketing concept, called experience
marketing, which focuses on understanding the customer’s experience across all channels, versus optomizing
each channel individually

Marketers however are not a dying breed. No doubt most are finding themselves on the defensive.
However, through updated marketing strategy and the use of a properly configured customer experience
management system (CXP), they can get back on the offensive again. The foundation of this offense is to
anticipate the needs of the customer. This is done by delivering highly personalized content to each user
across every channel. The user is coming to your brand with a very specific purpose in mind, and it’s your
job to leverage the analytics at your fingertips to present to them, in real time, what it is they are looking for.
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Real-time personalization can also be leveraged quite effectively in the context of campaigns. A good
CXP uses analytics to compile a single view of the customer’s interactions across all channels. A web
experience must drive conversions, engagement, and brand loyalty. You must deliver a quality, consistent
experience across all touch points. This, no doubt, is functionality well beyond the scope of mere WCM
solutions.

Key Priorities for a Customer Experience Platform

Every interaction with your brand is an experience, but do you know your customer across all these
interactions? Is every experience one your customer wants/expects? Is every experience creating value
for your brand? A CXP should provide the answers to these questions. In this section, you'll find a more
exhaustive overview of key capabilities a CXP should be bringing to the table. Later, we'll explore Sitecore
more specifically and how it brings these capabilities to your fingertips.

Easy to Use

This one probably goes without saying, but a CXP that is difficult to use simply won’t provide the kind
of ROI you're looking for. You shouldn’t be in a place where you're constantly relying on deep technical
skills to perform everyday administration functions, such as checking up on the results of a campaign or
adding a new video to the home page. Sitecore provides an intuitive treelist of all content items, such as
what is seen in Figure 1-2. This makes it easy to drill into the site and find the content you're looking to
update, for example.

= | sitecore

+ a Content

+ —.'_ﬁ Layout

3 &a| Media Library

£ $J System

= J Templates

= Vl Sample
=[] sample Iitem
= _] Data

(] Title
(&) Text

[]) __standard values

Figure 1-2. Sitecore’s intuitive treelist of all content items
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Real-Time Personalization

A top-tier CXP should respond to user behavior on the fly and in real time in order to change the
presentation of the site to best align to the users’ needs and goals, with the intention of getting the most
engagement out of the users. Personalization also is critical to driving conversions out of users, such

as purchasing a relevant product, getting them to sign up for a webinar, or generating an action a sales
representative could follow up on. Sitecore provides this, and much more, such as experience optimization
and content testing, so you can know the content on your site will produce the best benefit for the users
being targeted. Additionally, you can log user behavior to track users as different personas, which can then
feed into who you target within your e-mail campaigns, for example.

Key Statistic A full 97% of B2C marketers conclude that personalization is key to achieving their long-term
goals: https://www.internetretailer.com/2014/08/29/theres-more-work-be-done-personalization

Single View of the Customer

Your CXP should also enable a single view of each customer’s data and insights. Instead of having customer
data spread across three or four enterprise systems, spreadsheets, or databases, a CXP can be the point of
truth for who your customers are, how their behaviors are changing over time, and myriad of other insights
your marketing team can tap into. An example of this might be bi-directional synchronization between your
CXP and CRM systems, such as what Sitecore accommodates. In any case, the recommendation in the “age
of the customer” is to become obsessed with knowing your customer, and you can’t accomplish this if you
need to go to four places and piece together how your customers are changing.

Must Read Forbes Insights article called Customers for Life: Technology Strategies for Attracting and
Keeping Customers: http://sitecore.net/forbes

Search Engine Optimization

Your CXP should not keep you from being found. Far too many developers have made excuses for far too
many WCM solutions that come up short in this regard. Your CXP solution should have been designed
from the ground up with SEO in mind. This includes key strategies such as URL structure, cleanliness of the
HTML, redirection issues, ability to add keywords, and many other tips that a WCM commonly gets wrong.

E-Mail and Automation

While in the store, 61% of consumers would prefer to receive mobile ads with discounts or sales information,
but only 49% are actually receiving these ads, (source: http://www.ninthdecimal.com/wp-content/
uploads/2014/09/ND_Insights 02_2014.pdf), and 81% of shoppers say they want promotional e-mails

to highlight items that are on sale. What this means for the marketer is that traditional channels remain

alive and well when powered by a reputable CXP such as Sitecore. Your CXP should provide you an easy
interface to e-mail your customers by segment, and allow for out-of-the-box customer subscriptions to
e-mail preferences. Sitecore takes this a step further by providing multivariate testing capabilities so you can
understand which e-mail formats are generating the most engagement. Analytics such as click-throughs and
subsequent engagement scores can easily be tracked and optimized.


https://www.internetretailer.com/2014/08/29/theres-more-work-be-done-personalization
http://sitecore.net/forbes
http://www.ninthdecimal.com/wp-content/uploads/2014/09/ND_Insights_Q2_2014.pdf
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Multilingual Support

A multilingual experience is table stakes for a CXP solution, as customers expect an experience in their
native language. Having a CXP solution that enables language variation is a must-have. Sitecore, as seen in
Figure 1-3, enables users to translate each piece of content into multiple languages and thereafter you can
use geo-location or other mechanisms to ensure the right content is in the right language for a particular
customer. See Chapter 2 for more details on content translation features.

% & d __JLanguage Engish

English ~ | Add All Versions || Translate Compare | Latest | - |10 Latest
! lﬁl English (Canada) : English (Canada) .

1 version. A
. =

«1| Spanish (Mexico) : Espaiiol (México)
1 version.
EEE  English (New Zealand) : English (New Zealand)
[ il | version.
Spanish (Puerto Rico) : Espariol (Puerto Rico)
8 1 version.
& French (Canada) : francais (Canada)
1 version.
Chinese (Traditional, Taiwan) : 1 3(&#)
il 1 version.
nu More Languages

M

Figure 1-3. In today’s global economy, most marketers will require a CXP solution that accomodates
multilingual translation of their content

Omnichannel Support

Your CXP should enable you to manage content and view analytics across all your channels (e-mail, print,
mobile, web, etc.) in the same spot. You should never have to worry about maintaining multiple copies of
the same content, or needing to remember two different systems to view different insights on a particular
customer’s recent engagement activity. Figure 1-4 shows a typical customer journey, from seeing something
of interest on social media, to finding reviews of that item with an app, to checking inventory of a local

store, to checking out the item in person at the store, to then buying the item for less online at the cheapest
rate and, finally, checking shipping status via a mobile phone. The point is that your customers cross these
channel boundaries constantly, and you can’t think like a WCM user any longer.
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Figure 1-4. A customer experiences your brand from across many channels. Often a single purchase crosses
most of them several times through a single buying journey. It is critical to understand the customer’s
experience with your brand at every interaction

Key Statistic A full 78% of consumers today shop across multiple channels from online, mobile, and in the store:
http://www.oracle.com/us/products/applications/atg/cross-channel-commerce-survey-333315.pdf

Social Media Support

With customers crossing channels so frequently, it’s critical that each channel be deeply integrated with other
channels, such as social channels. For example, Sitecore allows you to configure Facebook, Twitter, and other
platform users to have the ability to log into your experience and interact with your content. This might be
posting a comment on a discussion board, or as they engage in your site they might earn wall postings noting
their engagement, such as when they complete a goal. Or more basically, you probably want to add “Like” and
Tweet links in your experiences to elicit greater social engagement to draw in new customers.

Mobile Support

Mobile is another given in the world of CXP solutions. This begins with creating rich, compelling front-end user
experiences driven off a responsive design to accommodate any browser size. It extends also from a content
perspective, where content should be easily managed for apps or other third-party systems, accessible anywhere
in the world but managed in one place. Additionally, marketers need real-time access to key insights about their
customer’s engagement, and the ability to make fast decisions around experience optimization—regardless of
access to a large screen. Sitecore was built with a mobile-first mentality to provide such ease of access.

Key Statistic 81% of consumers research the product on their mobile device before going out shopping:
http://www.ninthdecimal.com/wp-content/uploads/2014/09/ND_Insights 02 2014.pdf
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Integration Flexibility

Deep integration with business systems is critical for a marketer to truly understand the complete picture

of the customer. In fact, a study concluded that 78% of respondents attributed their failed digital experience
strategies to lack of integration and the challenges that brought. Technologies that don’t work well together
can incur significant manual costs and project delays. It's important to pick a CXP that has native integration
connectors with your key systems to minimize this risk. Fortunately Sitecore, through connectors or through
third parties, integrates seamlessly with CRM solutions, social networks, ERP systems, and e-commerce
solutions. See the appendix for deeper architectural and integration considerations.

Developer Friendly

For rich, highly customized experiences in the Web 2.0 world, developers need to get involved and you don’t
want a CXP solution that is difficult to customize or expensive to maintain. Many WCM solutions fall down
at this juncture; they often focused exclusively on a good content management experience at the expense of
ease of customization, or vice versa. Indeed, some WCM solutions focus solely on the developer. Some of the
most popular WCM solutions are open source, appealing to the developer and the budget constrained, but
never meeting the expectations that modern experience marketers place on them. Marketers and developers
need to engage in a healthy dialogue on what the CXP solution needs to accommodate. Sitecore carefully
straddles this tension, offering the separation of church and state that developers desire (separate of content
from its presentation details), and yet not sacrificing the marketers desire for control and responsiveness to
changing customer circumstances. Figure 1-5 shows how deep developer integration can go, such as within
standard development tools like Visual Studio.
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Figure 1-5. The developer can achieve tight alignment with Sitecore, their peers, and team development
software and source control with the help of third-party tools such as Visual Studio and Hedgehog TDS. Sitecore
keeps everybody happy
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Tip  Figure 1-5 demonstrates two very helpful add-ins: Sitecore Rocks and TDS from a company called
Hedgehog. Rocks seamlessly integrates all Sitecore content and assets into Visual Studio—something devs
love. TDS syncs all Sitecore and code changes between all developers on a team; a must-have for team
development scenarios.

Enterprise Grade

A busy web solution may be serving content consumed at one million requests a minute. Additionally, the
content is mission critical; perhaps it’s product information as part of an e-commerce web site. In this case
you don’t want garage code running your mission-critical site. You need a CXP solution that is dependable
and tested under stress and is fault tolerant. Sitecore allows for tons of architecture flexibility, from
supporting cloud deployments, web front-end load balancing, and SQL Server availability groups to account
for a highly available, scaled out solution. See the appendix for more details.

Key Features and Capabilities of Sitecore

Now that we have some history under our belt, as well as an understanding of what an modern CXP should
deliver, we can better understand Sitecore’s features and capabilities. Let’s begin with a quick discussion of
the architecture of Sitecore that enables all these helpful CXP features.

Sitecore Solution Architecture

Sitecore’s architecture (Figure 1-6) is broken into five main service tiers: Channels, Management, Sitecore
AIDA, Database, and Integration. The specific features and capabilities of Sitecore are spread throughout
this architecture in various forms.
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Figure 1-6. Sitecore’s defacto solution five-tiered architecture
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Channel Layer

Channels are the points of engagement a customer will enter when they interact with your brand. Sitecore
provides a host of features and capabilities that maximize engagement across the following channels.
Key features and capabilities of the Channel layer include:

e  E-mail Experience Manager

e  Print Experience Manager

e  Federated Experience Manager
e  Social connected

e  Sitecore Commerce 8

Those channels are described in the following sections.

Web

The web channel is the core channel users will engage in from a browser experience. The browser/web
channel also becomes the primary mechanism to administer Sitecore.

Email

Sitecore engages the Email channel primarily through the Email Experience Manager module. This module
allows marketers to create e-mail campaigns leveraging customer profile data, preferences, or segments. The
Email Experience Manager also allows for easy tracking of customer engagement within the campaign.

Must Watch Best practices for e-mail marketing: https://www.sitecore.net/learn/resources-
library/recorded-webinars/5-best-practices-email-marketing.aspx

Mobile

Sitecore accommodates a separation of content and presentation details. This makes it very easy for
developers to create compelling mobile web experiences within Sitecore. Sitecore also accommodates
device detection for situations when an adaptive experience is preferred.

Social

Sitecore allows for easy integration with Social channels such as Facebook and Twitter. When you post
content in Sitecore you can configure it to automatically post to one or many pages in Facebook. You can
also allow users to log in to your site with their federated Facebook credentials. There is a ton of possibility
for a marketer in this channel, from finding brand advocates, to capturing customer intelligence, and
proactively seeking feedback and advice.

10
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Commerce

Sitecore has rich commerce capabilities to tap into your customer shopping behaviors across all your
channels. Sitecore Commerce 8 is a new capability released in early 2015 that enables B2C and B2B
e-commerce managed within Sitecore and a Microsoft Dynamics backend. See the appendix for more
information on Sitecore Commerce 8 and other e-commernce solutions for Sitecore.

Print

Print is another channel that customers interface with regularly, such as brochures and print ads. Print
Experience Manager, a feature of Sitecore, allows marketers to easily capture personalization data to create
compelling, targeted print experiences for customers.

Apps

Mobile apps have become a critical way customers interact with your brand, especially when considering
e-commerce. One of the benefits of Sitecore is the ease of access to centralized content. Content for the web
can be reused for content in an app. Additionally, you can use Sitecore’s Federated Experience Manager to
tie in App engagement data into Sitecore to, again, create a single view of how your customer is experiencing
your brand.

Federated

Federated channels might be channels you don’t own but still represent a view into your customer. Perhaps
a partner web site captures valuable information about your target customers. Through the use of Federation
Experience Manager, you can easily capture those very important, non-Sitecore managed experience’s

data and combine it with native representations of your customer to create a truer representation of your
customer’s engagement across all your channels (and even partners).

Management Layer

The Management layer of Sitecore is the core of the experience platform. This is where content administers
manage content. It is where they configure personalization rules, view engagement scores, and view reports.
It is also what collects, evaluates, manages and analyzes customer intelligence from patters, behaviors, and
decisions gathered across your channels. Additionally, from Sitecore you can manage all of your company’s
digital assets, in one place used across all channels.

Key features and capabilities of the Management layer include:

e  Unified content management
e  The Sitecore Launchpad
e  Viewing analytics and reports

e Digital asset management

11
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Sitecore AIDA Layer

Sitecore AIDA (Analytics, Insights, Decisions, and Automation) encompasses all the sexy features and
capabilities that marketers salivate over. Therein is the power to do advanced content testing, such as
A/B testing. You can also configure customer engagement goals, triggers, and reports to show progress and
campaign outcome attainment. At its core, AIDA provides a rich suite of reporting and analytic capabilities
so your marketing team can discover new insights and customer behavior patterns. See Chapters 3, 4, 5, and
especially 7 for more information about AIDA.

Key features and capabilities of the Sitecore AIDA layer include:

e  Experience profiles

e  Analytics

e  Personalization

e  Experience optimization

e  Experience Automation

Sitecore Database Layer

The Database layer is the heart of Sitecore. Data is the lifeblood of your experience marketing solutions.
Without it, it’s impossible to deliver a highly relevant, personalized, channel optimized customer experience.
Sitecore’s xDB architecture leverages MongoDB for massive data capture and retention capabilities. This
allows high-volume, high-velocity data to be captured and become actionable in real time. See Chapter 7
and the appendix for more details on xDB.

Key features and capabilities of the Database layer include:

¢ xDB (MongoDB)
e  Scalability
e  High availability

Integration Layer

The Integration layer provides connectivity into backend systems such as your CRM or ERP systems. Tying
these systems together forms the basis for a single view of your customer, as well as provides the data you
need for more complex personalization rules (such as past purchases).

Key features and capabilities of the Integration layer include:

° CRM connectors
° ERP connectors

e  Sitecore Commerce 8 and Sitecore Commerce Connect for 3rd party commerce
solution integration scenarios

e  SharePoint connectors
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Unified Content Management

Managing content is a core capability of Sitecore. Content might be paragraphs of copy, web page titles, news

articles, product information, digital assets such as imagery, or rich content such as video, and infinitely

more. By “unified” we mean that the content is centrally managed. It doesn’t matter if the content is served

on a web page, mobile app, e-mail campaign, or shared across five web sites—you manage it all in Sitecore,

in one spot. In this way, Sitecore can become your single source of truth for all customer experience content.
There are three main ways to manage content in Sitecore:

e  Through the content tree
e  Through the Experience Editor
e  Programmatically

Web content is probably the channel most commonly used for content delivery. Therefore, managing
web content is the primary focus of this book. The third option best serves your needs if you are trying to
automate content changes, or perhaps you're trying to integrate legacy systems with your new Sitecore
system. Regardless, that is an advanced topic and won’t be discussed much in this book. Rather, end users
and marketers will most commonly use the Experience Editor for content editing, and to a lesser extent, the
content tree.

The Experience Editor within Sitecore allows users to administer content within a WYSIWIG editor
(what-you-see-is-what-you-get). This can be very helpful, because in the content tree you are often left
guessing what it will look like when you click Publish (or better yet, Preview), leaving you to click the
Publish button dozens of times before getting it right. With the Experience Editor you can see those changes
immediately. See Figure 1-7 for an example. In this case the user is updating the hero image header text to
“I know exactly where this will go” by simply selecting the text and typing the new message.
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Figure 1-7. In this figure you can see how users might go about updating the content on a page. They simply
select the content placeholder that they want to update and start typing! Very easy

The content tree works a bit differently. In the content tree you manage content totally independently
from its presentation. A content item is just a piece of content in this case; it could be used anywhere.
Perhaps the content is a body of text that represents a product description. Perhaps it is content for a drop-down
menu. It’s up to your information architecture to help you understand what it is you're editing.
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Tip  Thoughtful, custom icons on your content items in the content tree will help take the guess work out of
the equation when marketers are trying to figure out where they need to go to edit their content.

As you can see in Figure 1-8, the content tree looks very different. In this case we're making the exact
same update as we did in the Experience Editor. This time we dug around in the content tree to find the
specific piece of content we wanted to update. In this case we found our hero image header text within the
Carousel items item bucket. Therein we see the property we can update to change the content.

| Administator

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW MY TOOLBAR

H <2 & Carousel lbem of3) |_“ S Copy o ® = Rename A Up # Fust
Save Edit~ & Saved Search 2ol3) ¥ Duplicate » [ Movelo  Delete » | Display name v Down ¥ Last

leam -

Q

Read he Arbdes X

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY

VIEW MY TOOLBAR

= < Y Inserfom template (1601) & M S Copy o b 4 =1 Renams A Up £ Fust
Save Editw v Duplicate » $Moveto  Delate =] Dasplay name w Down ¥ Last

Edit HTML

Link Text

Riad the

[ LRI Media Library  Workbox

(el LU Media Library  Workbox

Figure 1-8. You can use the content tree to update content. Simply expand nodes until you find the content
you're looking for and thereafter edit the fields and click Save!
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PRACTICAL TIPS: USE A GLOBAL DATA FOLDER UNDER CONTENT TO
CENTRALIZE SHARED CONTENT

This is great for inline content administration. However, as you read, you can centrally manage content
in one place for many channels or many web sites. Notice in Figure 1-9 how we have a Global folder in
the content tree under the Content root folder. Within Global (not created out-of-the-box, but it’s a best
practice to create it), you can store all your content that you know is reusable. Then, in other content
folders, you can add your content specific to that channel.

4 [ sitecore
4 & Content
b &5 Home
» &5 Store
4 ] Global Data
» ]::J Call To Action Special Actions
» & Email Templates
(2] General Information
» {2 Header Ranks
@ List Types
& Months
» O Radius
» & Robot Commands
» {J Section Background Color Options
» & Sitemap Change Frequency
» {J Sitemap Priority
» o States
B Layout
& Media Library
@ social
%3 System

» E] Templates

Figure 1-9. Your first glimpse into the content tree where content gets managed within Sitecore

While this serves as a basic overview of content management within Sitecore, know that you can go
miles deep with other possibilities here. For example, you may want to configure multilingual content
variations to support multiple languages. You likely will want to configure publishing, workflows, and
security to help instill some governance on content updates. And you will also want to work with page
layouts and templates. All of these examples and more are covered in depth in Chapter 2.
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Analytics and Experience Optimization

At the heart of Sitecore’s analytics engine is xXDB. xDB is a data processing engine built on top of a technology
called MongoDB, an open source NoSQL solution that allows for massive data collection at scale. This is
what makes possible the data collection of every single interaction of every single customer engaging in your
cross channel experiences.

The best part of all this data is the power the information puts in your hands to optimize the site.
Experience optimization is a term used to describe the process whereby you can view experience usage
analytics data and tweak your channels to optimize them to work for effectively for your customers, achieve
your campaign goals, and so forth.

One of the ways to do this is to leverage Sitecore’s A/B testing capabilities. A/B testing allows the
marketer to test one or more variations of some content and compare the customer engagement scores
between each to ensure that the most effective variation becomes the long-term solution. You can test
individual page components, entire sites, or even the entire experience across all channels. Notice in
Figure 1-10 how a marketer can test the performance of an individual component between two variations.

Promo with Thumbnail

. ~ N I LI L
G ettl n g Current Variation

B. A 2nd Option

Avallable variations

B. A 2nd Option

A Original

Clean, moder

" @ Editvariations

Read the Articles

Figure 1-10. With A/B testing, you can try out different versions of the content to see which generates the
highest customer engagement value

These tests can allow you to easily see what is working well on your site and what is not working so well.
This enables you to refine, and hopefully improve, engagement scores across all your channels.

The value in question is known as engagement value. Engagement value is a numeric score that you
set on actions a customer could take. For example, if someone signs up for your newsletter, perhaps that
receives a score of 5. If someone downloads a whitepaper maybe that would be a 3. Each page on your site
has likely several possible actions a user can take, from which you can assign these values. Out-of-the-box
reporting in Sitecore allows for a quick understanding of how your engagement value is trending, as you can
see in Figure 1-11.
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Figure 1-11. Sitecore offers up many out-of-the-box analytics reports featuring, among other things,
engagement value

Engagement values can roll up into goals, such as goals you may have for a marketing campaign. There
are many great campaign reports to show how well these goals are being realized. Outcomes are another
possibility a marketer can manage within Sitecore. Outcomes are channel agnostic goals, such as a lead
converting into a customer. Goals and outcomes are great examples of topics you'll find in Chapter 5.

Experience Automation

Experience automation takes experience optimization a step further. In addition to collecting engagement
value, you can also set triggers on actions to automate marketing activity. For example, if a customer
downloads a whitepaper and also has an engagement value above a certain threshold, you may want

to trigger a qualified lead creation within your CRM. Or, if a customer browses a few products but never
purchases them, you may want to send a personalized e-mail with a discount code they could apply to assist
the conversion. This is a great way to keep you sales pipeline full of quality leads without needing to troll
through contact lists or send blind e-mail blasts out that rarely drive click-throughs. See Chapter 5 for more
details on how to leverage automation in your marketing campaigns.
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STRATEGY BITS: MORE MARKETERS ARE TURNING TO
MARKETING AUTOMATION

As a marketing strategist I'm always looking at reports and surveys to help me understand what
marketing departments are up to, but recently one survey’s results surprised me a little. Software Advice
released their Marketing Automation BuyerView (http://www.softwareadvice.com/crm/buyerview/
marketing-automation-2014/) and one stat that really jumped out is that out of the prospective

of Marketing Automation buyers, 21% currently had no dedicated solution to manage marketing
campaigns, instead relying on spreadsheets, paper/pens, and one-off e-mails.

| understand that a lot of people have shied away from marketing automation out of fear that the
solution is hard to use or implement, but relying on just a CRM solution or standalone e-mail solution is
leaving a lot of opportunity on the table.

But | was encouraged as | kept reading, because it turns out that marketers are starting to prioritize lead
nurturing and conversion-based marketing. 81% of respondents reported that lead nurturing was a key
priority in buying a marketing automation solution, with reporting and analytics coming right behind at 70%.

Marketing departments have been looking for years at ways to better measure and report on their
efforts and deliver better lead-management processes targeted to the prospects. Now they are turning
to marketing automation solutions to help fill some of those gaps. 91% of the respondents were looking
at a marketing automation solution for the first time, giving an indication that marketers are getting
confident in their ability to put a marketing automation solution in place and take advantage of it.

When Software Advice was asked what they thought the struggles for first time buyers would be they
said, “Probably the biggest struggle is understanding how to use the system to its fullest. Various
reports have come out showing that while many companies know they need lead nurturing and

lead scoring capabilities, they have difficulty making full use of the functionality because it is more
complicated than it seems on the surface. For instance, e-mail branching logic, as a concept, is not that
difficult to grasp. But deciding what to do after a buyer opens a lead nurturing e-mail (or doesn’t) and
understanding what content to deliver to keep that buyer moving through the sales cycle is much more
complicated. As a result, first-time marketing automation buyers can sometimes become overwhelmed
once they get into their new system. To counteract this, I'd recommend thoroughly researching exactly
what you need from a marketing automation system before you buy. Once you understand your needs,
start preparing for how you'll use the system well in advance of making a purchase.”

| have to say that | completely agree with this conclusion, but | would also add that bringing in a strong
partner who has experience in marketing automation and also understands the bigger marketing
department picture and operation will determine how successful you can be. Sure, from a technical
standpoint many partners can install and implement a marketing automation solution for you, but that
doesn’t mean they understand how a marketing department operates, or how to build campaigns that
work. They won’t be able to help you identify your processes, creating campaigns that match your
business objectives and take advantage of the marketing automation system at the same time.

So if you're looking at marketing automation solutions, or just trying to figure out what the best route
might be, start small and work fast. Get your plan and objectives on paper, hold a strategy session to
brainstorm all the things you would like to happen, and engage a partner early so they can help provide
support throughout the process.

Zack Wenthe
Marketing Strategist, RBA
Twitter: @zwenthe
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Experience Profiles

Experience profiles (Figure 1-12) are one of the most exciting features of Sitecore. A marketer can see a complete
picture of that customer’s experience with their brand, across all channels, from within that customer’s
experience platform. The massive data collection via xDB is what makes this possible.
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Figure 1-12. An experience profile becomes the single view of how the customer has been engaging with your
digital experiences

This information allows for many compelling possibilities, from simply a greater understanding of your
customers, to enabling personalized experiences (as described in the next section), and to help drive higher
conversions. Additionally, with Sitecore’s ability to integrate with your Customer Relationship Management
(CRM) system, experience data within a customer’s profile can easily be synchronized to CRM, making it
easy for sales associates to take action on leads being generated out of Sitecore.
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One of the most compelling aspects of Sitecore’s experience profile capabilities is the automated
customer segmentation that can take place. The profiling tab on a customer’s profile highlights what type of
customer Sitecore thinks the customer is based on trending experience behaviors or rules. This profile data
can feed into CRM, as well as drive personalized experiences within Sitecore.

Experience Personalization

As mentioned earlier, a customer’s experience profile enables a marketer to know what type of customer
they are. This again is driven from experience behaviors, such as page navigation history, click-through
details from marketing campaigns, or other rules you can configure. Personalization is the most powerful
tool a marketer can employ within their Sitecore experiences to create value for their business.

There are two main ways to enable personalization within Sitecore: 1) through a rules-based
configuration, and 2) based on user behavior. The rules system is very straight forward. Presentation rules can
be applied to any piece of content. For example, you may want to show/hide a piece of content based on what
persona the user is. Or you may want to show different news articles based on what country the user is coming
from (geographic targeting). There are innumerable examples that could be provided here. Suffice it to say,
there is a robust Rules Editor (Figure 1-13) that accommodates any amount of personalization customization
you could ever dream up. Additionally, developers can build custom rules, making the possibilities limitless.

Rule Set Editor

Seledt the conditions and aclions first Then specify the values in the description.

Selectthe conditions for the rule: Selectthe actions for the rule
Filter

WITETETITEare OOE O = DECIC & ~ T &
VT arerarea v LUMpareEs o's CIITC. Var s Conditional R?nﬂ:‘“.’!;s
where the business name compares to specific value hide rendering
where the city compares to specific city sel data source to ltem
where the country compares to specific country set parameters to value
where the DNS address compares to specific value set placeholder to value
where the IP address compares 10 specific value set rendering to ltem
where the ISP name compares to specific value System

re the latitude compares to specific value Add message to log file: level, text
re the longitude compares to specific value
where the metro code compares to specific value v

Rule description (click an underlined value to edit it)
Rule 1

where the country compares to United States

r where the country compares to Canada

orf where the country compares o Mexico

hide rendering
Add a new rule

Figure 1-13. You can configure rules on content to personalize the content. This might be to show/hide
content, or to dynamical choose the content source based on customer demographics
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Behavioral targeting is another great way to personalize content. Instead of fixed rules, Sitecore is
smart enough to assign a persona to a customer dynamically based on that customer’s interaction with
your experiences. This is especially helpful for anonymous users who haven’t logged in yet, since you really
don’t know anything about them at that point. As the customer engages with the experience, Sitecore learns
with each click how the experience may need to be personalized based on their behavior. This makes the
most obvious sense in an e-commerce setting, where you may feature products or sales based on browsing
history. See more in Chapter 3 on how to leverage these powerful capabilities.

Federated Experience Manager

Sitecore’s federated experience manager (FEM) has been heralded as a game changer in the CXP world.
FEM enables a marketer to see customer behavioral data and share Sitecore content across all their
experience properties regardless if they are on the Sitecore platform. This enables you to maintain a single
view of the customer and a single source of content no matter if you've upgraded/migrated all your digital
properties to Sitecore, or if you plan to take a more gradual approach to your migration. Examples might be
Sitecore sites, non-Sitecore sites, or native mobile apps.

Additionally, FEM enables better collaboration with partners. You and your partners may want to
collaborate on customer data. You can ask your partners to deploy the necessary page scripts on their
properties to send a feed of customer data back to your xDB instance to create a consolidated view. Here are
a few more examples where FEM can create value for your marketers:

e A company hosts sites that cannot be managed by Sitecore (e.g. non-.NET sites or
apps, such as WordPress or PHP sites)

e A company wants to better collaborate with their partners

e A company is in the process of migrating their properties; however, they don’t want
to wait until they are all migrated before taking advantage of xDB'’s capabilities

¢ You may be in acquisition mode and need to take control of new properties and
quickly integrate them into your overall marketing objectives

See the appendix for more details on FEM.

Email Experience Manager

Sitecore’s Email Experience Manager (EXM) enables greater marketing automation across web, mobile, and
e-mail channels. Additionally, EXM can be a great lead trigger in your CRM as customers engage with your
mail campaigns. EXM allows the marketer to send three types of mail messages:

e One-time message—This is for one-time blasts to your customers. Blasts can have
rules associated with them, in case you want to target a specific segment, for example.

e Subscription message—EXM allows for customers to subscribe to blasts, such as a
newsletter. Anyone subscribed will receive the mail.

e  Triggered message—A triggered message is a great automation technique to capture
customer behavior on your properties and drive greater conversion.

xDB captures click-through rates and subsequent engagement value and realization of campaign
goals. For example, you may create a campaign with various goals associated with it, likely across multiple
channels. When you send a message from EXM you can associate it to a campaign. As xDB captures
experiences, that data can pull engagement values to show the effectiveness of the message itself as well as
the campaign. Figure 1-14 shows a sample report that EXM provides.
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Figure 1-14. Email Experience Manager (EXM) provides rich reporting to allow the marketer to gauge the
results of the message and engagement value derived, which also feed into the campaign’s result

Note EXM also supports multivariate testing, which allows you to try different versions of your messages
to best understand which versions drive the most engagement values.

Print Experience Manager

Print experiences remain a critical component of a marketer’s arsenal. During sales presentations,

expos, conferences, and in displays, sometimes print remains the best channel to create a customer and
communicate your brand’s value. However, all the aforementioned expectations customers have in the “age
of the customer” haven’t changed. Customers still expect you to anticipate their needs. They expect highly
relevant, personalized experiences, even with print. Print Experience Manager (PXM) takes the capabilities
we've already discussed and delivers them onto a print experience.

PXM utilizes the same personalization rules, customer experience profiles, and content managed in
Sitecore to dynamically create print content your customers need. Use PXM to generate print media in real
time, such as when they click to download a brochure. Instead of a canned, “catch-all” brochure, download
requests can generate a brochure that’s best suited for that customer. This enables marketers to focus their time
on interpreting experience insights, versus hours and hours spent generating 20 copies of the same collateral.

Quick Tour of the Sitecore Admin GUI

The goal of this section is to give you a high-level sense of how to maneuver within the Admin screens. The
rest of the book will spell out the details. For starters, every Sitecore site is administered from beneath the
/sitecore path in the site’s root, such as http://mysite/sitecore. When you first navigate to this path
you’ll land on the Sitecore Launchpad (Figure 1-15). You can navigate to all of the Sitecore administrative
user interfaces from this Launchpad view.
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Sitecore Experience Platform

CAMPAIGN CONVERSIONS VALUE AND VISITS

Figure 1-15. The Sitecore 8 Launchpad offers an alternative to the windowed experience of the desktop view,
featuring a couple of high-level analytic reports

Alternatively, some prefer the more traditional desktop view (Figure 1-16). If you click the Sitecore icon
on the lower left, you'll see a launch panel appear similar to what you'd expect from a Windows 7 or earlier
operating system. Each of the screens loads in a “window” within the browser similar to a Windows desktop
experience. Alternatively, some prefer the Sitecore Launchpad (Figure 1-15) for their default view.

24



CHAPTER 1 " INTRODUCTION TO SITECORE 8

.0' E3 - - EN

«>2CH traincore/sit @ =

Content Editor Experience Editor

" Marketing Control Panel ™ Praview
Conbgure manketing features Preview yous websie

Media Library Debug
Maintain yeul media items N7 Open me Debugge

' Secunty Editor % Recycle Bin
Template Manager q Search

@, Sitecore App Center Workbox

@F  instaa anc maintain app Manage Incoming

o Fublish Site o Control Panel

Y Publish your website hanige seming
n Security Tools »
ULEE Development Tools »
"

Reporting Tool! »

4 Reporing Tools

All Applications

Figure 1-16. This is the view of the Sitecore Desktop, a launching point into Sitecore’s settings and
administration

The benefit of the Launchpad is that you can configure default reports to load on the page for a quick
view into how your site is performing, and it is also a bit more tablet friendly. What’s more helpful is the
avoidance of the windows; each component is loaded full-screen, leaving you to click the grid icon in the
upper right to get back to the Launchpad. In the end it is just a matter of preference.

A key point on the desktop view to take note of is the database selector on the lower right of the screen
(Figure 1-17). When you administer content or other settings you want to be doing that in the master
database. When you're ready to publish your changes, you publish to the web database. Sitecore settings are
stored in the core database.

Show Database Name
core

master

a

web

Figure 1-17. From time to time, you may need to switch between the master and web databases
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By default, the Launchpad and content editors are pointing to the master database, which where
all content administration should take place. However, there are times where your master database and
your web databases may be out of sync, such as before a large site update. In these cases, you may want
to toggle the database to the web to confirm how things are set up in production. Note, however, that
you should avoid editing content in the web database or that content will likely be overwritten during
the next publish.

Note You never want to make changes in the web database. The web database should be for published
content only. Changes in the web database run the risk of being overwritten when master database changes
are published.

Another administrative interface that is extremely helpful is the Sitecore Instance Manager (SIM),
as seen in Figure 1-18. SIM is available for download in the Sitecore Marketplace (found at
http://bit.1y/1L1f5iZ), a place where community members can share freely downloadable modules
for Sitecore. SIM is a small little GUI that helps you quickly track and administer your instances, and
it is especially helpful for developers who may have many instances of Sitecore on their development
workstations. Some of the key features of Instance Manager are:

e  Export and import entire Sitecore instances (a great way to promote an install when
you don’t have access to SQL Management Studio to restore SQL backups)

e  Quick links into IIS (resetting application pools, hot link into the inetpub folder, etc.)
e  Quicklinks into the instance’s Launchpad items

e Quicklinks to key configuration files

e  Keyadministrative function (backup, export/import, publish, etc.)

e Download and easily install modules/add-ins
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Figure 1-18. The Sitecore Instance Manager is a great administrator tool for keeping track of Sitecore
instances, providing quick links into configurations, and many other great efficiences

Tip There are many fabulous modules in the marketplace. Check them out at
https://marketplace.sitecore.net/.

What’s New in Sitecore 8?

There were many new enhancements made in the eighth version of Sitecore that make it stand out from
previous versions. The most innovative feature that is widely acknowledged is the new Federated Experience
Manager capabilities discussed earlier. These capabilities are really a game changer for marketers; namely,
the ability to bring the power of Sitecore to all their properties, whether they are on Sitecore or not.

Other notable enhancements in version 8 include native integration with the Experience Explorer, a
very popular feature for marketers who want to “explore” the experience of various personas to see if they are
getting the expected experience. Marketers also get a nice bag of tricks with version 8, including more robust
segmentation capabilities and the ability to target content with a persona. A key feature from an analytics
perspective is the Path Analyzer report, showing entry points and the most comment destinations users take
after landing on a page. See Table 1-1.
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Table 1-1. Highlighting the Key Differences Between Sitecore’s Verions

Feature

Sitecore 6+

Sitecore 7+

Sitecore 8

Marketing and engagement automation

Measurable value and efficiency data
Real-time personalization
Dashboards and reporting
Classified origin visits

Content experience platform
Device simulator

Page preview service

Native MVC support

Page Editor and Rich Text Editor
Supports SQL Server DB mirroring
Lucene.NET Search Engine
Executive Insight dashboard
Buckets

Content tagging/faceting

Search screens

Analytics collection database
Scalable analytics data architecture
Contact entities

Tracking across devices/visits
Launchpad applications
Experience Explorer

Content tagging using personas
Versioned layouts

Federated Experience Manager
List Manager and segmentation
Path Analyzer

Simple and advanced testing

T T B o R B T o B

T R R R e T o T o T T T B B I B

T T B B B R ST o T o T T B B B I I A s T o T o T B A
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Summary

At this point it wouldn’t be surprising if you found yourself a bit lost in this wide world of Oz. The
munchkins told Dorothy to follow the yellow brick road, and I know that as you proceed through the rest
of this book you'll find your way through this massive, beautiful, and yet sometimes scary world we know
better as Sitecore.

You've already seen how Sitecore is helping redefine a marketer’s expectations on a Web Content
Management Solution (WCM). In fact, Sitecore is helping to create an entirely new category of Customer
Experience Management Solutions (CXP). This is predicated on the emergence of the “age of the
customer,” where customers expect more from digital experiences, such as highly personalized, relevant,
targeted content.

Fortunately, Sitecore meets the needs of the marketer, and then some. With popular features such
as personalization, goals and campaign management, and rich analytics and reporting, marketers have
all the power they need to take their digital experiences to the next level. The beginnings of this journey
include managing content, which is where the yellow brick road takes us in Chapter 2.
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CHAPTER 2

Managing Content

This is probably the most important chapter you will read in this book, because it contains the most
foundational concepts that all other chapters build upon. All future topics branch out from their roots in this
chapter. The goal of this chapter is to lead you through the features, capabilities, and configuration options
found within Sitecore’s content and experience editors.

Before diving right in, however, the chapter begins by reviewing the Sitecore hierarchy. Understanding
the difference between data templates, content items, and layouts represents the most foundational
knowledge a Sitecore user is can have. Surprisingly, it’s not as straight forward as one might think to pick up
on, so an entire section is dedicated to ensuring you understand this more theoretical concepts.

Beyond this is a section geared toward helping you learn the fundamentals of content management
in Sitecore. This includes managing rich media, working in the Experience Editor, and managing multiple
language translation, among other important topics.

It should be noted early on that this book leverages Launch Sitecore (Figure 2-1) as a foundation for all
examples and images. Launch Sitecore is a freely downloadable Sitecore package. The package contains a
full functionality demo site that leverages all of Sitecore’s key features and capabilities. Additionally, Launch
Sitecore comes with the source code, making it easy for developers to learn the internals of the solution and
key customization techniques. You actually don’t even need to download and install Launch Sitecore. Even
without downloading, you can navigate to http://www.launchsitecore.net/ and play around within the
site, testing personalization and viewing your assumed persona. However, I recommend you ask an admin
to install Launch Sitecore on a sandbox environment somewhere where you can be granted administrator
access. It’s a fabulous learning tool, and that would make it easier to follow along in this book.
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Home | Launch Sitecore %

€« C fi launchcore ~ @ =

Q sitecore  » e

Learn About this Site

Launch Sitecore includes a collection of articles about how
and why we built this site.

\ Read the Articles »

Getting Started with Sitecore About Launch Sitecore
Clean, modern & responsive neh Sitecore is @ collection of article ﬂ

© ~ 0 5

Digital Marketers Content Owners Developers Network Architects

Figure 2-1. The Launch Sitecore site is free to download and a great tool for learning Sitecore. You can
download it by registering at http://www.launchsitecore.net/

The Sitecore Hierarchy

The first step a Sitecore user needs to understand is the tree view you see in the Content Editor. Figure 2-2
shows the default view of the content editor when you first open it, featuring the tree view off to the left. The
three most important nodes in the tree to familiarize yourself with are Templates, Content, and Layouts.
There are others, and they will be covered later. For now, it is important to not move on beyond this section
until you fully understand the concepts of these three nodes, as all else depends on them.
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> o ]
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Callto Action Link: .
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Figure 2-2. This is the default view of the content editor, featuring a tree of items on the left and an item’s
details on the right, with the ribbon across the top

Note Most marketers will only see “Content” and “Media Library” in the tree when they log in. The other
areas, such as “Templates” and “Layouts,” are managed typically exclusively by developers and administrators.
However, to provide a more holistic overview of Sitecore, these concepts are introduced in this section.

Many marketers and content editors may prefer skipping to the next section, “Content Editing Fundamentals,”
to get straight to the point. Power users are advised to continue reading this section.
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Templates

Templates are defined within the Templates node in the tree view. Templates, also commonly referred to as
“data templates,” are the foundation of your Sitecore deployment. Every piece of content in Sitecore needs a
data template to define what it is. For example, you might want a carousel featured on your home page

that rotates featured news stories. The first step to set this up is to create a new data template for this
component/functionality. You may choose to name your data template “Carousel Item” and give it a few
fields you would expect to see in a carousel, such as a title, a caption, and an image.

Note Many people are confused by the term “template” because they expect a visual thing, which,
in Sitecore, is more akin to a “layout”. Templates are just definitions of metadata around some type of object.

Figure 2-3 shows where within the Templates node that data template is defined (more on location
best practices later). Note also in Figure 2-3 the data template’s fields defining the template. Again, the data
template does not store any data. It is simply a template you use when you create content.

Builder Inheritance Content Q
» % Home A
» (B Developing in Sitecore
» @ Global

» B Layout

Carousel ltem

p & Media Library

» @ social Title Single-Line Text ¥
» &y System /

4 [&| Templates

Caption Rich Text »

» @ App Center Sync i 2
» & Branches
» -;,l Common Link Text Single-Line Text ¥
» J ListManager
» ] Sample

; Link Item Droptree ¥
» @ System

{ZJ User Defined

rl ;_'__—' Global Image Image v
a ContemTempIates/

» & Carousel ltem

Use Dark Text Checkbox v
» Promo Spot
» i) Quotation
» 3 Sticky Note Add a new fie Single-Line Text v
P |E] TextWidget

» ] Settings Templates

» J Launch Sitecore =

Ll L3

Content Editor [REVERNT e, IR0 T

Figure 2-3. Data templates define what metadata and settings get applied to content items
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Note See the appendix for more details on creating and managing data templates. Since most marketers
and power users will not be responsible for these settings, they are not covered in this chapter. However, proper
data template setup is one of the most foundational elements of a good Sitecore deployment, so they are
covered in more detail in the appendix for those who want to take their understanding to the next level.

Content

Content is administered below the Content node in the tree view. Sitecore end users and marketers will
commonly spend the majority of their administration time below this node in the tree view. Administrators
commonly restrict them via security settings to just this node, in addition to the Media Library node, where
they can upload imagery, video, and other digital assets.

Content in the Content node is just an instance of a data template. When you create a new content
item you must select which data template you will use as the basis for what that content will be. Figure 2-4
shows a user inserting a new carousel item to be used on the home page’s image rotator. In this case the
administrator created a item called “Carousel Items” and limited that item’s children to only allow items
using the Carousel Item data template to be created below that node (more on the Saved Search and Insert
from Template options later).

4 [2] sitecore
e z .
4 & Content v & @r Location: Carousel ltems
» & Home

» (B Developing in Sitecore

4 @ Global
4 [ Content
b = C
Insert » & Carousel ltem
» P
o Search r Saved Search
P Wa _ . o
4] Duplicate | 1 Insertfrom template
P & S
_ ®  Delete
P T
_ = Rename
» (¥ Setti
Copying »
» B Layout
Sorting »
P & Media Lib
¢ Refresh
» @ Social
P ¥ System

» E] Templates

Figure 2-4. You can insert child items below nodes in the tree view. In this case we're inserting a carousel item
below the Carousel folder
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STRATEGY BITS: HOW TO HARNESS THE POWER OF CONTENT

36

Our world is driven by design. We now design features, structures, and repositories; we spend hours
pouring over user research and technical requirements. But one area still so often lies forgotten—the
area of content.

Content has equally been described as “whatever you fill your CMS boxes with” and “everything”.
Essentially, content is what you use to convey your thoughts and persuade others to feel and take
action. “Content” can be words, pictures, icons, video, tables, and calculators—it truly is the meat of
your experience and it's becoming the most “in demand” area to get right.

Unbelievably, 5 exabytes of data were created between the birth of the written word and 2003. In
2013, 5 exabytes of data were created every day (reference http://aci.info/2014/07/12/the-
data-explosion-in-2014-minute-by-minute-infographic/). So, how do you keep ahead with this
insatiable demand for content when you’re the one having to plan or execute a digital project for your
team or business?

For many years, platform-first approaches meant that content is often an afterthought (“here’s your box,
now please fill it with something, oh, and you only have a few days to figure it out”; sound familiar?).
Just as importantly, once the haze of the launch party is over, you need a way to ensure that the
experience you’ve spent months creating continues to generate results in the long term.

This is where the discipline of content strategy comes in. In simple terms, content strategy helps you
plan the best way to engage and connect with people, so that you achieve your goals and theirs. Good
content strategy also helps defines decisions, processes, and tools around how organizations plan,
create, and manage content.

Four focus points can help establish even the most straightforward of strategies.
The “Why”

This is often the most neglected step but is also the most important. If you don’t have goals clearly
defined for your experience (whether a web site, app, intranet, and so on), this is your chance to shine.
Think of your goals as your anchor in a storm. They will help you center your team in the months that
follow with a clear vision as to what you want to accomplish. Ask these questions:

e What do we need to accomplish with this experience? (This can be a combination of
soft goals, such as changed perceptions, and hard goals, such as $$ in sales.)

e What does success look like for this experience?
e What does failure look like for this experience?

¢ How will we measure it? (Which tools and process will we use to measure and
communicate results, and who will be accountable for it?)

The “Who”

Unless you're really going for a cookie cutter experience, you need to be clear on “who” you’re trying

to reach. In other words, who is your audience? Instead of thinking about all of the content you want to
write, think more about what your users will respond to. What will resonate with them? How can you help
them succeed? What do you want to avoid? This activity can be executed in many ways—on a basic
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level, you can document your internal team’s assumptions, then test them after launch. Or you can invest
in user research to gain a first-person view of who your audience is and what they expect from you.

The “What”

This is where the substance of your content comes into play and is often the most challenging aspect to
content strategy. But you don’t have to start with a blank sheet of paper (or template) if you follow the
right steps.

Step 1: Be a Visionary

First, create a vision for what you want your content to achieve. Some people do this with a content vision
(ref: “Content Strategy for the Web” by Kristina Halvorson, Melissa Rach http://contentstrategy.com/);
others write a brief document or “manifesto” that outlines the mandatories for what they hope content
will drive for their experience.

Whatever you do, make sure you have buy-in on this vision from senior level decision makers in your
organization (preferably you’ll have worked with them to write it). You’ll need this agreement when
decisions need to be made down the line.

Your vision should be flexible enough to evolve with your knowledge and changing business needs,
aspirational and motivational to help lift your content efforts, and practical enough to deliver what your
organization and business needs.

Step 2: Know Where You Are Today

Digital experiences are rarely created on a whim. Many larger projects need to unravel years of content,
technology, and features to get to a new state. Sometimes things are deemed so “broken” that they
simply need to be blown up and recreated.

But sometimes, knowing what you have in front of you can be a good first step to creating something
new. A content inventory can help with this—an inventory is a catalog of the content that exists within
your experience today. Typically executed within a spreadsheet format, it includes information such as
the reference for the content (e.g. home page banner), the actual content itself, the content source

(a person, a vendor, or data), the content owner, and other pertinent information.

Step 3: Be Honest About Your Gaps

The beauty of the creative process is that you’re creating something new. However, you may have
existing content you already know you want to use in that experience—perhaps content you know has
worked well before or organizational “must-haves”.

One way to get a sense for how much content you will need is to conduct an audit. An audit can take
many forms, but two favorites are often:

e An opportunity analysis—This audit helps you understand how close your current
content is to your vision and your user needs and generally reveals broad areas of
opportunity within your intended experience. For example, your content vision could
say that you want your customers to connect together to share ideas, but your existing
web site may simply be online brochure-ware that promotes products. An opportunity
analysis will highlight gaps in content and features that you’ll need to address.
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e A “nuts and bolts” audit—If you’re considering keeping and transferring content from
an old experience into a new one, this more qualitative approach can be very helpful
in determining what you might need to update to create consistency or accuracy. In
this audit, you're reviewing aspects such as content accuracy (e.g. correct spelling and
grammar), use of best practices in experience design, whether you have broken links, etc.

Within your audit, be sure to note what content you may want to keep, what content you want to forget,
and what content you need to create.

Step 4: Become a Content Wrangler

When a new digital experience is being created, it suddenly seems that everyone is an expert on what
topics to write about! This can become challenging to manage if you’re in an organization bigger than,
say, the number of fingers on your left hand,

A helpful way to think about content is to create content themes, which are based on your content
vision, and also any brand pillars your organization may have.

This means creating a prioritized list of what matters to your organization. Then doing the same with
what matters to your audience. You bring those together and create a common set of “content themes”.
Let’s just say you work for an architectural firm that is passionate about sustainability. Start with
sustainability as a content theme. Define it. And use that definition to help guide editorial conversations
you have with your team—a top-down approach rather than bottom up.

Once you have your content themes in place, you'll find it’s easier to create posts yourself or organize
larger teams of content creators.

The “How”

The “how,” often also called governance, is the key to sustaining an effective content strategy. Find
my strategy bit in Chapter 9 for the all-important conclusion to harnessing the power of your content
strategy.

Laura Best
President, Best + Co
http://www.bestdigitalstrategy.com

Layouts and Components

Layouts are the third leg in our journey. We have content created from a template, but what does it actually
look like? Layouts tell Sitecore where to render the component, and components tell Sitecore how the data
template and the content instance should be rendered. A layout contains one or more content placeholders
marketers can add/remove components into. A component has a controller (a web control if you're using
Web Forms; see the sidebar entitled “What Is a Component?”) that renders the component on the page.

Should the title of the Carousel item be Heading 1 and Red or Heading 3 and Black? Should the image
be to the left of the title, or as a background? This is the responsibility of the component’s controller and
view, and for better or worse, this is where you will rely on a developer. For better, because you and your
developer team will appreciate the near infinite control to meet the needs of your requirements, but for
worse because as a marketer your control is limited to how much control the developers build into the
system to empower you to make these formatting changes (more on this later).
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However, marketers can control where on the page components are dropped by adding components
into placeholders. Placeholders then can be configured to only allow certain components to help enforce a
standard information architecture. Additionally, developers should be adding configuration properties onto
components to make component settings editable by marketers. As a best practice, developers should consider
making settings editable by marketers to make the solution as maintainable by as many people as possible.

As an example, notice the Presentation Layout Details dialog box on the home page (Figure 2-5). In this
case, a Carousel component was added to the components collection for the default device (mobile devices
use the default in this case since there are no settings for mobile specifically). The default device is set to use
a layout called “Main” that controls the positioning of the components on the page via placeholders.

A developer builds, deploys, and maintains each layout, such as Main in this case, according to the marketer’s
specifications. But the marketer can choose where within Main the carousel should be rendered.
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Figure 2-5. An item’s Presentation Layout Details, PLD, is where you can configure the settings Sitecore uses to
know how to render an item
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WHAT IS A COMPONENT?

A developer can build a component via Web Forms (legacy) or via MVC (Model-View-Controller) design
patterns. Alternatively you can download/buy components from the marketplace (http://marketplace.
sitecore.net) or from third parties.

MVC is the best practice when developing your own, in which case the component’s view is deployed
into the Renderings folder within the Layout node. The view/rendering has a property that specifies the
controller used to execute and render the component. In Figure 2-6, you see the Controller property that
specifies the namespace and class name that renders the component. The Controller Action property
specifies which MVC controller action (method) that is called specifically for this component (view).

4 Mé Layout
] Controllers @ Carousel
» [ Devices
» @ Layouts
» ] Placeholder Settings Data
4 @@ Renderings
» @ App Center Sync Controller
» {J sample LaunchSitecore.Controllers.ListsController, LaunchSitecore
» J System
4 {J LaunchSitecore Controller Action |
» {J Analytics Caroused
4 {J Lists
$= Articles By Co Placeholder

& carousel

EE Datasource Li
Figure 2-6. Developers can use MVC to build renderings

The scope of this book doesn’t go deep into Sitecore development and how to build MVC-based Sitecore
components. Suffice it to say, components live in the Layout » Renderings node and generate the
HTML needed to render the content instance based on a data template. Components can be added to
pages by marketers within the page’s Layout’s placeholders.

Content Editing Fundamentals

With your data templates established, you can finally begin entering some content! As you would expect,
content is managed from the Content node within the content editor tree view. More commonly, marketers
tend to favor editing content in the Experience Editor, because they see visually how the content will look
real-time while editing the content. The Experience Editor is covered later in this chapter, but with the
Content Editor being most foundational, we’ll begin there.
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Note Many examples in this section extend data templates discussed in the appendix’s section called
“Data Templates”. You are not expected to have read the appendix to understand this chapter; however, it's a
good place to go if you’re looking to take your understanding to a deeper level.

Typically below the Content node, you'll have child nodes for each web site you are managing (in the
case of Figure 2-7, “Home” might instead be called “Site 1”). In addition to you site root nodes, you'll have a
Global folder for content that is shared across sites.
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Figure 2-7. Direct decendents below Content typically include site-level nodes and nodes for globally
shared content
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Every item below the site’s root home node is URL accessible. In the case of Developers below
Audience, you would access that content by navigating to http://launchcore/audience/developers.
Therefore, all content items below the site’s home root node will need to be given a layout to control how the
item is rendered when a user browses to that URL. This is a rather complex topic and will be handled later in
the section called “Presentation Details and Applying Layouts”. For now, we'll skip all those details and focus
on creating content for our Featured Product and Product Promotion data templates created earlier.

Getting Started

To get started we're going to create content for a couple data templates, named Featured Product and
Product Promotion (steps on how to create these can be found in the appendix). We start by going into the
Content node within the tree view and considering where to put this new content. Here are some objectives
for these two components to help us understand where to put the content:

e  Featured Product—When someone visits the home page we want a model dialog
overlay of the site showing a featured product based on that user’s persona and/or
browsing behavior.

e Product Promotion—On the home page there is already a Promo Spot, but it is
generic and doesn’t have the fields we want when/if we want to promote a product,
such as the discount, its price, etc. In our data template we've extended Promo Spot
to incorporate these extra fields.

Since both of these are components within a page, not a page in and of themselves, we don’t want the
content to be URL accessible. There are a few ways to accomplish this. We can 1) create the content below
the site’s start item, but in not giving it a layout it won’t be accessible, or 2) create the content outside the
start item, such as in the Global folder. In the case of Featured Products and Promotions, there are very
reusable and would benefit from being in the Global folder. Use the following steps as a guide to create the
featured products and promotions:

1. Create a Global folder below the Content node if one doesn’t already exist. Below
that folder create a Content folder if one does not already exist. You create folders
by right-clicking the parent, choosing insert, and then choosing Folder in the
drop-down menu.

Note Oftentimes a developer or administrator would have first set up the Content node’s structure that a
marketer will be working in. You might not have the security access rights needed to create folders. In general,
this chapter assumes you will have a rather high level of access. If you find yourself not seeing an option in the
user interface that aligns to these steps, ask your administrator to make your requested changes or to increase
your access rights.

2. Below the Content folder, create two new folders—Featured Products and
Product Promotions.

3. Give the two folders icons to make it easy for end users to know what they’re
working with. Click the folder. Under the Configure tab, click the Icon drop-down
within the Appearance section.
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Before we start adding content to these folders, we need to talk about insert options. The standard
behavior of a folder is that only administrators can add content or folders, unless you specify insert options
that allow non-admins the ability to create content specifically permitted within that folder. The Insert from
Template option allows an admin to select from all data templates that exist, but that option is only available
to admins. So it is important to specify insert options, since marketers can’t create content if you don’t, and
you want to control what content goes where. If we have a folder called Featured Products, we only want
featured products to be in that folder. The following steps walk you through setting up insert options:

1. Click the Featured Product/Promotions folder.
2. Under the Configure tab, within the Insert Options section, click Assign.

3. Select the data template(s) you want to permit, which in this case would be
Featured Product and Product Promotion, respectively.

4. Remove the Folder insert option because we don’t want users creating folders
below these nodes.

When it’s complete, the Insert drop-down menu should look something like Figure 2-8 (note again that
only admins will see the Insert from Template option).

» & Featured Products
# Product Pr _
Insert » % ProductPromotion
» & Promo Spc =
Search |1 Insertfrom template
P i) Quotations _ _
[1] Duplicate
» & Sticky Note
#® Delete

o] TextWidge
= Rename

Figure 2-8. Insert options can be used to control what new content can be added below certain nodes

Remember the Source column on our data template fields (steps found in the appendix)? For Featured
Product and Product Promotion we had Image fields and Related Product fields. Each of these fields allows
the user to navigate to or search for other items within Sitecore, such as an image or other related product.
Since our Source columns are not established, the user will have to navigate across the entire content tree
to find our Featured Products. Rather, let’s go back and set the source now that our Featured Products folder
exists. Use the following steps to get this done:

1. Select the Featured Products folder below the global content node. Then, click
the red menu next to Home and then click Item Properties (Figure 2-9).
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HOME NAVIGATE REVIEW
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Figure 2-9. Every item has standard properties, such as its path within Sitecore

2. Select and copy the Item Path value. This is the path to the folder within the tree
view and will become the source for our Related Products fields.

3. Paste this value into the Source column within the Related Products fields within
our Featured Product and Product Promotion data templates.

Finally it’s time to add some content into Sitecore! It only took about 20 pages to
get to this point. In some sense that sounds a bit ridiculous, it’s a good example
of what it takes to really get to a point where you're adding content. There’s a
saying: “Sitecore is like a Ferrari engine. You know it’s fast, but just because you
bought it doesn’t mean you can use it” The foundation must be paved before our
marketer friends can get productive!

4. Create three Featured Products and Product Promotions. Don’t worry about the
Image fields or Persona field just yet. We'll cover media next and personalization
in Chapter 4. Click Save after each one. We'll discuss publishing later as well.

Managing Rich Media

You will want to store all your rich media in the Media Library node within the tree view. The Media Library
is your one-stop show for all your digital assets, including images, documents, videos, and audio recordings.
You will want to organize your items within folders named appropriately. After you create a folder, when you
click on that folder you will see three options: 1) Upload Files, 2) Upload Files (Advanced), and New (Sub)
Folder. You can upload one or many files by simply clicking the Upload Files button and selecting the files
you want to upload.

Advanced (Figure 2-10) upload provides a few extra features worth noting.
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Figure 2-10. Advanced media upload can be handy, such as upacking a ZIP file

e Unpack ZIP archives—This option will unpack a zip file containing an image, rather
than upload the ZIP file itself.

e Make uploaded media items versionable—By default media files are not versionable
(see the “Content Versioning” section later in this chapter). You can specify
language-specific versions of a file by making the files versionable. Additionally, you
can rotate in/out a version of a file, say when you have a seasonal promotion.

e Overwrite existing media items—Check to overwrite existing files of the same name if
they exist.

e Upload as files—Files will not render a preview.

A neat feature of the Media Library is the Image Editor (Figure 2-11). The Image Editor allows you to make
minor cropping, resizing, and rotation edits to photos. To open the editor, simply click the image you want to
edit, and then under the home page, click Edit under the Edit section and then click Edit in Image Editor.
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Figure 2-11. Sitecore comes with its own image editor for basic editing, such as cropping or resizing images

Execute the following steps to continue our configuration of our Featured Product and Product
Promotion components. This will limit a Featured Product’s product image to be chosen from a specific
location within the Media Library:

1. Start by creating a Products folder in the Media Library below a folder named
similarly to the site’s name below Content and Templates for consistency.

2. Click on the new Products folder, and then click the red menu and click Item
Properties (Figure 2-10). Copy the Item Path value.

3. Now that we have a folder for our product images, navigate to the Featured
Product data template and update the Source field on the Product Image field.
Paste the Item path into the Source column in the Product Image field, clicking
Save when complete.
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SHOULD YOU STORE MEDIA IN THE DATABASE, FILESYSTEM,
OR A CDN?

By default, all media is stored in the SQL database. An alternative to storing your media as BLOBs in
the SQL database is to store them on a network path with SQL simply serving as a pointer, similar in
concept to remote BLOB storage.

Storing media in the database offers unique advantages and disadvantages. The biggest advantage
to this is the peace of mind of a simplified architecture and fewer steps to worry about during a
disaster recovery. The biggest disadvantage is the potential for very large databases that might make
recoverability times longer during an outage if you needed to restore from a full backup.

Performance, in some cases, might benefit from getting the files out of the database. Specifically, large,
infrequently used files such as videos, would benefit from being served from the file share. The ASP.
NET BLOB cache can be used on your web front-end servers to cache large, frequently accessed files,
thus mitigating performance concerns in those cases. However, if you have thousands of videos being
accessed often, but each individually infrequently, that initial deserialization out of SQL can be a doozie.
In these limited scenarios you have a strong case to move your media files out of SQL. A CDN is the best
choice if performance is a concern. Offloading all assets to a separate provider can have a significant
positive impact on your infrastructure. However, using a CDN is commonly the most expense of options
for very busy sites.

For 99% of the cases, leaving the media files in the database is the best practice. Fortunately, files can,
on a case-by-case basis, be put in the database or the file share. This can be helpful for the edge cases;
however, users will need a lot of training to understand when to select the Upload as Files checkbox.

Or, you can force it one way or another.

Consider the following web.config settings to tweak this behavior:

e  Media.DisableFileMedia—By default Sitecore permits the user to specify at upload time
where the file should go, in the database or in the file share. This setting by default is
false, thus permitting file share uploads. You can disable file share uploads by setting
this to true, forcing all files into the database.

e Media.UploadAsFiles—By default media files are uploaded into the database.
This setting changes the default behavior to upload to the file system (Upload as
Files setting checked in the Advanced Upload dialog). This setting is ignored if
DisableFileMedia is set to true.

e Media.FileFolder—Here you can specify the UNC of the path to which files will
be uploaded.

Working in the Experience Editor

Now that we have out data templates in place, and we have content created that our components can render,
it's time to add those components to our site with the Experience Editor. But first, a brief tour is needed,
as there is a lot you can do with this tool!

47



CHAPTER 2 = MANAGING CONTENT

A Brief Tour

The experience editor within Sitecore allows users to administer content within a WYSIWIG editor
(what-you-see-is-what-you-get). This can be very helpful, because in the content tree you are often left
guessing what it will look like when you click Publish (or better yet, Preview), leaving you to click Publish
dozens of times before getting it right. With the Experience Editor you can see those changes immediately.
See Figure 2-12 for an example. In this case the user is updating the hero image header text to “I know
exactly where this will go” by simply selecting the text and typing the new message.

= |
W (Q Home | Launch Sitecore % \_

&« C # [3 launchcore/?sc_mode=edit#enhanced-carousel u =

| Administrator &

ADVANCED EXPERIENCE OPTIMEZATION VIEW

B & B B

Edit  Other Details  Reset Aliases

o The item is in the "Approved” workflow state in the "Regular Workflow' workflow.

Q sitecore

| know exactly wherethis

will
‘ Launch re includes a collection of articles

about how and why we built this site

Read the Articles »

Getting Started with About Launch Sitecore

Sitecore
Clean, modern & responsive

Read the Articles

Figure 2-12. In this figure you can see how users might go about updating the content on a page. They simply
select the content placeholder that they want to update and start typing! Very easy
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Home Tab

The Experience Editor is administered with the following tabs in the ribbon: Home, Advanced, Experience,
Optimization, and View. The Home tab is the logical place to start (Figure 2-13). When you set out to edit

a page, the first thing you may want to do is lock the page so others can’t override your changes (proper
configuration should make this unnecessary). In the Home tab, within the Edit section, notice the Lock/Unlock
button. When you click this that page will show up in your My Items (count) bucket. The My Items button
shows you all the content that you have locked for editing. It's important to keep an eye on that to ensure you're
not causing your colleagues frustration. Additionally in this section, you can rename the page’s name and
display name, where the name is the key and the display name is a language-specific translation of the name.

- HOME ADVANCED EXPERIENCE OPTIMIZATION VIEW

h
[
-~

:

Figure 2-13. The Home tab has basic settings, such as adding components and pages, locking items for
editing, and publishing settings

From the Home page you can also insert new components onto the page. Under the New section you'll
notice the Component button. When clicked, you'll be able to see all the locations where you can add new
components, as seen in Figure 2-14’s Add Here links. The Add Here links correspond to content placeholders
within the layout the page is assigned to. When you click one of the Add Here links, a pop-up will appear
showing you which components are permitted within that content placeholder. If your component doesn’t
appear in the dialog pop-up, you can add it to the allowed components list, steps continued from previous
sections.
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Figure 2-14. You can set an icon on components to make it easy for editors to know what to choose when
adding new components onto a page

Notice also the Insert Page button within Edit. Recall earlier how in the Content tree the Home node
below Content is URL accessible. Any page, therefore, below Home can support child pages. Each child page
can have a set of data templates marked as allowable to be created below any given page. When you click
Insert Page, those allowed templates will appear, and if those templates have a Layout assigned they will act
as child pages (more on layouts later in this chapter). Refer to earlier steps in this chapter on setting Insert
Options to control what types of pages should show up in the Insert Page dialog (specifically, Steps 16-19
apply here as well).

The Publish section will be covered in more detail later in this section. However, the obvious is
obvious—you need to Save and then publish your changes before they will go live on the site. Workflow
makes this a bit more complex, and therefore will be covered in greater detail later.

The Social section makes it easy to post links to this page on social networks, such as Facebook or
Twitter. You can store credentials to your account in Sitecore, and from the Social button (Figure 2-15) you
can enter your message and even associate links back to campaigns you're running (more on campaigns in
Chapter 5).
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sitecore/system/Marketing Confrol Panel/Campaigns/Social/Twitter/Twitter Content Messages -

Figure 2-15. Built-in social integrations make campaign integration easy

View Tab

There’s not a whole lot to say about the View tab (Figure 2-16), but what there is to say can save you a lot of
annoyance. The important point is the Enable section. There are basically two things you can do when in the
Experience Editor: 1) you can edit content, and 2) you can design the page (add/remove components, change
component properties, etc.). The trouble is it can be tricky to do both at the same time, which is the default.
Sometimes you might be trying to configure a components properties, but since the component renders a lot
of text it can be impossible to actually select the component apart from selecting and editing the text.

HOME ADVANCED EXPERIENCE OPTIMIZATION

1 #| Editing Controls « Control bar
Ed]

Edit Other « Designing Navigation bar

Figure 2-16. The View tab controls what options are shown within the Experience Editor, such as what mode
you are editing in, showing/hiding the nav bar, and so on

To disable inline text editing, simply uncheck the Editing checkbox. This will enable only the design
features of the Experience Editor. Vice versa is true if you only want to edit text, but that usually is less of a
problem. Rather, it is very helpful to disable both of them, because until they are unchecked you cannot click
on links. If you want to edit something other than your home page, this is worth noting. Alternatively,
you can launch into Preview mode from the Content Editor by clicking Preview on an item deeper in the
tree—jumping straight to that item.
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Tip Uncheck both the Editing and Designing checkboxes on the View tab if you want to move the
Experience Editor onto another page. Otherwise, you'll be stuck on the home page.

Experience Tab

The Experience tab (Figure 2-17) has a few neat tricks worth considering. The first is the Date section.
Publishing will be covered more later, but in regard to the Experience tab and the Date section it’s worth
noting that publishing can happen in the future and for only set durations. For example, you might want two
versions of a page, a main version and a version for a holiday promotion coming up. The holiday version is
not the current published version, but it’s coming up this weekend. If you change the dates you can see what
the page will look like for future publishing event.

H - HOME ADVANCED EXPERIENCE OPTIMIZATION VIEW

o & (<14

April 2015

07/59 Y a 2 O]

English Default Screenshots

Figure 2-17. The Experience tab allows you to toggle between languages and devices to get a sense of the user’s
experience from various perspectives

The Language section lets you toggle to other languages you have installed. You can translate, save, and
publish those versions. Similarly, you can toggle the Device to see what the page will look like on different
devices. Layouts will be covered in more detail later, but for this point it’s worth noting that you can have a
layout dedicated to each device you are supporting, such as phone, tablet, and desktop. This is often referred
to as adaptive design. In most cases, however, you'll have a responsive design so you'll only see the Default
device as selectable, since one single layout responds automatically to all browser widths.

When you toggle the device to, say your mobile layout, note that it only toggles the layout. If your browser
wide is 2,000px wide, obviously that’s not a good test of what it'll look like on an iPhone. In this case you can
install Simulators (Simulator section, Figure 2-18) to see for real what it will look like on those devices.
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Figure 2-18. You can add device simulators to get a sense for how the site will look across a multitide of
devices without actually needing to buy that device

n

Advanced and Optimization Tabs

The Advanced tab is used to configure presentation details and is covered in the “Presentation and Applying
Layouts” section later in this chapter. The Optimization tab is all about content testing, such as A/B testing.
This is an advanced topic warranting its own chapter; see Chapter 5.

Previewing, Exploring, and Debugging

The explore and debug features of the Experience Editor are some of the most compelling features in
Sitecore. You'll notice a Mode section within the ribbon while in the Experience Editor. By default you'll be
placed in the edit mode, which has already been explained previously. If you click Other, you'll notice three
hidden options, Preview, Explore, and Debug (Figure 2-19).

B o

& [« (1

Edit Other
[s) Preview

o b 7 Explore  PPrOV
3% Debug

Figure 2-19. The Experience Editor has four main views: edit mode, preview mode, explore mode (called the
Experience Explorer), and debug mode
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Preview removes the editing/design capabilities similar to unchecking the boxes within the View tab.
This allows you to easily click around the site and navigate to the page you want to edit.

Explore is very compelling. Explore is more formally called the Experience Explorer. The Experience
Explorer allows you to monitor your activity on the site and see how optimization and personalization rules
are reacting to your behavior. Notice the drop-down menus on the left and the right in Figure 2-20. Among
other options, the left is showing which goals you're hoping your behavior will trigger for testing purposes.
On the right you'll notice how the behavior has categorized the user as a “Developer” persona. Future
personalization is using this classification to drive rendering behavior, such as which components to show
developers versus other personas. At the top of the right drop-down, notice that the page views are counted
along with the Engagement Value that has accrued as a result. More on these concepts can be found in
Chapter 4.
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Figure 2-20. The Experience Explorer allows you to simulate user personas and test user personalization
configuration
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The other helpful mode is Debug mode (typically for Developers only). Debug mode spits out a bunch
of reporting at the bottom of the page, which shows performance and exception feedback (Figure 2-21). This
is a great tool to use if your page is responding very slowly and you want to understand which component is
to blame.
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Figure 2-21. The Debug mode within the Experience Editor allows you to see helpful performance data so you
can better troubleshoot problems
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Working with Components

In this section we’ll continue our previous steps of configuring our Featured Products and Product
Promotions. We're at the place where we have just about everything ready to add our components to the
page. Our data templates are configured, and we have content in the content tree built using those data
templates. Our last step is to drop components on the page that renders our content, which in this case are
our featured products.

A component renders data stored in the content tree based off a template. You will need a developer
to build components to your specifications. The following steps show general guidelines for working with
components, but some of the settings may differ depending on how your components were constructed.

If you recall, it is easy enough to add a component to a page. Simply open the Experience Editor, and
from the Home tab within the New section, all you will click is the Component button. This will load the
component picker dialog showing all the approved components you can select from. Every layout will have
one or more placeholders. These placeholders are set up in the Content Editor, below Layouts » Placeholder
Settings » your site name. Follow these steps to allow marketers to add components to a placeholder:

1. Open the Content Editor. Expand Layouts » Placeholder Settings. Continue to
browse until you find the placeholder you want to edit. Note: If you don’t know
the name of the placeholder you want to edit, you can delete the components out
of that placeholder and then select them. You'll see the name of the placeholder
(and a shortcut to editing its properties), such as in Figure 2-22.

S+ Add here

Figure 2-22. You can delete or move the components out of a placeholder if you want to get the name of that
placeholder

2. Select the placeholder, and under the Data section, note the Allowed Controls
list. Click Edit.

3. Browse to the component(s) you want to allow. Double-click them or click the
right arrow to move them to the right side of the selector. Click OK and then click
Save on the placeholder.

4. To add our Featured Product placeholder, go back to the Experience Editor and
delete the Promo with Thumbnail component. Select it while in Design mode
and click the red X (Figure 2-23).
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Figure 2-23. A component has a myriad of settings you can configure, such as its datasource, personalization
settings, or even custom settings

5. Click New » Component in the Home tab, and then click Add Here in the
placeholder you recently edited. Select the component and click OK.

Yay! We have a component on the page. Oftentimes you will have components that need to render a
content item. In our example, our component needs to render a featured product. There are three main
ways to do this: 1) user configured by setting the component’s datasource, 2) user configured by setting a
component property, and 3) programmatically controlled by a developer. We'll focus in on the first two since
the third option will be different for each implementation.

1. Setting a datasource: click the component, and then click the Datasource icon
in the gold component menu (third from the left in Figure 2-23). A pop-up
will appear; select the item from the content tree you want to associate to the
component, such as a Featured Product.

Tip A best practice is the component would prompt the user to select the datasource once it’s dropped
on the page. This can also be the right time to prompt the users to create a new content item if one doesn’t
exist that they want to use. In this way, marketers can be empowered to administer content wholly from the
Experience Editor, never needing to go to the Content Editor and learn two systems.

2. Setting a property: Click the component, and then click the More button in the
component’s menu, and then click Edit Component Properties. If you scroll
to the bottom of the component properties you'll notice a Parameters section
(Figure 2-24). You can add any arbitrary set of parameters that you want to pass
to the code/developer, but know that the code needs to specifically be looking for
them or nothing will happen. Click OK.
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Figure 2-24. Custom component properties allow marketers to easily tweak how a component behaves

You'll notice a few interesting options on the More drop-down (Figure 2-23). The Edit Experience Editor
Options dialog lets you configure a lot of valued component settings, such as the following list. Edit Related
Item takes you to the content item assigned to the datasource, making it easier to navigate to the Featured
Product, for example, and make some updates without digging for it in the tree view. Here are the settings
you can apply to a component from within the Experience Editor options:

Note Only Developers or above will see the More button on a component.

e  Thumbnail—When you’re browsing for components it is very helpful to see a
thumbnail image to help you select the right one quickly.

e  Editable—Uncheck if you do not want users editing the datasource item’s content
values. If unchecked the content drawn within the component will be static.

e Datasource Location—This helps you narrow down for your content admins where
the content should be coming from. In the case of our Featured Product component
we would want to set this to the Featured Products folder within the content tree.

e  Datasource Template—Alternatively you can narrow the results to just a specific
data template.
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e  Compatible Renderings—In Figure 2-23 the second icon in the menu is the replace
icon. At times you may want content admins to be able to swap out one component
for another, but retain the properties. To enable this, you must specify which
components are compatible with this component. Note that it is a two-way street;
you must do the same on both components so they are compatible with each other.

e  Experience Editor Buttons—Developers can create custom buttons to show on the
component menu. After they are installed they will show up in this list if you want to
add them to the menu.

Note Personalization and testing are also driven at the component level from the component button bar.
These topics are covered in more detail in Chapter 4.

Managing Thousands of Items with Buckets

It's great that we now have our Featured Product being rendered on the home page, but before we go
beyond content editing fundamentals, we need to cover a few miscellaneous topics. One of those topics is
that of buckets.

Buckets enable you to make sense of thousands of items in your content tree. Take for example our
Featured Products. It is very likely that over time you may have hundreds of products you may want to
feature. If you put all that in the tree view, that tree view will become virtually unusable. The tree view will
become very long, and it will be very hard to find the product you are looking for. By converting that folder to
a bucket, all of the child items are hidden from the tree view and all that is left is a search box.

Tip If you have a lot of items in a bucket (even 100, but certainly 1,000,000), you will be relying exclusively
on search to retrieve them. If you need to retrieve “an item” your search will require carefully planned metadata.
The more fields that you items are tagged with, and the more unique values that are placed in those fields, the
better chance you have at not losing those items, or during an audit, of finding them.

Converting an Item to a Bucket

To convert an item to a bucket, simply click the item, and then under the Configure tab, click Bucket. This
may take a few minutes. All the child items should now be hidden after the process completes. If some items
remain unhidden, that means those items are not marked as “bucketable” in their data template’s standard
values definition (more on standard values in the appendix). For now, just know that on the standard values
you need to ensure the Bucketable Settings, Current Item checkbox is checked (Figure 2-25).
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Figure 2-25. You can convert an item to a bucket to more easily manage thousands or millions of items
in Sitecore

Note Usually only administrators or other advanced users see the buckets settings and convert items into
buckets. Specifically, you need the Sitecore Client Bucket Management role to perform this configuration.

If this value wasn'’t checked, you don’t need to re-bucket your bucket after checking it. What you can do
is simply check the box, save the standard values, and then go back to your bucket and click the Sync button
under the Buckets section within the Configure tab. This will attempt again to add all child items to the
bucket that have their standard values set to bucketable.

Searching a Bucket

Searching a bucket is pretty much like searching anything else. Since, however, search in this case is critical
(because you can lose items if you can’t find them later) it’s worth calling out in particular. The key to
searching buckets is to do constrained field searches. If you have 1,000,000 items in a bucket and you want a
result set of one single item, you will likely need to filter the results based on several specific field values (if
you developer hasn’t setup readily available facets). To do this, simple enter your field name in the search
box followed by a colon. You'll then see the search change, prompting you to ender the value for that field.
Additionally, you can configure “can include,” “must include,” and “cannot include” rules on the fields.
Figure 2-26 shows how the search is trimmed to items that match on the Title, Department, and Customer

fields (for example, the fields will be whatever is available in your data templates).

& Tie Important X % Deparment Human Resources X

sr ComtosoCorp X
Figure 2-26. Once an item is a bucket it is easy to search that bucket for items and even to create property
restrictions to narrow the result set

You can toggle the can|must|cannot settings by clicking on the search magnifying glass on each field.
Notice how the Title field could start with Important; the Department field must not start with Human
Resources, and the Customer field must start with Contoso Corp.
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Archiving Content and the Recycle Bin

Deleting and archiving content will happen all the time in the lifecycle of a content administrator. The
Recycle Bin and the Archive are two separate things, and it’s important to understand their differences.

Recycle Bin Settings

By default, when you delete an item in Sitecore it is not deleted permanently. Instead it is moved to the
Recycle Bin. Your Sitecore Recycle Bin behaves just like a Windows PC recycle bin. Stuff sits in the Recycle
Bin until someone permanently deletes everything in it. This is good and bad. It’s good because it takes
an intentional action to delete stuff. It’s bad because your Recycle Bin might get huge and waste valuable
storage space. Additionally, if you have many people working in Sitecore, you may delete things that
someone else later might have wanted to restore, so it’s important to use discretion.

The Recycle Bin can be accessed from the desktop or the Launchpad. From the desktop, click Start and
then you’ll notice the Recycle Bin link under the All Applications drop-down. Simply click an item and then
click the Restore button to restore that item. You can also use search to find your items if there are too many
to sort through.

Note By default, only administrators can see items they themselves didn’t delete.

The Delete button will permanently delete the selected items in the Recycle Bin. The Empty button will
permanently delete all items in the Recycle Bin. The Show Versions checkbox will expand versions of the
items in the Recycle Bin in case you want to restore just one particular version of a deleted item, rather than
all versions.

It is common for Recycle Bins to grow forever and become a nuisance for your administrators
and infrastructure team who is concerned about restorability and recovery times. You may prefer to
simply disable the Recycle Bin rather than run the risk of it growing too large (not a best practice). In
this case, a simple web.config change can do this. Disable the Recycle Bin in web.config by setting the
RecycleBinActive setting to false, or for a given database, remove the /archives/archive/recyclebin
element.

Archiving Content

There may be content that you want removed from your site, but not deleted permanently. Perhaps this
content has legal implications, such as customer correspondence data. In these cases it makes more sense
to archive this content. Sitecore has an out-of-the-box archiving provider that looks and behaves nearly
identically as the Recycle Bin behaves. It’s a bucket of stuff waiting to be deleted, but with a name that is less
inviting to deletion (Archive vs. Recycle Bin).

Anything in the content tree can be archived. Simply click the item, and then in the Review tab click the
Archive drop-down (Figure 2-27) to show three options. You can archive that item immediately, archive just
a particular version of that item, or set a future date to archive it.
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g

Archive

Archive

No archive date has been set.

¥ Archive item now

[

i, Archive version now

[E, Setarchive date

Figure 2-27. The Archive is similar to the Recycle Bin, except that archived items typically are not meant to be
deleted perminently

These basic settings may or may not meet your legal compliance obligations. It’s a bit beyond the scope
of this book, but it’s worth noting that this archiving framework is extensible. A common pattern is to disable
the Recycle Bin and force all deletions to be sent to the Archive instead. Then, code can inspect the incoming
item for legal complications. If it matches legal requirements for archiving, you may want to send it to an
external archiving system or database. If not, you might instead send it to the Recycle Bin or just delete it on
the spot.

In the web.config, under archives/providers, you can specify your class that handles an incoming
archive request. That class can have whatever logic you need to meet your compliance obligations.

Must Read See one of John West’s blog posts, which shows sample code for how to tap into the archiving
pipeline: http://bitly.com/1DxntPw

Content Versions and Multilingual Language Support

Any piece of content can have more than one version of that content. Each version can be translated into one
or more languages. This section shows you how to configure multiple versions and how to translate those
versions into multiple languages.

Managing Multiple Versions

A seasonal promotion is a good example of why you may want to have more than one version of the same
piece of content. Perhaps you're having a sale over the Black Friday weekend and you want your home page
to look different from Thursday through Sunday. Instead of making all the changes and clicking the Publish
button Thursday morning, and then reverting all those changes and clicking the Publish button again
Sunday night, you can handle this with a second version of that page. Use the following steps to create a
second version of your home page (repeatable for any content item) that is published only for a specific
date range:

Note Versions can also be used for experience optimization, such as A/B testing. This is a topic beyond the
scope of this chapter and is covered it great detail in Chapter 4.
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1. Click the item you want to add another version to. Then, under the Version tab,
click the Versions drop-down. This will show you all the versions available for
this item (Figure 2-28 shows there is only one version so far).

— HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONF

l':‘ =y | H | L4 Add L4 Remove @3

Save Reset Versions + 34 Compare English « Transla

1. Modified 4/14/2015 3:49 PM by sitecoreladmin.

4 [3) sitecore
4 & Content
» ) Home
» (B Developir I
» @ Global

» B Layout L4 Add version <

b El Madia | ihrans

Figure 2-28. You can add a new version to an item. Perhaps you would do this to manage an upcoming
weekend promotion. Or, you may want that item translated into another language

2. Atthe bottom of the drop-down, click the Add Version link.
3. Inthe Publish tab, click Experience Editor to launch the Experience Editor.

4. While in the Experience Editor, on the Home tab click the Settings button within
the Publish section.

5. Configure the date ranges you want your alternate version published, such as
seen in Figure 2-29.
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Publishing Settings

Specify the publishing setfings for the selected item.

VERSIONS ITEM TARGETS

Specify when you want each version of the selected item to be publishable. This applies to the current language only

Version 1 Publishable | Publishable from | Publishable to

2. L 11/20/2014 - 1:00 AM - 11/23/2014 - 1130 PM -

Figure 2-29. You can set a data window to control when a specific version will be the published version

6. Publish the alternate version by clicking the Publish button in the Home tab (you
may need to approve a few workflow items to get it totally published).

7. Back on the Experience tab within the Experience Editor, toggle the dates
forward and backward to confirm that your alternate version and original version
are swapping on the expected dates.

The publishing viewer offers a graphical representation of when things will be the published version,
as can be seen in Figure 2-30. Within the Content Editor, click the item and from the Publish tab click
Publishing viewer. As you can see in this figure, the only version published over the Holiday weekend would
have been version two. Thereafter, version 1 is the published version again.

64



CHAPTER 2 ' MANAGING CONTENT

Publishing Viewer

An overview when each version of the selecled item is publishable. Click a start and end date to change the view to a specific
period.

Start date: End date:
< NOVEMBER 2014 > < NOVEMBER 2014 >
SUN MON TUE WED THU FRI SAT SUN MON TUE WED THI FRI SAT
1 : 1
2 3 4 5 6 7 8 2 3 4 5 6 7 8
9 10 1 12 13 14 15 9 10 1 12 13 14 15
16 17 18 19 20 21 22 16 17 18 19 20 21 22
23 24 25 26 27 28 29 23 24 25 26 271 28 29
30 1 : d 30
Today is Wednesday, April 15, 2015 Today is Wednesday, April 15,2015

Version 2

Version 1 |

Close

Figure 2-30. There is a nice report to see which version will be published on which dates. In this case, version 2
represents a custom home page created just for the thanksgiving holiday weekend

Note If you don't fully approve/publish an alternate version it won’t be the published version even if it falls
on the date specified in publishing settings. If the expected version isn’t approved, Sitecore will choose the first
version that is published.

Content Language Translation

Sitecore does a phenomenal job managing multiple language translations of content. Truly supporting
global sites is where many web content management solutions (WCMS) break down. Not Sitecore. Not only
is it easy to set up, it behaves and is managed nearly identically to any other content management we've
already discussed.

As described in the last section, any piece of content can have any number of versions. Any version
can have any number of languages that it is translated into. It is a simple process to create a new language
(below System » Languages), and then on a piece of content toggle to that language and translate the values
(Figure 2-31).
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» +¢ Marketing Control Panel

Figure 2-31. It is easy to toggle between languages when on a piece of content. Just click the drop-down!

Tip It's also worth checking out a service called Clay Tablet if you want to route content for external
translation. Their Sitecore connector makes for the easiest content translation imaginable. See more at:
http://www.clay-tablet.com/products/cms-connectors/sitecore.

Follow these steps to create a new language and a new language version for a piece of content:
1. Right-click Languages and choose Insert Language.

2. Choose the language from the supported languages drop-down. Click Next to
accept the default language and country region codes (recommended).

3. Click Next to accept the default encodings (recommended), and click Next again
to accept the default spellcheck files.

4, Find the content you want to translate. With that content selected, click the
Language button from the Versions tab. Select the language you want to translate
the content into.

5. Youwill see a prompt informing you that a language version does not yet exist for
this new language (Figure 2-32). Click Add a New Version to create one.

66


http://www.clay-tablet.com/products/cms-connectors/sitecore

CHAPTER 2 ' MANAGING CONTENT

EZE Home

Figure 2-32. You may notice that a content item doesn’t have a translated version for all configured
languages. Simply click Add a New Version to remedy this

At first you'll see an empty item with no data. You'll want to add your translated content into the fields.
A helpful way to know what to add is to click the Translate button in the Versions tab. This will open up
a side-by-side view of two languages helping you know what to translate. Notice in Figure 2-33 we have
Swedish on the left being translated from the English version. The source language can be changed to
another language version by toggling the Language drop-down next to the Translate button in the Ribbon.

i Swedish ~ 1=

m
_ T A
1 version

Titte German (Germany) : Deutsch (Deutschiand)
0 versions

Komma igang med Sitecore Geffing Started with Sitecore 1
French (France) : frangais (France)

0 versions
Subtitle:
Portuguese (Portugal) : portugués (Portugal)
Rena, moderna och lyhord Clean, modem & responsive 0 versions

Swedish (Sweden) : svenska (Sverige)
Body 1 version

@ More languages

Call o Action Text

Las mer Leamn More 1

Figure 2-33. Translation is made easy with a side-by-side comparison of source to destination languages

When you are done translating the content you will want to publish it. Click the Publish Item button
found within the Publish drop-down on the Publish tab in the ribbon. Notice how in Figure 2-34 we have
multiple languages to select from. By default they will likely all be selected. It is important to deselect
versions not yet ready for publishing. After you have approved it you will likely need to publish the workflow
before it will show up. From the Home tab, click the Edit drop-down and click Submit. Then, click Approve
Without Test (Figure 2-38) to finally get the item published to the production web site (workflow is covered
in greater detail later in this chapter).
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Publish Item

Select the relevant publishing setfings for the item.

Publishing
® Smart publish - publish differences between source and target database.
Republish - publish everything.

#| Publish subitems
#| Publish related items

Publishing language
Selectall
#| Arabic (Saudi Arabia)
#| English
French (France)
German (Germany)
Portuguese (Portugal)
¥ Swedish (Sweden)

Publishing targets

¢ Internet (web)

Figure 2-34. Now when you publish you need to be specific as to which language to use

Yah! In the following example, we've just published the Swedish version of the site. But oh no! It looks
horrible. It may seem obvious, but you have to translate all the content before you’ll want to publish the
item, especially an item as high level as the home page.

Tip A good thing for your developers to consider is what the language fallback strategy should be.
A developer can configure Sitecore to fall back to the default language if not all fields are translated (called a
“partial language fallback”). Without a plan in place you’'ll notice behavior similar to what’s seen in Figure 2-34.
Language Fallback is now built into Sitecore 8.1. It requires administrator configuration to enable. See the
following kb article for more details: https://doc.sitecore.net/sitecore experience platform/
language fallback/enable_and_set_up_language fallback

Note in Figure 2-35 how the Home page data template fields have been translated as you saw earlier
in Figure 2-33, but the rest of the page is blank. There is one piece of content that shows up—the Developer
audience component. Each component on the page is pointing to a piece of content. Those components will
start rendering their data as each of those pieces of content are translated, published, and approved.
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Navigate

Figure 2-35. Notice the URL. This is a simple way to force a language change on the user

There’s also another problem with the Swedish site. Namely, there is still a lot of English on it! Notice the
search box says Search, as well as the Learn More links. This text is hard-coded into the components, rather
than localized. Instead, these values should be values in the content tree like everything else. A good place to
put them would be Content » Global » Settings, since they are likely settings easily shared across all sites.

If they were in the content tree, you would be able to translate and publish them just like other content.
A development best practice is to retrieve these localized values, versus putting them directly in the code.
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PRACTICAL TIPS: CONTROLLING THE DEFAULT LANAGUAGE
WITH GEO-LOCATION AND BROWSER PREFERENCE

Notice the ?sc_lang=sv-se in the URL (Figure 2-35)? This is how you control which language the user
sees, which in this case sv-se is the code for Swedish. Using a convention of http://www.site.com/
sv-se is actually the more normal practice.

In either case, this code is whatever you put in the language country/region codes form when you
originally set up the language. A developer can write code to do geo-location to detect the IP of the
users and where they are coming from. Based on this location information you can append this little bit
onto the URL to change the language.

A second option is that the developer can look at the browser settings of the user. A browser stores
language preferences and you can use these to know which language to show. You probably want to
use some combination of both geo-location and language preferences to know where the users should
go (or better yet, offer a suggestion of what you think they want, and ask them to confirm). For a global
site, you may need to redirect them to the Chinese site based on geo-location, but you may need to rely
on browser preference to determine if you should show Mandarin or Cantonese.

After the user is first sent to the page with the ?sc_lang=ab-cd value, the language will be set for that
entire session. Thereafter, you no longer need to worry about keeping that value in the URL, unless of
course you want to change it to something else. Note, however, that for SEO purposes this isn’t a best
practice. A http://www.site.com/sv-se/xyz convention is preferred.

Content Cloning

Content inheritance is a powerful tool in your information architecture arsenal. Imagine a single piece of
content replicated across 100 instances (clones, as they're called) across your site. This ability to manage
content in one, centralized location can have many uses. Global sites are a great example. Perhaps your
U.S. site is the main site, but you also have regional sites. Some of the regional content is unique, but much
of it needs to be reused. Content inheritance here allows you to manage the content centrally and have it
propagated to all your regional sites.

To clone an item, simply click the item in the content tree and then click the Clone button under the
Configure tab. A pop-up will appear asking you to specify where you want to place the clone. This can be
anywhere in the content tree, even another site.

After the clone is created you'll notice it reuses all the values from the original item. Note in Figure 2-36
how next to the Title field there is a [original value] message. This is informing you that the field is getting
its value from its original item. Note as well there is a value now in the Created From Quick Info details. The
original item’s value for this is blank, but the clone has a reference back to the original item. “Original Item,
en, 1-{guid}” represents the name of the host item, the language of that item, the version number of the item,
and that item’s global ID.
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Figure 2-36. “Original item” text next to a field informs you that the item is a clone and it’s getting its value
Jfrom another item

While this is all fine and good, there are important scenarios and gotchas worth considering. Consider
the following scenarios:

e You edit a clone’s field and thereafter the original item’s field is updated—In this
case the clone will not receive the update from the original item. Instead, when
you browse to the clone, you'll see a prompt (Figure 2-37) asking you to resolve the
conflict. You can 1) review the original item and see what the new value would be,
2) accept the incoming value, or 3) reject the incoming value.

B - '
D AU clone

Item ID: {8D9489F8-4A6B-468E-BTBE-D8776340DB1B}

Figure 2-37. Cloning can result in conflicts. Fortunately, Sitecore recognizes conflicts and will help you
through them
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e You delete an item that has clones—Upon deletion you will receive a prompt
informing you of the existence of clones. If you proceed all clones will essentially be
“uncloned” and they will act like normal items going forward.

e You create a child item below an item that has clones—Upon creating the item you
will be prompted to see if you want to also clone the child items as an optional step.

o  You clone an item that has running workflow—When you clone an item with a
running workflow the workflow data is also copied but not cloned in the same sense
that field data is. There is no link between the parent workflow and its state and
cloned workflows. They will behave independently.

e  Cloning an item that has multiple versions—A clone is only the clone of one single
version, whatever version you had selected on the original item when you clicked the
Clone button. If that original item has many versions you'll need to click Clone on
each individual one.

e You add a new version to a clone’s original item—This won’t be a problem since,
again, a clone is based on one single version, so adding more versions won't affect
existing clones. However, you get a helpful prompt on the clone notifying you of the
new version and asking you if you want another clone for that version.

e Youadd a new version to a clone—If you add a new version to a clone, that new
version becomes a new clone pointing back to the original item the original clone
was based on. This is basically like copying a clone, and there are not many good
reasons why you'd need to do this.

e Aversion of the original item is updated—Only the clone(s) created from this version
will receive the update.

e  Youremove a version from the original item—If you delete a version on the original
item that has clones, those clones are essentially “uncloned” and will act like normal
items going forward.

Note You can always unclone an item later. Simply click the Unclone button in the Configuration tab.
Afterward, the item will act like any other.

Workflows and Publishing Overview

The term “published” in Sitecore means a few things. First, the item has been approved via a workflow

and rests in the final state of the workflow. Second, the item has been copied into the web database and is
available on the content delivery server. A piece of content is never published until the workflow is over,
assuming a workflow has been assigned to the data template, and the content is copied to the web database.
There are a few out-of-the-box workflows that this section seeks to explain.

Note This topic of workflows quickly moves into building custom workflows, since no business operates
in the exact same way. Custom workflows, however, are an advanced topic typically performed by developers
(even though it doesn’t necessarily require coding). As such you can read more in the appendix if you want to
take your knowledge of workflows to a deeper level.
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A workflow in Sitecore is composed of three main building blocks: states, commands, and actions.
A workflow “state” is basically the status the workflow instance is assigned to. For example, a state might
be “pending approval,” “approved pending publishing,” or “published” The state helps explain what the
workflow is waiting for, such as some human interaction.

Within a workflow state you can have multiple commands. A command is something a human will
execute as they interact with the workflow. For example, Approve and Reject are two common commands
a workflow approver would perform. A command’s primary job is to move the workflow from one state to
another. The Approve command might move the workflow to the next state, and the Reject command might
move the workflow back to the start, for example. Commands show up in the Edit window (Figure 2-38) on
an item for those who have access to click them (see Chapter 8 for more details on workflow security).

HOME NAVIGATE REVIEW ANALYZE

MY TOOLBAR
I.:‘ <3 ) Articles Section (10f5) 4
Save Edit~ ® Glossary Section (20f5) %
Workflow

The item is in the Awaiting Approval state
in the Regular Workflow workflow.

< Edit
4 [3 site

4 &

Fl

<% Approve with Test H
+" Approve without Test

®  Reject

4 @ Auuence

L U R S S

Figure 2-38. Workflow commands appear in the user interface for those who have access to advance the
workflow from one state to another

A secondary duty of a command is to have a collection of actions. When users click the Approve
command, you may want to send an e-mail or send a message to an external system. Unfortunately there
are only a few valuable out-of-the-box actions, such one for sending e-mails another for validating the data
before it gets approved. This means you will likely rely on a developer for more advanced business processes
beyond simple Approve/Reject and basic notifications.

Note Sitecore is not a Business Process Management (BPM) system. Complex business processes should
be managed outside of Sitecore. Rather, the workflow capabilities Sitecore are meant for near-finalized content.
Anything beyond this requires heavy customization that you typically get out-of-the-box in an enterprise BPM
solution. Keep focused on basic approval of content, where you’re more focused on how the content looks
on the site (such as mobile renderings) than the content itself. If you're a third-party ISV, there is a ton of
opportunity here for a lightweight BPM add-in into Sitecore, as a full BPM solution is likely also more than what
most marketers need.
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The out-of-the-box “sample workflow” is a good case study when learning on these building blocks
work together. You can find and create new workflows from the System node » Workflows within the
Content Editor. Notice in Figure 2-39 we have a workflow with three states: Draft, Awaiting Approval, and
Approved. Below each state we have commands, such as Submit, Approved with Test, and Auto Publish.
These commands correspond to the earlier figure, Figure 2-38.

Again, these commands move the workflow from one state to another. Notice in Figure 2-39 the
workflow settings. There is a setting to designate the initial state. Anytime an item is modified it will land
within this initial state. The commands have a Next State field where you can select from a drop-down that
the workflow should move to when that command is executed. In the case of sample workflow, the Submit
command below Draft moves the state to Awaiting Approval. Likewise, Approve with Test and Approve
without Test both move the state to Approved. Reject as you can imagine moves the state back to Draft. It’s
important to note that workflows and A/B testing are tied at the hip; Approve with Test is literally how you
will start your A/B tests (see Chapter 4 for more details).

» Toolbo
(@ Toolbox S Regular Workflow

4 ®© Workflows

» © Analytics Testing Workflow

s A o

» ®© Path Analyzer Maps Data
4 5 Regular Workflow
4 [& Draft Initial state [shared]:
2 Submit Workflows/Regular Workflow/Draft -
» (3 __OnSave
gz
471g Awaiting Approval Default Comment Template [shared, standard valuel:
4 < Approve with Test
Templates/System/Workflow/Standard Comment Template -
(=1 Validation Action
das Launch Create Test Dialo:
9 Default Comment Dialog Height [standard value]:
4 " Approve without Test
250

=% Remove Tests
(-4 Validation Action
R Reject
4 Approved
@ Auto Publish

» © Sample Workflow

Figure 2-39. Regular workflow is an out-of-the-box workflow within Launch Sitecore (similar to sample
workflow)

Caution Administrators bypass workflows! This is why you don’t want administrators administrating
content, as you will no longer have tractability into who changed what, why, and when.
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At each leg of the journey the users are prompted to enter comments as to why they approved or
rejected the item. These comments are stored in the item’s workflow history for tractability later, such as
during an audit. The workflow history can be viewed from the Review tab » History button within the
Workflow section, as can be seen in Figure 2-40.

REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION VIEW MY TOOLBAR

E:| Click Editto lock and editthis item. < Edit g =]
Validation Subscribe » My items ©; History Reminder »  Archive =
LQ audrey Thursday, April ~
m Changed from Draft to Awaiting Approval.

[Zk2 bill
@ > =

— Changed from Awaiting Approval to Draft

Ed Managers omments: | think it looks great, but we need 1
[=3 audrey Thursday, April 30, 2015
E)

Changed from Draft to Awaiting Approval

0 bill Thursday, April 30, 2015
Changed from Awaiting Approval to Approved.

Figure 2-40. Workflow history provides a helpful way to determine why content was changed and by whom

It can be very hard to manage your workflow tasks, such as approval requests, when you're working
across hundreds of items with content being published continually. E-mail actions can help mitigate this
pain, by notifying you of when someone is requesting your approval. However, this has its limitations as
well. Within Sitecore there is a concept called the “workbox” where all your workflow tasks are aggregated.
This creates a one-stop-shop if you're unsure of the state of things. You can get to the workbox from the
Launchpad or from the desktop.

Notice the workbox in Figure 2-41. When you first get there you will probably see a blank screen. You
must first check which workflow you want to see status on (upper-left corner of the workbox). Thereafter you
will notice all running workflow states you have security access to see (such as Draft or Awaiting Approval, as
can be seen in Figure 2-39), along with quick access to the commands you have access to execute (buttons).
In this example for the “regular workflow,” you’ll notice in Figure 2-41 there are seven items in a draft state
with two items waiting my approval.
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| Administrator &

Path Analyzer Maps = ltems per Page: | All v | (9 Refresh

¥ Reaylar Workflow

Regular Workflow

Awaiting Approval - (2 items)

F‘?E Home - (Arabic (Saudi Arabia), version 1)
Last change: admin changed from Draft to Awaiting Approval on Wednesday, April 15, 2015.
Comments: More
Preview Open Diff Approve with Test Approve without Test Reject

.9'_-’} Home - (Spanish (Spain), version 1)
Last change: admin changed from Draft to Awaiting Approval on Thursday, April 16, 2015.
Comments: More
Preview Open Diff Approve with Test Approve without Test Reject

Approve with Test (selected) Approve with Test (all) Approve without Test (selected)

Approve without Test (all) Reject (selected) Reject (all}

Figure 2-41. You can use the workbox to easily see the status across multiple workflows in Sitecore

Tip The RSS feature of the workbox is really powerful and unfortunately too often underused. It’s a great
way to be notified that you have something awaiting your attention. If you don’t want to use an RSS client, a
developer can set up e-mails based on the RSS feed that are better than the built-in workflow e-mails. See this
blog post for more details: http://bit.1ly/13d03A0.

We should now go ahead and add a workflow to our data template’s standard values, now that we have
a basic understanding of workflows. A workflow will not run on a new item’s creation or when content is
edited unless a workflow is assigned to that piece of content. The best practice way to do that is assign it to
the content’s data template’s standard values.

Note In almost all circumstances, a developer would be the one to configure standard values. See the
appendix for a description of what standard values are, how they’re configured, and why they are helpful. It’s
an advanced topic beyond this chapter and the core audience of this book. However, because of the universal
tendency to apply workflows to standard values, the subsequent content is left in context.
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Like any other time when you need to configure standard values, expand the data template and select
the _Standard Values item below the template. Workflow settings are hidden by default. You need to check
the Standard Fields checkbox within the View tab to get them to show up. Thereafter you'll see like 20 new
sections of configuration options appear, with workflow being one of them. Set the Default Workflow field
to the workflow you want assigned to that item. Leave the other fields alone, as they are used after the item’s
instantiation. Note these three steps in Figure 2-42.

| Administraior §

HOME NAVIGATE REVIEW  ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY

H o Contenttree ¥ Hidden items Raw values
Siie ) Enfire tree # Standard fields Bucksts

* Q - English~ 1=
i List Manager - ar i
» {J Sample Workflow n =
r @ Lt
Workflow L]
i User Defined
4 {J Global b =
4 [ Content Templates
State

» & Carousel tem

» il Featwred Product - -
4 W Product Promotion
» [5] Promotion Detaits Lock

& _ Standard Values
Promo Spot
) Quotation

»

»

b W Sticky Note
L4 Defaull workflow
»

Workflows/Regular Workflow - WorkflowsRegular Workflow -

LU BN Media Library  Workbox

Figure 2-42. You can make a workflow start automatically when someone edits a piece of content by adding
the workflow to that content’s data template’s standard values item

Note The __standard values of your template should only have the default workflow field set. Do not set
the workflow field on the __standard values. That would set the __standard values item itself as a workflow.
Similarly, do not set the State field on the __standard values item as that is saying that the __standard values
item is in that state.
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INTRODUCTION TO WORKFLOW SECURITY

There’s an entire chapter dedicated to security (Chapter 8). However, workflow is pretty tightly
coupled with security, since you typically have different people creating version-approving content and
subsequently have the authority to publish that content.

You can find more details in Chapter 8, but suffice it to say workflow security is treated like security for
any other item. Security is applied to items within the content tree. You can grant rights to items to roles
or users individually. Typically you will create a role and assign that role access rights to items.

From a workflow perspective you are securing the workflow items, which in this case are the states and
commands different roles or users are allowed to participate in. For example, if you don’t have access to
the Awaiting Approval state but you do the draft state, you will only see Draft items in your workbox.

It is a common pattern to create three main roles: Editor, Reviewer, and Publisher. An Editor can create
content, but can also have access to the Submit Workflow command to move the item to the Awaiting
Approval state. Reviewers might not have access to publish content, but they would have access to
review and approve content. A Publisher then may tee up batch publishing during select windows, and
therefore are the only ones who would have the access to move the items to a Published state. See the
appendix for how to create a custom workflow with four states such as this, and see Chapter 8 for how
to take that workflow and apply security.

Summary

Wow, we're making progress now! By this point we have definitely picked up our friend Mr. Scarecrow and
well on our way to the woods where we hope to find more friends, like, perhaps a tin man. We'll see. For
now, it is suffice to say that we've effectively paved a solid foundation of Sitecore that we can use as we
continue our journey home in subsequent chapters.

The key points in this chapter were the fundamentals of the content editor, and specifically how

information is organized in Sitecore. We discussed the importance of having a solid grasp of key concepts,

such as data templates, content items, and their presentation details. The Sitecore hierarchy is truly Sitecore

bread-and-butter, and prerequisite knowledge before continuing on into future topics.

Beyond this overview we went deep into each of those three foundational items. We covered what goes

into a data template, how content inherits those templates, and options for configuring data fields.

Next we covered content editing fundamentals, including a deeper tour of the Experience Editor as

well as administering content within the content tree. We learned how you can manage millions of items
with buckets, as well as how to manage multiple languages and translations. Content needs presentation

details, so Sitecore knows how to render that content. Those details include configuring layouts and content
placeholders. All of these settings can be configured on a data template’s standard values to ensure that new

items leverage common, global settings. Even things like workflows can be configured as default settings, to
ensure items flow through your standard business processes.

With content editing under our belt it’s time to take things deeper and start building more robust

experiences and web applications. The next step in our journey is to learn how to add forms into our site
to capture customer information and interactions. We'll take a deep dive into a popular and foundational
module: Web Forms for marketers.
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CHAPTER 3

Experience Personalization

This is the chapter we’ve all been waiting for, and it’s likely the chapter you bought this book for in the first
place. We all think personalization is going to save the digital marketing world. Personalization makes all
sorts of promises that we all get really excited about.

Personalization is kind of like the Good Witch of the South in the Wizard of Oz in this regard. She
promises a path to digital marketing bliss, meeting the unique needs of each user in this “age of the
customer,” or world of Oz we live in.

However, just as the Good Witch shows you the path to ROI and your eventual promotion, you realize
that the path has many perils. Few have survived to see personalization in all its glory as she describes it. In
fact, it’s rumored that nearly 85% of so-called “digital marketers” still are not fully utilizing these capabilities
at their fingertips. Too bad the “good witch” didn’t go with you on your journey, much like Gandalf did in The
Lord of the Rings. Dude—he fought a Balrog for Frodo! Nope, no such help with our friend from the south of
Oz; you must fend for yourself. With a wave of the hand and a friendly, but sort of sinister, “good luck,” she’s
off to finish her cup of tea.

Fortunately for you, you have a good book in your hands that will guide you to the ROI and promotion
she so shallowly promised you. This chapter seeks to explain the ins-and-outs of personalization in Sitecore.

The discussion on personalization will start with a comparison of rules-based and predictive
personalization. These two types represent degrees of complexity, but also degrees of reward. Rules-based is
great for basic personalization, but lacks the all-encompassing knowledge of your customer that predictive
promises.

Predictive personalization is heavily dependent on personas. The next part in this journey is
understanding personas, tips for defining them, and how your personas get implemented in Sitecore. From
here we can finally start configuring personalization and hopefully experience the wonderful bliss we've so
desperately been searching for all these years.

Let’s begin!

What Is Personalization?

Web site personalization usually results in three different changes you would choose from:

e  Change the content that’s rendered (i.e. update a component’s datasource to
something other than the default).

e  Change which component is rendered (i.e. swap the default component out for a
totally different component).

e Hide the component.
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There are two main ways to configure those changes. You can assign display rules onto the components,
or you can use pattern cards and drive the personalization based on which persona Sitecore thinks the
current user is (formally called predictive personalization). These two options are compared in this section.
In the next section, we’ll show the steps to configure each.

There are other options for personalization beyond the web site. You can also personalize e-mail and
print experiences. Those topics are more advanced and not covered in this book.

Rules-Based vs. Predictive Personalization

You can personalize your site to match unique customer needs in two main ways: rules-based
personalization (also often called ad-hoc personalization) and predictive personalization (also often called
behavioral personalization). Rules-based personalization is super easy to understand and configure. When
you personalize a component, for example, a pop-up appears showing you dozens of rules you can select
from to change the behavior of that component.

Rules are essentially if/then conditions. You can assign multiple rules to a single component and the
rule that matches first wins. The winning rule dictates how the component is personalized.

Notice in Figure 3-1 the Rule Set Editor. Again, there are many dozens of rules to choose from. For
example, you may want to change the datasource on a component if the user entered the experience from
an e-mail campaign (first item in the figure). Perhaps the e-mail promoted a specific product and you want a
10% off coupon to display on the home page in an attempt to get that user to convert.
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Rule Set Editor

Select the conditions and actions for your rule first. Then, specify the values in the Rule
Descripfion field.

Select the conditions for the rule:

Visit
where the specific campaign was triggered during the current visit
where the number of engagement value points compares to number
where the specific goal was triggered during the current visit
where the current visit matches the specific pattern card in the specific profile
where the ID of the page event is specific value
where the name of the page event compares to specific value
where the page index compares to nhumber
where the specific page has been visited during the current visit
where the value of the specific profile key compares to specific value
where the search keywords compares to specific value
where the site name compares to value

Rule description (click an underlined value to editit):

where the current visit matches the Paula pattern card in the Persona profile

Figure 3-1. The personalization Rule Set Editor lets you quickly apply rules to your content to change how it
behaves based on your user’s needs

The second option is interesting as well. Engagement value points are accrued as the user completes
goals or events. Maybe you have a user who is highly engaged, but has not yet converted or accomplished
the goal you are really wanting her to accomplish. Perhaps in these special situations you would want to
sweeten the pot and offer a 20% off coupon to push her over the edge. This rule would help you do that.

In both of those examples the rule is again a simple if/then clause. The rule does not know or care about
who the user is, i.e. their assigned persona.

Personas are a way to characterize a set of behaviors that different types of customers may share. You
may have 4-8 personas trying to represent your different customer’s behaviors. Personas help you prioritize
features and the design of your site based on which personas get the highest priority. However, they can also
drive personalization.

Persona-based predictive personalization is easily the most robust personalization option in Sitecore.
Instead of a series of if/then clauses, Sitecore can watch the movements, behaviors, and actions taken on the
site and attempt to match those behaviors to the persona that most closely personifies those behaviors.
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The benefit here is that personalization requirements are not usually so simplistic and if/then clauses
fall short of a marketer’s expectations. You may need to personalize based on 5-10 considerations, many of
which are less objective than a rule. A persona can characterize those more subjective qualifications.

Predictive personalization works by tagging content with profile cards. Basically a profile card has different
keys and each key is scored. Notice the keys in Figure 3-2 (i.e., Contributor, Learner, People-Finder, etc.).

Select Profile Cards

Select the profile cards whose values you want to assign to the current page.

Profile Cards Profile Card Details Profile Card Values Customize OB

Name % Paula Policy  |a0% = “pe-Sqmye
e Raiph %~
iy Sy Add Requester

Remove

i Lenny 0% -~
| Learner

n eskine

Figure 3-2. A profile card is composed of keys with each key having a value. Together these keys/values
represent the wants, needs, and desires of a persona

These keys are assigned to profile cards and weighted differently based on what that profile card
represents. Personas are represented in Figure 3-2, with Paula Policy, Ralph Requester, and Lenny Learner
assigned to a content item at different weightings (note the percentages).

A profile card may or may not be a persona, but usually is. A profile card could instead be more generic,
such as “High-Level” or “Detailed” if you want to tag content based on its information type. In that case,
rather than persona (or in addition to) you may want to keep tabs on the level of detail the current user
prefers to see. Perhaps you have people named Paula who prefer high-level content, and people named
Paula who prefer the details; but in both cases these Paulas want to see policy information. This example
lends itself to using two separate profile cards: one for their persona and another one (or more) for their
other preferences not represented within the persona itself.

Tip Don’t go crazy with profile cards! It's best to create solid personas that characterize your users.
Information Type actually isn’t a great example to use a second card. “Buying stage” might be a better example,
with keys such as Prospect, Qualified, and Customer (post-conversion). In this example, the persona is not
changing when the user flows through your funnel—it’s still the same customer. High-Level/Detailed would most
likely be manifested in the persona itself, thus making them redundant and adding needless complexity to your
personalization strategy. You want a really good reason to create profile cards that extends beyond your personas.

In Figure 3-2, notice how the requester and policy keys are both assigned four points, and the learner key is
assigned two points. Any user who browses to this content item will accrue these points across these categories.
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Note You can test this and watch points accrue through simulations in the Experience Explorer. See the
“Personalization Testing in the Experience Explorer” section later in this chapter.

Over time, as the customer engages across many pages/items, these points can start being matched
against profile cards and a card will be assigned to the users when their points matches a card. Then, you can
show personalized information to that card, such as content tailored specifically to the needs of Paula Policy
or content that is “high-level” if you were tracking something more generic such as information type.

Notice in Figure 3-1 there is a rule you can assign to a component to target a profile/pattern card. The
rule matches when the current user has been assigned to the Paula Policy persona. Of all the rules in the
rules picker, this rule is the most powerful. In the next section we’ll dive more into personas, since good
personas are the foundation of your personalization strategy.

STRATEGY BITS: SEGMENTING YOUR USERS

Personalization begins with knowing who your users are. What do they expect from you? What are their
needs, wants, and desires? What are their preferences? These questions are very difficult to answer
without a segmentation strategy.

Your segmentation strategy should encompass two main points; 1) implicit segmentation, driven from
user behavior and 2) explicit segmentation, based on data you have on file about that user.

Fortunately your persona strategy gets you through most of the first point—your implicit segmentation
strategy. By tagging pages with your personas, users accrue points for each aspect of the persona and
eventually fall within a persona based on a matching algorithm that works to get them into a persona
that is closest to their behavior.

However, in addition to personas there are other things you should consider when creating your implicit
segmentation and personalization strategies. For example, what goals and events did the user perform
during their visits? Did they enter the experience as a result of a campaign? If so, how then should the
experience be tailored? Perhaps the user experienced a failure event. Can you respond and rebuild trust?

These are all more complex examples, but it could be as simple as location or basic demographics.
Would someone in an urban setting want to see something different than someone in a rural setting?

All these questions may or may not be represented in a persona. You need to think beyond personas to
really grasp a complete implicit segmentation and personalization strategies, especially regarding things
such as goals and campaigns, which are so often glossed over in a Sitecore context.

Explicit segmentation and personalization is another area that is commonly overlooked when creating
segmentation and personalization strategies. It's great to personalize based on behavior, but what if
their behavior falls short of answering some important questions you have about the user? What do you
do then? Funny enough, the answer is quite simple—ASK THEM! ©

Explicit segmentation is very pragmatic. Present a call-to-action where you collect important
information about that user. News sites often use explicit segmentation to drive their personalization.
Have you ever gone to your local news site and they prompted you for your news preferences, such as
neighborhoods you do/don’t want to see news about, or your preference to see sports over crime news?
This is explicit segmentation at work.
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Another example of explicit segmentation might be a request to fill out a survey, or even as basic as site
registration. When your customers register for your site, what can you ask them to better understand
what their expectations are?

The fundamental problem with explicit segmentation is user resistance to provide the data you need.
This resistance is usually due to laziness, but sometimes due to security concerns. Laziness needs to be
overcome with simplicity and a strong call to action. It’s your job to make them really want to enter that
information. If you don’t, they won’t. Security needs to be overcome with statements of trust. Provide
them details into your security hardening strategies and other customers who have entrusted their data
to you. Additionally, show them a transparent and easy-to-understand privacy policy.

The bottom line here is that your personalization strategy needs to be paired with a segmentation
strategy, which asks the question, “how will we know who are users are?” Don’t rely solely on
behavioral patterns, and don’t rely solely on just the data you have in your CRM. Don’t forget about
goals, events, and relation to campaigns. You need to bring it all together in one holistic segmentation
strategy that accounts for all the facets of implicit and explicit segmentation. Leave no stone unturned
in your search for what motivates your customer!

It All Starts with Personas

Since personas are the foundation of creating an effective predictive personalization strategy, it makes a
ton of sense that you want to create good personas that match the needs, motivators, and attitudes of your
customers. There is a ton of literature on personas you can read elsewhere. Since, however, personas are so
foundational to a Sitecore deployment, a quick intro makes sense. Personas tend to be categorized in three
main categories: their goals, their behaviors, and their attitudes.

e  Goals—Some personas are driven by a specific purpose, such as the need to find the
best price on a specific watch. They come into your experience with a specific goal in
mind and they want you to help achieve that goal right away.

e  Behaviors—Behaviors are patterns you observe a persona taking, such as reading
every review possible or coming back to the site five times per day.

e Attitudes—An attitude is a point of view the persona brings with them when they
enter your experience. For example, a persona might be a staunch believer that
used cars are preferable to new cars or that Cannon makes the best cameras. You
need to understand the attitudes of your customers to ensure your tailor to those
expectations right away, or are very intentional to change those opinions.

Personas are behavioral categories that combine these three dimensions into unique statements of
purpose or intent on behalf of any given customer who may enter the experience you are building. Personas
are not roles, such as Director of Operations or CEO. Personas are clusters of behaviors. It is especially
important to know the difference for sites such as vendor portals or customer portals.

The Persona Workshop

So how do you actually go about creating your personas? Holding a 2-4 hour persona workshop with key
stakeholders is a great way to go about it. Fill the room with 6-10 individuals who either are your customers
or know them very well. Use the following process as a guide. The result of this should be a common
agreement to who your experience’s personas are and how they should be prioritized.
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Identify all the roles—When dealing with portals, such as customer portals or
partner portals, it helps to identify roles. Personas and roles are not the same
things! However, people tend to understand roles better than personas and
getting them on the table helps facilitate a discussion. Roles likely won't exist for
public-facing brochureware sites or e-commerce sites. Create a large post-it note
for each role and stick these around the room.

Identify all the events—Events are things users can do on your site. Go through
each role (or generally if no roles exist) and create a post-it note for each event
that user/role would want to perform on the site. Stick it under the appropriate
role, if applicable.

Identify behavioral patterns—Throw all the role post-its away and instruct the
room on the difference between roles and behaviors. Stack up all the event
post-its into one pile. One by one, compare each post-it to another and ask this
question: When the user comes into the experience motivated to do event A, will
they likely also be doing event B at that time as well? If the answer is yes, group
the two together. If no, create two groups. Move on to event C and do the same,
either putting it into category one or two, or creating a third category. Do this
until all the events are sorted into behavioral categories.

Tip Don’t let the room fall back into role-based thinking! Two different roles may come into the experience
both motivated to do the same thing. It will be impossible to prioritize personas, features, and campaigns if
there is a ton of redundancy in your personas!

Remove obvious behavioral categories—Take a look at the categories. It is likely
that you may have 15-20 categories on the board if you had 75 event post-its
you sorted through. 15-20 is way too many. You should shoot for 5-10 personas
at most. Compare each category to your company’s business objective or more
specifically the objectives of the site, and give each one a rating from 1-10 on
how well it aligns in support of those objectives. Discard anything rated <7. If
your team finds this hard to do, remind them that a site needs focus. A watered
down experience that leaves users unsure of what they can use the site for is
not effective. A separate site/experience may be needed to better support those
categories rated <7.

Create personas—The categories that are left become the building blocks for
your persona. Go through each category and describe that persona’s motivators,
pain points, and alignment to business objectives. Also, describe the goals you
have for the persona, things you want that persona to do that they might not
themselves know to do or plan to do (such as make a purchase when they are
just coming to read reviews). When complete you may have a high-level persona
description such as the one for Lenny shown in Figure 3-3.
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Figure 3-3. Creating your personas on paper before you create them in Sitecore is critical. Be behavior-centric,
not technology-centric or role-centric in your persona strategy

You can much more easily create a personalization strategy when you have personas such as Lenny
identified for your site. Additionally, when personas are prioritized against the site or company’s business
objectives, it is much easier to understand which features or capabilities of the site need to take priority and
which features can wait for a later release.

Creating a Persona Journey

The next stage in creating a persona personalization strategy is to determine each persona’s unique journey
you want them to embark on. Sure, priority #1 is the create an experience that they want to engage with;
however, it’s just as important to know what you want to get each persona to do. In the case of Lenny,

he is a basic information seeker engaging in a partner portal solution. He has a question and he wants it
answered. But, can we get him more engaged? Can we work to change his behaviors and attitudes, such that
he becomes an active contributor and an active promoter of the portal? Can we change Lenny’s persona to
another persona that creates more value for our business? What we want to do is create an engagement
plan for Lenny that leads him toward becoming a more engaged, more valuable customer.

One could argue that each persona may get its own yellow brick road of sorts. In Sitecore, a persona’s
yellow brick road is called an engagement plan. An engagement plan leads a persona toward a desirable
outcome. Engagement plans dovetail closely with campaigns and are covered in greater detail in the next
chapter. However, now, when discussing personas, it’s helpful to keep engagement plans in mind. In

86



CHAPTER 3 ' EXPERIENCE PERSONALIZATION

Figure 3-4 you'll notice a persona engagement funnel that we want Lenny to flow through. He starts as a
basic information seeker, but in the end becomes an active contributor and promoter of the partner portal
solution. Create something similar for each persona. In the next chapter we’ll work to make these journeys a
reality by incorporating the user into an engagement plan. This is the foundation of Marketing Automation
in Sitecore.

Basic information seeker

Solved it!

Self-service app-seeker

Submitting best practices

Social people-finder

Active contributor

Figure 3-4. People have aspirations and goals for their life, and so should your personas! Create a persona
digital funnel and map out how your want your personas to evolve over time (and become better customers)

For now, describe each stage in the funnel. How do you nurture this persona in particular? How do you
get them to advance their stage? Content should be aligned and personalized to each persona and ideally
each stage to ensure the persona is advancing deeper into the funnel. This exercise will help you add greater
depth into your personalization strategy beyond the obvious. You will likely find content gaps, and gaps in
your strategy for various personas and their respective stages. This is a good thing! Work to close these gaps
over time, and in doing so your digital experience will be increasingly personalized, customer-centric, and
value-laden for your business.

Predictive Personalization Terminology

We need to get some nomenclature under our belt before we dive in and configure our personas and
thereafter personalization. The following are all key concepts for Sitecore personalization. Most of them are
covered in detail in this chapter, but others, such as goals and outcomes, are covered in the next chapter
with more context provided. For now, however, when planning your personas it is good to have all the
nomenclature in mind so you know holistically what you should be planning for.
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Profile cards—Remember that a piece of content can be tagged to a profile
card. As the user navigates around, numeric values are accumulated and those
values are used to match the user with the closest profile card that represents
the user’s behavior (pattern card to be precise—more on that later). A profile
card commonly is akin to a persona. However, you may have profile cards for
individual goals, behaviors, or attitudes, such as the example provided earlier
about information type—High-Level and Detailed.

Profiles—Profiles are just categories of profile cards. Profile cards are what

you attach to content so Sitecore can start tracking behavioral patterns and
match a user to the nearest cards. However, you can have multiple categories
of cards assigned to a piece of content. Figure 3-5 shows some content that has
assignments for the Persona and Information Type profiles.
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Profile Cards zz English= =
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n Focus Edit
7 I Function Edit
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Content Tree

Figure 3-5. You can assign your personas to content items to help drive a matching algorithm for site visitors

Profile keys—XKeys represent the goals, behaviors, and attitudes of a profile card.
Take the Lenny persona profile card shown in Figure 3-6. The Persona profile
has the following keys: App-seeker, Contributor, Learner, Newsy, People Finder,
Policy, and Requester. Lenny, then, has values set against those keys to tell
Sitecore who Lenny is and what his preferences are. You can see that Lenny is
primarily a learner, but also cares a fair amount about getting the official policy
stance on important subjects. To a lesser extent he is a contributor and people
finder. Keys, as you can see, weigh the persona accordingly.
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Figure 3-6. Technically speaking, personas match profiles, profile keys, profile cards, and pattern cards (and
events, failure events, and goals—but more on that in Chapter 5!)

Pattern cards—Pattern cards are used to match the current user’s key values and
accrued points against some set of standard values. To be perfectly explicit, a
user is matched to a pattern card, not a profile card. Profile cards set how much
value is given to the different keys, whereas pattern cards look at how much value
the user has accrued across the keys, with the closest matching pattern card
being assign to the user. It’s all rather confusing, but suffice it to say your pattern
cards most of the time will be configured to look identical to your profile cards.
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EVENTS, FAILURE EVENTS, GOALS, AND OBJECTIVES

Events, failure events, goals, and objectives are all covered in more detail in the next chapter. However,
they bare significant consequence to personas, so this is a teaser as to what is coming next.

Events—Look back at Lenny’s persona in Figure 3-3. Note specifically the Motivators section. Events
are these motivators. You can tag content and actions to events that correspond to a persona’s
motivators. The benefit to doing this is reporting. Wouldn’t it be nice to validate post-launch that your
assumptions about your personas are accurate? Reporting can also help you see event trends, where
trending up means that personas are getting better and better at accomplishing what they are setting
out to accomplish.

Failure events—Notice the pain points in Figure 3-3 as well. These pains points are also events, but
tagged as failures. Again, reporting can help you understand when you are letting your customers down.
If you see high failure actions you should update the design/strategy of the site to reduce the amount of
discomfort you are causing your customers.

Goals—Goals are things you want the customer to accomplish. Goals are also noted on the persona
in Figure 3-3. Again, goal attainment is easily measured. Goal examples might be downloading a
whitepaper, registering for a webinar, or just about any action imaginable.

Outcomes—These are high-level, macro goals you have for a persona. This might be a conversion from
lead to customer. In Lenny’s case it means growing beyond just an information seeker and becoming an
active contributor.

Your measurement strategy will benefit by considering objective events, failure events, goals, and
outcomes during the persona development process. It helps to pair up a persona definition with a
measurement strategy across these dimensions. The persona itself can remain rather abstract, but
a technical resource, such as a Sitecore architect with xDB experience, should be weighing in and
providing ideas to make these points measurable and a bit more objective.

Personalization Testing in the Experience Explorer

The Experience Explorer is amazing. There is no doubt that your personalization strategy will be rather
complex by the time it’s implemented on your site. How do you know if the implementations is built
according to specification? How do you simulate a persona and see how your site responds to their
preferences? The answer is you do your personalization testing in the Experience Explorer (Figure 3-7).
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Figure 3-7. The Experience Explorer is a great way to see how your session is aquiring persona points

There are a few use cases you should be aware of:
¢  Monitoring profile key value accrual
e  Monitoring assigned pattern card/persona
e  Watching the site respond to that persona
e  Manually setting key values to force different behaviors to occur

e  Manually setting the persona you want to set
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e  Monitoring goals and events you're engaging with
e  Validating user information, such as location or demographics

e  Manually attributing the visit to a marketing campaign to again monitor how
personalization responds

The left panel lets you manually set the details of what you're testing. The right panel shows what the
values are set to. In the case where you're in Journey mode both will be whatever Sitecore matches you with.
In the case of Fixed mode, the values in the right will be whatever you set on the left panel. These values can
be key values, but you can also tag which goals and events you're anticipating the testing will encounter.
Additionally, you can set a marketing campaign as a source in the Referral Information section to view how
your personalization is responding to campaign referrals (Figure 3-8).

Referral Information ~
CAMPAIGNS REFERRAL

Click the campaign that you want to trigger during this &

visit

¥ Google Plus Share Butto
¥ Linkedin Share Butto

® 9 Social Markete
$9 Twitter Content Message:

Figure 3-8. You can assign your Experience Explorer session to a campaign

The Visitor Information tab on the left lets you assign a device channel as well as location information.
If you recall, you have create layouts that support different device formats. If your site is fully responsive,
you likely only have one layout and just one default device. Otherwise, you may have multiple devices and
you can swap between then here (the Device tab in Figure 3-9). As you can see in Figure 3-9, it is also very
easy to simulate location information. Just click the Apply button after your settings are made to see how the
experience responds.
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Figure 3-9. You can also set presets around location and device

You can configure presets if you get tired setting all these Experience Explorer configurations over
and over again. Your presets can be found in the Experience section. By default there are two: Default and

Anonymous. It is very easy to create your own, however. Use these high-level steps to guide your creation of

a preset:

1. Navigate to the Marketing Control Panel from the Launchpad.

Expand the Experience Explorer node.

2
3. Right-click Presets and click New Item » Preset Persona.
4

Enter as many presets as you want. See the following list for some of the most helpful.

Name—Name of the preset mostly likely consistent with the persona

Image—Always good to give your presets an image especially if it’s correlated to
a persona

Viewed pages—Pages you want the preset to have already viewed

Device—Perhaps the preset should be configured to come in on a mobile device
versus the default

Location section—Here you can set the location information when location
drives personalization

History—You can preset up to four different histories, such as page views or
downloads

Profiles—Most important; preconfigure a persona
Goals—Configure the goals you want the user to accomplish

Attributes (events)—Configure events you want the user to accomplish
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Note Profiles, goals, and attributes can all be found in the Advanced section (Figure 3-10). That section is
hidden by default. Under the View tab, check the Standard Fields checkbox to show the Advanced section.

Source [standa
Standard values [shar

Tracking |

Profiles Goals Attributes ‘
""’"S\‘\ i

Persona
Leamner: 10
App-Seeker: 2
Requester: 0
Policy: 5
Newsy: 2

Figure 3-10. Presets around personas, goals, and attributes (events) help save time when testing your
personalization implementation.

Configuring Personalization

This section covers the two main ways to configure Predictive personalization: ad-hoc personalization and
predictive personalization.

Configuring Ad-Hoc Personalization

Personalization is configured at the component level for web experiences. The easiest way to configure
personalization is from the Experience Editor. While in the Experience Editor, select a component you want
to personalize. Click the Personalization button in the menu (note the arrow in Figure 3-11).
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Figure 3-11. Configuring personalization on a component is easy; you simply click the icon and set the rule

After you click the Personalization button you should receive a pop-up similar to that in Figure 3-12.
Begin by clicking the New Condition button at the top right. The Rules Editor pop-up will appear showing
you several dozen rules you can choose from. Select the rule you want and fill out the required settings to
satisfy the requirements of the rule.

95



CHAPTER 3 * EXPERIENCE PERSONALIZATION

Personalize the Component IS¢

Manage the personalization conditions, content, and design of the component The list of conditions is prioriized. The first
true condition determines which personalization content is displayed
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Hide Component

If none of the other conditions are true, the default condition is used

Home

Personalize Content:

Not sef] Home

Figure 3-12. Conditions are used to tell Sitecore which content/component version should be used

Note that the conditions are served on a first-come, first-serve basis. The first condition whose rule is
satisfied wins, and that condition controls how the component is personalization. This is done from top to
bottom, so ensure that your default rendering is the last condition in the list. To change the sort order, click
the Actions drop-down on the condition and select Move Up or Move Down.

After your condition and rule is configure you need to decide how the component should be
personalized. Note the Personalize Content setting in Figure 3-12. When you choose this you will be able
to change the datasource on the component and set it to alternative source in your content tree. This is
the most basic form of personalization imaginable. Alternatively, you could opt to hide the component
altogether by selecting the Hide Component checkbox.

Another option is to swap out the component entirely. Note the Enable Personalization of Component
Design checkbox in Figure 3-13. When this is selected you will be able to swap the default component for an
alternate. Note now in the figure there are two options: one to select which component is rendered, and the
same option as was available previously to select the datasource.
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Figure 3-13. Component personalization is enabled by checking the checkbox

Simply click OK when you're done personalizing the component. After publishing, your personalization
settings should be ready to go! It can be quite difficult to know what is personalized on pages, especially
very busy pages with a lot of personalized components. In the Optimization tab within the Experience
Editor, there is a Personalization button that shows a helpful pop-up. Figure 3-14 shows this pop-up. You
can see a quick view of what is personalized on this page. Each component is highlighted with a red box for
a quick view. Also helpful is some easy-to-understand reporting that shows how often the versions of the
component are being rendered. Each personalized component is listed on the left with each version. Each
version will tally how many times it is rendered, giving you insight into how often your personalization rules
are taking effect.

97



CHAPTER 3 * EXPERIENCE PERSONALIZATION

| Administrator &

ADVANCED EXPERIENCE OPTIMIZATION

sine m . Mo test — £ Active tests = Suggested
# u) ["- . ';" i =
Edit Other Goals Attributes Personalization £ Historical tests

©Q e . : O x§
Personalized experience

11 personalization rules in 5 components on this page

Promo with Thumbnail E =

Policy Lovers - Pa\: NODATA

Default = NODATA © +~ @ ¥

Abstract Spot

Network Architect | NODATA E

Developer = NODATA

Palicy Lovers - Paula
Condition: whare the curment visit matches the Paula patiem card in the
Persona profile

Default = NODATA

Abstract Spot
Trailing Value/Visit
Marketers and Cont NOT PERSONALIZED PERSONALIZED

entOwners | NODATA

Default = NODATA

EFFECT

Abstract Spot

Edil personalization e

Figure 3-14. You can quickly see what is personalized on a page by clicking the Personalization button on the
Optimization tab in the Experience Editor

Configuring Persona-Based Personalization

You configure predictive component personalization in pretty much the same way you configure rules-based
personalization, as described in the previous section. Figure 3-1 still applies; there’s a “pattern” rule to
personalization against the assigned profile/persona. The only difference with predictive personalization
configuration is setting up your profiles and personas and tagging them to content items. Your customers will
accrue value points assigned to those personas as they browse your site and interact with those persona-tagged
content items. Let’s start first by configuring a persona, and then we’ll move into tagging content with that
persona. Personalizing a component, as described in the previous section, will not be repeated.

Note A new concept introduced in Sitecore 8.1 is ‘persistent profiles’ and the concept of ‘profile decay’.
This means that historical behavioral personalization will be carried over from previous visits. However, you may
want more recent visits to weigh heavier on how the site is personalized, hence the concept of ‘decay’.

If you have 100 points for one persona for the current visit, and your decay score is .75, only 25 points will carry
forward into the next session. See the following post for how to configure decay:
http://sitecoreskills.blogspot.co.uk/2015/10/behavioural-profiling-improvements-in.html.
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Predictive personalization configuration starts in the Marketing Control Panel (Figure 3-15). You can
find the Marketing Control Panel on the Launchpad or in the desktop. The Marketing Control Panel contains
all the marketing automation features that will be describe a bit in this section, but more specifically in the
next chapter. In particular, there is a node called Profiles where you can add all your personas and other
predictive personalization profiles.

4 %Y1 Marketing Control Panel
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b
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2k Federated Experience Manager
b ¥ Outcomes
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P & Focus
P & Function
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(¥ Profile Cards
] Pattern Cards
P &3 Score
& TestLab
b . Experience Explorer
» Y Analytics Filters

Figure 3-15. The Marketing Control Panel is where all the marketing action is. More on this in Chapters 4
and 5, but for now, suffice it to say this is also where your personas are configured
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The structure of the Profiles node can be seen in Figure 3-16, as described previously. It is most common
to store personas below a profile node called Persona. An out-of-the-box Sitecore installation has a bunch
of profiles (e.g., Focus, Function, etc.) that you probably want to delete. Likewise you will want to delete the
out-of-the-box personas since they are just there for example purposes (e.g., Cecile, Chris, etc.). Itis also a
best practice to have the Profile Keys align with the persona behaviors, not with the personas themselves, as is
out-of-the-box and can be seen in Figure 3-15. Instead, create keys that align to the behaviors, and below the
Profile Cards folder create profile cards for your personas. This is demonstrated in Figure 3-16.

» ',- * Path Analyzer @}1 Persona
» B Personalization
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» & Focus Data
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weamet Percentage v
Newsy
Feople Finder
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0 @ e 8
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a','.'. April
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Figure 3-16. A profile has a Type field that’s used to track how the behavior value points are accrued

Note The profile node also as a helpful type setting, as can be seen in Figure 3-16. This setting controls
how the value points are accrued as users interact with your persona tagged content. You may prefer a different
type based on your reporting requirements and the nature of the persona/profile card.

In addition to the profile type, you should also consider the Authoring Selection setting (Figure 3-17).
You can configure the profile to allow adding a single persona to a content item, multiple, or multiple with
percentages. In some cases a content item has relevance across more than one persona so applying multiple
tends to be necessary. It is a general best practice to apply with a percentage; however, since most commonly
that content item does not apply equally across all personas. Setting a percentage tells Sitecore what
percentage of the total points should be applied to the current customer’s browsing experience.
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Figure 3-17. A content item can have one or more profile cards assigned to it

You will create profile keys below your profile nodes. Right-click the profile and choose Insert New
Profile Key. There are a few settings, most important of which is the key name, such as Learner, and the max
value. The max value is what is configured when setting up the profile card/persona. A typical max value is
10. A max value of 1 may be helpful for Yes/No circumstances. Min Value and Default Value may or may not
be helpful depending on what you're trying to accomplish with your persona.

The real excitement begins when you create your persona cards. These persona cards are tagged onto
content items, and each of the profile keys can be weighted on the card. A sample profile key configuration
on a persona can be seen in Figure 3-18. Along with the profile card values, it is helpful to set a persona name
and an image to represent the persona. The images show up as icons when you tag content, so it’s helpful to
pick a headshot that is distinguishable when trying to quickly see how a piece of content is tagged.
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Figure 3-18. Create a profile card and assign the key values to connect the card to the persona

Note Profile cards are created below the Profile Card folder, as you may have guessed. However, there are
two types of cards that you can create: a default card and a persona profile cards. The only difference is the
persona cards has a bunch of extra fields you can use to give the profile cards a more “human” touch, such as
Age, Interests, and Education. These fields are optional. At a minimum, configure the Card Name, Image, and
Profile Card values.

Pattern cards are what a current user’s value accrual are matched with. So again, profile cards are what
applies value points onto a user’s experience, and a pattern card is what that experience gets matched to if
the points align to the pattern. The pattern field on the pattern card in most cases is configured identically
to the profile card. So the settings in Figures 3-18 and 3-19 would look the same. Sometimes administrators
name the pattern cards “Looks like Lenny,” since they just want to match the user with a value score that
is similar to Lenny to Lenny himself. About all you need to configure on the pattern card is the name of
the card and the pattern itself. Thereafter, this pattern card can be used on a component’s personalization
settings to change behavior for users who behave like Lenny, for example.
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Figure 3-19. Pattern cards are typically created identically to profile cards

The last step is to add the profile cards/personas to content items so that when users interact with that
content item they accrue those value points. Notice the content item in Figure 3-20. There is a little blue
profile card box to the right of the content name. When you click this box, you are prompted to add the cards
you want to associate with the item.

REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW MY TOOLBAR

H < 1 Articte Folder oty & m T Copy o b = Rename a Up f Frst
Save Edit= Artice 2013) w Duplicase =

Profile Cards

Click Edit ciate & new prodle card io e ilem of lo edil he exising profile card
T m Q glish
Audiencs Segment Edit
7 Persona Edit
PG OurStrategy -[Our _ Ea @
Function Edit
el
R 102 nsooFcrz7cE O Edy
Rem name: Qur-Srategy - Dt
Rem path: shecoreicontent

Tamplate: witcorntemplan

Created from: lurkneram]

Figure 3-20. When you're ready, assign the pattern cards to content so Sitecore starts tracking behaviors

You can assign as many cards as you want from as many profiles as you want. Note, however, that when
more than one card is allowed (Figure 3-17), you may need to specify a percentage allocation, as can be seen
in Figure 3-21. This tells Sitecore how many points to allocate when a content item has relevance across
more than one persona. In any case, add the applicable profile card(s) to the content item and click OK. You
will need to publish the item, as well as ensure all the profile cards are published, before the personalization
will be working in production.
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Figure 3-21. You can assign multiple profile cards to a piece of content. When you do you can optionally set a
percentage weight
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Figure 3-22. Afterward the personas appear next to the profile card blue box

Alternatively, you can assign profile cards through the Experience Explorer (Figure 3-23). If you have a
super wide monitor you will notice a Profile Settings area within the ribbon in the Optimization tab. Once
you click the double-down arrows, and then click Edit profiles, you will see the same pop-up that you see in
Figure 3-23.
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Figure 3-23. Alternatively, you can set profile cards from the Experience Explorer

Summary

Well, there you have it! Sitecore personalization at its finest. You can imagine the power and intrigue that
personalization offers to a marketer; you can create experiences directly correlated to the wants, needs, and
desires of your customer! That is pretty amazing, and in the “age of the customer,” it is pretty much table
steaks for web experiences.

This chapter compared rules-based, ad-hoc personalization to predictive, or what is often referred to as
behavioral personalization. If you remember, ad-hoc personalization is the easiest to configure; simply add a
rule to a component. However, predictive personalization is where the fun really begins.

As you know by now, your persona strategy is the bedrock of your personalization strategy. Beginning
with rock solid personas is key. They must be well aligned to your business objectives, and just as
importantly, the objectives of your customers. With that in place, it is easy enough to configure those
personas in Sitecore, tag content to them, and configure your components to be influenced by them.

The question we now face is, “is my personalization strategy actually working?” With that we transition
to Chapter 4, where we dive into multivariate content testing. You know what they say about ass-u-me(ing)
your strategy is working; best not leave it to fate and risk our reputations!
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CHAPTER 4

Experience Optimization

We just discussed personalization in Sitecore, which is no doubt one of the most exciting capabilities
Sitecore provides. However, having good, highly effective content is the first step to any personalized
experience. What good is showing your customers content that should be interesting to your customer,

if that content is arranged in a really crappy way or written poorly? Experience optimization, aka testing,
tests different content variations and component layouts in order to determine which combination creates
the most engagement value possible. Experience optimization, then, goes hand in hand with experience
personalization. The two work together to create the most engaging, valuable experience possible for your
customers and your business.

Sitecore offers out-of-the-box page comparison testing and multivariate A/B/N testing to ensure your
content, components, and pages are structured and written as effectively as possible.

Do you have a hypothesis, a potentially better way to structure your page? Test it! Know, don’t just
guess. Are you fresh out of hypothesis? Do you just want to click the Publish button and move on with your
life? Well, test it anyhow! Test everything! Sitecore’s motto is, “Test everything, everywhere, and all the time!”
You will benefit from testing whether or not you have a hypothesis. Sitecore, a few days or weeks later, is kind
enough to e-mail you, letting you know of the results, and asking if you want to take its recommendations
and update your pages based on them. Pretty easy and cool!

This chapter discusses key considerations for testing that will help you create a testing approach, or at
the very least, understand some of the terms and get your expectations aligned. Thereafter, we’ll dive in and
configure the two types of tests available, page tests and multivariate A/B/N tests.

Experience Optimization Considerations

It makes sense to begin with some considerations before we dive straight into configuring experience
optimization and testing in Sitecore. What is A/B testing and how does that compare to multivariate testing?
There are also some mobile and personalization considerations to keep in mind as you plan your testing
strategy. Lastly, you need to put your statistics hat on; you don’t want the data to lie to you!

What Is A/B and Multivariate Testing?

A/B testing is simply the process of comparing two options and picking the one that performed better.

A/B testing splits the load across both experiences, where half the traffic goes to variation A and the other
half goes to variation B. You then want to compare the results of those two experiences. Goals, events, and
thereby engagement value is the measurement of success in the Sitecore world. You will most likely choose
the variation that drives most engagement value to become the permanent selection, but because of the test,
you pick that variation in confidence.

© Phillip Wicklund 2015 107
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That is the big attractor with A/B testing. Instead of theories, you have concrete conclusions. Instead
of telling your boss, “I think we’ll get more conversions by putting the call to action on the right side of
the article,” you can say, “I compared four variations, and the modal dialog pop-up produced the most
conversions so it’s now live on the web site across all segments”.

Note A/B testing isn’t a replacement for a good content plan/strategy. There’s a good (and entertaining)
Atwood article on how A/B testing is really just about smoothing out the details: http://bit.1ly/1ipf2bw

Experience optimization in Sitecore enables you to try things and play around with different options.
These options might be different content variations, different components, hiding components, adding
new components, as well as trying different personalization settings. In the end you can drive a lot more
engagement through tested pages than just assuming the current arrangement is best.

What then is multivariate testing, and how is that different than A/B testing? In reality, there is no
practical difference in Sitecore. We're at the mercy of industry standard terms. In Sitecore, all testing, or
more specifically, experience optimization, is multivariate in nature. Multivariate means you can have
multiple variations all being compared, where the best combinations of variations wins the day. In this
sense, you are not limited to two variations, A and B. You could have as many as you want. In fact, for busy
pages such as your home pages, you may find yourself testing 100+ different variations, when you count up
all possible testing and personalization combinations.

There are three kinds of test candidates:

e Page Version—The previous version of the page can be compared to the new version,
or to another page altogether.

e  Component—Components can have variations of content (by setting an alternate
datasource) or variations of the component (such as swapping out the component
for a different one).

e  Personalization—All personalization settings on components are treated similar to
component test. They are a great way to validate that your personalization settings
are optimized.

Tip The data doesn’t lie, but that doesn’t mean it can’t be way better. Personalization testing should be a
key priority for testing in general, not just component variation testing. The test results might show an increase
in conversion for a given test across all users, but certain users may fare significantly better with a variation
that is personalized. The selected variation, despite performing best across the aggregate, may actually hinder
certain customer personas. Knowing the overall conversion rate is 4% is far less valuable than knowing the
conversion rate for each persona.
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STRATEGY BITS: GETTING STARTED WITH TESTING

The digital marketing world moves quickly, as do the expectations of your users. So, when you’re
managing content for one of your digital properties, it can sometimes feel like a constantly moving
beast. How do you keep up? The answer is to integrate testing into your overall content plan.

Is your brand or product department considering a change to design or messaging?
Conducting tests can provide leading indicators of what will resonate best.

Are your audiences diverse in their demographics or needs? Testing can help you find
common themes that resonate across your audiences.

Is your leadership insisting on “consistency” regardless of the impact on your goals?
Running quick low-risk tests can help prove your case for performance-focused
marketing and will help you gain their confidence in your approach.

Are you reconsidering a web site redesign or big media campaign? Testing can be a
cost-effective way to test concepts before larger investments are made.

So, where to start? Think about your content as a recipe you are adjusting to bake the perfect cake. You

have multiple ingredients that you need to mix together in the right way to get the result you need.
To execute organized, successful tests, follow these steps:
1. Create a “test plan” by:

Creating clear goals for your digital properties, then setting goals for the content
you plan to test within it. Ask yourself what should this piece of content do to help
me achieve my broader digital goals?

Considering what you want to learn from your test. Maybe you simply want to drive
more sales. Perhaps you are interested in what content different audiences respond
to. Maybe you’re simply trying to learn more about who your audiences are. Think
about what knowledge will help you be most successful, and then create a test to
help you achieve that knowledge.

Creating your hypothesis. This could come from your research department, or you
may just have a hunch that people will share video A more than video B. Be sure to
start out with a hypothesis, so you can prove yourself right or wrong.

2. Choose a testing approach. There are typically two core approaches:

OPTION 1. A/B. These are simply two versions of the same page or page elements
that are tested at the same time. Traffic is sent to both versions and the response is
evaluated. A/B testing can help organizations become familiar to the idea of testing;
they’re low-risk yet can reap significant results in short time periods, especially if
you have higher site volumes.

OPTION 2. Multivariate is popular in organizations that have experience with
testing. This tests multiple elements at the same time on the same page. This
method can be a fast way of getting to your ideal “recipe,” especially if you’re
testing landing pages or e-mails.
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3. Select the testing platform, such as Sitecore.

4. Decide on the location and time of your test. Start small and build your testing
volume and complexity over time.

5. Test, evaluate, and share your results with peers and senior management.
6. Repeat.

Looking for a good place to start? Focus on where people will take action so you give yourself the
best chance of seeing response—your “ingredients” here might be Click Here buttons, form style,
placement, and words/color/style.

Above all, enjoy it—consider testing your secret weapon to achieving your goals!

Laura Best
President, Best + Co
http://www.bestdigitalstrategy.com

Good Expectations (1% Rule)

The question, “how do you eat an elephant?” is similar to that of “how do you create a highly optimized
digital experience?” The answer? You guessed it. One bite at a time!

The biggest problem with experience optimization in Sitecore isn’t the effectiveness of the tool, nor its
ease of use. The biggest problem is its lack of use. Too often, customers dabble around with testing. They
run a few tests, recognize they need two weeks to run the test instead of two hours, and only see a 1% gain in
engagement value as a result. Dismayed, they give up, never to return.

How sad! 1% can be add up and become serious revenue if you stick with it. Experience optimization is
all about continuous improvement. It might be best compared to that of Toyota’s principal of Kaizen, than
say the U.S. moon landings. Yet often people expect the moon out of testing, which is unfortunate because
they pass up the 100 small gains that lead them to competitiveness and larger market share.

Tip  Understand the impact of your tests beyond their localized results. If you increase conversation rates,
driving more event registrations, does that take away from them purchasing a product?

Landing Pages vs. Corporate Web Site

We discussed what you can test (pages, components, and personalization), but where should you test?
Historically it is far more common to test campaign landing pages, as compared to, say a company web site’s
home page. The attraction to landing pages is their association to a campaign. That campaign has a budget
and you need to drive conversions to demonstrate ROI. Testing, then, becomes a way to optimize that
landing page to ensure you're driving as many conversions as possible. Additionally, landing pages often
are far more targeted and personalized than corporate pages. Simplicity requires less testing time, fewer
impressions, and clearer impact of the test.

However, by sheer volume, we often fail to test our corporate pages to our own peril. A corporate page
may drive 10x more conversions than a campaign, and yet since the home page isn’t associated to a budget
or initiative we often fail to do the testing where it can have the biggest impact on the company. Oftentimes
it requires intentionality at the CMO level to drive changes in governance policies to instill this behavioral
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change. Marketers often get too focused on one campaign, taking their eyes of the company’s cash cow, their
corporate web site.

Fortunately for us, Sitecore offers a recommendation on what pages it thinks you ought to be testing.
This report is shown in Figure 4-1. The recommendations stem from several criteria:

e  Number of variations—or previous versions—available to be tested (you need
something to test)

e  Amount of traffic that page receives (it takes a lot of data/traffic to validate a theory)

e Engagement value that page drives (you don’t want to test dead ends)

! Q

Page | Potential | Impact | Recommendation
Events 10 9 10

Home 9 10 9

Find a Health Plan 7 4 6

Binding Content and Presentation 7 3 5

Developing in Sitecore 5 0 2

New Featured Product 5 0 2

Step 1 5 0 2

Step 2 5 0 2

About Launch Sitecore 5 0 2

Building the Site 5 0 2

Accessing Current Visitor Information b 0 2

Figure 4-1. Sitecore is kind enough to recommend which pages it thinks would benefit from testing

So by all means, optimize campaign landing pages, where you have the most tangible opportunities for
a conversion to occur. But do not neglect your corporate pages, where you have the by far the most volume
and thereby the most potential to create new customers.
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Calculating Statistical Significance

Have you ever heard an election poll discuss its “margin of error”? In statistics, understanding the margin of
error is key to understanding how trustworthy the results and recommendation are. Another way to look at
the margin of error is to consider a data set’s “statistical significance”. In Sitecore, a test with high statistical
significance, such as 95%, has a small margin of error and the test’s results are trustworthy. It takes a lot of
samplings (traffic) to generate a high level of statistical significance.

Note The statistical method Sitecore uses is the Pearson’s Chi Squared test.

If you fail to meet statistical significance you may be working on false or incorrect assumptions.
Above 95% should be your goal. There are a few things that impact your ability to achieve high
statistical significance:

Number of things being tested, such as number of pages being tested, number of
components versions being tested, and number of personalization rules being tested.
The more things being tested, the harder it will be to achieve statistical significance.

The amount of samplings available, such as page hits. If your test for a page gets
10,000 hits you stand a much better chance of hitting 95% than if the test only
encounters 100 hits. The more hits, the more confidence the results are because
they have been validated many times.

Must Read Most winning A/B test results are illusionary! See: http://bit.1ly/1LtalLkVv

If you're doing a page test and are comparing two very different pages, it will take far fewer samplings to
generate statistical significance and thereby confidence in which page creates the most engagement value. If
you are doing a page test comparing only one page, but 100+ component or personalization variations, you
are going to need a large sampling size and perhaps a lot of time to get the same level of confidence. As such,
multivariate page tests with dozens or hundreds of variations should usually be reserved for your busiest
pages, or you'll find you need weeks or months (or infinity!) to get enough samplings to validate your theories.

MOBILE CONSIDERATIONS

It’s important to consider mobile in your testing strategy. Traffic sources between desktop and mobile
continue to shift, commonly becoming a 50/50 split between the two. When the mobile vs. desktop
experience is vastly different, you may need a different testing strategy. Too often users set up tests
across desktop and mobile and apply the results equally to both.

Perhaps the test resulted in an increased level of conversion for desktop, but a decreased level of
conversion for mobile. But you never knew and took a recommendation that negatively affected 40% of
your user base.

Responsive design makes this more of a problem. With adaptive design, it is easy to segment mobile
and desktop users and view results individually, and then make individual modifications to the
experience. With responsive design, you do not have as much flexibility. If the experience is dramatically
different, it may be worth considering adaptive to allow for greater testability.
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Resist the temptation to implement changes based on early feedback. If your test has not achieved
statistical significance of 95%, be weary of its recommendations.

Caution! Watch out, too, for false positives. Seasonal variables, such as running a test over the Christmas
season, may create false confidence for other months of the year.

Fortunately, Sitecore provides a report when your test is complete (and in progress) of the current level
of statistical significance. You can see this report in Figure 4-2, specifically the Confidence measure. When
the confidence exceeds 95% it is safe to stop the test by picking a winner (Pick as Winner button when one of
the tested experiences is selected).

O X
. Test result
:: Cvervigw Details - Experience 2
‘ PESTEXPERENIEEFRECT CONFOENZE IC3RE | 8 4 180%
4+ 180% 96.45% 241

2 o b

Al page

ENGAGEWENTVALLE CIVERZICH RATE VARWELES

Top experiences

Reach - Visitors exposed to expenences

- Sepemznied 31 -

Figure 4-2. After a test is complete you can compare results and select a winner that will take over as the
published version

Additionally, before you even start the test you are shown Sitecore’s guess at how long it will take the
test to achieve statistical significance. You can see this warning in Figure 4-11 later in this chapter when we
create our first test. Note how Sitecore tells you how long the test will take. In the case of Figure 4-11, I know
I'won't be able to wait the 18,986 days to achieve statistical significance (due to one request per day on my
laptop’s Sitecore instance)!
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Getdatadriven has a fun little tool (Figure 4-3) you can use if you want to do some basic calculations
on your own. This is helpful when you are planning your tests, so you can get an idea of whether statistical
significance is possible or not without needing to do the work of setting up the test. Unfortunately it only
works for two tests and not multiple. Check it out at: http://getdatadriven.com/ab-significance-test.

© AB Significance Test o fesiam

Did that button color change actually improve your conversions?

Try KISSmetrics for FREE to get help with running your A/B test and check out AJB testing documentation

A 1000 23 2% .
B 1000 27 3%

Figure 4-3. This helpful tool helps you think through your ability to achieve statistical significance before you
go through the legwork of setting up a test in Sitecore

PRACTICAL TIPS: ONLY USE MULTIVARIET CONTENT TESTING FOR
YOUR HOMEPAGE OR OTHER BUSY PAGES

You just saw an example test with two versions of the item, version A and version B. Multivariate
testing is when you have a myriad of versions and combinations and the goal is to figure out which
combination is the best. Personalization adds another dimension to the mix. You may want to test
variations of content, variations of components and display patters, and for various persona/segments.
You could have hundreds of possibilities when you combine all three of these dimensions.

As you can imagine, multivariate testing is incredibly powerful. You can find the best combination for
each persona out of a hundred options. The problem with multivariate testing is, yet again, statistical
significance. You will need a /ot of data (hit counts and conversions) to achieve statistical significance, or
you will likely be making decisions based on false positives.

Therefore, multivariate testing (testing in general beyond more than a couple options) typically should be
done only on your busiest pages, such as your home page. You don’t want to make dramatic changes to
your home page without solid justification!
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Optimization Gamification

If you have a large marketing team, you will benefit from Sitecore’s Experience Optimization gamification
capabilities. Gamification is a term that describes the intentional creation of friendly competition amongst
your peers. Sitecore tracks who started a test. It tracks their expectations for the test, whether they are
guessing, or whether their theories are well founded. When a test is complete, Sitecore produces results of
the tester’s impact to the experience over time, as well as if they are good guessers.

The Experience Optimization dashboard landing page is where all this fun takes place. The dashboard
can be found on the Launchpad » Experience Optimization button, and is seen in Figure 4-4. The figure
example (local PC) has limited data, making it somewhat underwhelming; however, you can see a month
over month comparison of June against July. Within each you can see a leaderboard of testers who did the
best those months, who were the best guessers, who had the biggest positive impact on the experience, and
who were the most active in their testing. This dashboard can certainly be a fun way to drive adoption of
testing, and is a great way to baseline the giving of recognition or awards on a monthly basis.

Craate page test Experience Optimization

L2 Dashboard

B Lsts Current activity

Draft Tests

TESTS STARTED TODAY TESTS CURRENTLY VISITORS EXPOSED TO OUTCOME OF TESTS
RUNMING TESTS TODAY THAT ENDED TODAY
Leaderboard - June 2015 Leaderboard - July 2015
Mo data LR You
Score
Guess
Effect
Actraty
Best Guessing - June 2015 Best Guessing - July 2015
Ho data No data
Highest Effect - June 2015 Highest Effect - July 2015
Ha data No data
Most Active - June 2015 Most Active - July 2015
No data T vou

Figure 4-4. Sitecores Experience Optimization gamification dashboard brings an element of fun into
your testing
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Running Your First A/B Test

To begin testing, you first want to decide if you are going to compare two different pages to compare which
page drives the most engagement, or make tweaks to a single page with the goal being to optimize that
page. The path to start the test is different based on which approach you take. The former is oftentimes used
to compare two very different landing pages for a campaign, and the latter is, in general, by far the more
common approach, where you want to optimize existing pages to make them better.

Creating a New Page Test

A page test is used to compare two very different pages to see which page generates the most engagement
value. This is commonly used when testing different campaign landing pages. Use the following steps to set
up a page test:

1. On the Optimization tab within the Experience Editor, click Page Test within the
Create section.

2. This will launch a new window similar to Figure 4-5. Select Use Existing to
compare the current page to another page.
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Page Test

PAGES REVIEW AND START

— -0
D

use existing new page version

Figure 4-5. When you create a new page test, you must use a totally different page, use the current page’s
previous version, or create a new page version to compare

3. Select the page you want to test against. A pop-up with the content tree will
appear, allowing you to make your selection. Make sure your pages are fully
published before starting these steps.

4. After you added the page you want to compare, click the Review and Start tab, as
seen in Figure 4-5.

5. The Review and Start tab has many sections that you need to configure.
e Test preview—Nothing to configure here; it just shows the pages you've selected.

e My expected effect of the changes—This helps populate the “guessing” reports,
showing how accurate your assumptions are over time. Move the slider to one of
three positions: I expect a negative, neutral, or positive impact.

e Percentage of visitors exposed to the test—For a busy page, such as your home
page, you may not want all traffic to participate. Optionally, slide the percentage
to a lower level. Note: This may make achieving statistical significance take
longer or impossible.
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e  Statistics—You can set which level of statistical significance you require before
the test is deemed complete, optionally 90%, 95%, or 99%. 95% should be used in
most situations.

e Test objective—What are you hoping the test will accomplish? You can select a
specific goal. Whichever variation drives the most goal completion for that goal
can be automatically deemed the winner, or you can manually select a winner.
For landing pages this may be appropriate, but for home pages, you typically
want to select a winner based on engagement value, not a goal (in which case
leave Trailing Value, the default, selected). Note: Engagement Value is covered in
more detail in Chapter 5.

Note When testing commerce pages such as a shopping cart, you will typically want to use a Checkout
Complete objective, especially for brand sites where commerce is potentially one of many goals. Engagement is
still important but changes to the cart/checkout are typically aimed at increasing cart conversions.

e Duration—You can select how long you're willing to let the test run.
6. Click Start Test when you're ready.

Hereafter your test is running and live on the site. You can always view the status of the test by clicking
Active Tests on the Optimization tab. You can see the active tests report in Figure 4-6. It shows how
many experiences are being tested, how much time is left before the test completes, and the effect of the
engagement value that has been demonstrated thus far. For more detail you can click on the test to show
the tests details, as seen in Figure 4-7. From there you can also change the settings for the test, such as
shortening the duration or the traffic allocation.

ADVANCED EXPERIENCE OFTIMIZATION @

ctove best —_— — = > Actvetests (2) 5T Suggestedtests (111) = S
‘;4 v + - - = i here are no profie can
Expecied to end in 14 days -

g . ' = Associal
Amributes Testresull  Optimizationview  Personalizaion & Historical tests

Active Tests

=m | . | | Darsien | createdty | Ema

Mew Featured Product 2 17-Jul-2015 14 Adrninigirator

Figure 4-6. The Active Tests button in the ribbon is where you can go to see the status of your currently
running tests
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Details - Page 1

Page Test

> P TRAILING VALUEMSIT

ﬂ EXPERIENCE EFFECT
PAGES REVIEW AND START ﬂ Sl

Emgtopers Home

BEST PAGE EFFECT
‘M0 Select a Broker Category
LAY, [ =]
Providers Home
CONFIDENCE
SRart Here to Find Your Health Plan
SCORE GAINED

Engagement value e~

Preview

Page 1 NO DATA

Top Goals Converted

Page 2 NO DATA Goal Conve...

Mo data has been set

Top Clicks to Pages v

Please selecta goal
Chaose one

Conversions

]

Conversion rale
o

Figure 4-7. A test results page shows the effect the different experience had on engagement value. You can
select the one that created the most value, and then click Pick as Winner so that version is used for future
requests

From the test details page, you can also see specifics around how each experience is performing
against others involved in the test. The Engagement Value section, as seen in Figure 4-7, will tally up the
engagement value accrued for each experience. If you select one of the experiences you will see details for
that experience, such as top goals converted, exist points, and site usage. Also from here you can choose a
winner and stop the test. Stop the test by clicking the Pick as Winner button when you have an experience
selected. That experience will then become the published version for all future traffic.

After you have picked a winner and the test is complete, you will be prompted with a test results
summary. The summary includes the results of the tests, how accurate your assumptions were going into the
test, as well as suggestions for future tests that Sitecore thinks may create value for you. Notice the summary
in Figure 4-8.
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O X

Test summary
Page 2 won the test
The experience decreased the engagement value by 0% compared to the original, based on 0 visits.
You have been assigned 0 points to your test score.
You guessed the outcome of the test would be "no change”. However the outcome was “worse”
You might also want to...
Optimize one of the following pages

Page name | Potential Impact ] Recommendation

Developing in Sitecore 0 0 0

OK

Figure 4-8. When you pick a winner you're presented with a summary screen that shows you what transpired

Creating a Multivariate Page-Level Test

A multivariate page-level test is more about optimizing a page than comparing two pages, as was
demonstrated in the previous section. What we want to do this time is configure component variations on

a page, such as differing content or different components altogether. We also want to test the helpfulness of
our personalization. We will begin by creating a new page version, much like you would when you want to
update the page in general. This is why testing is Sitecore is so elegant—every time you update your content
you can test it! This is why Sitecore’s motto for testing is, “Test everything, everywhere, all the time”. Basically,
when you update a page as part of the workflow, click Approve with Test to validate that the updates perform
better or at least as good as the previous version, or to see certain component variations work better than
others before you commit the publish for good.

Note Your Sitecore site has to be built with a proper component-based architecture to allow testing of
components, as seen next. Some Sitecore implementations, especially older/legacy implementations, follow
more of a “page template” approach. Unfortunately these implementations would need to be refactored to take
advantage of component testing. In Sitecore 8 though, they could still do page testing.

The following steps demonstrate the process of creating a new page version, editing multivariate testing
on a few components, and approving that page with a test.
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1. The easiest way to create a new page version is to simply make a change from
within the Experience Editor. Note: If you're an admin your changes won’t go
through as new versions and you'll need to create a new version through the
Content Editor » Versions tab » Add Version link. Another reason to never edit
content when logged in as the admin!

2. Select a component you want to test. Click the Test this Component icon, as seen
in Figure 4-9.

I Promo with Thumbnail -

B ¢ i 2w More v

-

bout Launch Sitecore

ts.Thank You

Read the Articles

Figure 4-9. Click the Test this Component icon to start adding component tests to the page

3. Click the New Variation button one or multiple times, depending on how many
variations of the component you want to test. Select a datasource for each that is
different, based on your test (you may need to create new content items to set up
your tests).

Tip Using the Clone Current Content option can be an easy way to test small changes to existing content
(Figure 4-10).
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Select the Associated Content

Select the content that you want to associate with the rendering and use as the data source.

Clone the current content item.

D Name: Copy of Getting Started with Launch Sitecore
Select Existing
Content
Parent:

4 & Promo Spots

ABC - About Launch Sitecore
Search for Content
& FAQ

¢ Favorite Articles

DT; ¢ Getting Started with Launch Sitecore
&
Clone Current ¢ Sitecore and Gartner

Content

¢ Thank You

[

Create New
Content

Figure 4-10. Using the Clone Current Content feature is a great way to make and test tweaks to your content
without starting from scratch

4. Optionally, click Enable Variation of Component Design to configure the
component’s display rendering to another rendering. Between this step and the
previous step, you can configure any number of content and display variations
imaginable.

Caution Sitecore doesn’t appear to restrict the available renderings to those that are compatible with
the current rendering. You may have unexpected results or errors if the datasource (test content item) and the
component design (rendering) aren’t compatible. If there isn’t already an existing “compatible” rendering to test
with, you’ll need a developer to create it and deploy to your Sitecore installation.

5. Optionally, check Hide Component if you simply want to remove the component.

6. Click OK to save the component.
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Tip  You may want to test the impact of a new component on a page. If so, simply add it and add a second
variation that is hidden. This way, the previous layout without the component can be compared to the new
layout with the component to see its impact on the experience.

When you are done editing your components with their tests, simply click Submit below the Edit
drop-down. You will now see an option to Approve with Test (Figure 4-11).

ADVANCED EXPERIENCE OPTIMIZATION VIEW

- - - — 1 My ltems

¥ \ =0 y Y . =

L‘\b_ 2 L= (4 1 J EH
Edit Other Component Insert page | Display name  Lock <G Workbox Publish  Settings Messages Close
o The item is in the ‘Awaiting Approval’ workflow state in the 'Regular Workflow’ workflow. Approve with Test Approve without Test Reject

Figure 4-11. To start a multivariate test, simply click Approve with Test

Note Depending on your workflow settings specified by your developer, you may or may not be asked to
“Approve with Test” (or even “Submit” for that matter, since workflow isn’t enabled by default). If you do not see
this dialog box, ask your developer to add testing into your workflow process, as described in the appendix and
in particular here: http://bit.1ly/1GoBB8J.

When you click Approve with Test you will see a preview pop-up with a button to start the test. The
Preview page is similar to the Page test seen in Figure 4-5. What's interesting, however, with multivariate
tests is the Variables tab where you can see a list of all the variations configured. Notice in Figure 4-12 how
we have two types of tests discovered on our new version: component tests and personalization test. In total,
there are 14 variations that produce altogether 144 unique combinations that can be tested. Again, this is
where statistical significance is important to consider. A page with 144 combinations will need a lot more
samplings than a page with two combinations, such as what was described in the previous section, to arrive
at statistical significance.
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Preview and start test

PREVIEW VARIABLES

Variables in test

Name Variations DISABLE/ENABLE
Promo with Thumbnail Component 2 w7
Abstract Spot Component 2 v
Promo with No Image Component 2 v
Abstract Spot Personalization 3 @
Abstract Spot Personalization 2 v
Abstract Spot Personalization 3 v

Experiences created -~

. which together create 144 experiences

tion of 100% and a confidence level of 95% the test is

m ki

Figure 4-12. You may want to enable/disable different tests to hone in on the specific question you're asking

Fortunately, you can enable/disable variations that you may not want to be included in the test. This
can reduce the level of samplings needed, and thereby time needed to complete the test. After you've made
your selections, simply click Start Test and publish the page and any other related content items you have
changed in the process. Thereafter, your test is live.

You can view the tests status and end the test similarly to what was described in the previous section.
Specifically, note Figure 4-7 again to refresh your memory.

Caution! If you are an admin and you want to end tests without selecting a winner you can choose
Marketing Control Panel » Test Lab and search for the test. Below Edit you will see the End Test link, as seen in
Figure 4-13. 1 have noticed inconsistent results with ending a test this way and | do not recommend it.
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< Edit
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Figure 4-13. Back door way to end a test, but beware!

Summary

Test everything, everywhere, all the time. That is Sitecore’s motto. This chapter walked you through some
important considerations for testing, such as the three different types of tests, statistical significance, and
considerations for mobile and personalization. In the end, testing is incredible easy to do; you simply
Approve with Test! It can also be a ton of fun. If you're the director of digital marketing, create some
friendly rivalry by hyping up the experience optimization dashboard, highlighting your team’s efforts

to make your site better and better, bite by bite. Give a gift card away each month to the team member
who increased engagement value via testing the most that month. These sorts of capabilities, as well as
culture of continuous improvement, is sure to drive a more customer centered experience, as well as
competitive advantage.
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Marketing Campaigns

Welcome to the chapter on marketing campaigns! You could describe the goals of this chapter in two
main ways:

e  Understand how well your digital experiences are performing
e  Automate your marketing processes to create more valuable customers

Most of the core “marketing” features in Sitecore are there to drive more powerful analytics and
insights. Page hits and geo-demographics are only so helpful. What is more compelling would be to
understand how well your “Lenny” persona is actually aligning to your visitors. Or, are we hitting Lenny’s
pain points more often than meeting his motivators? These sorts of detailed questions are answerable
through the use of Sitecore’s “marketing” features, delivered out of the Marketing Control Panel.

I put “marketing” in quotes because things like events, failure events, goals, campaigns, and outcome
actually have more to do with analytics when you think about it. “Big M” marketing comes into play with
engagement plans. Engagement plans are at the heart of Sitecore’s marketing automation capabilities.

Engagement plans help you “nurture” a lead; they help you create more valuable customers without the
need of human intervention. They help you take a customer with passive interest in your brand and present
personalized experiences that move them toward being a marketing qualified lead, and even all the way to
being a customer.

The possibilities are endless with engagement plans; it is truly a feature of Sitecore worth getting
excited about. As such, the chapter begins with a theoretical discussion on the possibilities with marketing
automation to set the tone for what is possible through the use of the concepts found in this chapter.

Sitecore Marketing Automation

So what are we trying to do here? I think the best place to start a marketing automation conversation is with
Figure 5-1, introduced to you in Chapter 1. As you may recall, a customer journey can be a bit schizophrenic.
A customer may engage your brand from any multitude of channels and will likely do a lot of research before
making a buying decision. Sitecore’s marketing automation capabilities can help you reach across all these
channels, engage your customer with personalized, relevant, and timely content to help drive them deeper
in your digital marketing sales funnel.
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Figure 5-1. A customer’s journey is all over the place; mareketing automation can help you keep the customer
engaged

A Looking Glass and a Rudder

Sitecore’s marketing automation capabilities behave a lot like a looking glass and a rudder. A ship captain
needs to know where she’s going (looking glass) and needs a way to get there (rudder).

It can be near impossible to see what’s going on with your customers when you're working across
6-7 channels and you have tens of thousands of customer interactions a day. In this regard Sitecore’s
marketing automation capabilities are like a looking glass, in that you can see what'’s going on (powered by
xDB analytics). You can see what actions your users are taking, all the way from downloading a whitepaper
to something incredibly granular, such as clicking a link. You can also see what paths your customers are
taking, as they go from one channel to the next, or from one page to another. The Federation Experience
Manager helps us tie all customer actions across all channels into one single view of the customer. From a
marketing perspective, this is invaluable.

These analytics, along with the Federation Experience Manager, will be covered in more detail in
Chapter 7. For now what is imperative is understand that reporting isn’t the end goal. Engagement value
is the end goal; we need to drive more valuable customer experiences that lead to higher revenues for our
business. This is where automation and the rudder analogy comes in. Yes, there is a steady flow of data, but
Sitecore gives you a rudder to steer the experience and the customer in the right direction so you get to most
value out of every interaction as possible.

Tactical (t) versus Transformational (T)

Similarly, there are two main ways you can get started with Sitecore’s marketing automation capabilities.
You may elect to start off tactical (t), working to employ as many events, goals, outcomes and other analytics
across as many channels as possible to get as best a view of your customer as possible. Many in fact do start
this way. One main benefit is most do not want to bog down their web site redesign project, for example,
with what seems like the big unknown of marketing automation. Fortunately, many of these tactical
strategies, when done correctly and thoroughly, form the building blocks of marketing automation, which is
more transformational (T).
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Big T marketing, however, is where the true power of the Sitecore platform resides. Personalization is
neat and helpful, but most personalization is more complicated that a simple A/B example. Big T marketing
helps the customer through a multistage buying journey, again like we see in Figure 5-1. How do you
get the customer from their passive interest to make a purchase? Is that as simple as just showing some
simple personalization, such as location, demographic, or content preference personalization? For simple
sales your digital strategy may stop at personalization, but for complex sales, personalization is only the
beginning. If you want to move beyond tactical reporting and develop a transformational marketing strategy
you need to start incorporating more complex automation concepts such as the ones that Sitecore provides
in campaigns and, especially, engagement plans.

Tactical (t) helps you know what your customer just did, but transformational (T) helps you affect what
your customer will do next.

STRATEGY BITS: MARKETING AUTOMATION IS MORE THAN JUST E-MAIL

Marketing automation is hot right now, finding a place on all the trend charts, and it's a buzzword

used at all the conferences. Yet with all the coverage, many still look at marketing automation as just

a fancy name for e-mail marketing. While e-mail is a major component of marketing automation, it is
more than just a tool to manage newsletters. Marketing automation is all about managing the ever-
increasing complexity of a marketing funnel or sales cycle. It's about creating a path of least resistance
for the prospect to find out about your company, do the appropriate research needed to make a buying
decision, and then ultimately convert to a customer.

The goal of marketing automation is to map and manage the paths that customers could take as part

of this journey and automate steps that normally would add resistance to the buying process, or that
wouldn’t be feasible if they had to be done manually. Marketing automation is built to help a marketing
department get as close to one:one marketing as possible. Sure, everyone would like to customize every
step and message for every customer and their unique situation, but scaling that to the masses is often
impossible.

Understanding marketing automation starts with thinking about the goals of marketing. In very general
terms, marketing is about generating awareness for your brand, eliciting consideration and interest
from prospects, delivering materials to help them make the appropriate decision, and then ultimately
propelling a prospect to convert into a customer. Once a prospect becomes a customer, marketing
should start over and work on retaining the customer and generating future purchases through the
marketing loop.

How marketing automation fits in at each of these stages depends on your company and how you plan
your marketing, but let’s look at some of the key areas where marketing automation can be leveraged.

Generating Awareness

From branding ads, events, social media, and search marketing, the main goal of this stage is to

get your brand in front of prospects and get them to pay attention long enough so that you can get
permission to continue marketing to them on a personal level. Marketing automation tools at this stage
are all about capturing information from the potentially fleeting prospect and getting them into your
marketing funnel.

For example, events are a great way to get in front of a large amount of people, but too often the list
of prospects generated gets put into excel and left to sit. Marketing automation tools, on the other
hand, force a more structured follow-up. Imagine a prospect comes to your booth or brand experience
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at an event, signs up for a contest, and opts in for messages from your company. Set up properly,

the marketing automation system will capture that lead, tag the event as the source, and send an
immediate thank you e-mail for signing up. If it’s a multi-day event, the system may send a follow-up
e-mail reminding people to stop by your booth for the big drawing, or showcasing other things going
on at the event. Following the event, the system sends out an e-mail with more information about your
company and a couple paths that the customer can take. Using this concept, you can use lead scoring
to help you determine their level of interest and their potential buying stage.

What about all those people who aren’t at the actual event, but might be following along on social
media? As part of your campaign, you also post to appropriate social channels and offer a way for
prospects to enter the same drawing or contest. These prospects are captured and tagged as part of the
larger campaign, but also as non-attendees, so your can track their source. They get a slightly different
set of follow-up e-mails because they weren’t at the event.

Now that all these prospects are in your funnel you can leverage marketing automation to move them
through each stage.

Eliciting Consideration and Interest

Now that you’ve captured these prospects in the system and they have received the welcome e-mails
and first follow-up from the event, it is time to drive interest in your product and to sort your prospects
into groups so that you can begin tailoring messages to their level of interest and propensity to
purchase.

In the follow-up e-mail, you offered the prospect an option to visit the company blog or to download a
whitepaper. You may have also included a link to pricing or features of your product depending on what
your sales cycle looks like.

Based on the action the customers took with your follow-up e-mail, you can branch your campaign out,
using a lead scoring model to determine who is a good prospect to follow up with. Anyone who clicked
on multiple links and visited multiple pages might be the most likely to convert at this point because their
buying signals are the strongest. Using information that is tracked by your system, these leads are sent
an offer to sign up for a demo or webinar, or even a deal to make a purchase. This could be sent a day or
a week after the follow-up e-mail, all configurable and automated by your system. Prospects who visit an
online store or sign up for a demo are obviously interested and are moved to a targeted list to convert.

Customers who don’t click any links or don’t fill out the form/make a purchase might still be interested
but just aren’t ready. This branch of prospects should receive more information about your company,
another unique use for your products, or even a customer testimonial in a follow-up message. All these
options are focused on driving continued interest in your brand and getting a prospect ready to buy.

But as | said, e-mail isn’t everything. Maybe at this point you also want to send a direct mail piece
to these prospects. Anyone who has opened the e-mails but isn’t moving to the next stage could be
targeted to get a glossy catalog, or a coupon deal to drive traffic to your retail store. Your marketing
automation tools could manage this list and fulfillment.

Decision Making

Customers whose actions are expressing interest by clicking e-mail links, visiting your site directly, or
downloading materials, but aren’t converting currently have moved into the decision-making stage.
They are interested, but there is some point of friction keeping them from taking action. It’s time to get
serious with these prospects. At this point, it’s time to get a salesperson involved if you have them in
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your organization. Marketing AUTOMATION allows this to be done automatically once your criteria is
met. The follow-up task is generated and assigned to the sales executive and who can follow up with
the prospect, and ultimately get the customer to convert.

Other prospects who have stopped clicking links, or may just read the e-mails but not take any action
aren’t ready to make a decision and would just feel bothered by a salesperson calling them. It’s time

to split them off into a list of prospects that have shown awareness but don’t have distinct interest.
Maybe you’ll send them your quarterly newsletter and a few other major announcements. Until they
start raising their hands and expressing interest again, let the system automate these customer and
keep them in the loop. This frees up the sales executives time to focus on the best customers, while not
letting potential future customers fall away completely.

Converting to a Customer

Whether a prospect becomes a customer on his or her own, or through the help of a sales professional,
it’s important to attribute this conversion to the original campaign and source that drove them to your
business so that you can track the return on investment of your marketing. It’s also time to take these
customers out of the sales cycle so that they don’t continue to receive sales messages. Instead, they
should be moved to your customer-focused campaigns which make sure they are receiving the level

of quality and service you expect, as well as showing them additional items they could purchase to
complement what they already have.

This is just one way to set up your marketing funnel using marketing automation. The power in
marketing automation is about the process that takes a customer through the journey, and when you
think about all the actions that you would have to take manually to achieve the same level of marketing,
it becomes clear why this buzzword is picking up steam.

Zack Wenthe
Marketing Strategist, RBA
Twitter: @zwenthe

Sitecore Marketing Building Blocks

Events, failure events, goals, outcomes, campaigns, engagement plans, and taxonomies are the building
blocks of Sitecore’s marketing automation platform. The following sections discusses each, including when
they are used and how you can get started using them.

Events, Failure Events, and Goals

Events, failure events, and goals are all customer behaviors recorded by Sitecore during a customer’s journey
across your channels. Events, failure events, and goals are amazingly more valuable from an analytics
perspective then, say, page clicks or other pretty, yet rather useless, data you might get in Google Analytics
without customization. The reason events, failure events, and goals are so important to a marketer is
twofold: 1) they can be tied directly to your user personas, and 2) they track occurrences and value.

Recall Lenny, the persona from Chapter 3. Personas are great because they help us capture a set of
behaviors, preferences, goals, and all sorts of other characteristics into a single, fictitious character (like Lenny)
to help us understand and prioritize what our digital experience ought to be doing for our customers. In
the case of Lenny, you can see in Figure 5-2 that we’ve captured his motivators, goals, pain points, and
alignment to business objectives (among a lot of other, less applicable characteristics). Notice however
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how motivators are things Lenny comes to the site to do. I like to think of motivators as events; they are
things Lenny does when he engages with our brand. Events help us track and measure how well our digital
experiences are meeting Lenny’s needs.

Lenny Learner

Lenny’s motivators

bt e IEa \
Weighted Score: 266 (26% of total) Leriiyy v to the silé to

Priority Weighting: #1of 7

» Find technical manuals and updates for his
equipment/domain
» Find installation best practices for equipment he

“What's the process for

. .y
doing this? services
* Understand how other partners or team members are
Lenny visits the partner portal to locate training and process overcoming their challenges/issues

documentation related to his current work or personal situation.

s : ‘ 3 . “how to” n o5 50 | rfor f-sery
Within the context of his situation, he has an idea of the type of Read “how to” resources so he can perform self-serve

information he is looking for (how to update benefits, how to use tasks

team member discounts, etc.). However, he expects additiona - Collaborate with partners and team members on

iﬁ‘?t%i‘zt.ons s0 he doesn't inadvertently miss a critical piece of understanding and improving process documentation
{= al

: = ok o o , * Locate pertinent process and/or document templates
Lenny is a self learner and would rather find the material himself or
collaborate with colleagues than attend training. Additionally, his Qur goa|5 for Lenny
5 ul hat he hi rning & ets back ;
tnfuq)ifss;:;dJe dictates that he completes his learning and gets back What we want Lerrv e do.:

* Overcome his installation/support issues and

Lenny’s alignment to business objectives challenges
= Perform his task our way

mprove partner retention and recruiting
» Advocate usage of the partner portal

Lenny’s pain points
Lenny dislikes experiences that

Achieve 80% partner

adoption

mprove and modk
partner engagement

= Make him hunt for information.
» Cause him to question the accuracy of the information
* Showcase information not relevant to his needs

mprove operational efficiency

Figure 5-2. Your user personas should have a platform persepctive, incorporating events, goals, and failure
events in the form of motivators, goals, and pain points

Goals are a bit different than events, in that goals are what we want Lenny to do. Sometimes what
your customer wants to do is not what you want them to do. Lenny is a good example. He is coming to the
experience to find information and to research policies. However, we want him not just to consume content,
but to become a customer. As such our goals for him are to get him to convert. Goals, therefore, tend to have
a higher value than events because we always want every customer going deeper down the funnel (and not
just kicking the tires, as is the case of events).

Failure events, or in the case of Lenny, pain points, are things Lenny hates. Yes, you should track in your
digital experiences where you are letting your customers down. Are you creating experiences that work well
for one persona, but poorly for another? If you don’t track failure events against your persona’s pain points
you'll never know the answer to this question. When you are tracking failure events, you may conclude that
separate experiences are needed to create highly specific experiences tailored to a given persona to match
their buying behavior as closely as possible.

Secondly, events, failure events, and goals are far superior to simple page hit counts because they can
help you track value. Not every interaction means as much to your business as another. Is it twice as valuable
for a customer to register for a webinar as to download a whitepaper? If so, don’t treat them equally.
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This is one of the best features of Sitecore; namely, that you can attribute Engagement Value scores onto
each of these—events, failure events, and goals. I don’t mean to take away Chapter 7’s thunder here, but
the timing is too important. Look at Figure 5-3, how we see a measure of number of hits to the site and their
corresponding Engagement Values. This way, in combination with events, failure events, and goals, you can
set out to create strategies that drive Engagement Value (make your experiences better) and separately set
out to drive more hits (such as pay-per-click campaigns).

Interactions by visits and value per visits v

Figure 5-3. Sitecore analytics report not just visit counts, but the value of those visits to your business

Value is an important point to think carefully about. You shouldn’t be too quick to throw out value
assignments to your goals, failure events, and events. The number is less relevant than that assignment’s
relation to other assignments.

For example, is an event registration twice as valuable to your business as a whitepaper download? If
so, perhaps the Event Registration goal receives a value score of 10, while the Whitepaper Download event
receives a value score of 5. Would you prefer one customer request a product demo over 10 customers
register for an event? If so, perhaps you should assign the Request a Demo goal to a value of 100. Does a
subscription cancelation represent a loss of a customer? If so, perhaps this failure event should receive a
value score of -100.

In this way it is important to create a hierarchy across all persona events, failure events, and goals ahead
of time so you can agree on scoring options. A simple matrix with the following columns serves best to align
on this deliverable:

e Name

e  Type (event, failure event, and goal)
e Value

e  Persona (multiselect)

e  Description
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Note More on analytics in Chapter 7, but for now it’s important to know that all of these events, failure
events, and goals can be viewed from a customer’s experience profile for future reporting.

Use the following steps to create an event or a failure event:

1. Navigate to the Content Editor and find the Page Events node under System »
Settings » Analytics » Page Events.

Note Alternatively, others prefer to create page events in the Marketing Control Panel below the Goals
node. They intermix goals and events. In many ways this is preferable, but an administrator will need to edit the
insert options of the Goals node to allow page events to be created there; otherwise, only admins can create
them there. As such, the standard place for page events is demonstrated in these steps. Check out the steps to
create a goal to see where to create your page events if you want to follow this best practice.

2. Create a new Page Event Category (right-click Page Events, Insert) for your site
below Page Events, such as Launchcore.

3. Right-click your category and insert new a page event.
4. Provide a name and a point value (Engagement Value score).

5. Scroll down on the settings and note the following settings that you may or may
not want to configure:

e  Is Failure—Selecting this marks the event as a failure event

e  Show in Events—Selecting this ensure this event appears on a user profile report
(it is associated to the profile regardless, but you may want it to display on the
profile by default)

e  Track as Latest Events—Similar to Show in Events

6. When your event is complete, below the Home tab click Edit » Deploy to publish
your event.

Notice in Figure 5-4 there’s a customer event called View Best Practice. This event can be used to report
on our customer’s consuming information that you consider to be a best practice.
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Figure 5-4. You can create custom events and failure events to measure how your personas are actually
interacting with your digital experiences. Don’t guess; know!

Use the following steps to create a new goal:

1. Goals are administered from the Marketing Control Panel, so navigate there from
your Launchpad.

2. Expand the Goals node; this is where you will create your goals.

3. Create a Goal category by right-clicking the Goals node » Insert Goal Category.
Provide a category name that aligns with your site or digital property name.

4. Create a new goal below your category by right-clicking your category and
choosing Insert. Provide an appropriate goal name.

5. Skip the classification section for now (goal properties). See the section on
Taxonomies later in this chapter to understand how you can categorize your
goals in reports.

6. Confirm the goal name and then provide an Engagement Value to the Points
property.
7. When complete, click Edit below the Home tab, and then click Deploy to publish

your goal.

With your events, failure events, and goals created it is a very simple process to get those assigned to
pages within Sitecore so they are getting logged. Note also that goals can be logged as a result of a form
submission (such as requested to download a whitepaper). Form submitted goals are discussed in Chapter 6.
For page events and goals, see Figures 5-5 and 5-6. Under the Optimization tab within the Experience Editor
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you will notice a Goals button (Figure 5-5) and an Attributes button (Figure 5-6). The Goals button is where
you can select which goals are triggered as a result of the user visiting that page. The Attributes tab has a

bit more going on, with tabs for Campaigns, Events, Failure Actions, and Settings. The Events and Failure
Actions tabs are applicable in the case of our events and failure events. Simply check the events, failure
events, and goals you deem appropriate for that page and click OK (along with Publish, etc.).

Administralor &

HOME ADVANCED EXPERIENCE OPTIMIZATION
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Figure 5-5. Goals can be registered to a page with just a few simple clicks
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Figure 5-6. Likewise, events can easily be registered to a page

Note Events, failure events, and goals can also be triggered programmatically. In most cases, page level
events and goals are entirely sufficient. However, sometimes it is more appropriate for them to be triggered
in code, such as in response to a button click or some other interaction with a customization. Check out this
helpful blog post for more details on how to do this programmatically: http://bit.1ly/1CFvPiC

Outcomes

Outcomes are used to track the lifelong value a particular customer is to your business overtime. An
outcome in its most basic form is just a tag on the customer’s profile. That tag name can be whatever you
want it to be and it can represent whatever you want it to represent. Typically, outcomes represent some
combination of events, goals, and/or campaign interactions.

For example, you may have goals around social media sharing. Perhaps a customer is sharing a lot of
your content on social media and has reached 10 “shares”. In this case, you may use this milestone to tag that
customer with the “Promoter” outcome so you can segment your promoters for an e-mail campaign down
the road, such as a new product launch.
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Tip Outcomes can also be used for content personalization. Search for “outcome” in the Rules dialog to
find the “where the user has registered the outcome during any interaction” rule that you can apply to your
personalization condition.

You can create custom outcomes from the Marketing Control Panel, below the Outcomes node
(Figure 5-7). You first will create the outcome type, followed by the outcomes themselves below the type.
This hierarchy helps with organization and reporting purposes.

4 "8 Marketing Control Panel
& Taxonomies @ Social Type
¥ Goals

L3

L3

» ¥ Campaigns
»  Engagement Plans
L3

o Experience Analytics Quick Info

% Federated Experience Manager
4 4 Outcomes Item ID: {DDBEAA1D-43E8-41E4-A5TC-F5FOADDCIZE]

» & Identification Item name: Social Type

4 ¥ Lead Management Funnel

Item path: Isitecore/system/Marketing Control Panel/Outcomes/Social Type
# Close - Cancelied
& Close - Lost Isitec /Outcome/Outcome Type - (BIOCAIF2-BCCA-46TA-BES-ADDATEBCIACS)
@ Close - Won Created from:  [unknown]
# Marketing Lead
Tem owner: silecoreladmin
# Sales Lead
o |
» & Purchase
+ @ Socia Type Name:
# Detractor
Social Type
& Nuetral
& Promater

Figure 5-7. Create custom outcomes to track the financial value of a customer to your business over time

There are three out-of-the-box outcomes in Launch Sitecore you can use, including:
e Identification
e  Contact Acquisition
e  Purchase
e  Purchase Product
e Lead Management Funnel (Figure 5-7)
e Marketing Lead
e SalesLead
e  Opportunity
¢ Close Cancelled
e Close Lost

e Close Won
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Again, with outcomes tagged on customer profiles, it would be easy to retrieve all marketing qualified
leads if you are tagging customers to marketing lead when, say they register to download a whitepaper on
the heels of an e-mail blast.

When you create a new outcome, you'll notice the Monetary Value Applicable checkbox. This
signifies that this particular outcome is also used to track a financial value of the customer. For example,
if the customer purchases a digital camera off your web site, you could tag that purchase with a “Camera
Enthusiast” outcome along with the monetary value of the purchase. Simply reporting then could sell
you the total value across the life of the customer, assuming all purchases are being reported (see more in
Chapter 7 on outcome analytics).

So you have all your outcomes created, but then what? What actually gets the outcome associated to the
customer’s user profile? Unfortunately outcomes can only be registered programmatically, since they are
usually never the result of one event or page request. To read about how to register an outcome, check out
this helpful article: http://bit.1ly/1LSHujt.

Campaigns

Alot of people, when they think of Sitecore campaigns, are thinking of marketing automation through
the use of Engagement Plans (see the next section). Rather, campaigns are tools to help you drive better
analytics; analytics tied to a marketing campaign that might be a one off, or perhaps organized in another
solution such as dynamics marketing.

Campaigns in Sitecore tie a set of behaviors in a digital experience to a campaign. For example, you may
have a Google AdWords purchase driving clicks to your web site. Wouldn'’t it be good to calculate the ROI of
that AdWords investment? Sitecore campaigns can help you calculate that ROI because you can associate
each visitor coming from that AdWords campaign to that campaign. From an analytics perspective this will
help you determine, on average, how much Engagement Value is created for that AdWords campaign. If you
are savvy with your Engagement Value planning, you'll understand how many points of value correspond to
a dollar’s revenue, and thereby you can calculate ROI on a marketing campaign. It’s pretty cool stuff, despite
it being embarrassingly simple to configure. It's so simple you begin to feel a bit let down, like there should
be more to it than that, but again, check out the next section on Engagement Plans to satisfy that thirst for
marketing automation.

Note With the release of Sitecore 8.1 a new tool is available called the ‘Campaign Creator’ you can use to
create and manage campaigns. The steps below however are still applicable, but this new Ul might be worth
familiarizing yourself with. Unfortunately the timing of this book going to print did not afford an exhaustive
update to this section.

You can configure a campaign much the same way you do a goal or event. Use the following steps to
create a campaign:

1. Go to the Marketing Control Panel from the Launchpad.

2. You may have hundreds of campaigns over time, so it’s a good idea to create
some campaign categories to help you organize them. Do this by right-clicking
Campaigns, and choosing Insert » Campaign Category. Give the category a name.

3. Below your Category insert a new Campaign (right-click, choose Insert »
Category) and give it an appropriate name.
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4. There are several categories of properties you should pay special attention to:

a. Classification—See the section on taxonomies later in this chapter to help
you categorize your reporting data. This may be necessary if you have
hundreds of campaigns.

b. Data
Title—The name of the campaign

Campaign Link—This is the most important of all properties (see Figure 5-9)
since it is what associates the visit to this campaign

Type—Mostly used for additional reporting segmentation

Enroll in Engagement Plan—see the Engagement Plan section coming up
next. For now it is important to understand that a visit coming in from a
campaign can be set to automatically enroll that user in an Engagement Plan.

c. Traffic Type—Used to again provide richer reporting/analytics, in case you
want to filter data on its source (e.g., search engine vs. direct vs. e-mail).

d. Duration—You may want to apply a start/end date, again for analytics purposes

e. Cost—You may want to add cost reporting into your analytics. For example,
if you are using Google AdWords pay-per-click at a fixed cost of $.25/click,
you could enter that cost into the Cost per Click property. In doing so you
can see analytics showing campaign visits, the value from those visits, and
the cost of those visits. All very handy to see.

A good example campaign might be a request to drive more of your product demos. You might set up a
Google or Facebook pay-per-click program to drive more visits to your site and an appropriate landing page.
You're hoping that when they visit the landing page they will fill out the form to request a demo, but you'll
also present other calls to action to try to get as much engagement value out of the campaign as possible.

When you enter the URL into Google or Facebook ad programs, you want to add the sc_camp attribute
onto the end of the URL, as seen in Figure 5-8. This associates that visitor to your campaign, and thereby all
the analytics you need to calculate the ROI of the campaign.

ODemuhndlngpagellaun... x +
& tto://launchcore/deme land » o 13565B684E31ABF4 4524A4D @ || Q Seerch B U 3 & O

18 Most Visited Getting Started UST Blackboard | | NWS - National Mosai... | : Ultipro- REA HR Projects Dev links

O sitecore

1 ¥ Demo landing page

Request a demo E

When you know every customer and shape every experience
you have with them, you create customers for life. The

Figure 5-8. Associate a landing page to a campaign by adding the campaign ID in the query string. Now all
future engagement will be associated with that campaign, helping you track ROI
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| Jdld
4 Marketing Control Panel e —

b & Taxonomies Title
» ¥ Goals

Drive more requests for demos
4 [ Campaigns

» ) Emails

Campaign Link [shar
» [E] Social
¥ Drive more requests for demos sc_camp=979C13565B684E31A8FA8C8D4924A4D3

¥ Example Campaign
» & EngagementPlans
» a8 Experience Analytics
2k Federated Experience Manager

» 4 Outcomes

Figure 5-9. Simply insert the Campaign link into the URL

Note Campaigns will only be associated with the visit if the visit’s first page has this value in the URL and
no other campaigns are already associated. If the visitor already browsed a few of your pages and then found a
link with this in the URL, the association would not be made because it wasn’t in the URL on the landing page
they entered the experience through. The campaign must start on the landing page (you can get around this
programmatically if you are so inclined).

Engagement Plans

Engagement Plans are the core building block of Sitecore’s marketing automation engine. Engagement Plans
might be better named “engagement workflows” because they behave just like you'd expect a workflow to.
An Engagement Plan can have one ore many “states”. A customer can be assigned into an Engagement Plan
and into one of those states. Most Engagements Plans have a start and end state, such as the case when you
are trying to sequentially move the customer through a sales funnel, for example. However, the states need
not be sequential and a customer can be assigned to any state as their first state. It depends on your business
requirements.

The point is, Engagement Plans help you move your customer from one state to another; where the goal
is to advance them toward a more desirable state. This often results in an outcome that you're trying to help
the customer achieve. The following is an example of a sequence of events you could automate through the
help of an Engagement Plan.

1.  Anunknown user downloads a whitepaper, prompting them to register.

2. Heisthen entered into an Engagement Plan, in a state called “Passive interest in
XYZ Product”.

3. Personalization drives content for users in that state. That content drives him
toward an Event Registration.

141



CHAPTER 5 © MARKETING CAMPAIGNS

4. He registers for the event, progressing his state to “Definitely Interested
in XYZ Product”.

5. Ane-mail campaign targets customers in the Definitely state. The campaign
presents a call to action to register for a demo.

6. The customer responds to the call to action, progressing his state to Considering
a Purchase.

7.  After the demo, the customer never makes a purchase.

8. The next time he visits the site, personalization offers a 20% discount for
customers considering a purchase, since 10 days as elapsed since the demo.

9. The customer uses the coupon to purchase the product and is unenrolled from
the Engagement Plan.

This workflow is a snap to automate in Sitecore with an Engagement Plan. You could create the e-mail
campaigns from a third-party solution, but you would have a bugger of a time driving the personalization
on the web site. This is a competitive advantage for Sitecore; your e-mail marketing and digital experience
content can both be working together to create marketing generated leads across all channels, versus
needing to develop a one-off strategy for each channel.

Engagement Plans can be viewed from the Engagement Plans node within the Marketing Control
Panel (Figure 5-10). They are very easy to configure a well; Sitecore provides an intuitive drag-and-drop like
experience to configure the flow. Square shapes represent states, and diamond shapes represent conditions.
You can see an example Engagement Plan design surface in Figure 5-11. The design surface is loaded when
you click the Design button in the middle of the screen, near Options.

NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY VIEW MY TOOLBAR

H < Engagement Plan State (1012) 4 D_‘] L Copy lo b 4 2 ¥ Cut = Rename A Up # First
Save Edit~ [ Insert from template 2002) % Duplicate [$Movelo  Deletew Paste  [[3) Copy ~| Display name w Dovn ¥ Last
h T contemt Q
Options
4 . Marketing Control Panel
» @ Taxonomies i‘ ] (|
» ¥ Goals Design Supervise Monitor

-

¥ Campaigns

# Engagement Plans

[

¥ ¢ Email Campaign Registered Users Qualified Users Evaluating Sitecore

» # Evaluation Plan Description Descriphon Descrighion

b testep

-

wd Experience Analytics

% Federated Experience Manager

-

4 Ouicomes

-

‘#* Path Analyzer

-

8 Personalization Is User Quabed? 0+ Is User Engaged? .
& Profiles

-

S TestLab

-

. Experience Explorer

-

Figure 5-10. Engagement Plans are where you automate your marketing strategies through the configuration
of simple marketing workflows
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E] \._> . ¥ T

State Condition Group Labe

New ltems

Registered Users Qualified Users

Descriplion Description

Figure 5-11. The Engagement Plan workflow designer is a simple-to-use, drag-and-drop experience

Note The Engagement Plans use Silverlight for their rendering. For best results, use Firefox or

Internet Explorer.

The Supervise button opens a view (Figure 5-12) that allows you to see how many contacts are enrolled
in the Engagement Plan, as well as which states they fall into. Perhaps there is a bottleneck in your plan and
you need more personalization rules to help customers advance to the next stage faster. Additionally, if a
customer is stuck, you can manually move that customer by clicking the Move button. Or, you can add a
new contact manually into the Engagement Plan as well with the help of the Add button.
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Supervisor O X

Home View

Evaluation Plan

Number of Contacts: 0

Qualified Users

Description

States:

Evaluating Sitecore
CQualified Users

B Registered Users

Figure 5-12. Reporting is available in an Engagement Plan to see the percentage of customers that are in each
state, as well as the total number of customers enrolled in the plan

The Monitor button looks very similar to the Supervise button, except it is in a read-only view.
Engagement Plans are a rather elaborate configuration process, and are covered later in this chapter in the
section called “Creating Your First Engagement Plan”.

Taxonomies

You may have noticed we skipped over the Classification settings in our Goals and Campaigns. Classification
properties help you segment your goals and campaigns for reporting purposes. The reality is you may have
hundreds of campaigns, and perhaps many hundreds of goals over time. Tracking all this can be impossible
without some basic organization. Enter taxonomies.

In the Marketing Operations Panel, you'll notice the very first node is the Taxonomies node. You can
configure metadata below the Taxonomies node that you can associate to groups and campaigns to help
filter them in reporting. The following are all examples of things you can configure below taxonomies:

e  Campaign Groups—Campaign Groups are the most basic form of categorization
for campaigns. An example of a group might be “Product Launch - Thingy,” where
you want to associate the engagement value from across 12 different campaigns to
show the effectiveness/ROI across the entire group of campaigns for the upcoming
product launch. Campaign Groups can be created below the Taxonomies »
Campaign Groups node and assigned to Campaigns by selecting them in the
Campaign Groups Classification property.
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e  Group Categories—Group categories are not as sophisticated as campaign groups
but still serve the same purpose. Groups have a property called Category that is a
free-form text box you can use to again filter group reporting.

e Channel—Channel effectiveness is another important facet when reporting on the
ROI of your campaigns. Campaigns can be tagged with a channel by setting the
Channel property. Fortunately there are already just about every channel you could
image pre-configured in taxonomies (Figure 5-13).

4 & Taxonomies
» [E] Campaign Group
4 [E] channel
4 & Online
» & 3rd Party
» & Apps
» & Automation Programs
» & Digital Events
& Direct
& Display
» & Email Campaigns

»
»

» & Organic Search

» & Paid Search

» & Referral

» & SMS Campaigns

» & Social Community

» & Social Mentions

» & Social Sponsored Posts
4 & Offline

» & Advertising

» & call Center

» & Direct Marketing

» & Event

» & Pariner Marketing

» & PR

» & Resources

» & Sales

Figure 5-13. Tag your campaigns to channels to help understand which channels are performing best

e  Asset Types—There may be times where you want to associate campaigns and
goals to assets types, such as Video or Best Practice or Instruction Manual. Perhaps
driving customers to best practices drives more ROI than driving them to instruction
manuals. Tagging in this regard can help answer these questions. To tag a goal
or campaign to an asset, simply set the Marketing Asset property of the goal or
campaign. Sample tags can be seen in Figure 5-14.
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4 & Taxonomies
» [E] campaign Group
» E] channel
4 [E] Asset
4 @ Content
© Best Practice
% Instruction Manual
4 @ Video
¥ How-to Video

¥ Installation tips video

Figure 5-14. Assets, too, can be a helpful metric to report against

e  Facets—Facets exist because Sitecore doesn’t know what else you may be interested
in filtering on in your reports. Perhaps what you need is a Product Category field or
a Region. The possibilities are endless, so Sitecore threw its hands up and created
generalizable “facets” you can rename. In the example in Figure 5-15, Facet 1 is
known (tribal knowledge) to refer to Region and Facet 2 is known to refer to Product
Category. Note how in Figure 5-15 how we’ve created some Custom Taxons below
each facet to start building out the possible values. When you right-click the facet
and choose Insert, you'll notice you can create Taxons and Taxon Groups below
the facet (groups can be used for organization if you have dozens or hundreds of
possible taxons).
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- Classification
4 ! Marketing Control Panel

4 Taxonomies
" Channel

» [E] Campaign Group
Channel/Online/Digital Events/Webinar live

» [E] channel
» [E] Asset
Campaign Group
4 ‘w Campaign Facet1
Brazil Campaign Group/Product Launch - Thingy
¢ China
% EMEA Marketing Asset
Latin America AssetVideo/Installation tips video
-5 Middle East
7 North America Campaign Facet 1
4 % Campaign Facet2 Campaign Facet 1/EMEA
% PCs
¢ Phones Campaign Facet 2
Software
Campaign Facet 2/Software
- Tablets
¢ Wearables

Campaign Facet 3
¢ Campaign Facet3

& Campaign Facet4

Figure 5-15. When in doubt, use custom facets to extend your campaign reporting into almost limitless
directions

That concludes the discussion on taxonomies, but remember the real value of them is in the data.
Check out Chapter 7 for a continuation of this discussion when we dig into xDB and Sitecore analytics.

Creating Your First Engagement Plan

Engagement Plans deserve special elaboration for a couple of reasons. First, they are at the core of Sitecore’s
marketing automation capabilities. Secondly, many of the other building blocks, including goals and
campaigns, work in tandem with engagement plans because by creating an Engagement Plan you are
working with all the building blocks discussed earlier. As such they are great at bringing it all together.

Since Engagement Plans are so important we’ll create one, step by step. We'll also use a real-world
example to help demonstrate the concept. The setting is the healthcare insurance industry. An insurer
wants to better target and nurture leads through the process of applying for Medicare insurance. As you can
guess, Medicare is a “complex sale” and requires a lot of hand-holding to get a lead to become a customer.
However, they just didn’t have the manpower to nurture every lead. Instead, they turned to Sitecore’s
Engagement Plans to help them automate most of the interactions.
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Here are the states of customers as they progressed through the digital funnel:

Passive interest in Medicare—This may be a customer browsing the site and getting
tagged to a persona known to be interested in Medicare, or less ambitious goals,
such as downloading whitepaper or subscribing to a newsletter. These all signify
some interest in acquiring insurance.

Qualified interest in Medicare—When a visitor registers for a Medicare event or
webinar, this is catalyst to market them as qualified interest.

Researching plans—Researching plans is the next state. These customers are “hot
leads” because they are actively comparing plan options, ripe for a sales associate to
help them make a decision.

Application initiated—These are visitors who have applied, pending application
acceptance. They can still drop out and therefore need continued nurturing.

Our goal as marketers is to get these potential customers through the digital funnel as quickly as
possible with as little human involvement as possible. Because of the volume of leads and limited human
capital, it is the only way.

Let’s begin by creating a new Engagement Plan with these four states. Later we'll add the rules/
conditions/actions that facilitate the visitor moving from one state to another. Use the following steps to
create these four empty states:

1.
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Right-click Engagement Plans node from within the Marketing Operations Panel
and choose Insert » Engagement Plan. Provide a name, such as “Medicare
Nurture Program”.

Click Design below Options to launch the Engagement Plan designer surface.

In the Ribbon within the Designer, note the New Items category. Click the square
State new item to add a new state to the surface.

Double-click the state to launch the state’s properties. Provide an appropriate
state name and description, such as can be seen in Figure 5-16.



CHAPTER 5 MARKETING CAMPAIGNS

Home View

o b b

Undo

¥ Standard

Is Email Address Validated

Is Password Validated i
NG INlorest Description

Time Spent in Automation Stale Descriolion
i S el Visitors to the sile who acquire the Medicare profile card or those who download Medicare

refated content items

Dizplay name - I5 shown in the content editor

Passive Interest

Figure 5-16. You can add a new state to your Engagement Plan by clicking the State square icon

5. Next we need to repeat Steps 1-4 for the other states. However, states are
separated by conditions. To add a condition, hover over the state and click the
diamond icon that appears below the state after you hover, as seen in Figure 5-17.

Passive Interest

Visitors lo the sile who acquire the
Medicare profile card or those who
download Medicare

Arms

h

Figure 5-17. When you hover over a state you're prompted to add conditions, as noted by the diamond
simbles. Alternatively, you can drag the circle symbol onto an existing condition to make the connection

6. Afteryou click the diamond icon a condition element will appear below the state.
Do this same process until all four of your states are created separated by three
conditions, as can be seen in Figure 5-18.
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Figure 5-18. A sample Engagement Plan that nurtures a lead

Note You were expecting three conditions, but a fourth was needed because a contact can go from passive
interest straight into “Researching Plans” without needing to register for an event first. As such, a duplicate
condition is needed since it is a 1:1 relationship between states and conditions. Additionally, we’ll configure a
fifth in a bit used to send friendly reminders to customers “stuck” in the qualified state (been in the state >7 days),
nudging them to keep progressing.

To finish our Engagement Plan we need to configure the following components:

e  Triggers—Triggers are what the state is waiting for before it evaluates whether the
customer can move to the next state or not. Triggers are either events or goals, like
what we configured earlier. Simply check which events and goals the state will
“listen” for. Triggers are configured on the state.

e Rules—After one of those events or goals has fired, rules can be set up to check if the
customer is ready to move to the next state. Rules are configured on conditions.
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e  Actions—Actions fire if a rule evaluates true. Actions might be sending e-mails, creating
leads in your CRM, or any number of custom actions you might dream up. There are
several out-of-the-box actions you can use right away (Figure 5-19). The 0 indicator on

a condition indicates how many actions have been assigned to that condition.

¥ Standard

/‘ Add or Remove Visitor from Roles
f Add Points

s Copy Visitor to Another Plan

f Decrease the Profile Value

o Edit Email Audience

S Increase the Profile Value

& Move Visitor to Another State

< Record EMail Address as Validated
o Record Password as Validated

f Remove Visitor from this Plan

s Send Email Campaign Message
s Send E-Mail Message

f Update Value on the Visitor User...

Figure 5-19. These are the out-of-the-box actions you can add to your Engagement Plans. However, it is also

easy to add your own actions to this list for more advanced scenarios

Let’s begin by configuring triggers first, and then rules, and lastly actions. Use the following steps as a

guide to configuring triggers.

7. The first trigger we need to configure is on the Passive Interest state. This state
is waiting for either the Event Registration goal to fire, or the Comparing Plans

goal to fire. Click Trigger on the state and select those two goals (or others as

applicable). Click OK.

8. The Qualified Interest state is waiting for the customer to start comparing plans.

As such we’ll configure a trigger similarly as described in Step 7 to wait for the

Comparing Plans goal to fire.

9. Lastly, the Researching Plans state is waiting for the Application Initiated goal to
fire. Configure that trigger similar to the other states in the previous two steps.

Now all the states are waiting for the right things to happen before confirming all conditions are met.
Assuming all conditions are met, the customer will move into the next state of the Engagement Plan. Since
goals/events fire all the time, you probably want to set up some rules to validate it’s appropriate for the

customer to progress.
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Note There is a “where true” rule you can use to send the customer through to the next state. Since a rule
is a required field, use this rule when you don’t want one.

10.  Click the condition after the first state (“did they register for an event...”) and then
click Edit to launch the Condition Properties window.

11.  First you need to specify when you want this rule to evaluate using the following
as a guide. Select Always Evaluate. Since we are not configuring a timeout the
other two are not applicable.

a. Always Evaluate—Evaluate the rule regardless if it was the result of a goal
firing or a timeout expiration

b.  Only Evaluate on Timeout—Helpful when you want to wait a set number of
days before evaluating if the rule is true

c.  Only Evaluate for Subscribed Events—Only as a result of goals or events
firing

12.  Second, configure the rule itself. Click the Edit Rule link within the Condition
Properties window. Then, search for “goal” and set it to evaluate against the goal
you are waiting for, as seen in Figure 5-20.

Rule Set Editor

Select the conditions and actions for your rule first. Then, specify the values in the Rule Description field

Select the conditions for the rule

goal|

Visit
where the specific goal was triggered during the current visit

Rule description (click an underlined value to edit it):

Rule 1

where the Event Reqistration goal was triggered during the current visit

Add a new rule

Figure 5-20. Rules are evaluated to determine if the customer should advance to the next state in the
Engagement Plan, or remain in the current state
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13. The “are they comparing plans” conditions/rules are configured similarly to the
“did they register for an event” condition/rule, except they are evaluating against
a different goal.

14. The “Time spent in state >7 days” condition is a bit different, however. Notice it’s
configuration in Figure 5-21. We want the rule to Always Evaluate, because if the
timeout hasn’t expired we want the second condition to check for the Comparing
Plans goal. Otherwise, we could use the Only Evaluate on Timeout setting. The
rule itself is simple; just check if the timeout has expired or not.

O X
_ A
Description
Pescription

Evaluate - when the rule is evaluated (lriggered and/or timeouts)

Always Evaluate ﬂ

Rule - for this condition to be true, one of the following rules must be true:

Edit rule

Rule 1
where the timeout interval has been exceeded

Figure 5-21. Another helpful rule—wait until a period of time has expired before evaluating. This is helpful
when you want to target customers “stuck” in a less desirable state
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15. Next we need to actually configure the timeout. If seven days have gone by, we
want to fire the trigger to evaluate the condition. Simply click the arrow at the
bottom-right side of the state and enter 7 days, as shown in Figure 5-22.

Qualified Interest

This contact has atlended an event
or webinar but has not yet begun

comparing plans on our site.

Timeout date

X

Days: Hours: Minutes:
el ol Vs

Figure 5-22. Set the timeout before the rule is evaluated

Note If the rule does not pass, the customer will stay in the current state until the goal is fired again and
the rule will be tested again. This will happen perpetually until the rule evaluates true.

That does it for the conditions and rule. Next we need to configure actions. Again, actions are optional
things that can happen as the customer is moved from one state to another. For example, you could send the
customer an e-mail if he has been sitting in the “qualified” state for more than seven days. Use the following
steps to configure a simple action:

16.  Click on the 0 number next to the Yes to show the Actions dialog (Figure 5-23).

1 A
~ s Add  Edit 3 Delete To add an action, double click it or drag and drop it.  x

< Send E-Mail Message 3
: o Edit Email Audience

Actions ﬁgﬁOI:I‘S

& Increase the Profile Value

& Move Visitor to Another State

f Record EMail Address as Validated
& Record Password as Validated

& Remove Visitor from this Plan

o Send Email Campaign Message
& Send E-Mail Message

& Update Value on the Visitor User Profile

Figure 5-23. When you click the 0 next to the condition the Actions dialog will appear, allowing you to add
actions that fire after the condition has been met
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17. Click Add in the Actions dialog and then find and select the Send E-Mail Message
action. Double-click the action to add it to the list.

Note Current Visitor’s Email Address is the default address that will be used, that of the currently logged
on user who’s enrolled in the Engagement Plan. You can change this value to Fixed Email Address if you need to
specify a static address.

18. Double-click the e-mail action again to load the e-mail properties dialog. Fill out
all the properties and click OK.

Note Unfortunately, you cannot use dynamic tokens in e-mails out-of-the-box, such as the customer’s
name, which is dependent on context. Fortunately however, a fantastic member of the Sitecore community
found a way to extend this e-mail action to accommodate tokens, thus allowing for more personalized, context
sensitive e-mails. Check it out here: http://bit.1ly/1GXqFmé.

The last step in creating the Engagement Plan is to deploy it so it can be used.
19. On the Home Tab, below Edit, click Deploy

Now your Engagement Plan is ready for prime time! However, we still have a couple important steps to
consider. Namely, how do we get visitors into the Engagement Plan in the first place? As a reminder, there
are three main ways:

e When they are associated with a campaign—Campaigns have an Enroll in
Engagement Plan property. Enrolling visits into an Engagement Plan is as simple as
setting which plan and which state you want them enrolled into from this property.
Note, however, that only known, logged-in contacts can be added to a plan so your
campaign is limited to authenticated scenarios (such as driving the customer into
their shopping cart, where you know they’ll need to log in first).

e When they fill out a Web Forms for marketers form—You'll see how easy it is to create
forms in Chapter 6. Forms can have actions too, and there’s an out-of-the-box action
to enroll the contact into an Engagement Plan. The nice thing with this is that could
be a new contact, such as someone who just registered to download a whitepaper
and gave us their contact information.

e When a goal fires—Wouldn't it be nice if when a goal fires you could add the contact
into an engagement plan just like you can with campaigns? Sadly out-of-the-box you
can’t, however the Launchcore.net codebase has a goal rule in the solution you can
steal! Just have your developer download that source from http://launchcore.net
and copy that code into your solution so you can do the same. See Figure 5-20 for
what that would look like.

e  Programmatically—You tap into the API to enable all other scenarios. For the
Medicare example this was the chosen path because we wanted contacts assigned to
a persona to be registered into the Engagement Plan. This was achieved by tying into
the pipeline and adding this extra step.
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The last and final step in configuring your Engagement Plan is to remove the customer, at some point,
from the plan itself. In the Medicare example, this is either when the application is approved, when sales
receives confirmation of a loss, or when an opt-out is received from an e-mail, signifying the loss.

Upon approval of the application, it’s best to programmatically remove the user from the plan. In
the case of the sales representative getting confirmation of the loss, that rep can log in to Sitecore and
“supervise” the plan, find that contact, and remove them. Or, more preferably, you tie into an action in their
CRM and remove the contact programmatically to make it much easier. This would likewise be similar for an
opt-out response.

Basically, the programmatic removes is the only practical approach. For this example, that’s true, but for
yours, not necessarily. See the example extended in Figure 5-24. An Engagement Plan can remove users itself
ifyou tell it to with the Remove Contact action. You can use this action as an out-of-the-box way to remove
contacts from an Engagement Plan.

Application Initiated

This customer has submitied a

Did they submit an 0 pending application.

application?

Unenrolled from plan

The customer has be removed from
this plan 4k Add , Edit 3 Delete &

Actions
fRemove Visitor from this Plan

Figure 5-24. Don’t forget to remove customers from your engagement plans or the reporting will be less
meaningful over time

Email Experience Manager

The Email Experience Manager (EXM) is a great solution for small or medium sized businesses for e-mail
delivery. You can send hundreds or thousands of e-mails through EXM at a time. EXM can be configured to
use Sitecore’s hosted delivery service, or you can configure your own delivery servers to facilitate the e-mail
delivery. You need to be licensed to use Sitecore’s hosted delivery service, and it can be accessed from the
Launchpad » App Center » Email Delivery.

Note EXM is one of the biggest areas of investment by Sitecore in 2015/16. Today it is an “up and comer”
best suited for small businesses (thousands of recipients, not millions). Its coverage is limited in this book,
knowing the content will quickly be out of date by early 2016. Stay tuned on sitecore.net for product updates
and sitecoreconfig.com for my personal EXM blog updates.
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You access EXM from the Launchpad. It requires a separate download/install (download can be found
here: http://bit.1ly/1INGdal). When you first open EXM you'll be on the dashboard showing e-mail
performance for past e-mails, as well as a left pane for more options. The large Create button, as seen in

Figure 5-25, can be used to create new messages.

Create Message

L[] Dashboard

message

= o
] Messages s rmeguane

Draft Messages

In Progress Messages

Sent Messages ﬁ

Recently Sent Messages

Triggered message
S008Il

Scheduled Messages

Active Triggered Messages

Reports

Top 10 Best Me

Active AB Messages

One-time message
Create a message lo send once

ssage from an existing

Create List

Recipient list from file

& 2

Recipient list from existing list
Creale a recipien 1 existing list.

ecipient list from a file{CSV, TXT

Segmented list from existing list
Create e s{ from an existing

Figure 5-25. You can create one-time messages, subscription messages such as newletters, or triggered

messages as a result of a goal completion

E-mails are created from lists of contacts. Lists are managed in the List Manager, separately accessed
again from the Launchpad. Typically, you might buy a list of contacts in a CSV file that you would upload
to the list manager to drive your e-mails. Often you also will manage your own lists. For example, when a
customer fills out a form on your site, you may want to at that time add them into a list to enroll them in an
e-mail campaign, such as a weekly newsletter. You will be asked to select which list of e-mail addresses you
want to use on the Recipients tab on the new e-mail creation wizard, as seen in Figure 5-26.
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| Administrator §

One Time Message

EMAIL EXPERIENCE MANAGER > Draft Messages > Drive demos

Email Campaign ¥ EN = A

MESSAGE ACTIONS
m RECIPIENTS MESSAGE REVIEW DELIVERY REPORTS M

& Aod atachment 1T

! One-time
Saveasa i
Subscription Drafts
General Message Info -~ message
template dot initiated
Name: Diive demos T b Edit engagementit [
pian
Description: Dupbcate =4
message
Campaign category:
Campaign group:

Sender Details

-
>

Fram name: Launchcore Special Offers

From email: danotreply@iocathast com

Figure 5-26. The new message wizard is very easy to use. Simply specify your list, enter the message content,
deliver the message, and await the analytics

The Message tab (Figure 5-26) is where you draft your e-mail message. The tab features a rich text
editor. Also, you can toggle which campaign you want the e-mail associated with, which language your
message is in, and as you can see in Figure 5-26, there are Message Actions allowing you to add an
attachment, save as a template, edit the Engagement Plan, or duplicate the message.

When EXM sends a message all respondents are entered into a rather elaborate Engagement Plan to
track their response. You can see this Engagement Plan in Figure 5-27, and you can edit it to your liking from
the Message Actions menu discussed previously. Enrolling recipients into a fully customizable Engagement
Plan gives you full flexibility as to how your want to engage those on the list; taking their interactions with
your brand hopefully well beyond just an e-mail message.
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These recigaents have unsubenbed
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{ ' Actions

Figure 5-27. Recipients are entered into an Engagement Plan so you have full control over what happens after
the message is delivered

Summary

This chapter was all about analytics when you think about it. The chapter was about knowing what is
happening in your digital experiences. Are your customers finding them helpful? Are they performing
according to your expectations, or are there areas that need to be improved? Tracking events, failure events,
goals, campaigns, and outcomes provide these insights. With all these being tracked, we’ll see in Chapter 7
these data points come to life—a chapter exclusively on analytics.

Beyond analytics however, is a concept called “marketing automation”. It’s all the buzz these days.
Events, goals, and so on, form the foundation of automation, but Engagement Plans are the basis of that
automation. Engagement Plans send your customers through a workflow, where you're trying to get them to
be an ever more valuable customer. You can use targeted content personalization to “nudge” the customer
to take that next step, and progress through your plan for them.

Finally, this chapter concluded with a short tutorial of the Email Experience Manager (EXM). EXM is
a great tool you can use to deliver newsletters or one-off e-mail blasts. A lot more functionality is coming
to EXM over the coming year and it is a great area of Sitecore to keep your eyes on for new features and
capabilities.
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CHAPTER 6

Web Forms for Marketers

Well here we go, yet another highly touted Sitecore module, Web Forms for Marketers (WFFM for short).
WFEM helps a marketer do what marketers often do the most when it comes to digital experiences.

WFFM makes it easy to set up lead capture pages. Are you creating an e-mail campaign through the Email
Experience Manager (as discussed in Chapter 5), but you want to link that customer to a digital experience
where you hope to capture some data and a lead? This is a great use case for WFFM. Do you want a small
Download Now button on your home page connected to a text box asking the users to enter their e-mail
address? Yet another creative WFFM use case. Do you want to ask a developer for help every single time you
want to collect an e-mail address? Oh heck no!

Now, WFFM has certainly many uses beyond simple lead capture. You can use WFFM for user
registration forms, event registration forms, blog commenting forms, and so on and so forth. These are more
common developer use cases, since what marketer wants to configure the registration process? None, I bet.
There are countless practical uses for WFFM. However, lead capture has a special place in a marketer’s heart
and so it’s an important use case to highlight.

WEFFM forms are simple to create. Simply create a page (or add one to an existing page), add the WFFM
component to that page, configure the fields you want to gather, and tell WFFM what to do with that data
once it's submitted. Very simple indeed!

As you have guessed by now, this chapter teaches you how to apply oil to your elbow—or should I say
create simple, effective, and ROI-laden marketing forms. It’s so easy!

Overview of Web Forms for Marketers

WFFM is fundamentally just another component you add to a page and configure. Like other components,
you must first add the component to a placeholder’s allow controls setting before you can add a WFFM form
onto a page. Thereafter, you will notice an Edit Form in Form Designer icon within the component toolbar.
This icon launches the Form Designer, as you have probably guessed by now.

Figure 6-1 shows this Edit icon, as well as a form used to capture lead information before routing users
to download the whitepaper they are requesting. Simple data capture forms, such as this one, are the core
use case for WFFM. It is recommended to use a developer to build custom forms for more complex use
cases. A developer can make WFFM do a lot of things beyond simple data capture, but you must balance
the maintainability promises that make WFFM so compelling. The bottom line: A form such as the one seen
in Figure 6-1 can literally take 10 minutes for a non-technical person to create, but don’t expect it to launch
the space shuttle! If you want to launch the space shuttle, check out Michael Reynold’s series on WFFM for
developers, an excellent resource: http://bit.1ly/1351ymg.
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Figure 6-1. WEFM comes with its own component that you simply add to your page

Note I'm not trying to sell WFFM short! WFFM is a powerfully helpful tool when used appropriately (note
all the excellent submit actions in Figure 6-8). However, it is common to see people push it well beyond what
it’s intended for, such as having 100+ fields with complex display rules, process-like tabbed steps, field-level
“security”, and so forth. In these cases what you really need is a custom developed component, not WFFM.
Notice in Figure 6-2 a graph that shows the tradeoff of the diminishing value of WFFM and when you should
consider enlisting the help of a developer.
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High

’ Build
Custom

Form Complexity

Figure 6-2. WFEM is easy to use and fast to implement, but you may want ot consider a custom component
Jor forms with a lot of complex rules

Note Like any other component, WFFM can be personalized! Different personas may have different data
you want to collect. Using concepts from Chapter 3, you can easily apply personalization rules to your forms to
show/hide different variations of the form based on the needs of your customer.

Another way to create a WFFM form is to create it from the Content Editor treeview (Figure 6-3). When
you add the WFFM component to a page, as seen in the previous figure, what happens behind the scenes
is a new item is created below System » Modules » Web Forms for Marketers » Website. Every WFFM
configuration you make is really just editing the item in this location.
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Figure 6-3. You can launce the WFFM Form Designer either from the Experience Explorer or through the
Content Editor

Notice in Figure 6-3 how a WFFM form item is selected. When selected you'll see a Forms tab bar in the
Ribbon with the following options:

e  Form Designer—This button launches the Form Designer, where you can add/
remove/configure fields, validation, and submit options.

e  Form Reports—There are several reports that allow you to see how many times the
form was submitted, what fields are commonly filled out versus left blank, as well as
dropout counts (Figure 6-4). More on analytics in Chapter 7.
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Figure 6-4. WFEM also comes with its own set of analytics for reporting purposes

e  Form Verification—There is an out-of-the-box verification action that checks the
form for malicious data when it’s submitted. There are several more that can be
optionally added, such as checking if a user is in a role, or verifying a password.
These verifications must be satisfied before the submit action can proceed.

e  Save Actions—Save actions take the data in the form and do something with it. There
are many to choose from, such as creating an item in Sitecore, sending an e-mail,
and even CRM integration to create leads in your CRM, for example.

e  Properties—The Properties dialog allows you to associate the form submission with
a campaign (Figure 6-5). Additionally, you can optionally track dropout data to
capture form data that is not submitted. This gives you a feel for how your users are
interacting with your form.
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Analytics

Choose which Analylics opfions you want to use with this form.

Goal
Select an existing goal

Downloads whitepaper -

Dropout Tracking
» Enable Form Dropout Tracking

Figure 6-5. Oftentimes you will want to associate a WFFM form submission to a goal setup in the Marketing
Control Panel

e  Profiles—This dialog lets you associate a profile card to the form item, similarly as
you would a page as described in Chapter 3.

Note Notice the Action drop-down in the upper-right corner of Figure 6-3. From there, you can easily
export the form submission data to Excel or XML files for reporting or processing purposes.

The Form Designer itself can be seen in Figure 6-6. A form has the following hierarchy:
e  Title—You can optionally add a form title when Title is enabled in the ribbon.

e  Intro—You can optionally add a form introduction paragraph or other rich text
(by inserting HTML) when Introduction is enabled in the ribbon.

e  Sections—A form is divided into one or more sections. By default, there is only one
section, but you can add more by clicking the Add Section link.

e  Fields—You can add one or more fields within a section by clicking the Add Field
link. Also, when a field is selected the left settings panel will update showing that
field’s settings.

e  Submit—You can have one and only one Submit button assigned with one or more
submit actions. You can assign submit actions by clicking the Edit button within
the Save Actions setting in the left settings panel after you have selected the Submit
button itself (Figure 6-7).
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Figure 6-7. When you select the Submit button you can start configuring save actions from the left panel

There are a few less than obvious ribbon buttons that may be worth explaining.

e  Layout—You can enable/disable the title, introduction, and footer text placeholders.
You can add any kind of text you want into these placeholders, even HTML/
JavaScript if you want to some advanced displays.

e  Language—A form item is like any other item, in that you can have multiple versions
of that item, either for testing purposes or for multilingual purposes. The language
drop-down can be changed to different languages so you can translate the form
elements, such as button name and title into other supported languages.

e  Export—Did you build a WFFM form but your requirements changes adding
complexity you didn'’t originally anticipate, thus forcing you to go down a custom
route after all? Don’t start from scratch; export the form to an ASCX file so your
developers don’t have to recreate the wheel.

e  Sorting—Move fields or sections up or down the list.
e  Analytics—Same settings as described in the Content Editor.

e  Switch To—Same settings as described in the Content Editor.
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Note At this point you have probably noticed the left pane in addition to the top ribbon. The left pane shows
settings for the selected field or the Submit button. In Figure 6-5, you see the settings for the data_Persona
selected field.

When you select a Submit button you will notice several additional settings appear in the left setting
pane (Figure 6-7). Form verification and submit actions have already been introduced; this is simply
another way to find these settings. However, an additional setting that is helpful is the Success setting. What
should happen when a user fills out the form? You can optionally send the user to a different page, such as
a confirmation page. Or, directly inline the form can be replaced with a success message, such as a thank
you message. In the case of this example, the user would be redirected to a page that starts the download of
the whitepaper. Unfortunately you can’t redirect to a document; it must be a page. In these cases you would
have JavaScript on the page that yet again redirects the user to the download upon arrival of the user to the
download page.

Asyou can see in Figure 6-8, there are many, many form save actions to choose from. Most are quite self
explanatory. However, below are some important actions you will likely be using a lot:

e Add the contact to a contact list—Lists can be set up in the List Manager, used
primarily in conjunction with Email Experience Manager (as described in Chapter 5).
WEFEM can help you administer these lists when customers submit their contact
information.

e Account management (create user, change password, user login, logout, update
contact details, edit role membership)—Need to build registration/login
capabilities? This is a create use case for WFFM due to a broad swath of save actions
that help you create users, assign them to roles, and provide password management
capabilities.

e  Create item—Do you have a news article page template and you want to track
comments? Commenting is a great use case for WFFM as well as this action. You
can use the Create Item action to create items, such as a comment, below the news
article, for example.

e  Enroll in Engagement Plan—As described in Chapter 5, Engagement Plans can be set
up to help drive your customers to a desirable outcome. A form submission is often
the catalyst to enroll a customer in an engagement plan.

e Register a Conversion/Campaign—You will most likely want to associate the form
submission to a campaign and/or conversation to feed into your analytics reporting.

e Create CRM Account/Contact/Entity—CRM and digital web experiences are almost
always integrated. There are two very important modules (one for Microsoft
Dynamics and one for Salesforce) separately installable to help you integrate with
your CRM system.
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Figure 6-8. There are many, many out-of-the-box save actions!

Note CRM add-ins for Sitecore can be found here: http://bit.1ly/1T8ULto (Microsoft Dynamics), and
here: http://bit.1ly/1KT4SNk (Salesforce).

Do you not see an action you wish was there? It is very easy for a developer to create custom actions for
your forms. The basic process is to create a new Action item to register your action, create a .NET class that
is executed when the action is executed, and to create a custom settings/properties page so marketers can
configure the action. Read more here: http://bit.1ly/1Gsaheu

WFFM INSTALLATION

WFFM is a module that you install over the top of your existing Sitecore instance. Like just about
anything with Sitecore, the process involves installing a package and then manually changing a slew of
config settings.

The process is elaborate and thoroughly documented for each release. As such, it makes the most
sense simply to direct you to the installation instructions for the most recent update, which can be
found here: http://bit.1ly/1HHKsmz.
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Building Your First WFFM Form

Now that we have an overview of WFFM, it’s time to build a form from scratch. The example we’ll work
through involves an Event Registration form. We want to enable customers to browse upcoming events and
to register for events that interest them. The setup assumes an event data template exists with a component
that queries/renders events. Each event will store registrations as child items below the event itself. When an
event is submitted we will send a confirmation e-mail to the registrant. Additionally, we want to create a new
lead in CRM for a sales associate to follow up on. Let’s begin!

Adding a Form to a Page

The first thing we need to do to start building a WFFM for is to add the Form component to our page. You
will want to launch the Experience Editor to do this. Create a new page if you don'’t already have one.

As we discussed in Chapter 2, you will need to ensure that the MVC Form component is an allowed
control of the placeholder you want to add your form into (use Form if your solution is an ASP.NET Web
Forms solution—less common and not a best practice). If it’s not you won't see it in the list. If you select your
placeholder, you can edit the allowed controls by selecting Edit the Placeholder Settings button from the
context menubar. From there you can select the Edit button and browse to Renderings » Modules » Web
Forms for Marketers and you'll see the MVC Form item you can add as an allowed component.

Note You won't see the Edit the Placeholder Settings button unless all components are first deleted from
the placeholder.

With that setup complete, add the MVC Form component into the placeholder. Upon doing so you will
be prompted to provide a name for your form (Figure 6-9). Additionally, you can select to create a blank
form or you can copy an existing form. In most cases you will select to create a blank form.

Create a New Form

Create a blank form or copy an existing one.

Form Name

Sitecore-Summit-2015

® Create a blank form

Select a form to copy

Figure 6-9. Give your form a good name and optionally copy an existing form
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Note There’s no easy way to add an existing form to a page. You can only create a copy of an existing
form when you’re in the Experience Editor. In many ways this is unfortunate (such as if you accidentally delete a
form off the page and want to put it back on that page). The alternative is to set the presentation detail of the page
and add the form from there, and thereafter manually set its datasource to the existing form item. This way of adding
a form is more advanced and generally not a recommended practice, but it can bail you out when in a pinch.

Once you click Next, you will be prompted to create a new goal or associate the form submission
to an existing goal. Goals, as discussed in Chapter 5, are great analytic tools to keep tabs on how your site is
performing. An event registration is an obvious goal for this example, as can be seen in Figure 6-10. Additionally,
you are also prompted to enable/disable form dropout tracking. Form dropout tracking does more than the
obvious, such as tracking how many people visited the form and didn’t click the Submit button. It also tracks
how they interacted with the form. Perhaps they started filling out the form but became overwhelmed with
the 75 fields you want them to fill out. If they filled out the first 20 and then gave up, Sitecore will actually
save those 20 so you can see that data and where they got hung up. It’s kind of sneaky when you think about it!

Analytics

Choose which Analytics options you want fo use with this form.

Goal

e Create a new goal
Name: Engagement Value:

Event Registration 10

Select an existing goal

Select existing goal -

Dropout Tracking
»~ Enable Form Dropout Tracking

Back ﬁ Cancel

Figure 6-10. When you create a new form you are expected to associate that form to a goal for analytics purposes
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After you click Next, you'll see a confirmation page from which you can click Create. Hereafter, you
should see your form on your page within the placeholder you selected!

Oh Snap! Unfortunately you probably don’t see your form! & Call it a bug; call it a feature; I'm not quite
sure. Sometimes if you save the page at this point and come back you’ll see your new form component where
it should be. Often you still won't. If this is what you are experiencing | recommend you start over, but this time
first delete all other components out of the placeholder before adding the MVC Form component. This is the
surest way to getting it to consistently work.

Now that your form component is on the page, you can launch the Form Designer by clicking the Edit
Form in the Form Designer icon on the context menu (Figure 6-11).

s 1> '.-'II:.' weIie Iﬂu.‘l\_lllllg Uig JIELUIE SUTIINLZY 12, 01 vulndauviauun
re to give you insigl
Mvc Form give y g
duce measurable b

£ B 2A R f. More~

Edit form in che:i;ne_r m m It_201 5

Submit

Figure 6-11. Launch the Form Designer by clicking the pencil icon

If you created a blank form you will notice that the Form Designer is blank as well. You can start adding
fields by clicking the Add Field link. You'll notice also that after your first field you can add multiple sections.
In the case of this example, I will be adding two sections: registration details and e-mail preferences.

The first two fields I need to add in the Registration Details section are First Name and Last Name.

I can provide those strings in the Title field, and then I need to select and appropriate field type. You can
see in Figure 6-12 there are many field types to select from. This is a good thing. Different field types display
differently (e.g., text box vs. drop-down vs. radio buttons), but they also have different out-of-the-box
validators to control format (e.g., telephone and number types).
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Type

Single-Line Text

v

Password
Email
Telephone

‘ Number
Date
Date Picker
Checkbox
| File Upload
List Types
‘ Drop List
List Box
| Radio List
‘ Checkbox List

Complex
Captcha

Simple Types A
Single-Line Text 1

Multiple-Line Text

SMS/MMS Telephone

Password-Confirmation -

Figure 6-12. There are many out-of-the-box field types to chose from, and most come preloaded with the

appropriate field validators

Adding Fields to the Form
Table 6-1 shows the fields I will be adding and their types.

Table 6-1. Field Settings

Field Name

Section

Type

First Name

Last Name

E-mail Address
Company
Title/Role
data_Persona
data_Topic
Contact Me About

Contact Frequency

Registration Details
Registration Details
Registration Details
Registration Details
Registration Details
Registration Details
Registration Details
E-mail Preferences

E-mail Preferences

Single-line of text
Single-line of text
E-mail
Single-line of text
Single-line of text
Single-line of text
Single-line of text
Checkbox list
Drop list
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All of these fields are pretty self explanatory, with the exception of the data fields and the list types. In
our example we want to create a CRM lead when the user submits the form. However, we want to load that
lead with helpful information about the user. Obviously we want to send basic data, such and the name and
e-mail address, but Sitecore has other helpful context that might benefit the sales associate when they make
the call. Perhaps there is personalization information you want to pass along or a lead topic. We're going to
use hidden data- fields simply as storage containers for our create lead save action. We can enter a default
value into these data- fields by selecting the field and then entering a default value in the left pane that
appears. Additionally, we can hide the field from the user by clicking the Rules/Edit button and adding the
Hide Element rule to that field.

Note At the time of writing this, the Hide Element rule unfortunately wasn’t working. It apparently
doesn’t do anything! | wrote a blog post on how to get around this bug. Since it is a bit of a hack, and since I'd
have to assume a fix is forthcoming, | didn’t include the workaround in this chapter. Check it out here:
http://sitecoreconfig.com/2015/08/21/sitecore-web-forms-for-marketers-hidden-fields/.

The other interesting fields in the example are the List Type fields. List Type fields populate values for
drop-downs, radio buttons, and checkboxes. The cool thing about these lists is they can be static or dynamic.
If you know the values you want for your drop-down you can simply enter them. Or, you can enter a query to
query items in Sitecore to retrieve them dynamically.

Notice your options in Figure 6-13. When you set a field type to Drop List (drop-down), for example,
you can click the ellipses button in the left pane to enter or select what the values should be. There are five
options by default:

e Manually entering names—Use the +/- signs to add/remove item text manually
(Figure 6-14).

e Selecting Sitecore items—Browse to a path in Sitecore whose children represent the
items you want to appear in the drop-down.

e Choosing from three query options (XPath/Sitecore/Fast)—Advanced options for
complex queries. This is the most dynamic option, as the results may be different
each time a user views the form.
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List Items
Seled the values and texts lo display in the list You can manually enfer

hese or use Silecore ilems or queries.

Setife

Selecting Sitecore items

= Y = — — 3 - -
H H |_J L1 seiectsd Rol Manually entering names n E
Save Save/Close Title Infroduc  ltem Selecing Siecora e 85 Frofiles Form Reports Close
List Tyoe
Apnl April
e Drop List v
. Conan Conan
0 items
Default Website Default Website
Email Campaign Email Campaign Single-Line Text v
Experience Explorer Experience Explorer
Files Files Single-Line Text v
as - Global Global e
ce I
Images Images Single-Lina Taxt -
| Appearance Launch Sitecore Launch Sitacore
Heloy Lenny Lenny P
Si v
Ned Ned
Pam Pam

Figure 6-13. A drop list needs values for the drop-down. These can be entered by hand or they can be
dynamically queried from Sitecore

List Items

Select the values and lexts to display in the list. You can manually enler
these or use Silecore ilems or queries.

Setitems by: Manually entering names v

Display a different text on the form

Value:

As items arrive

Daily

Weekly

Monthly summary

XL X X X)

Cancel

H 0000

Figure 6-14. Example of entering drop-down values by hand
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CONTROLLING FORM AND FIELD APPEARANCE WITH CSS

In the left pane, when a field or section is selected, you will also notice a section called Appearance. In
this section, you can set a CSS class to control the form or field styling (Figure 6-15). Out-of-the-box
these styles are empty and you’ll need a developer to create styles against your requirements and/or
create designs. Unfortunately, out-of-the-box, WFFM forms look pretty ugly. It is too bad there are not
any actual out-of-the-box CSS styles and a “previewing” capability to toggle between them and see the
style in action before applying it.

] Appearance —
Registration Details
Show Title Yes v
Tole
Help: First Name
Last Name
€55 Class: half B
8 scfSectionBorder =
] Rules Email Address
helf-section
There are| one third Tiie
al % Short Date
elemeant. Short Text Company

Figure 6-15. A field/section can have a CSS class to control the styling. Get a developer to create the associated
CSS to make your forms on-brand and looking pretty!

In the meantime, a developer can create CSS classes for each of the CSS options in the drop-down.
Thereafter, when you toggle between those (clicking Save and Close to preview) you will see the form
reflect those changes. Until then, do not be surprised when you toggle the CSS and nothing happens!

Configuring Form and Field Validation

You will want to configure field validation in most of your forms. Validation might be as simple as marking a
field as required or not. However, you can also add rules to validate the content of the field itself to ensure it
matches a pattern you anticipate for that field. For example, you likely want to use a validator on a ZIP code
field to ensure that only numbers are provided and those numbers match a particular pattern.

There are many out-of-the-box field validators. Most are not worth mentioning because they are tied
behind the scenes to the field type. For example, there is an e-mail address validator for the E-mail field
we are using in our example. Number fields only allow numbers. Telephone fields validate that the format
follows a telephone number pattern.

Notice in Figure 6-16 that when you select a field you may or may not see a Validation section in the
left panel. The Last Name field is a single line of text field that supports adding a validation. A Telephone
field, for example, does not support adding a validation since a built-in validation is preconfigured. As you
can see in the example, there are several to choose from: No validation, Numbers only, Letters only, Special
characters must be included, Number and special character, E-mail address, and Custom. You will use
Letters Only and Custom most often, since the other options tend to be built into field types, such as the
Number, E-mail, and Password field types.
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Help: Title
Last Name

the

CSS Class: v Email Address

[ validation Taie
) Company
Validation: Letters only v
; No Validation Tee
Regular Numbers only Title / Role
Expression: Letters only
Special Character must be included g
Alg-zA-ZT* i tie
[8-2AZF  Number and special character
Email address data_Persona
Error | Custom |
Message: [l Tale

Ak Taoro

Figure 6-16. Field validators keep junk data out of your lists

For the sake of demonstration, I have toggled our E-mail Address field type to a single line of text instead
of an e-mail. I've also added the E-mail validator to the field. Basically now my single line of text field type is
behaving exactly like the E-mail field type.

But that is not the point. The point I want to make note of is the regular expression you see in Figure 6-17.
All field validations are regular expressions that match text against an expected pattern. When you toggle the
field validator to Custom, you can add your own custom regular expression into the Regular Expression text
box for that field. Regular expressions can be very simple and get very complex. A great resource for you to
use is http://www.regexr.com. This site has a lot of great example regular expressions and provides a
free-form editor for you to test your expressions and ensure they work before you stick it in your form and
test it the hard, long way.

€SS Class: scfSingleLineText v Email Address

) validation

Company
Validation: Email address v
Regular Title / Role
Expression:

MA-Za-20-9._%+J+@[A-Za-20-9.-}+ B
data_Persona

Error You must provide .
Message: a valid email .
address, e.g. - data_Topic

Figure 6-17. If an out-of-the-box validator is not available you can create your own by entering an
appropriate regular expression
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Note in Table 6-2 the field validation settings for this example.

Table 6-2. Field Validation Settings

Field Name Validation Required

First Name Letters only True

Last Name Letters only True

E-mail Address E-mail address True
Company No validation False
Title/Role Letters only False
data_Persona Letters only Not applicable
data_Topic Letters only Not applicable
Contact me about Not applicable False

Contact frequency Not applicable False

One field type worth calling out specifically is the CAPTCHA field type since it is very much related to
validation; validation in the sense that you want to validate the current user isn’t a malicious robot or hacker.
The CAPTCHA field will prompt the user to enter the text they see in an image or hear on the audio in order
to submit the form. This validation is impossible for a machine to do since it requires visual identification.
The only problem with CAPTCHA is that it is a pain for your users; most people are annoyed by it and it may
be a detractor from what could be more leads coming into your site. Fortunately, there are some settings to
show CAPTCHA when malicious activity is detected, but hide it for normal use.

When you add a field and assign the type to CAPTCHA you will notice a new Security section on the
left pane (Figure 6-18). There are two basic settings worth considering: 1) always show CAPTCHA, or 2) only
show CAPTCHA if. Blog/news comments are a good place to select option 1 as they are prone to attach.
Event registrations or lead capture pages are better candidates for number 2, where you only want to show
the CAPTCHA validation prompt when malicious activity is detected.
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Form Designer

Robot Attack Protection

H H m Set attack detection thresholds and configure wamning nofifications. You can
Save Save/Close Title QGGG also select whether you want to display the form on a different page.

< ﬁ —= Attack Protection | Warning Email
& ; Sy s Detection Thresholds
Properties Profiles Form Reports

Enable attack protection by showing CAPTCHA if
o A suspicious visitor is detected

A visitor submits the form more
than
| Suspicious form activity is detected.

& Security

3 timesin 15 minutes

The form is submitted more than 20 timesin 15 minutes

¥ the visitor is a robot

Form Display Page

] Appearance Display the form with CAPTCHA on a different page if:
» Visitors are robots.

Page: .../web forms for marketers/attack protection/robat
Change
Placeholder: content
None v &
I A suspicious visitor is detected.
ne Noise: Page: ...F marketers/attack protection/suspicious visitex
Line Noise: 9 P P Change
Placeholder: content e
None v = 4 3
|7 Suspicious form activity is detected.
Help: Page: ...eters/attack protection/suspicious form activity
¥ ’ : ? e Change

Placeholder: content

55 Class: sciCaptcha B “ Cancel

] Rules
There are no rules for this Edit Captcha v B “
element.
© Add Field
% Add Section
Email Preferences >

Figure 6-18. Use a CAPTCHA field to keep the flying monkeys away. Optionally only show the CAPTCHA ifa
monbkey is detected

Notice in Figure 6-18 the settings for how a malicious user is detected. This screen is viewable when you
click the Edit button next to the Show CAPTCHA if radio selection.

You can watch for how many submit attempts the current user has attempted (first checkbox) or you
can watch for submit attempts in general (second checkbox). These values will be higher or lower depending
on the type of form. A comment on a blog post probably should have a high number in case the customer
is engaged in a discussion, but an event registration should probably have a very low number. The second
option is for all users, not just the current user. It is more comment to have this setting disabled. If you
recently opened registration for an expo you may expect a lot of traffic from different sources initially and
CAPTCHA may not be appropriate.

180



CHAPTER 6 © WEB FORMS FOR MARKETERS

The Form Display Page section is helpful if you want the capture form displayed on a separate page after
the Form Submit button is clicked. This is helpful as it lessens the possibility of form dropouts due to users
feeling overwhelmed with all the data you want them to submit, as they won't notice your request to submit
the CAPTCHA until the next screen.

Note You can configure a warning e-mail to your admin if an attack is detected. Notice the Warning E-mail
tab in Figure 6-18. From there you can configure the e-mail address, subject, and body of the e-mail to be sent
to your admins during an attack.

You can see a sampling of the validators in action in Figure 6-19.

Q sitecore

Events

» Sitecore Summit 2015

s * Sitecore Summit 2015

Sitecore Summit 2015

* The value of the First Name field is not valid.

# The Last Name field is required.

* Email Address contains an incorrect email address.

* The value of the Email Address field is not valid.

# The text you typed does not match the displayed characters.

Registration Details

First Name
23

The value of the First Name field is not valid.

Last Name

The Last Name field is required.

Email Address

phil

Figure 6-19. Notice how the validation error messages appear above the form if bad data is entered

Configuring Save Actions

The next step in the process is to configure what happens when the form is submitted. In the case of an event
registration, we want to save the registration details and create a lead in our CRM for a sales associate to
follow up on. We also want to configure what happens if the save was not a success. Additionally, we want

to submit the registrant information into an e-mail campaign list for future correspondence, but also send
them an immediate e-mail confirming their registration. Finally, we need to configure what happens after
the form is submitted: either sending them to a success page or simply presenting a confirmation message.
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Saving the Event Registration

We want to save the registration data when someone registers for an event. The most common way to do this
is to create an item below the event item, such that all children represent registrations for that event.
A similar pattern would be used for comments on a blog.

Note While common, storing registrations below an item isn’t a best practice. The ideal way would be to
store them in a custom database and have a developer build a custom SPEAK interface to allow moderating/
reviewing to occur seamlessly within the existing Sitecore experience that marketers are familiar with.

A database just does some things better than an item in Sitecore can.

Now, for strictly data capture purposes this isn’t necessary. WFFM saves the data in its own database. As
we discussed earlier, it is easy to export the submission data to Excel from the analytics, Actions drop-down.
The trouble with this is it is a steeper learning curve for a developer to query that data (via the WFFM data
provider), whereas querying item data is very easy. In our example we may want to capture the number of
registrants against the max number of registrants, where we’d close the registration process automatically
if the event gets filled up. With child items it is easy to simply do a search, get the count of the results, and
render that count on the page. Likewise for news/blog commenting, for example, it is easy to simply query
for comments and display the comment at the bottom of the post. Searchability is also an important factor,
where in the case of comments you would want those comments searchable and therefore an item versus
just sitting in the WFFM reporting database.

Note The Sitecore.ContentSearch development framework can also be leveraged to include WFFM data
within native search results if that is a requirement.

Use the following steps to configure our item creation save action:

1. Select the Submit button in the Form Designer and then click Edit next to Save
Actions in the left panel.

2. Select Create Item from the drop-down then click Add and then click Edit.

3. On the first edit screen you need to specify which template to use for the new
item and where that item should be placed after it is created (Figure 6-20). Select
your data template and the location and then click Next.
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Select Template

Select a tempiate and a destination for the itlems.

Template Global/Content Templates/Event Registration Browse

Destination:  /sitecore/contentHome/Events/Events/Sitecore-Summi Browse

Figure 6-20. The Create Item save action needs a template to know what to create and a Icoation to know
where to create it

4.  After you click next, you need to map the fields in the data template to the fields
in the form. Provide the mapping, similar to what you see in Figure 6-21, and
then click Next.

Map the Form Fields

Select the fields in the created item which will be populaled with values
from selected form fields

Settings

Show Standard Fields

Mapping

First Name:

First Name X
Last Name:
Emai Address: Last Name v
Company: Email Address ¥
Title / Role: Company v
data_Persona:

Title ¥
data_Topic:

Not Defined ¥
Contact me about:

Net Defined v
Contact frequency:

Contact about Y
Captcha:

Contact frequency b

MNot Defined v

Back “ Cancel

Figure 6-21. The left side contains the values coming from the template, and the right side shows the values
coming out of the WFFM form
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5. The final screen notes any data you may have missed in the mapping (Figure 6-22).
In our case, this is okay because these data elements will be handled in
subsequent actions (with the exception of CAPTCHA data, which is never
of any value).

Confirmation o] ks

Confirm that you have selecled the comect lemplate and folder for the new
item, and that the form fields are mapped comectly

The template for items
« GlobaliContent Templates/Event Registration
The items will be stored

« [sitecore/contentHome/Events/Events/Sitecore-Summit-2015

data_Persona
data_Topic
Captcha

Close

Figure 6-22. Not all values need to be mapped, but you'll be warned!

With this action in place, whenever a user submits the form all the form data will be saved into Sitecore
as child items below the appropriate location. In our case, the registrations fall below their respective event
items, as you can see in Figure 6-23.

4 (@ Events
4 & Events
4 [Z] sitecore Summit2015
[Z] EventRegistration
[£] Event Registration-1
[£] EventRegistration-1-1

[£] EventRegistration-1-1-1

Figure 6-23. After the form is submitted the new items will be created in the location you specified

Creating a Lead in CRM

Next thing we want to do is create a lead in our CRM system for a sales associate to follow up on our event
registration with a product offering and/or discount. There are two add-ins for Sitecore, one for Salesforce.
com and one for Microsoft Dynamics CRM. Both behave similarly as far as the integration is concerned.
The Dynamics add-in includes an action called Create CRM Entity. From this action you can create
50+ different entities in CRM, including contacts, leads, activities, and accounts. They all behave similarly:
the Create CRM Entity action identifies required fields in CRM and forces you to map your form fields to
those required fields. Beyond that you can add optional fields. Fortunately all the queries are real time and
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the drop-downs are populated from the CRM schema so you know your configuration will flow into CRM
appropriately. There is very little you need to do on the Sitecore side besides what is called out in the module
installation instructions.

Note CRM add-ins for Sitecore can be found here: http://bit.1y/1T8ULto (Microsoft Dynamics), and
here: http://bit.1ly/1KT4SNk (Salesforce).

Use the following steps to configure the Create CRM Entity, Create Lead action:

1. Select the Submit button again from the Form Designer. Choose Edit Next to Save
Actions in the left pane.

2.  From the drop-down, select the Create CRM Entity action and click Add and then
click Edit to edit the action properties (Figure 6-24).

Create CRM Entity O X

Choose the CRM enfity you would like fo creale. Then select the values you want fo use fo creale the enfity. You can select under
what conditions the values should be enlered, and where those values should come from.

CRM Entity: Field Settings:

Lead il Complete CRM Field: Always
Use Value From: Form Field v

@ Add w Delete Value: data_Topic v

-l Required Fields
- Last Name

~ Name

E-[.g Additional Fields
— Company Name
~ First Name

- Email

Audit

Save Audit Information to]  Description v

Figure 6-24. The Create CRM Entity has several required fields, but you can also pull in other/custom fields
Jrom CRM itself, making the possibilities endless
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3. From the CRM Entity drop-down, select Lead to create a new CRM lead.

4. There will be several required fields. Associate those fields to equivalent form
fields. Note how our data_Topic in this case is used to populate the required
Topic CRM field. Since Topic isn’t something a customer will provide, it is hard-
coded into the form by setting a default value in the data_Topic field settings.
This, again, is a helpful way to pass data behind the scenes to your CRM system.

5. Click OKwhen complete.

After you have done some testing you should see your leads being populated in your CRM system. In
this case, we created a registration lead in dynamics (Figure 6-25).

v  Leads

~  @BIMPORTDATA = gl CHART PANE -

6/17/2015 148 PM

Mike X Demo request New /2015 451 PM
Demo request New 5/28/2015 316 PM
Demo request New 5/27/2015 813 AM
Theodore James Demo request New 5/26/2015 9:51 AM
ample Mailed an interest card back (sample New 5/13/2015 1:53 AM
Nancy Anderson (sample Mew store opened this year - follow ...  New 5/13/2015 1:53 AM
ampbell (sample; Interested in online only store (sampl... New 5/13/2015 1:33 AM
Good prospect (sample New 5/13/2015 1:53 AM

nple; Interested in our newer offerings (sa..  New 5/13/2015 1:53 Al
an Anna (sample Some interest in our products (sample)  New 5/13/2015 1:53 AM
ample Likes our products (sampile; MNew 5/13/2015 1:53 AM
ong (sample; Follow-up with information regardin..  New 5/13/2015 1:33 AM
Debra Garcia (sample Store is expanding - send new literat..  New 5/13/2015 1:33 AM
New store opened this year - follow ..  New 5/13/2015 1:53 AM

Figure 6-25. A new lead in CRM!

Subscribe the User to an EXM E-Mail Campaign

Our example WFFM form has several options at the bottom where the users can select which e-mail
campaigns they want to be entered into and the frequency of which they want to receive e-mails.
Unfortunately out-of-the-box we can’t get that sophisticated. However, we can add the contact into a
campaign list using the out-of-the-box “Add the contact to a contact list” action. This action takes the logged
in user’s contact details and adds them into the contact list of your choosing (Figure 6-26). Email Experience
Manager uses these contact lists to drive which e-mail recipients should receive the e-mail. A developer
could fairly easily extend this out-of-the-box action with if/then logic to determine if the user should be
added or not.
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Add to Contact List

Select the contact lists that you want fo add the contact fto.

Contact lists:
« Customers interested in a box of tools
Common Global Opt-out
Global contacts
My Active Contacts
Cpt-out
My Active Contacts
My Active Contacts

Opt-out

Figure 6-26. When a user submits a WFFM it’s a good time to subscribe them to a camaign by adding them
to a list

Sending a Confirmation e-mail

The “Send Email Message” action is probably the most widely used action of all the actions. Fortunately it

is incredibly easy to configure. Figure 6-27 shows the action settings screen with all the fields you'd expect.
Click the down arrow next to To, CC, etc. to add form fields. Also, you can click the Insert Field drop-down
to add a form field into the body of the e-mail itself to add context. This is a great way to send a confirmation
e-mail of the event and the user’s form submission details.
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Send Email Editor

Configure the template of your mail.

To: »  [Email Address]

BCC

From: = no-reply@localhest.com

.9u3|evf= [First Name]
Insert Fi il W Jt-- 49" - "31 ’L
= LastName I
L Email Address
Title / Role

data_Persona
data_Topic
Contact me about
Contact frequency

Captcha

Figure 6-27. E-mails are easy to configure; you supply a to, CC, subject, body, etc

Note There is a secondary e-mail action titled Send Email Campaign Message. The nice thing about this
action is you can use e-mail messages already drafted in Email Experience Manager so you don’t have to
recreate the wheel. The downside is the user receiving the e-mail must be a contact/user, which isn’t always
the case.

If you don’t see the drop-down to add form fields, you are not alone! At the time of this writing there is a bug
with Chrome. Configuring this action works in Firefox and IE, but not Chrome. In general, Firefox seems to be the
most stable browser for Sitecore administration.

Redirecting to a Confirmation or Download Page

One of the last things to configure in our form is what the users should see after they submit the form.
Should they see a thank you message or will you redirect them to a confirmation page that has additional
information, such as links to download materials only registered customers can see? This can easily be
configured by selecting the Submit button and clicking Edit next to the Success section. From here you'll
notice two basic configuration options: a page or a message (Figure 6-28). Select the page you want the
user to be sent to, or select the message you want them to see (the form itself is simply replaced by this
message).
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Success =] ¢

Select the page or create the message that you want to display when the
form is committed successfully

®) Success Page

@ Download
1@ Events
J Registration
{4 Whitepaper download
., Register
< Search
i3 Configuration
» ] Sample Newsletter
» (g Developing in Sitecore v

-

Success Message

Thank you for filling in the form

Figure 6-28. When users submit the form you can simply show them a thank you message or redirect them to
another page (such as a page where they can get the download they are looking for)

Note Oftentimes you are having a customer send their contact information before allowing them to
download a whitepaper. One way to do this with WFFM is to send them to a download confirmation page that
has JavaScript on it that in turn redirects them to download the whitepaper itself (not ideal, however, because
it’s easier to pass around the URL to bypass the form). This is needed because in WFFM you cannot select to
redirect them to an item in the Media Library, which is unfortunate. If you're a non-dev and want to give this
a shot, use the code sample in Figure 6-29. Simply paste this code into an HTML field that gets rendered by a
component on that page.
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Rich Text Editor O X

Body.
Show editor Sy

Thank you for dowr

Thank you for downloadng this whitepaper. Your download should begin
momentariy.

installation guide 30.pdf; </saipt>

HTML

lcon:

Browse Proper 2

I aunch Sitecnral

Figure 6-29. Here's a way to kick off a download automatically

Configure an Error Message for a Save Action

Things don’t always go the way you intend them to go. Such is the case with WFFM form submissions.
Sometimes a Save action fails to do what it intended to do, such as actually create the lead in CRM.
Regardless, the data for the submission will be saved in WFFM and can be exported, but with some actions,
such as sending the confirmation e-mail, the user may need to be notified. You can configure a failure
message for each save action in the Error Messages tab (Figure 6-30). For some, such as the create CRM
action, you may not have an error message at all since it isn’t a blocking event. For others, such as a failure
to send a confirmation e-mail, you may simply state that we have them confirmed but they should contact
Sales for a confirmation. Keep this in mind as you gather requirements for your WFFM forms.

Save Actions o] &3

Select the save actions to perform when a form is submitied. if a save action
fails, the form is submitted successfully and the visitor is shown an ermor

message.

ERROR MESSAGES

If ‘Create Item'’ fails display this message

We experienced a technical difficulty while processing your request
Your data may not have been correctly saved

If"‘Create CRM Entity: Lead’ fails display this message:

We experienced a technical difficul
Your data may not have been corre:

lle processing your request
aved

Figure 6-30. If an action fails (such as creating a lead), you may or may not want to tell the customer through
an error message
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Localizing/Translating the Form

Like pretty much everything in Sitecore, WFFM can be localized so it can be translated into multiple
languages and dialects. Those languages must be first configured, as is described in Chapter 2. But thereafter
itis a simple enough process to toggle the Language drop-down in the Form Designer to that change and
start translating. Some things you may want to translate:

e  Field names

e Introduction, section names, and footer

e  Field validation error messages

e  Submit button text

e Success message when the form is submitted
e  Error messages when a particular action fails

Notice the Language drop-down in Figure 6-31, as well as the field validation error text for the Last
Name field, which is also translated. Sitecore will serve the appropriate form language based on language
preferences of the current user.

Form Designer 0O X
H H 8 <l (O] [# A Up & First 2 A :
Save  Save/Close Tige nroduction  Foater Swedish - To ascx v Down ¥ Last Properies  Profiles Form Reports Close

German (Germany) : Deutsch (Deutschland)

| Appearance
French (France) : frangais (France)
i T v ’
{Portugal) : portugue
T v @ %
Swedish [Sweden) : svenska (Sverige)
1 varsion i
half P2 & More languages Email - "
1 Validation
agel gle-Line T v
etters onk v
. Titel / R gle-Line T v
M-ZA-ZI'S
2 : data_Persona Single-Line Text L
. data_Topic Single T v 1

Checkbox List v

1 Analytics

Figure 6-31. Forms can be easily translated into other languages much in the same way as any other piece of
content, which is described more thoroughly in Chapter 2
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Summary

As you can see, Web Forms for Marketers is a very visual, easy-to-use form creation tool. It is appropriately
dubbed “for Marketers” as it shouldn’t need any developer involvement to do basic things such as quick and
dirty lead capture form, event registration form, and new user registration forms.

This chapter toured through the WFFM UI. We reviewed the Form Designer, how to set up field
validations, and how to configure some of the more popular save actions. All in all it’s been quite the trip,
and we're all the closer to getting back to Kansas now that we know how to create a good ol’ form!
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CHAPTER 7

Experience Analytics

Marketers want to demonstrate return on investment (ROI). This has been an age-old dilemma for the
marketer, tracing advertising costs to sales, for example. It’s rarely a solid line from one to the other.
Experience analytics within Sitecore, however, offers some serious promises to the marketer seeking to
demonstrate ROI, performance, etc. How is this possible? Sitecore logs every interaction from everywhere
and tapping into this vastness of data is your key to understanding how your digital experiences are doing.

For example, a customer profile shows every interaction that customer has had with your brand. You
can see campaigns that customer entered into the experience through, goals that enabled conversion, and as
aresult, outcomes such as purchases. All of these interactions are plotted on a timeline enabling traceability
to the campaign, the investment, and therefore your ROI. This is truly more than just “web analytics,” my
friends.

This chapter begins with a discussion on how to plan your measurement strategy when considering the
uniqueness of the Sitecore platform. Industry standards/approaches around measurement still apply, but
knowing what the platform can enable you to measure is helpful; it enables you to ask much more specific
questions of the data and rely less on high-level abstracts.

We then will cover the out-of-the-box reports available from the Launchpad. There are at least 18 at this
writing. These 18 reports offer tons of out-of-the-box value to the marketer in measuring the performance of
their experiences, campaigns, and the like.

Lastly we discuss self-service BI. What if you're looking for that 19th report that doesn’t exist? You
could ask a developer to build it for you, or you could just get it yourself with the right tools. An empowered
marketer with tools such as Excel PowerView and PowerBI enable all sorts of data discovery and
dashboarding possibilities not available out-of-the-box.

Note Federated Experience Manager enables you to capture all insights and customer interactions from
digital experiences that aren’t even on the Sitecore platform. You can capture every digital interaction with
your brand if you incorporate FEM into those experience’s architectures. The analytics are the same, but the
configuration is quite different. Since the configuration is an advanced topic, you can find more about FEM in
the appendix.
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STRATEGY BITS: FIVE BENEFITS OF EXPERIENCE ANALYTICS

194

Not getting the customer insights you need by tracking aggregate visitor data with your web analytics
platform? Seeing the data in CRM, but not able to tailor content on the fly? Experience analytics tracks
behavior at the visit level, providing the insight needed to understand specific customers’ behavior,
the capability to personalize the digital experience with rule-based triggers and in turn build stronger
relationships with your customers. Here are just five benefits of utilizing experience analytics on your
web site:

1. Track visit specific customer behavio—With visit-level tracking, you can begin
to see the paths visitors are taking throughout your site across multiple visits,
whether they are identified or not. Get a view into the pages visited, content
downloaded, how long they stayed on-site and how often they came back. Once
an unidentified visitor submits their contact information through a sign up or form,
all their prior visits will be connected to that unique profile. This level of detail will
allow for a more intimate view of your customers’ experience and engagement
with your brand, allowing your team to target specific customer with offers that
meet their needs.

2. Automate content personalization for a highly relevant experience—If experience
analytics is incorporated with your CMS, set rule-based triggers to serve content
as a visitor completes specific triggers, providing a more relevant experience that
caters to the specific needs of your visitor. For example, if a visitor clicks on a piece
of content regarding a specific brand line and is located in Asia, personalize their
experience to ensure that the next page serves a detailed locator page for that
product line in that geographic area (not just the generic product page).

3. Arm your sales team with details to facilitate a more relevant conversation—As
soon as a visitor identifies themselves through voluntary submission of their
contact information, your sales team can have instant insight into the prior
interactions a visitor had with your site, giving them the power to tailor their
conversation to the leads’ specific experience with your site and their interest with
your product or service. With experience analytics, you can see the content that the
potential customer had interacted with, the steps they took (or haven’t yet taken) to
learn more about your business, the source that brought them to your site, and the
number of times they visited.

4. Focus your marketing efforts on your best bets—Through profile scoring against
your site’s goals you can begin to build an engagement score for each independent
visitor. As visitors accomplish previously identified goals within the site (such as
viewing a specific page, signing up for a newsletter, or searching for a dealer), their
score increases. This way, you can see which of your visitors is the most engaged
and target them with personalized messages to bring them further down your
marketing funnel.

5. Increase visitor satisfaction and boost conversion—By focusing on your most
engaged visitors and providing personalized content that is tailored to their needs
and interests, you can improve your customers’ experience with your site, engaging
them further and increasing the propensity to turn the visitor into a converting
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lead. With the insight that experience analytics can provide, you can take action to
develop the right content, serve it to the customer at that right time, and increase
their affinity with your brand.

Experience analytics, in addition to a traditional web analytics platform and marketing automation
software, will provide your team the relevant insight to take action targeted to each individual visitor. In
today’s digital landscape, you can’t afford to have a poor digital experience. Delight your customers with
the personalized and targeted experience that they have come to expect.

Sasha Vaynberg
Product Consultant, Optum
Twitter: @sashavay

Creating Your Measurement Strategy

In the next sections you'll learn about all the wonderful out-of-the-box reports that come with Sitecore 8.
There is a ton of data that will help you understand how your experiences are performing. However, it’s a bit
challenging to know where to focus, to know if you're making progress, and to hold yourself accountable to
the progress you are setting out to make. Because of all this, having a measurement strategy is critical.

A measurement strategy should discuss:

e  Whatis being measured

e Why those things are being measured

e  How we will measure them

e  Who will measure them (for manual samplings)

e  How often will we measure them

e  What, specifically, are the measurements (the KPIs)

e Who needs to be aware of the measurements (communication plan, governance, etc.)

Chapter 9 discusses governance in general, but it’s worth knowing that measurement strategy is a key
component of governance. Since governance is all about ensuring a performing, healthy, well-maintained
Sitecore deployment over time, measurement strategy is a key piece of knowing if you've been successful in
doing so.

Start by creating a document or wiki page for this measurement strategy and follow along with those
topics/questions. Next, begin through the following stages to flush out the details of the strategy:

1. Business Objectives Workshop—Start with the business objectives. What are they?
How are they measured? Are there KPIs already available to measure them? The
answers to these questions should be measured.

2.  Digital Strategy Workshop—How does your digital strategy ladder up to your
business objectives? Do you have measurable digital objectives? Are there digital
KPIs that should be included in this measurement strategy? The answers to these
questions should be measured.

3.  Sitecore Experience Measurement Workshop—What are the objectives of the
experiences you're creating? What purpose do these experiences serve
the digital strategy or business objectives? How do you know you're successful?
The answers to these questions should be measured.
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4.  Behavior Measurement Workshop—What are the personas for your experiences?
What are their goals, and what goals do you have for them? What outcomes
are you driving them toward? What things do they hate? The answers to these
questions should be measured.

5. Identify KPIs—You have your list of things you want to measure. Next identify
expectations and goals for those samplings. What is the normal/expected range
for each KPI? Think stoplight KPIs; what value represents Red, Yellow, and Green?

6. Measurement Governance—Answer the questions stated earlier around who/how
will measure, who needs to be made aware, how will we communicate/escalate
issues and status, etc. (more on this in Chapter 9).

Now that you have a bunch of KPIs identified for your Sitecore/digital experiences, the next step is to
create a dashboard and start measuring. There are a few ways you can do this. You can use the out-of-the-
box dashboards as described in the next section. The benefit here is that there is no additional technical
work you'll need to do. The con is that you might not be able to answer all your questions and provide
values into your KPIs. Additionally, if you have a monthly executive status meeting where you're expected to
present the KPIs, you'll likely be manually sampling all the data from these reports and manually plugging in
values into a document of some sort and perhaps cutting PDF or something in preparation for your meeting.
You might spend 8 or more hours assembling all this information.

Another approach is to build the dashboard along with all the KPIs, so that in your executive meeting
you simply bring up the dashboard and walk through the results for the past month. This obviously can save
alot of time and is discussed later in this chapter as we discuss self-service business intelligence.

With that dashboard in place and your measurement strategy loaded into your governance plan, you're set
to go. Everybody’s KPIs will be different, because every company’s objectives are different. However, Table 7-1
has a list of some common KPIs you may find yourself including in your Sitecore Measurement Strategy.

Table 7-1. Example KPIs

KPI Category Description

Revenue Executive For e-commerce sites, this one is obvious. However, through goal
association and potentially a mashup with external system data
(such as CRM), you could calculate how much revenue your digital
experiences influenced. Influenced revenue is worth putting in as a
KPI on your executive dashboard.

90-day revenue Executive Similar to the revenue KPI. If you know that 100 engagement value

forecast points correspond to $10 of revenue 90 days from now, you could
create a KPI that measures projected revenue. What CEO wouldn't
want to see that?

Marketing Executive Or otherwise called conversions, otherwise called goals, but that

qualified leads are routed into your CRM as a Marketing Qualified Lead. A VP of
marketing loves telling the VP of sales how many leads she handed
over the previous month, and this is a common KPI worth putting
on your executive dashboard.

Campaign ROI Executive This one is a bit tricky but certainly a helpful KPI. If you do a
lot of pay-per-click advertisement, and you track those back
as campaigns and subsequently track through toward goal
completion, you can calculate ROI assuming those goals have
arevenue component (or that one can be calculated through
association with data in a back-office system).

(continued)
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KPI Category Description

Persona scorecard Behavioral Every persona could have a scorecard. How do you know if the
persona is accurate? Are you certain that "Pam" likes the things you
think she likes? Personas should have measurable goals, outcomes,
events, and failure events (as described in Chapter 3) and these
should be in your measurement strategy and perhaps represented
as KPIs, especially persona goals (things you are trying to get that
persona to do, like convert).

KPI for each goal =~ Behavioral Goals in general might warrant a KPI, especially high-value goals.

Visit count Operational Visits are somewhat helpful to measure. Value is more important,

(perhaps by but since visits are so easy to measure, why not? Their usefulness as

visit, campaign, a KPI, however, is rather low.

persona, etc.)

Value (perhaps by  Operational This is almost certainly a KPI. The question is more around value

visit, campaign, granularity. Value all up, or value broken down by persona?

persona, etc.) Channel? Campaign category? Etc.

Average page Operational Perhaps, as part of your digital strategy, you want to increase

counts (perhaps engagement on your site. Page counts is one way to measure

by visit, campaign, engagement. Someone who browses to eight pages is more

persona, etc.) engaged than someone who browses two pages. As such, this may
be a worthwhile KPI on your dashboard.

Average time spent Operational Similar to page counts but another way to measure engagement.

on site (perhaps

by visit, campaign,

persona, etc.)

Repeat visit % Operational Similar to the previous two but yet another way to measure
engagement (if they come back for more later, they are more
engaged then if they never come back).

% of indirect visits Operational A referral is always better than a cold call, they say. You may want
to measure the percentage of your traffic that is not direct traffic,
especially if a key digital strategy is driving more social, e-mail, or
other sources of traffic to your site. This KPI will help you measure
if you're successful at that.

Bounce rates % Operational If part of your digital strategy is to reduce bounce rates by delivering

(perhaps by more relevant/personalized content, you may want bounce rates as

visit, campaign, a KPL

persona, etc.)

Geographic or Operational Perhaps you have a business objective to expand in China. If so,

language visit % you may want a KPI around value growth from visits originating in

(perhaps by China. Likewise, language could be measured.

visit, campaign,

persona, etc.)

Average page Operational You may have strict goals around page responsiveness that could be

response times

captured as a KPI for monitoring purposes.
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Note Some of these KPIs are easier to create than others. Some you can create from data directly in
the Sitecore analytics database, as described later in this chapter. Others need the analytics data augmented
with other data from external systems or processed data, such as from financial systems for revenue or CRM
systems for holistic campaign results. All of this can be accomplished, but with varying degrees of technical
proficiency and/or integrate or use of external tools/systems. Self service Bl is a great way to create these
mashups of various data; see that section later in this chapter for more information.

Out-of-the-Box Analytics

Sitecore has more than 18 out-of-the-box analytics that you can use to get quick insights into how your
digital experiences are performing. Most of the reports are very intuitive; the goal of this section is simply
to help you understand what is out there and where these reports reside within the Sitecore admin
interface.

Note Experience Analytics depends on MongoDB and an xDB processing server to be appropriately
configured to ensure data is getting aggregated in Sitecore’s analytics database. If the following reports are
broken it’s likely that these dependencies have not been configured. See the appendix’s architecture section for
more details. Additionally, the list of out-of-the-box reports below was built off Sitecore 8.0 Update 5. Sitecore
adds more all the time and this list is sure to grow with future releases.

Analytics Dashboard

The Analytics Dashboard has several of the most important reports. You can get to the Analytics Dashboard
from the Launchpad by clicking Experience Analytics. If you don’t see this button on the Launchpad you
likely do not have access. See Chapter 8 for more information on setting up security.

Online Interactions by Visits by Value Per Visit

The first report you'll see shows online interactions by visits by value per visit. Basically, this shows hit
counts and the value those hits are generating for your business, as shown in Figure 7-1.
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Online interactions by visits and value per visit v

Value per vivit
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Figure 7-1. Online interactions by visits and value per visit

Channel Groups by Visits

EXPERIENCE ANALYTICS

Channel groups by visits is next on the dashboard. This report (Figure 7-2) shows you from where those visits
are coming from. In my demo environment I only have one channel (web) set up. You likely will have many

(social, e-mail, etc.), so this report will be more helpful for you.

Channel groups by visits ¥

Visits

IMay 10May 17 May 24May 31May 7Jun  14Jun 21Jun 28 Jun 15 12 OJul 28 Jul
15 15 15 15 15 15 15 15 15 15 15 15
Date
il Direct & Referal

Figure 7-2. Channel groups by visits
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Top Campaigns by Value

This report shows you the value points your campaigns are generating for you. You can quickly see which
campaigns have been most effective. Notice the example in Figure 7-3.

Top campaigns by value

I _

2016 Medicare Open Enroliment

Value

F— All vists by Campaign

Figure 7-3. Top campaigns by value
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Top Pattern Matches by Value Per Visit

The top pattern matches by value per visit report (Figure 7-4) shows you which personas (or more
generically, your profile cards) are generating the most value. This can be very helpful when you're trying
to get more value out of lower performing personas. You may notice their low performance and as a result
update your personalization strategy to target more relevant calls-to-action, or perhaps you would spin up
an e-mail campaign to target a particular persona.

Top pattern matches by value per visit v

Figure 7-4. Top pattern matches by value per visit
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Top Goals by Conversions

The top goals by conversions report is the last report shown on the dashboard. This report shows you how
people are converting on your site. You can see in Figure 7-5 how “add a favorite” is the most common
conversion, but it is likely a lower value than a “request a demo’, in which case you may want to update your
personalization strategy to better align to higher value conversions, for example.

Top goals by conversions

Add a Favorite

Downloads whitepaper
Registration Form Completed
Request a demo Form Completed
Event Registration

Brochures Request

Count

= Al visits by Goal
% ]

Figure 7-5. Top goals by conversions
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Language and Location Analytics

The language analytics reports (below the Audience section, as seen in Figure 7-6) show you which
languages are most common on your sites. In my case I had two languages set, Arabic and English, and you
can see how many visits are allocated to each of those languages. There also is a language value report that
shows you which languages are generating the most value for your site. This might be better as an average
(see self-service BI section later in this chapter); otherwise, volume distorts the picture and makes the report
less useful.

30 Apre1S -1 Aug'ts ¥ Aasites ¥

Top languages by visits v Top languages by visits

Rslerriog sites Top languages by value v Top languages by value

Behavior
Overview
Downloads.

Inbeenal search

Exit page URLs

Figure 7-6. Language analytics
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Location Analytics

The Location Analytics (next link in the Audience section) shows very similar reports as the Language
section, except that instead of language it shows geographic data so you can get a sense of where your users
are coming from. You can see an example of location analytics in Figure 7-7, but since this is from my demo
PC the data is all coming from the same place, so you'll need to use your imagination a bit.

Locations

30 Apr15-1Aug s W Alsiles ¥
Top countries by visits v Top countries by visits
e Top regions by visits v Top regions by visits

Behavior

Overview
Downloads.
Inteenal sesech
Fages
Eriry pages
Exit pages
Page UFLs

Enry page URLs

Exit page URLs

Figure 7-7. Location analytics
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Pattern Matches

The top pattern matches dashboard (Figure 7-8) shows you how often users are getting matched up with
your various personas (or more generically, your profile cards). This can help you understand which
personas are more prevalent on your site. Additionally, you can see which personas are generating the most
value. This can be very helpful when you're trying to get more value out of lower performing personas. You
may notice their low value performance and/or low visit count and as a result update your personalization
strategy to target more relevant calls-to-action, or perhaps you would spin up an e-mail campaign to target a
particular persona. Or, if you notice your site hardly ever matches users to a particular high-value persona.

Pattern matches

0 5 Pasem makchis

Pattern matches by visit v Pattern matches by visit

Hferting sibes Patiern matches by value v Pattern matches by visit

Behavior

Overview
Downloads.
Inteenal sesech
Pagers
Ertry pages
Exit pages
Page UFLs

Enry page URLs

Exit page URLs

Figure 7-8. Pattern matching analytics
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Acquisition Analytics

Acquisition analytics shows from which channel sources your users are entering, the value those channels
are driving, as well as which goals are getting those users to convert from. This data can help you identify
underperforming channels and how different behaviors lend themselves more or less to driving conversions.
Notice the example in Figure 7-9.

Overview

Channels by visits

N Top campaigns by visits Top campaign groups by visits

Behavior

Overview
Downloads.
Inteenal sesech
Fages
Eriry pages
Exit pages

Page URLs

Enry page URLs

Exit page URLs

Figure 7-9. Acquisition analytics
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Campaign Analytics

Campaign analytics show the performance of all your campaigns, as shown in Figure 7-10. It is common to
group/categorize campaigns since you may have many running in parallel. The first report shows how those
different categories are performing in aggregate, followed by specific, individual campaign performance.

Campaigns
30 Apr15-1Augts W Alisiles ¥
Top campaign groups by visits v Top campaign by visits '
O Top campaigns by visits Top campaigns by value per visit Top campaigns by bounces
Behavior
Overview

Downloads.

Inbeenal search

Pagrs

Ertry pages

Figure 7-10. Campaign analytics
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Keyword Analytics

Keyword analytics show from which keywords users are entering your site. This is driven from your
configuration of search engine pay-per-click configurations, such as Google’s AdWords. As people enter your
site from an AdWords campaign, you can track those interactions here including keywords, assuming you
have many campaigns each with different keywords. This is a helpful way to identify which keywords are
driving the most traffic to your site.

Keyword Analytics can be vied from the Keywords link, below Acquisition.

Behavior Analytics

Behavior Analytics (Figure 7-11) show which pages are getting the most traffic. Additionally, you can see
which pages users typically enter into as their first page, as well as which pages they tend to leave from (dead
ends). In the top chart, you'll notice the total page visits, as well as the average number of page visits per
visit. This can help you understand how much time your customers are spending on your site. Other reports
such as site search behaviors and download activity can also be found under the Behavior section.

Online interactions by page views and page view per visits

Raterring ses Top entry pages by visits Top exit pages by visits

Behavior

Cverview
Downloads
Irternal search
4 Pages
Ertry pages
Fait pages
4 Page URls

Entry page URLs

Exit page URLs

Figure 7-11. Behavioral analytics
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Conversion Analytics

The conversion analytics are some of the more interesting reports. They show which behaviors are
generating the most value (and as a result, leads) for your business. The overview page (Figure 7-12) shows
a summary of the number of conversions, and which goals are converting. Then, there is a Conversions
(Figure 7-13) page that highlights more details on conversions, such as the number of times a user converts
on average. Lastly, the goals overview (Figure 7-14) highlights more details around your goal interactions.

Hogons Onling interactions by conversions and conversion rates

Clties

Pattem matches

Acqusition

Hiferming sies
Top goals by count
Behavior
Ovorview
[
Irternal search
Pages
Entry pages
Exit pages

Page Lfds

Entry page URLs

Conversion analytics overview
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Adminiskaier §

v Top goals by count
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Conversions by visits (intervals)

Organic branded

Orgaric non-branded
b Paid overview
Rislersieng sites

All online Interactions by conversions

Entry page URLs

Exit page URLs

Figure 7-13. Conversions dashboard
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Adminiskier §

Top five goals by count v

Pattem matches

Acqusition

b Paid overview

Fistorsieng sites

Top goals by count Top goals by conversion rate

Behavior

Overview
Downloads.
Intemnal sesch
Fages

Ertry pages

Exit pages

Page s

Entry page URLs

Exit page URLs

Figure 7-14. Goals dashboard

Experience Profile

Experience profiles are where you go when you want to see a “single view of the customer”. You can get to
your customer’s experience profiles from the Launch Pad » Experience Profiles.

Every interaction, everywhere, should be saved to the profile to enable this single view of the customer.
Certainly every interaction within Sitecore is tracked here, but you can also use the Federated Experience
Manager (discussed at the end of this chapter) to bring in data from non-Sitecore experiences. Additionally,
you could build customizations that integrate CRM data, for example. In any case, when you want to
understand how a customer is engaging with your brand, you go to their experience profile.

The interesting thing about experience profiles is they are not limited to known users. Anonymous
users are also tracked. Notice the anonymous profile found in Figure 7-15. This user engaged the brand
from a campaign named “Drive more requests for demos”. After entering into the experience, we’ve learned
that this user matches a persona named “Pam,” a pattern card “Digital Marketer,” and that they prefer
“high-level” information. Depending on what these personas/cards signify for your business, this can be
very valuable information to know further down in your digital pipeline, as you're trying to get this user to
convert into a customer.

Notice also how this anonymous user has had three different interactions, the first on May 28th,
the second on June 2th, and the last on June 4th. Anonymous behavior is even tracked across multiple
sessions (ID stored via cookie). This is powerful, because when/if they do convert, all of those anonymous
interactions come into that, now known, customer profile. So you see every interaction for that
customer even before they became a customer! Additionally, past interaction data can help drive future
personalization, making conversion easier to achieve.
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Anonymous
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Figure 7-15. Experience profiles help create a “single view of the customer”

I mentioned three different interactions as seen in the timeline. You can click one of those interactions
and everything below will update to show specifically what happened during that interaction. By default all
pattern matches, campaigns, goals, etc. are aggregated across all interactions so you see the full lifecycle of
that customer. However, it can be handy to see what that customer did last week, say if you're a sales rep and
you want to follow up on a request for a demo or something like that. By finding your target’s profile you can
get the intel you need to have a very specific conversation with that customer (or drive personalization, etc.).

Path Analyzer

The Path Analyzer is a really helpful tool in Sitecore. Most of the other reports will show you the average
user viewed eight pages, for example, but which eight? If they started on the home page, what are the most
common paths to other pages? Where are the dead ends in the site and how are users getting to them?
Which of those eight pages is generating the most value? Which page are they converting on the most? All
these questions can be answered through the use of the Path Analyzer. You can access the Path Analyzer
from the Launchpad.

Notice the following example of the Path Analyzer in Figure 7-16. It shows all the most common paths
on the site. In this example, I clicked the home page, and thereafter I see some common second pages that
people interact with after leaving the home page. And likewise I can keep clicking down the path to see what
happens down the line.
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Notice that by the fourth node in the path, whitepaper download, we can see the digital funnel on the
upper left. It shows that 0.7% of users get to this node from the Downloads page, and that 1.7% of users get
to downloads from the EXM Installation Guide page. Additionally, you can analyze value and visits at each
node to see where the value is generated on your site, and potentially where users are finding no value at all.

EXM Instalaton Guide 30
13% 2

Whsepaper dowrkoad
07% 1

Show all lunnels

Internet

Sublres vakue 1,085
S 152
Subtree value per visit 7.14
Exit value 1]
Exit visits 0
Exdt valus por vist 0.00
Exit potential gain 0
i 5 wihitegaper download
Other visits 6
Average time speri (sec) 0.00
Dopth 0

Figure 7-16. The Path Analyzer helps you understand how your customers are navigating the digital
experience

Self-Service Sitecore Business Intelligence

Asyou just saw, there are at least 18 different out-of-the-box reports, so why would we need to extend

this discussion any further? Are there other reports we don’t get out-of-the-box? Well, yes! Really, the
possibilities are infinite. Every business is going to care more or less about different things. Every Sitecore
installation will have a different measurement strategy that measures digital success against benchmarks
and business objectives. Since building custom reports is such a pain in the rear (see note in the chapter’s
introduction), we turn instead to self-service Business Intelligence (BI) to accommodate our custom analytic
needs.
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Note Custom reports within Sitecore is an alternative, but you’ll need a savvy Sitecore developer. The
benefit is that you get an integrated reporting experience alongside all the out-of-the-box analytics. The
downside is that it’s akin to launching the space shuttle, when compared to the self-service techniques
described in this section. Empower the marketer, or enforce consistency? That’s a business decision you’ll have
to make. Since custom analytics are beyond the scope of the audience of this book, it is not covered here. For a
good example of custom, integrated analytics, check out http://bit.1ly/104410L.

A few benefits of self-service BI for Sitecore are:

e Mobile BI—Sitecore admin interface is not mobile optimized. Get your analytics on
the go with self-service BI.

e Key Performance Indicators (KPIs)—The out-of-the-box dashboard has great
information, but it takes a while to interpret. Wouldn't it be great to have a KPI, so in
three seconds you can understand how you're performing?

e  Cross-dimension relationships—Would it be nice to see what goals a campaign
generated and the value of those goals? Or, perhaps you want to understand
which Personas trigger which goals the most across various campaigns? These
relationships can be expressed either as three separate custom reports, or as one
single report with filtering capabilities—something most self-service BI tools do
natively.

e Mashups with other datasources—Perhaps you want to extend your web analytics
data and mash it up with your CRM data. This would help you understand a
customer’s journey across campaigns managed across multiple systems.

e The marketer can ask questions of the data that otherwise is not answerable in a static
report. PowerB], for example, has a Q&A feature where you can free-form type your
questions in a search box and PowerBI displays charts/graphs it thinks align to your
question.

There are many tools you can use for self-service BI against Sitecore data. Microsoft Excel, a tool
everybody is familiar with, is a great start. If you want to share your dashboards and KPIs with others on
your team, you may want to consider PowerBI. PowerBI is configured very similarly to Excel, so it is a very
easy-to-use product. You can publish your dashboards into and Office 365 PowerBI site to share with others
in your organization. While there are many other tools (Tableau, for example), these two will be covered in
this section.

Note This isn’t a Bl book. You can buy entire books on Excel and PowerBI, and | recommend you get one if
you’re serious about leveraging these tools for your Sitecore Bl needs. The goal of this section is simply to whet
your appetite and provide a high-level understanding of what is possible, with minimal step-by-step procedures.
Once you know the data model and once you know the tool, you have no need for step-by-step procedures.
That’s the promise of self-service Bl, after all.
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Excel spreadsheets, and specifically PowerView dashboards, provide an easy fast way to get your fingers in
the data and start playing around. In 15 minutes you can create a dashboard similar to the one you see in
Figure 7-17. Notice how we have many of the types of data you see in some of the out-of-the-box reports
described in the previous section. You see visit counts, value for those visits, campaign data, etc. Since you're
connecting Excel to the same datasource that Sitecore connects to, you have all the same data available

at your fingertips. Simply check a value in the table that interested you (below PowerView Fields) such as
Traffic Type » Visits and you'll see a graph pop up on the left showing that data. It’s that easy!
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B FermFieldValues
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FIELDS

Figure 7-17. PowerView is an excellent and easy way to create your own custom reports without needing a

developer

You could add other fields or create relationships between different types of data. Notice in Figure 7-18
how I clicked a campaign named Drive More Demos. When I clicked that campaign, PowerView is smart
enough to update all the charts/graphs on that dashboard and check to see if they can filter their data by
that item. Notice how the visits/value chart has updated to just show the visits/value for just that campaign.
Likewise, the top pages value updated, as well as the traffic source on the lower right. Unfortunately with my
limited dataset (demo environment), the charts in my figures don’t look as cool as yours will look when you

have production data you're reporting against.
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Figure 7-18. When you click an item in PowerView, all the other reports update to show the relationships
between the data elements, which is not available in the out-of-the-box reports

Check out these high-level steps to create a PowerView dashboard similar to what you see in the
previous two figures:

1. Open Excel 2013 ProPlus or later version.

Note You can install a module into Excel 2010 to support PowerView if you’re not on Excel 2013, where it's
installed by default.

2. Onthe Ribbon, click PowerPivot (last tab) and then click Manage.

Note If PowerPivot is not shown, click the Insert tab » Power View button. Thereafter you’ll be prompted
to enable PowerPivot, and after which the PowerPivot tab should appear. Click PowerPivot » Manage.
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3. Within the PowerPivot Manager, click Get External Data » From Database »
From SQL Server, as can be seen in Figure 7-19.

x| - s
& - 5= o = .
HOME INSERT  PAGE LavouT [ialia e PowerPivot for Excel - Book1
“ Home Design Advanced
o HELP IMPROVE OFFICE? Click Yes to add a S} -
. B C * i
Al - fx Format p
- Clipboard Get External| Refresh  PivotTable Sortand Find
A B c D - Data - . 2 . Filter =
1 Formatting Find Calculations
3 L‘ _r-j n
3 er |
4 From  From Data From Other Existing

Database ~ Service *  Sources Connections
E From SQL Server Get External Data

g3 From Access

[ From analysis Services or PowerPivat

9

10

Figure 7-19. In Excel, simply import the Sitecore Analytics database to start creating your custom reports

4. Enter the name of the SQL server that’s hosting your Sitecore Analytics database.
Thereafter, you should see the Analytics database show up in the drop-down of
databases. Click Next.

Note You may not have access to the analytics database. If not, ask your Sitecore administrator to grant
your user ID read access to the Analytics database. A best practice here might be to have an Active Directory
group that maps to your “Contoso Sitecore Marketing Analysts” Sitecore role (see Chapter 8) and this AD group
also has read access to this database to enable self-service BI.

5. Select “Select from a List OF Tables...” and click Next.

6. Selectall of the tables to import all the analytics data (Figure 7-20) and then click
Finish. Excel will import all of the data, which might take a good long time. Click
Close when it’s complete.

Note This may only be appropriate for smaller sites. The analytics database can get huge if you're getting
millions of requests a day. If so, you should consider PowerBlI (see the note in the next section), which can
handle larger datasets and can refresh the data behind the scenes, or simply import the specific tables you
need (but you’'ll limit the reporting you can do as a result).
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Select Tables and Views

Select the tables and views that you want to import data from.

Server:  localhost
Database: LaunchcoreSitecore_Analytics
Tables and Views:

| Rﬂfadori.og | | P\PfadorLog |

DeviceNames
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DimensionKeys
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Fact_AutomationStates

Fact_AutomationState...
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Fact_AutomationState....

Fact_AutomationState....

- -~

pamnammm\ ‘Preview&FiEber‘
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Figure 7-20. Import all the tables and Excel with auto-generate all the needed relationships

7. Backon the spreadsheet, click the Insert tab » PowerView to add a PowerView
report to the book.

8. You'll notice all PowerView Fields on the right. Most of the names are
self-explanatory. For demonstration purposes, scroll down and expand
Fact_Traffic and then check the Visits and Value checkboxes.

9. You'll notice the data added to the design surface but not in a chart format
(Figure 7-21). To convert it, click the border around the data, and then click the
Design tab » Other Chart » Line to convert it to a view that will look similar to
Figure 7-17.
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Figure 7-21. Use the Switch Visualization options to choose what type of chart or graph you want

10. Perform similar steps to add other types of data, such as Campaign performance,
channels, or top pages that provide the decision support you need.

PowerBI for Teams

PowerBl is a feature of Microsoft’s Office 365 cloud (www.0ffice365.com, www.PowerBI.com). Essentially,
PowerBl is a cloud-based business intelligence platform. It is very easy to connect PowerBI to internal
datasource (such as an on premise Sitecore Analytics database) or external datasources (such as a Sitecore
Analytics database hosted in Microsoft Azure or Amazon AWS). PowerBI has very similar charting and
graphing capabilities that you find in Excel.

However, PowerBI has certain advantages over PowerView in Excel. Those are:

e  You can easily share your dashboards with others in your company (it’s a pain to
e-mail large files around, keep them in sync, etc.) because PowerBI uses a web
browser for data visualization (Figure 7-22 shows a retail sample).

e  PowerBI does a much better job with mobile insights. For example, there is a native
iPhone/iPad app for PowerBI, whereas loading a spreadsheet on your iPhone is a bit
more clunky, and depending on the size of the spreadsheet, likely impossible.

e  PowerBI can refresh the data on a schedule of your choosing such as hourly, behind
the scenes, so every time you go to PowerBI you know the data is fresh. This is very
important for large datasets since you probably don’t want to watch a spinny spin for
30 minutes before you get the decision support you need.

e  PowerBI has free-form Q&A abilities to “ask questions of the data” This is very
powerful for data discovery purposes, or when you're lazy and don’t want to build
pre-canned charts, etc. ©.
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Retail Analysis Sample
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Figure 7-22. PowerBI has rich visualization tools and offers Q&A features, as you can see in this retail
example provided by Microsoft

Note PowerBI has maximum dataset sizes (currently set at 250MB of compressed data; you’ll see about
50% compression of your Sitecore Analytics database). For true “enterprise grade” self-service Bl you need to
build an OLAP Cube or Tabular model on top of the Sitecore Analytics database that pre-aggregates information,
from which you connect PowerBI to the cube or model through the Analysis Services Connector. In this case,
live queries are issued, as opposed to caching all the data within PowerBI. OLAP cubes and Tabular models are
far beyond the scope of this book, but they offer a solution for medium to large implementations, should that be
your situation.

Use the following high-level steps to create a dashboard in PowerBI:

Tip The PowerBI team is continually rolling out new “content packs” with preset reports/configurations for
popular tools. They have already released packs for Google Analytics, Adobe Analytics, CRM, etc., so keep an
eye out for a Sitecore pack in the future (Get Data » Services link).
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1. Gotohttps://powerbi.microsoft.com/desktop to download the PowerBI
designer desktop application used to design your dashboards (Figure 7-23).

2. You'll notice the PowerBI Desktop Designer has a very similar ribbon as the
one you saw in Excel in the previous section. Repeat those steps here (they are
identical).

Tip  One nice feature of PowerBI is the ability to create KPIs, as you can see in Figure 7-23 (the gauge).

3. When your dashboard is complete, click the Publish button. Browse to
https://app.powerbi.comto view your dashboard and share it with your
teammates.

[ = e | PowerB! - Power Bl Desktop - olEN
Home L]
. B = | - —
: m R D | )
Refresh Test Iimage New Manage Mew Hew Pubdish
Box

Get  Recent |
Page  Relationships  Measure Cokumn |

Data = Sources

Report  Relationships

Referred - Analys

Fact_MyTesting

Figure 7-23. You can use the PowerBI Desktop Designer to create a custom dashboard from the Sitecore
Analytics database much the same way you can with Excel
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Summary

Experience Analytics enables you to measure success and drive performance and return on your investment.
In the Sitecore world, Experience Analytics is driven from Sitecore’s XDB platform, where every interaction,
everywhere, is captured, enabling rich reporting and even self-service business intelligence with tools such
as PowerBI.

It all starts, however, with your measurement strategy. Knowing what to measure is just as critical as
knowing how to measure it. Measurement in Sitecore stems from all the previously discussed topics in this
book, especially campaigns, outcomes, goals, and personas.

Measurement helps us understand if we configured those things correctly and if they are driving their
anticipated value or not. This chapter covered all of these concepts, including self-service BI for extra credit.

All things considered, the potential is limitless; we’ve just seen the tip of the iceberg on what can be
accomplished with Experience Analytics.
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CHAPTER 8

Security

Oh, the dreaded “Access Denied” page. Security is table stakes for any configuration guide such as this one.
However, security is a huge topic, so it’s important to straight away align on what is covered in this chapter,
and what is intentionally not covered.

Security tries to answer questions like “who are my users?,” “how will they authenticate?,” “what are
they allowed to do once they’re logged in?’ and “is my configuration hardened against attack?”

In a book focused on end users, marketers, and power users, security has a narrower focus than
say, administrators. Administrators are concerned with all of these aspects of security. Power users
(technologists but not necessarily developers or admins) are concerned more with the application
configuration and hence the questions “who are my users?” and “what are they allowed to do once they're
logged in?” This, then, is the primary focus of this chapter. The appendix does a bit to elaborate on “how will
they authenticate,” but even that is a topic generally beyond the scope of the majority of those who will be
purchasing this book.

To get started, we want to dig into user management and access management in Sitecore. This will
allow power users to create users who can log in to the site, as well as configure what they are allowed to
do once they get into the site. These features stem from the Launchpad (Figure 8-1), specifically the User
Manager, Security Editor, Access Viewer, and Role Manager icons (the Domain Manager is discussed more in
the appendix).

e User Manager—Where you can go to create new users, reset passwords, etc.
e  Security Editor—Where you can go to grant access rights to users.
e Access Viewer—Where you go to see what access rights a user already has.

e Domain Manager—Where you can set up new user sources, such as “Extranet” vs.
“Partners” or a link to CRM or an internal Active Director.

e Role Manager—Where you go to create roles (groups of users granted similar
access rights).
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| Administrator §

User Manager Security Editor

Access Viewer  Domain Manager

L

Role Manager

Figure 8-1. Security configuration options are available on the Launchpad

User Management

User management is a great place to start a security conversation. Security is applied to users; when
someone logs in to Sitecore we need to configure what they are allowed to do and what they are prevented
from doing. In order for users to log in, they must have an account. That account is managed from the User
Manager utility, which can be launched from Launchpad (as seen in Figure 8-1).

The User Manager should look similar to Figure 8-2. There are four main sections of configurations to
choose from:

e  Users—This section features buttons that allow you to create new users or update
existing users, such as editing the e-mail address or resetting the password. The list
of existing users is below the ribbon.

e  Security—This section has a link to the Role Manager, as well as a link to launch the
Domain Manager.

e  Tools—This section has a link to the Access Viewer, as well as a link to launch the
Security Editor.

e  Serialization—Serialization is a way for an administrator to essentially back up all
your users/roles onto the server file system, often used for portability purposes.
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Figure 8-2. You can create new users from the User Manager

Users are tabbed, showing the first 16 by default. If you have hundreds of users (or more), you'll likely
rely on the search box to find a user. Thereafter, you can select that row in the table and then click one of the
ribbon buttons to take action on that user.

USER DOMAINS AND AUTHENTICATION SCENARIOS

You'll notice in Figure 8-2 the Domain column. Domains typically refer to categories of users. The Sitecore
domain is an out-of-the-box domain that signifies that the user is wholly managed in Sitecore. Figure 8-2
shows a couple more domains: crm, default, and extranet. In and of themselves, these domains are
nothing more than a categorization. However, they also help you understand the source of the user.

“Extranet” or custom domains can be a great place to categorize your external site users (users who
log into your site—aka customers—but don’t need access to Sitecore). For multisite scenarios you may
have several custom domains, one for each.

Active Directory, CRM, and other sources can provide users to Sitecore, but where you may or may not
want the user actually managed in Sitecore. CRM, for example, you might want managed in Sitecore,
and by managed we mean things like password resets, or other profile data, such as a name and e-mail
address. These data can be synced back to CRM via a two-way connection.

0On the other hand you likely won’t want Active Directory accounts managed in Sitecore, because of
stricter rules for maintaining a single source of truth. For simple scenarios, such as extranet scenarios,
you can create custom domains from within the Domain Manager (Figure 8-1) to start categorizing your
users. Additionally, see the appendix for more details on user authentication scenarios, such as Active
Directory, or social scenarios, such as using your Facebook account to log in to Sitecore.
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Creating a New User

Creating a new user is as simple as clicking the New from the User Manager. You'll be prompted to fill out
some user information, as can be seen in Figure 8-3. Beyond the obvious, there are a few settings that may
warrant some additional elaboration:

e  Domain—User categorization and source, see the sidebar entitled “User Domains
and Authentication Scenarios” earlier in this chapter.

e  Roles—Roles are used to assign security to a group of users of an item so the security
can be managed in bulk. Select which roles you want the new users to be a member of.

e  User Profile—A user can have one or more pieces of metadata about them that
describes that user, such as name, e-mail address, company, and so forth. Different
profiles offer different metadata possibilities, and you can even create custom
profiles to select from.

Create a New User

Enter information about the user.

User name: phil

Domain: sitecore v
Full name Phil Wicklund

Email: phil@me.com

Comment test users

Password: sssseee

Confirm password: sssssse

Roles sitecore\Author 2

sitecore\Experience Explorer
<sitecore\Sitecore Client Social Authoring>
<sitecore\Analytics Testing>

<sitecore\Sitecore Client Users> v
User Profile: CrmContact ~
LS User
Subscriber
Visitor Profile G
Next Cancel

Figure 8-3. When creating a new user, you'll want to assign appropriate roles and an appropriate profile to
manage metadata about that user

226



CHAPTER 8 © SECURITY

After you click Next, you'll receive a confirmation prompt, notifying you the user was created
successfully. Additionally, a checkbox will confirm whether you want to edit the new user in the user editor.
Figure 8-4 shows what the General tab looks like in the user editor.

Edit User

Edit the information about the user.

GENERAL MEMEER OF PROFILE LANGU#
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INFORMATION
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Figure 8-4. Every user has a profile. Some fields are consistant across all users, but users can have a different
profile template for different types of users

e  General—The General tab has basic information such as name and e-mail (as shown
in Figure 8-4). Note the “Roles” section later in this chapter for more information on
the “Administrator” checkbox. It is not a best practice to check this for anybody.

e Member Of—The Member Of tab shows which roles the user is a member of.

e  Profile—The Profile tab has all the custom metadata assignable, leveraging the
profile data template selected during user creation (Figure 8-5). Additionally, you
can set the start page for a user. Content administrators rarely, if ever, work outside
the Experience Editor, so setting their start page to Page Editor may help minimize
some confusion.

e  Language Settings—The Language Settings tab stores language preferences for that user,
such as a “Default Content Language” setting that is a time saver for content editors.

e  Information—The information has general non-editable information in it, such as if
itis a locked account, and when they last logged in.
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Note New users will not be able to log in until you set and provide them with a temporary password.
Select the user, click the Change Password button, and then choose Generate to generate a random password
they can use when logging in to Sitecore.

Edit User

Edit the information about the user.

GENERAL MEMBER OF PROFILE LANGUAGE SETTINGS INFORMATION

User Profile
StartUrl: (® Default
Content Editor
Page Editor h
Preview
Desktop
URL:

Additional Properties:

Data A

Isitecore/shellthemes/ackgrounds/lighthouse jpg

Edit Change

Figure 8-5. Sometimes it's handy to provide a start URL so that users go to the right place after they log in

Creating New and Custom User Profiles

There are times when the out-of-the-box user profile templates may not best align to your users and what
you want to track against them. The best example for when this is helpful is when managing customer users
(users who log into the site but don’t access Sitecore). A customer’s profile might have different metadata
than a partner or an employee. The best practice is to create a custom user profile with that custom
metadata, extending the existing user profile template.
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Note This is definitely an administrator’s task. Marketers beware; you probably don’t have the needed
access to create custom profile templates.

The profiles that show up in the new user form can be found in Core » System » Settings » Security
» Profiles. Any item below this node will appear in the new user form. First, create a user template by
extending the user template. Create this template in the Templates folder, as can be seen at the bottom
of Figure 8-6 (“LS User”). Next, create an item from that template below the Security » Profiles node.
Thereafter, you can start creating new users from that template with your expanded profile metadata.

» {J Key Map

4 Protles < —

& CrmContact
& LS User

& subscriber
& User

& Visitor Profile
» (J Subitems Sorting

» ({J Validation Rules

» { EmailCampaign

4 {J Launch Sitecore
b & LSUser

» O Sitecore Client

b3 System

LS User 1 -

v i Proxies

4 {J Security Portrait
» ) Password recovery
» {J Policies
b {J Presets Wallpaper

isitecore/shellthemes/ackgrounds/Field jpg

Engagement Value:

Current Position

English~ 1=

¢ & Workflow
» & Tasks Badges:
» (B Toolbox Selectall Deselectall
© Workflows All Selected
o A
4 1§ templates ( %
» ) Common

-

(LU Media Library  Workbox

Figure 8-6. There are several out-of-the-box profiles, but you can create your own as well
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Administering Users

There comes a time when you need to administer an existing user. When you select a user in the users list,
you can then select from the buttons in Figure 8-7 to change that user’s settings. These include editing,
deleting, unlocking, enabling, disabling, and resetting a user’s password.

z 2 Edit &= Change password o= Disable = Unlock

New ® Delete £¥ Reset settings “= Enable

Figure 8-7. Managing users involves reseting passwords and unlocking accounts if they type in the wrong
password too many times

Editing/Deleting a User

To edit a user, simply select the user in the table and then click Edit. This will bring up the user profile, as was
discussed in Figure 8-4.

Deleting a user is a similar process. Select the user you want to delete, and then click the Delete button
to permanently delete that user from Sitecore.

Unlocking a User

A user will become locked if they fail to enter their credentials incorrectly 256 times by default. If a user
becomes locked, it requires an administrator to go in, select the user, and click the Unlock button. The
obvious recommendation for the security sensitive is to lower the number of allowed attempts, down from
256 to perhaps 5. To accomplish this, ask an administrator to update the maxInvalidPasswordAttempts
value of the membership provider in your site’s web. config file.

Enabling/Disabling a User

There may come a time when you want to disable a user, thus preventing them from logging in to Sitecore
temporarily. Examples might be when you are working with outside consulting companies going off-project,
or perhaps employees taking a sabbatical. Simply select the user and click Enable or Disable as appropriate
to either deny or grant them access.

Changing a User’s Password

Users can retrieve a forgotten password by click the Forgot Password link. Through these means most of
your password management will just be the exception. Forgot Password relies on an e-mail address. If one
is not available an administrator will need to manually reset the password. To accomplish this, simply select
the user, and then click Change Password. Since you don’t know the old password, just click Generate to
generate a random password, as shown in Figure 8-8. Send that auto-generated password to the user, who
can then change it to a password that is easier to remember.
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,; Anonymous default defaulbAnonymous

Change Password o) 5

Change the password.

& Anonymous  Emailcampaign  Emailcampaign\Anonymous

-

& Anonymous extranet extranelAnonymous
& Testnew user extranet extranetiTest new user Testr N Test
“ sitecore
Message [* Old Password M

The password has been changed n ar
Confirm Password

If you do not know the old password, you can change the passw o a randomly

v generated password
“ IMPORTANT: THE PASSWORD WILL BE CHANGED IMMEDIATELY VRREN YOU

il CLICK GENERATE

& Test sitecore sitecore\Test Test
S4@=KnW2)2UuzD@ Generate

.; test2 sitecore sitecoraitest2 test2

Figure 8-8. It is a very simply process to reset someone’s password

Note The Forgot Password link is enabled by default. You can disable it via a web. config setting, performed
by an administrator. Simply set the Login.DisableChangePassword and Login.DisablePasswordRecovery
values to false. This may be helpful if all your users are Active Directory users and you prefer them using other
means to accomplish this.

Serializing Users

Serializing users or roles (Figure 8-9) is an admin function great for backing up your user database or for
porting users from one environment to another. When you serialize users or roles, those users and/or

roles are saved onto the server’s file system below the Data » Serialization folder. You could revert those
users and/or roles in a different environment by pointing to that location as your source. Again, this is not
something commonly performed apart from having server access and even then in rare circumstances, such
as backward environment compatibility (Dev, Test, and Prod).

& Serialize user 22 Serialize all users

2 Revertuser 22 Revert all users

Figure 8-9. Serialization can be a handy way to back up users/roles or export/import them from one
environment to another
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Access Rights

Access rights form the foundation of security and authorization in Sitecore. Access rights are concrete tasks
a user is permitted to do. You can be granted read access, to view an item, but you may not have write access,
to edit that item. Read and Write are two examples of the out-of-the-box access rights you can assign to users
or roles. Access rights are applied to items, as you'll hear more about in the next section.

Out-of-the-Box Access Rights

Table 8-1 shows all of the out-of-the-box access rights. The Description column specifies how they can be

used.

Note Itis possible for a developer to add custom access rights for your unique circumstances, if this list
below limits you in some way. See this blog post for how: http://bit.1ly/1hk15SG.

Table 8-1. Out-of-the-Box Access Rights

Access Right

Description

Read

Field Read

Write
Field Write

Rename
Create
Delete

Administer

Language Read

Language Write

Read is the most basic access right. If you or a role you're in has this access right
assigned with an item, you can view that entire item (all the data fields). Read is a
prerequisite to all other access rights, with the exception of Delete (you can delete
child nodes you can't read if you delete the parent node).

Sometimes you may not want a user to be able to read an entire item (all the data
fields). In this case, you can use Field Read to grant access to only the fields you want
them to see. Field Read would be applied to the Data Template's fields themselves
(Template name » Field section name » Field name).

Write enables you to edit an item.

Similar to Field Read, you may only want a user to be able to edit certain fields instead
of all the item's fields. In this case use Field Write instead of Write. Field Write would
be applied to the Data Template's fields themselves (Template name » Field section
name » Field name).

Rename permits changing the item name.
Create allows creating child item below the node you have Create access on.

Delete access permits deleting the item. Note: If you delete a parent node you will
also be deleting all descendant items, even if you don't have the Delete access right to
those descendant items.

Controls whether or not you can apply access rights to items.

Controls whether or not a user can read certain language versions of an item. Similar
to Field Read, but is applied to the language itself (/sitecore/system/languages/
language).

Similar to Language Read, except it controls which language versions that user can edit.
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Table 8-1. (continued)

Access Right Description

Site Enter Controls if a user can log in to a site (applied to home item of a managed site).

Show in Insert Controls if users can see certain insert options when creating new items, applied to
templates only (/Sitecore/templates).

Workflow State Controls if a user can delete items that are currently associated with a specific

Delete workflow state (see later section on workflow security).

Workflow State Controls if a user can edit items that are currently associated with a specific workflow

Write state (see later section on workflow security).

Workflow Controls if a user can execute a workflow command (see later section on workflow

Command Execute security).

Customer Profile ~ Grants access to apply values to profile key values.

Key Values
Create Bucket Permits converting an item to a bucket.
Revert Bucket Permits reverting a bucket back to a normal item.

Note Most of these access rights relate specifically to content management. However, Read is very
important for content delivery. Anonymous users need to be granted Read access to items in your site that do
not require authentication. If the Read access right is not allowed on an item, the anonymous user will get an
“Access Denied” error if they try to browse to it.

Access Viewer

The Access Viewer is a very handy way to explore what access rights have been assigned to a user or role. The
Access Viewer is found on the Launchpad; it’s the green lock icon (Figure 8-1). Simply click an item and the
roles and the users list will update to show those currently assigned to that item (Figure 8-10). If you select
one of those users or roles, such as the “sitecore\Author” role, as seen in the figure, you will then see green
checkmarks next to all the items that user or role has access to.

The right panel on the Access Viewer can help explain how a user or role has access to that item/access
right. If you click a column and an item, such as the Rename column on the Team node, as seen in Figure 8-10,
you'll then see how it came to be that sitecore\Author was granted that access right. This example shows
us how sitecore\Author was granted the Rename access right on the Home items along with all descendant
items. Knowing this can save you a lot of time if you ever want to update access rights. You should get very
familiar with the Access Viewer before too long.

233



CHAPTER 8 © SECURITY

Access Viewer

: &7 sitecore\Author (of7) * r\:l A ¥y Security Editor
Account £ sitecore'\Designer 20f7T) w» Assign Columns T User Manager
Name | Read | Write | Rename | Create | Delete | Administer The R?""m’ access rights for the
Team item
4 [J] sitecore = | Read » 0| Rename » B Create » B Delete » B Administer
4 & Content x| Read - O Rename [~ [3Create [~ [JDelete [~ C3 Administer ‘:"c”'“" " "
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¥ D Email Campaign x| Read = | Rename x | Craate x|Delete [~ O] Administer
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» & Medica = |Read « [ Rename < O Create - B Delete + B3] Administer
» @ Global x | Read « [ Write « O Rename < [ Create < O Delete « O Administer
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Figure 8-10. The Access Viewer is a great way to see how security is currently configured and who has access to
do what

Note The “Access Denied” page is not on brand. Most companies will not want users to inadvertently see
the Sitecore branded error pages. For the case of access denied, it is a simple web. config change to specify a
custom page to use instead (via the NoAccessUrl element).

Roles

Users are added to roles and roles are assigned access rights to items in Sitecore. Sure, you are able to assign
access rights on items to an individual user, but there is no good reason to do so. If you do, you'll end up
dying by a thousand cuts, and your security configuration will becoming increasingly more complex over
time. Roles, then, are very important to understand.
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Out-of-the-Box Roles and Role Inheritance

There are many out-of-the-box roles that you should familiarize yourself with. There are upward of 40 roles
in fact. Of the 40, there is also a complex inheritance structure. Roles can be in other roles, so by adding a
user into one parent role you may actually be adding them into 13 roles, such as the case with the Developer
role. Table 8-2 attempts to describe each of the 40 roles, what their purpose, what they allow by default, and
any applicable inheritance. The indentation (as denoted by P>) signifies the inheritance. So, Developer is a
member of Author, and Author is a member of Sitecore Client Authoring, and so on and so forth. You will
find yourself commonly using the tier 1 and tier 2 roles in most cases. For very large teams, you may find
yourself needing the extra granularity you get with tier 3 and tier 4 roles.

Table 8-2. Out-of-the-Box Roles

Anonymous Anonymous isn't really a role, and yet it acts like one. Anyone who
has not yet authenticated is a “member” of the anonymous “role”
until they log in.

Everyone Everyone is kind of the opposite of Anonymous, in that the

Everyone role will represent every logged in user. There's an
Everyone role for each domain, as well as a global Everyone to
represent all logged in users across all domains.

Sitecore Client User Sitecore Client User is a root role that every “Client” role below is
either directly a member, or indirectly via some other role. This
role provides access to the Sitecore (/sitecore) user interface.
Note: They won't be able to do anything when they get to /
sitecore if they are not a member of other roles.

Developer A Developer has a broad set of permissions; they can author content,
design pages, create layouts/components, and data templates.

» Author An author can create, edit, and delete items in the content tree (/
sitecore/content)

» P> Sitecore Client Authoring This role enables settings in the Content Editor to make editing
content possible.

» P> Sitecore Client Social Gives the user access to post messages to social networks from

Authoring Sitecore.

» P Analytics Testing Enables creating component and page tests. Also enables access to
the Test Lab.

» > Analytics Personalization Enables creating personalization rules.

» Designer This role enables settings to make designing pages possible, such

as component configuration and switching layouts. It also permits
changing design details on data template standard values.

» P> Sitecore Client Designing Provides access to the Experience Editor design features.
» Sitecore Client Developing Provides access to the Development Center and shortcuts required
by developers.
» Sitecore Client Maintaining Access to create and maintain data templates.
» Sitecore Client Configuring Allow access to configuration of items, such as the icon.
(continued)
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Table 8-2. (continued)

Sitecore Client Bucket Man.

Sitecore Local Administrators
» Sitecore Client Securing
» Sitecore Client Account Managing

Analytics Reporting

» List Manager Editors

Experience Explorer

» Analytics Maintaining

Sitecore Client Publishing

» Sitecore Client Advanced
Publishing

Sitecore Client Translating

Analytics Advanced Testing
Analytics Management Reporting

Analytics Content Profiling

Sitecore Minimal Page Editor
Sitecore Limited Page Editor

Sitecore Limited Content Editor
Facebook Message Reviewer
Social Marketer Message Reviewer
Social Message Author

Social Message Workflow Editor

Social Message Workflow Reviewer

Twitter Message Reviewer

Allows access to bucket settings in the ribbon, to enable converting
items into buckets. This role is also a member of Sitecore Client
Configuring and Sitecore Client Developing.

Can manage security and accounts.
Can manage item security through Content Editor or Security Editor.
Can manage accounts, roles, and domains.

Provides access to the marketing control panel, engagement plan
monitor, and the executive dashboard.

Can manage contacts lists, primarily for those using Email
Experience Manager.

Note: List Manager Editors is also a member of Sitecore Client
Authoring.

Grants access to use the Explore mode within the Experience
Explorer, as well as manage presents within the Marketing Control
Panel.

Grants access to the Marketing Control Panel, and the ability to
design engagement plans and supervise those plans.

Grants access to incremental, smart publish, and related items
publishing. Without this role, users will not be able to publish content
apart from a workflow set up to automatically publish after approval.

Grants access to republish already published items.

Enables translation features in the ribbon.

Enables extra functionality/tabs in the Marketing Control Panel
around testing.

Permits access to management reports around testing and
optimization.

Enables content profiling in the Experience Editor.

Restricts functionality in the Experience Editor to an absolute
minimum (no ribbon in the Editor).

Similar to Sitecore Minimal Page Editor, but shows a simplified
version of the ribbon with only key editing buttons.

Similar to Sitecore Minimal Page Editor, but for the Content Editor.
Enables the editing of Facebook messages.

Enables read access to social marketing messages.

Enables creating, editing, and deleting of social marketing messages.

Grants access to the Draft workflow state in the social marketing
workflow.

Grants access to the Awaiting Approval, Awaiting Post Review,
Post Accepted, and Post Removed workflow states in the social
marketing workflow.

Enables access to edit Twitter messages.
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You may also want to create your own custom roles. For example, your administrators may want
Sitecore Local Administration privileges AND Sitecore Client Publishing, allowing for security management
and the ability to publish content as a separation of duties from content editors. A custom role might be
“Contoso Sitecore Admin,” which includes both as members, where Contoso would be your company name.
In general, these 40 roles can be confusing, and it is a best practice to consolidate these to align to your
unique governance/role policies, prefixed by your company name to distinguish custom roles from their
out-of-the-box counterparts. The following is an example of a potentially helpful role consolidation, aligning
to your admins, content editors, developers, and marketers.

Contoso Global Sitecore Administrator

e Allroles

Note This Global Sitecore Admin role is a bit redundant. You can simply check the Administrator box on a
user to give them full control to everything. However, this is troublesome because they bypass workflows when
making changes, and there’s no out-of-the-box view to see who all your administrators are. Using a custom role
addresses these issues.

Contoso Sitecore Environment Administrator
e  Sitecore Local Administrators
e  Sitecore Client Publishing
Contoso Sitecore Content Editor
e Author
e  Designer
e  Experience Explorer
e  Sitecore Client Translating
Contoso Sitecore Developer
e  Developer
Contoso Sitecore Marketing Analyst
e  Analytics Reporting
e  Analytics Advanced Testing
e  Analytics Management Reporting
e  Analytics Content Profiling
e Analytics Testing
e  Analytics Personalization
Contoso Sitecore Marketing Administrator
e  Contoso Sitecore Content Editor

e  Contoso Sitecore Marketing Analyst
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Assigning Roles to Items

Just by being added to a role doesn’t mean you can do a whole lot yet. That role still needs to be assigned
access rights to items before they’ll become of much benefit. There are two main ways to grant a role access
rights on an item: 1) through the Content Editor, as seen in Figure 8-16, or 2) through the access editor, as
seen in Figure 8-11. The Content Editor is best if you know exactly which item you want to grant access to.
The Security Editor is best when you need to apply access to multiple items and you want to do it all at once
(versus opening each item individually).

The Security Editor will likely be where you spend most of your time; if you configure security once with
proper inheritance, you shouldn’t need to be configuring security on an item-by-item basis often. Notice
in Figure 8-11 how the Security Editor aligns with the content tree; as you expend the tree you'll notice
assignable access rights as columns across the top. If you click the checkbox next to an access right, it will
turn green, signifying that the access right has been applied. If you click the X that access right is explicitly
forbidden. Leaving neither checked/clicked allows room or potential inheritance.

Caution The Security Editor is a “hot editor,” meaning that changes you make immediately take effect;
no publishing is necessary. This is where a separate test/stage environment can be helpful if you’re not exactly
sure what settings you need to make.

In most cases, you will want the configurations you make to propagate down into descendant items.
You don’t need to expand every node and make the same setting. Rather, simply click the Assign button on
the item, as seen in Figure 8-11, and then check the Descendants checkbox to ensure that the access rights
are inherited down. This Assign button is the same button you'd find in the Content Editor when applying
security there, as can be seen in Figure 8-16.
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Assign Security Rights
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Figure 8-11. The Security Editor allow you to browse the hierarchy and directly apply security on an
item-by-item basis

Note Only administrators can see unassigned items.

You may have noticed that not all of the out-of-the-box columns are available in the Access Viewer. You
can add more granular access rights as column into the Access Viewer by clicking the Columns button and
then selecting which columns you want. Notice this in Figure 8-12.
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o Columns

Columns Add or remove columns from the view.
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Figure 8-12. Not all the access rights are displayed in the Security Editor, so you may need to add some more

Tip When managing security in the Content Editor, there still may be times when you want to quickly apply
access right settings across multiple items consistently. One way to do this is to copy the __Security raw values
(ass seen in Figure 8-13) and paste them into the raw values across all the items you want to match. Security
presets help you do the same thing, as is discussed in the next section.
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Figure 8-13. Copying the raw values is another way to easily replicate the same access rights on one
item to others

Caution If you ever delete a role, the access rights assignments on items for that role are not removed.
Over time this can lead to a bunch of garbage. It is a best practice to remove these assignments when roles are
deleted to keep your security configurations as clean as possible.

WORKFLOW SECURITY

Workflows deserve a bit of special attention. Technically speaking, security is applied to workflow in the
exact same way as any other item. But, knowing what do apply is a bit of a trick.

In the Appendix we created a custom workflow called the “Standard Publishing Workflow,” but didn’t
take that next step to apply security to it. Now with all the context found in this chapter, let’s finish that
workflow off with this important last step.

As discussed, we want editors to be able to start the workflow, but only reviewers can approve. A review
can approve, but they shouldn’t be allowed to publish to production. Administrators should handle
publishing. To keep things consistent, let’s use our “Contoso” best practice roles here as well, with the
editor being the Contoso Sitecore Content Editor, the reviewer being the Contoso Sitecore Marketing
Administrator, and the publisher being the Contoso Sitecore Environment Administrator.

The first step is to grant all three roles Read, Write, Workflow State Delete, Workflow State Write, and
Workflow Command Execute on the workflow itself and all descendant items. This will allow all roles to
start the workflow, advance states, and execute commands. Notice this configuration in Figure 8-14.
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Remove Inherit &
Require Login v . . .
Assign Security Rights O X
Click a role or user to edit its permissions for the selected item. To add a new
role or user to the list, click Add.
» © Path Analyzer Maps Roles and users: o
» % Regular Workflow sitecore\Contoso Sitecore Content Editor
- S sitecore\Contoso Sitecore Environment Administrator
bW Sample Workllow sitecore\Contoso Sitecore Marketing Administrator
» © Experience Analytics Segment
» % Social Account Renewal I

» & Social Marketer Message Workflow

» © Social Message Workflow

Add Remove
4 % Standard Publishing Workflow
» [ Dratt Permissions for Standard Publishing Workflow:
» [& Awaiting Approval Read x| ltem x | Descendants
» @ Awaiting Publishing Write x| ltem x | Descendants E-4
Y Rename v x|Item » = |Descendants
» Published
Create » x|ltem » x|Descendants
> © TestWF Delete + x|ltem ~ = |Descendants
E] Templates Administer v x|ltem « x| Descendants
. Workflow State Delete x | ltem x | Descendants
» i@ App Center Sync ¢ .
Workflow State Write » | ltem x | Descendants
» Branches \ "
L B Workflow Command =11tem =l Dascandants
i Execute
» & Common
Create Bucket v x|ltem » x|Descendants
» & Email Campaign Revert Bucket ~ x|ltem ~ = |Descendants
» i ListManager
» J Sample Inheritance:
» (@ System Inheritance » x|ltem » | Descendants

) User Defined

» ! Web Forms for Marketers
- Cancel
» ) Global

» ¢ Launch Sitecore

Figure 8-14. Workflow security is configured in the same way as when you secure any other item, but there are
a few considerations to take note of

Obviously the three roles are not all alike. Only one should be able to start the workflow, only one should
be able to approve, and only one should be able to publish. All three can currently do all three. The fix for
this is to go on each state and add a deny rule where appropriate.

Warning There’s an important best practice with Sitecore security worth mentioning, which is to deny
access via breaking inheritance rather than explicitly denying access. This is because in the case of conflicting
security definitions across different roles, “deny” will always win out. This may be overly heavy handed, where
simply breaking inheritance and applying unique security is more appropriate.
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For example, the Contoso Sitecore Editor needs a deny on the “Awaiting Approval” and “Awaiting
Publishing” states, to keep the fox from guarding the hen house. Likewise, the Sitecore Marketing
Administrator needs a deny rule on “Awaiting Publishing,” because publishing should be the job of the
Contoso Sitecore Environment Administrator. Note an example of a deny rule in Figure 8-15.

4

»
»

Remove Inherit

q 4 »

Require Login

» ®© Path Analyzer Maps

» ®© Regular Workflow

» ®© Sample Workflow

» © Experience Analytics Segment

» ® Social Account Renewal

» ®© Social Marketer Message Workflow

© Social Message Workflow

4 B Standard Publishing Workflow
» @ Dratt
» [& Awaiting Approval
» @ Awaiting Publishing
» @ Published

» © TestWF

=1 Templates

“® App Center Sync

# Branches

[l Common

(&) Email Campaign

{J List Manager

] Sample

@ System

) User Defined

-] Web Forms for Marketers
{2 Global

) Launch Sitecore

Assign Security Rights O X

Click a role or user to edit its permissions for the selected item. To add a new
role or user to the list, click Add.

Roles and users: ==

sitecore\Contoso Sitecore Content Editor
sitecore\Contoso Sitecore Environment Administrator

Add Remove

Permissions for Awaiting Approval

wa
Read - 0 item - §J Descendants i
Nrite v x|ltem » » Descendants 43
Rename v x|ltem » x| Descendants
Create v x|ltem » x| Descendants
Delete v x|ltem » x|Descendants
Administer » x|ltem » x| Descendants
Workflow State Delete v x|ltem » x| Descendants
Workflow State Write v x|ltem » x|Descendants I
Workflow Command

¢ | Item v ndant

Exatiik v x|lte = | Descendants
Create Bucket » x|ltem » = Descendants
Revert Bucket v x|ltem » x| Descendants

sele
Inheritance:
Inheritance v x|ltem » »|Descendants

Figure 8-15. Add a deny rule onto roles that shouldn't have the ability to advance the workflow state from one
state to another

With these security configurations in place, your custom workflow should be good to go!
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Security Presets

Security presets are a helpful way to apply the same set of access rights to items over and over. There are two
out-of-the-box presets found in the Content Editor within the Security tab, as seen in Figure 8-16.

HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENTATION SECURITY

H Remove Inherit 4 Q \\"‘ (X ] G Access Viewer
Save Require Login v Assign  Details Change 7 User Manager

Figure 8-16. Presets are another way to easily set the same set of access rights over and over

The two out-of-the-box presets are 1) remove inherit, which breaks all inheritance and defines rights
explicitly on the selected item, and 2) require login, which adds a deny read for anonymous users (as seen in
Figure 8-17).

i Q
m Assign Security Rights

Click a role or user lo edit its permissions for he selecled itlem. To add a
new role or user lo the list, click Add
Require Login

Holds a preset security definition

Roles and users

_ e . I

tem ID: {S06FCEI0-44A, 6954
Iem name: Require Login
»
Item path: sitecore/systemSetings/SecurityFres
»
Add Remave
[ Template: sitecorsfemplates/System/Security/Se
Pamissions for Require Login
2 Created from: [unknown] q o
Read - O tem « 0| Descendants
= Item owner: sitacora\admin Write - wltem + = |Descendants
emove Inharit
Renams x| ltem - = |Descendants
e _ o e T e I
Dalate = | ltem - | Descendants
Administel » u|ltem - = |Descendants
Security Preset s
Create Bucket < u|ltem < = |Descendants
Revert Bucket < u|lem = | Descendants
Account Permissions
L4 Inheritance
' & exranefAnonymous O Read
Inhegritance - x| ltam - = |Descendants
»
»
2l “ o
»
e Owanarite

Figure 8-17. The out-of-the-box Require Login basically removes annonymous users’ ability to view an item
by adding a Read deny rule

To create your own presets, simply create a new Security Preset item below the Sitecore/Settings/
Security/Presents item.
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It’s time to add users to your roles when all your roles are created and access rights are applied. Fortunately,
this is super easy. Simply open the Role Manager from the Launchpad, select the role you want to add a user
to, and then click Members where you can add your users. Click the Add button, and then search for either
the users or roles you want to add. You can see this in action in Figure 8-18.

Note When you add a user to a role, that user then is indirectly added as members into that role’s other role
memberships, thus inheriting those other role’s access rights in addition to the role the user is directly a member of.

& 4 838 g - T G Access Viewer
New Delete  Members  Member Of Domains  Users ¥ Security Editor

Members

& Serialize Role g Serialize All Roles

& Revert Role &° Revert All Roles

Add or remove the roles that must be members of the role you selecled.

Emailcampaign\Common Opt Out
sitecore\Analytics Advanced Testing

sitecore\Analytics Content Profiling

: 7 . - Domain | Local name
sitecore\Analytics Maintaining

sitecore\Analytics Management Reporting sitecore Bill
sitecore\Analytics Personalization sitecore phil

sitecoreAnalytics Reporting
sitecore\Analytics Testing
sitecore\Author
sitecore\Designer
sitecore\Developer
sitecore\ECM Advanced Users
sitecore\ECM Users
sitecore\Experience Explorer

sitecore\Facebook Message Reviewer

Add Remove

Figure 8-18. The last step—adding users to your roles

1 Full name | Comment
sitecore'\Bill User
sitecore\phil User
» M Page 1 of 1 (2 items)

Close
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Summary

Security in Sitecore is all about users, roles, access rights, and items. Users are added to roles, and roles
are assigned access rights onto items. That’s how it’s done, and setting up those four pieces is what was
discussed in this chapter, besides a few more advanced topics, such as workflow security.

Beyond this basic principle, however, was a comparison of all the out-of-the-box access rights and
roles. There are many! So many it can get confusing in a hurry. A key recommendation in this chapter is to
consolidate into fewer roles that better align to your company’s governance, terms, and nomenclature (as
well as work closing closely with your administrators and developers in designing and implementing your
Sitecore security). That is a sure way to making managing security in Sitecore easier for everyone.
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Governance

One of the most troubling observations I've noticed over my many years is how web site redesigns are often
treated as projects, rather than as products. A project has a defined beginning and end, a scope, a budget—
but then it’s over. A product might have a beginning, but most never think in terms of an end. Nobody is
planning on the end of the iPhone. They just keep making more and more, making it better and better and
continually aligning the iPhone roadmap to Apple’s strategic business objectives. Should your Sitecore
deployment be treated any differently?

Governance exists to ensure that as you plan for day 1, you also have a plan for day 2 and into infinity.
Your goal is to ensure all your hard work building the site has a plan for continued success and value
creation for your business. All too often sites are launched and neglected. All too often the great design in the
beginning turns into a pile of cow dung two years later because you allowed it to become the Wild,

Wild West.

Or, you end up shooting yourself in the foot. Consider the ill-timed Tweets. Off-message news articles
can ruin your reputation, and untested data template updates can blow up your site. Or, you may be
Canadian and have regulatory concerns around ensuring all content is perfectly translated into both French
and English. Governance is how you avoid these scenarios.

What Is Governance?

First, governance is not a document. You need a governance plan to be sure, but really, governance is
people, people creating rules and ensuring those rules are being followed. You're the legislature and the
police. You need both. The first key to governance success, however, is pragmatism. If your governance plan
is not pragmatic, it'll succumb to oblivion. If it’s too abstract, it won’t be understood. It needs to be clear,
concise, objective, and measurable.

Figure 9-1 depicts the Wicklund Framework for Sitecore Governance you can consider using with
your Sitecore installation. I'll be honest, if you ask 10 people what governance is, you'll get 10 answers. Based
on my personal experience leading governance workshops and installing governance committees, this
framework of mine has proven itself over and over, but I won’t be so naive as to not acknowledge many other
ways to structure your Sitecore governance program. That’s why I'm branding this framework with my name;
not to be narcissistic, but rather to acknowledge there are many ways to shape/frame your governance
strategy.

Most people start a governance conversation with roles and responsibilities. I think this is the place you
should finish, not start. Rather, start with the work. Define what the policies are and how you’ll enforce them.
Discuss what your procedures are and who will perform them. Thereafter, you'll get a much better sense for
what roles you actually need, and those individuals serving in those roles will understand what is expected
of them.

© Phillip Wicklund 2015 247
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The key concepts of the Wicklund Framework are:

e  Policies define what the rules are, but they also need to be audited to ensure
compliance.

e  Procedures set expectations with all stakeholders on how you'll respond to events,
but procedures also correspond to ongoing tasks that need to be performed by
people or by automation.

e Those tasks can be estimated and resource leveling can help you understand what
key roles you need and what resourcing gaps you may have.

e  The Product Owner is the most important role (the role who owns the long-term
vision for the product’s strategic direction, the one who is primarily accountable to
the entire products success or failure); the Product Owner is in the business, not the

IT dept.
¢ Committees need to be installed to hold the various roles accountable, including the
product owner.
Policies Procedures
(Audits) (Ongoing Tasks)
L 4 L 4

Roles & Responsibilities

(Committees)

Figure 9-1. The Wicklund Framework for Sitecore Governance can be applied to your Sitecore installations to
help ensure continued success over time

Policies

Policies form the heart and soul of any governance plan. In the simplest of terms, they describe what is and
is not permitted. Governance is all about maintaining a healthy environment, but how will you define what
constitutes healthy? Policies offer that definition.

When you set up Sitecore you likely spent a lot of time and money defining data templates, an
information architecture, a content strategy, style guidelines, security rules, etc. All those details shouldn’t
be forgotten on day 2. Day 1 is about launch. Day 2 is about governance.

The first area of policy consideration are content policies. Who owns the content? What types of content
are there? Are there different editing, approval, and publishing rules depending on the type? These, and
many other questions, can be found in Table 9-1.
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Table 9-1. Content Policies

Topic

Description

New/update content
policy

Content approval policy

Content publishing
policy

Media

Global/multilingual/
regional content

Content expiration,
archiving, and deletion

Versions

SEO policies

What are your policies around content strategy? Should content be “on
message”? Do you need multiple content policies for different areas of your site
because there are different content messaging expectations?

Will you allow new/update content requests from the business, partners, or
vendors? When will you reject a request for new/updated content?

When will you reject a request for content approval? Will you have different
workflows for different content areas within the installation? Will some areas of
the site have a more streamlined approval process (less risk) and others have a
more thorough approval process (more risk)? Should all content be “approved
with test” to ensure it’s optimized? When should you test and when shouldn’t
you? Will you require content to be tested for cross-browser ascetics before you
approve, or will you assume it’ll look fine (consider HTML editors)?

When will content be published? At any time of the day, bulk nightly publishes,
weekend publishes? What types of content can be published on varying
frequencies? Do certain types of content require no approval and the ability to
bypass publishing (e.g. blog post comments)?

How and where will you manage media? Consider all the previous content
policy questions, but this time for media. The answers will likely be different.

Consider all the previous policy questions and ask them again, but with a global
perspective. What is your translation policy? Does any new content need to be
translated into X languages before being released? Are there certain acceptable
agencies for external translation? Do you allow machine translation?

Should certain types of content expire? If they expire, should they be archived
or deleted? If deleted, when should the Recycle Bin be emptied? Never, or on
some rolling basis?

How many versions of an item should be maintained? By default all versions
are maintained indefinitely but that can be a waste of storage and can slow
down editing performance over time.

Which URL conventions, keyword best practices, or other SEO rules do you
expect your content editors to be taking into consideration?

STRATEGY BITS: HOW TO HARNESS THE POWER OF CONTENT

The “How”: Content Governance Continued from Chapter 2

This is the area that is often most difficult to get people excited about but ironically, can be the most
impactful thing you can do with content strategy in your organization. You may have followed all the
steps and created world-class content for launch, but if you don’t have a plan for how you’re going to
manage that content— either as an individual or a highly-matrixed global organization, then ultimately
you won't see the success you hope for.

Before your experience goes live, make sure you have agreement and documentation on the following

areas:
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How Decisions Are Made

Does Jimmy in Sales or Natalie in Product get to put their content in the upper-right corner? Who
has the final say on the homepage image? Can a manager decide to change a form on the web site?
Content governance can help with these very common scenarios.

Governance can often be a tricky undertaking if you’re in a complex organization (because often it can
refer to people’s roles and ownership), but at the least, make sure you outline:

e The roles and responsibilities of the people involved in making decisions about content
(it helps to separate out the day-to-day tasks from the higher level strategic decisions
here, as you’ll find different people may need to approve different things.) If you're in
a highly regulated industry (such as financial services or healthcare), you'll find that
many steps are needed before you can push something live. Document those steps, the
roles, and the expectations around format and timing and get commitment from people
on those items before you launch. If you do, you’ll be a step ahead.

e The guidelines people should follow if they’re being empowered to manage content
(these can include assets such as editorial or creative style guides, which can help
create consistency).

How People Will Work Together

The most successful content strategy efforts are collaborative and involve of partnership with the

user experience, search engine optimization, or technology teams during and after launch. Talk as an
organization about how your efforts should combine early and vet solutions as one team as often as you
can. Post-launch, formalize that process as much as you can with inclusive planning conversations with
the core team that will help carry forward the strategic intent of your experience.

How Content Will Be Managed

There are a plethora of tools available to help you manage content beyond launch, from tools that
auto-publish your social posts while you're on vacation to analytics and editorial platforms that help you
create performance and efficiencies.

Think ahead to what you or your team will need to be successful after launch. Sometimes teams find
that the simplest Google Document can help a team collaborate on editorial ideation. Other times,
organizations find they actually do need to invest budget into a technology platform that for example,
helps them monitor social conversations, so that they can anticipate customer content needs or issues.
If you're working with a specific content management solution, you may already have these tools at
your fingertips, but just need to look closely at how they can help you.

Last but not least, don’t forget to outline how you will archive your content.

e Start with your organizational needs. Highly regulated industries will need to store
documentation for 7+ years. Others may not. Consult your legal department to check what type
of content should be stored, what level of detail is needed and how it should be kept. Some
organizations have sophisticated document management systems (DAMs), but most still rely on
e-mail or shared drives. Choose the one that will provide the best protection for your content.

e Think about what you want your “source of truth” for your content to be. If you created
an inventory as part of your planning process, consider treating it as an evolving tool to
help you keep a clear view not only of your content but the information associated with
it (such as metadata or analytics code).
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Content strategy is a wonderful mix of planning, imagination, and governance. Executed with passion,
it can make or break digital experiences and has the ability to truly empower and lift up the teams who

create them.

Laura Best

President, Best + Co

http://www.bestdigitalstrategy.com

Information Architecture (IA) is another area worth governing. A good IA helps improve usability,
helps users find information faster, and improves consistency. IA can be enforced with things like Insert
Options and Allowed Components, but admins can go around these barriers so it’s important to keep
tabs on how your configuration is evolving over time. Check out Table 9-2 for some IA policy questions

worth discussing.

Table 9-2. Information Architecture Policies

Topic

Description

Insert Options and
Allowed Components

Clone, copies, and
versions, oh my!

Buckets

Navigation

Site IA User Experience
polices

You will want policies that determine which types of content items can

be created where, as well as which components can be added into which
placeholders. Sure, this is a configuration in Sitecore, but your governance
plan should be the source of truth, not how it’s actually configured (hopefully
they’'re in sync, however).

Asyou learned in Chapter 2, there are several unique ways to manage copies
of content, but each with certain plusses and minuses. You may want to have
policies on when to use which.

Policies on bucket use—when to use them, when not to.

How will you manage navigation? Who can update navigation links, search
filters, etc.? For global/multilingual/regional site variations, this concept of
navigation maintenance can be contentious, especially when navigation or
content is centrally managed and distributed.

What are your standards around information finding approaches for your
customers (browsing vs search vs faceted search) and use of Ul elements (tabs
vs accordions vs whatever else)? These policies are especially important when
your Sitecore implementation is very open-ended (components on an open
grid vs preset page layouts).

Data quality is an important consideration for every company. You can put a lot of data in Sitecore—or
around it—managed or viewable in Sitecore. Therefore, you may want policies specific to data usage to
control how it’s used, where it comes from, and so forth. See some example considerations in Table 9-3.
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Table 9-3. Data Policies

Topic Description
Field type policies Describe the field types and how they are being used. Data types such as phone
(field validation) numbers should have specific policies as to what the content editor should

Third-party data
integration/validation

enter, or better yet, what the validator is validating.

You may be integrating with external systems and you may need policies that
stipulate the rules for those integration points, such as dependencies on data
being in a particular format, etc.

Having a consistent look and feel across your digital property is paramount (unless the brand is
intentionally different). Your governance plan is a great place to denote policies on look and feel. See some
example policy considerations around style in Table 9-4.

Table 9-4. Style Policies

Topic Description

HTML editors Will you permit HTML editors to enable content editor flexibility, but at
the risk of stylistic variance? Note: The HTML editor in Sitecore can be
customized on a field-by-field basis to explicitly grant/deny certain HTML
elements. This is a great way to enforce your policy.

HTML compliance Are you requiring all HTML to meet strict W3C compliance standards?

Accessibility compliance

Brand guidelines

Style guidelines

Layout guidelines

What level of compliance are you requiring? What validators are in place to
automate validation of compliance?

Do you need to meet Section 508 or WCAG accessibility standards? These
policies are especially important for government sites in the United States
and most public sites in the EU.

Your company likely has brand guidelines (colors, fonts, and imagery) that
are required to be used on your digital properties. Noting these requirements
in your governance plan is essential. You likely may have hundreds of policies
regarding your brand usage. Oftentimes these are represented in a “digital
style guide,” but your governance plan should denote expectations around
the importance of aligning to the guide. See the following site for some great
real-world examples of digital style guides: http://saijogeorge.com/brand-
style-guide-examples/.

You likely spent a lot of money with a creative agency to design your digital
experiences and create a style guide, denoting font usage, sizes, rotator
specifications, etc. The Content Editor will likely need to abide by these
specifications and they should be noted in your policies.

Different types of pages or various places in your sites may have different
layout policies. Designers can put content anywhere, unless it’s locked down
with allowed controls or through stylistic policies in your governance plan.
What are your guidelines for what should be above/below the fold? What calls
to action should be prominent, versus other less prominent ones?
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Security is an interesting one. This is a place where you actually tend to not want to rely on policy.
Rather, you want to rely on configuration to guarantee that policy isn’t breached, and you want to rely on
procedures to ensure the configuration is maintained (such as adding users into the right roles). Still, you
need a source of truth, for how Sitecore should be configured. Shortcuts, laziness, forgetfulness, and other
human error happen; your security configuration itself shouldn’t be the source of truth. As such, you should
document all your roles, their purpose, and other security policies in your governance plan (more thoughts
in Table 9-5).

Table 9-5. Security Policies

Topic Description

Roles Describe your roles (see Chapter 8) and how they are to be used, those who should and
should not be in them, etc. Security is one thing you don’t want to govern, per se. Security
should be systematically enforced through proper configuration. If you have very broad,
generic security roles you will rely more on policy to enforce compliance, but with Sitecore’s
robust security configuration options it’s easy enough to rule out this risk. Other things to
consider:

o Authentication sources (where are users coming from, what can different types of users do
or not do, etc.)

 Security hardening policies (IIS configuration, firewall rules, least privileged service
account configuration, etc.)

 Partners/vendors/customers (data sensitivity and/or compliance concerns)

Many industries care a great deal about regulatory concerns. Some content, after it’s deleted, still needs
to hang around for seven years or more. Patient data or cardholder data might find its way in your xDB
analytics (goals, events, etc.), which may have a HIPPA or PCI implication. See Table 9-6 for some regulatory
policy considerations.

Table 9-6. Regulatory Policies

Topic Description

Sensitive data in xDB Be careful what you're tracking. xDB is fantastic at tracking every bit and byte
about customers and their interactions (personally identifiable information).
Those interactions, however, can be personal. Do you have healthcare
content and calls to action that could signal personal information? You will
want policies on types of goals, events, failure events, campaign interactions,
and outcomes that you don’t want to be tracking because of regulatory or
compliance concerns.

Auditability Describe any regulatory concerns around the auditability of who published
what and when. In some cases, you may need to prove content was or
wasn'’t available at some point in time. Backups can be a way to do this, but
at considerable storage costs. Perhaps a custom audit table might be worth
considering.
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Much can be governed from a technical perspective. What are your policy on cache size? Do you have
policies on placeholder arrangements and layout usage? Will you use Team Development for Sitecore
(TDS - http://bit.1ly/1iIvusp) for developer collaboration? The list could go on and on, but considering
most are beyond the audience of this book, Table 9-7 focuses more on general policies that concern most
stakeholders.

Table 9-7. Infrastructure and Environment Policies

Topic Description

Product change control ~ What types of production changes are permissible and by whom? Can all
content changes be published whenever the business wants, or are there types
of content that should be published at specific intervals? What about layouts,
components, and data template updates—when can they be published?

What expectations will you set with the business around code and bug fix
change windows? Once per month for server-side code changes is common,
but will that be too limiting for a fast-paced marketing department? What
are your requirements around backout steps and backups in case of a failed
deployment? Will you permit the environment to be taken offline during a
change window, or must you maintain constant availability?

Uptime and performance Are you making commitments to the availability of Sitecore? 99.9% allows

service level agreements 8 hours, 45 minutes of downtime per year. 99.999% (“three nines”) only allows
about five minutes per year. You likely need granular SLAs for each service
supporting Sitecore because various outages may or may not be acceptable
(e.g. content delivery vs. content management, MongoDB vs. xDB processing,
and core infrastructure components such as SQL Server, server hosts, and
networking).

From a performance perspective, how responsive should the site be? All pages
should return in <1 second?

Each has dramatic infrastructural implications. Three nines will have a much
larger server footprint than one nine. A guarantee of responsiveness typically
requires cloud-based auto-scaling and stringent load testing before changes
can get through the change control.

Recovery time objective  If the site goes down, will you provide a guarantee of when it will be
(RTO) brought back up again? 4 hours? 1 hour? 24 hours? This can have dramatic
infrastructural implications.

Recovery point objective  If the side goes down, how much data loss is acceptable? 4 hours of data loss?
(RPO) 1 hour? None? This can have dramatic infrastructural implications.

Procedures

Defined procedures help you align on how you and your team will respond to certain events or requests.
You can also set good expectations with your stakeholders along the lines of who to contact, how to submit a
request, what their expected response time should be, and so forth. Documented procedures are an integral
part of a governance plan. They spell out “how” that work will be done.

Tables 9-8, 9-9, and 9-10 have several example procedures you may want to consider for your
governance plan. These lists are not meant to be exhaustive, but it should give you a good example of the
types of requests and procedures you should be planning for. There are three main categories of procedures:
support procedures, content procedures, and environment procedures.
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Table 9-8. Support/Requests Procedures

Topic

Description

New user setup

Password reset request

New module from marketplace
or third-party add-in request

Request for new feature/
component

General content editor support
request

New campaign landing page
request

How will you set up new users? Will you have a registration for self-
registration or will you require a manual setup? How will you know what
security settings are appropriate for different types of new user requests?
How will you send password information for manual setup?

These policies may be different for Sitecore users vs. customer users, etc.
If a user locked his password, who will he contact to get it unlocked?

Will you allow the business or others to request modules/add-ins? What
is your process for vetting these requests? What if they send you some
code they want you to add into the solution? Will you support that code
once it’s in the solution?

How will the business or other stakeholders request development time
to implement new feature requests? Will you manage a backlog of
requests? How are requests approved and prioritized? Where does the
budget come from for minor, non-project related enhancements?

Sitecore isn’t the easiest technology to learn. Who will users reach out to
when they have questions?

Marketing loves spinning up landing pages for their campaigns. Who
will create them? How are they requested? What features/functionality
are you offering or limiting them to? How will custom/advanced landing
page requests be handled?

Table 9-9. Approvals and Publishing Procedures

Topic

Description

Content update request

How will you respond to content update requests from your business or

partners? Who will they contact? Will you have a ticketing system? What is
your service level agreement (response time) for low-priority, high-priority,
and emergency content requests?

Content approval request

How will you respond to content approval requests from your content editor

team? Who will they contact? Will you use a workflow or manual process?
What is your service level agreement (response time) for low-priority, high-
priority, and emergency approval requests?

Content publishing
request

Who handles publishing requests? Are they automated into a nightly batch
publish, or do you want a human actually looking at and vetting requests?

What is your service level agreement (response time) for low-priority, high-
priority, and emergency publishing requests? What’s your procedure for
“emergency” requests?
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Table 9-10. Environment Procedures

Topic

Description

Non-emergency issue resolution request
Emergency break-fix/outage response

Production environment/infrastructure
change request

Disaster recovery procedures

Windows and/or Sitecore updates/
upgrades

Proactive administration

What will happen if someone finds a bug?
What will happen if something is broken?

What will happen if a change requires server-side changes?
These are high-risk changes as compared to general content
updates. How are they handled? How often will you allow
these types of changes? Once per month? What if there’s an
emergency?

You may want to identify all your disaster scenarios and have
recovery procedures for each to offer guidance and sanity
during an emergency. This is crisis planning and prevention,
when you consider how the planning will identify gaps you
may end up filling (such as adding redundancy, etc.).

What are your procedures to install/test a windows update?
What are your procedures to install/test a Sitecore update?

Will you have procedures around proactive administration
of the environment that must take place (e.g., checking SQL
maintenance plans, checking logs, checking free disk space,
disposing the Recycle Bin, etc.)?

Ongoing Tasks and Audits

Each policy discussed in the previous section should have a corresponding audit task to ensure compliance
over time. If you don’t plan on enforcing the policy, the policy shouldn'’t exist. Again, you want your
governance plan to be pragmatic. Individuals should be assigned granular, specific, and measurable tasks
that ladder up to policies and procedures that form the core of what you want to govern. High-level abstract
tasks are unenforceable and shouldn’t exist in your governance plan.

Procedures, too, should have corresponding tasks. A “new user request” procedure may result in an
actual person doing some work. That work should be defined, assigned, and estimated for resource leveling

purposes.

Use the format found in Table 9-11 to capture all the tasks coming out of your defined policies and
procedures. You want to capture the topic/category, the task detail (specific and measurable), the owner/
role (who is assigned to the task), the frequency in which the task will be performed (five times per week,
weekly, monthly, etc.) and the estimated hours per week that will be spent performing the task. If the task is
a monthly task, divide by four to come up with an average hourly estimate, for example.

Note It would be redundant to restate all of the policies and procedures in described in the previous
sections, so the focus in Table 9-11 is more to demonstrate the concept, not to be exhaustive. That, and every
company is going to identify different policies and procedures, so every company's audit/tasks will be different,
making an exhaustive list impossible. Rather, consider this a framework you can follow and extend.
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Topic Task Owner Frequency  Effort (hrs / wk)
Analytics Monitor path analyzer and compare Marketing Monthly 1
current month’s top paths to previous analyst
baselines. Summarize findings.
Analytics Review testing/optimization results. Marketing Monthly 1
Summarize findings and trends. Identify analyst
top opportunities for future tests.
Personalization Review events, failure events, and goals Marketing Monthly 4
accrued for each persona over the past  analyst
month. Compare trends over previous
samples. Identify trends. Determine if
original expectations for the personas
are actually correct. Summarize
findings and identify updates needed
to personalization strategy plan, if
applicable.
Information Ensure no item templates have been Technical 2x Yearly 1
Architecture created below items from which thereis lead
no Insert Option. Ensure Insert Options
align to the Information Architecture
(IA) as defined in the IA governance »
allowed Insert Options section.
Content View keywords in Google Webmaster Content Monthly 1
Tools. Ensure alignment to keywords approver
strategy. Summarize findings; identify
recommendations for content editors.
Content Run versions script to identify items Environment Monthly 1
with more than 10 versions. Trim administrator
versions >10 where appropriate to
reduce storage footprint and increase
content administration performance.
Content Run archive script to identify expired Environment Monthly 5
content. Archive all items. Summarize  administrator
what was archived.
Content Approve content if it meets approval Marketing Daily 2.5
guidelines. administrator
Content Publish content according to publishing Environment Bi-Weekly 2.5
guidelines. administrator
Campaigns Summarize status across all engagement Marketing Weekly 2
plans (number of new customers analyst

entered into engagement plans,
current numbers across all states,
drop out counts). Identify bottlenecks
and strategies to improve progress.
Summarize findings.

(continued)
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Table 9-11. (continued)

Topic Task Owner Frequency  Effort (hrs / wk)
Campaigns Summarize campaign interactions, Marketing Weekly 2
number of conversions, and path analyst
analyzer results to determine drop
off points. Summarize findings,
identify recommendations to improve
conversion.
Environment Run security penetration testing tool Environment Monthly 5
against web site. Summarize findings. administrator
Environment Run a DR simulation on the SQL server. Environment Quarterly .25
Remove node A from the availability administrator
group. Ensure DR site stays online.
Performance Run load simulations against DR Environment Yearly -
environment in preparation for administrator

Black Friday. Ensure performance
benchmarks are met. Summarize
findings.

Roles and Responsibilities

It is all too common to start with roles, and then figure out what they are responsible for. The good thing for
you, is in previous sections, you saw how we started with the work, from which you can extrapolate the roles.
Never identity/create a role if you don’t know what the work is and what they are accountable for. Never
identity high-level, abstract responsibilities. Rather, identify granular, measurable responsibilities to ensure
the resource really understands their duties. You saw these examples in the previous section. With those
understood, you can start planning your roles and do some resource leveling.
By way of generalization, there are some common Sitecore roles you may end up identifying. They may
fall along the lines of the following roles:

e  Product owner/manager

e  Technical lead/architect

e  Content editors

e Content approvers

e  Content publishers

e  Marketing analysts

e  Marketing administrators

e  Developers

e Infrastructure administrators

e Business analysts
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Note The product owner is the only role worth defining at this point, because it’s the most important
role and a role that far too often doesn’t exist. The product owner’s main objective is to ensure Sitecore’s
(really the digital experiences—it doesn’t have to be technology specific) ongoing alignment to the business’
objectives. This person owns the product roadmap. She sets the overall direction for other roles and holds other
roles accountable to her tasks. She is the one held accountable to ensure governance is actually happening.
This person should be in the business, usually the marketing department, who often has acumen of a digital
marketing technologist when owning a product on the Sitecore platform.

The names of the roles really aren’t the point. The point is, who is doing what tasks? If you're assigned
the marketing analyst, do you understand what that means? Do you know what you're responsible and
accountable for? Do you have enough capacity to perform the duties assigned? These are the more
important conversations than simply getting a list of roles defined. Every list of roles at every company
will vary, since nobody will have the same list of tasks and priorities needed to governance their Sitecore
instances. Therefore, focus on the work, not the role, and you'll be better off because of it. People understand
tasks; roles can become ambiguous over time.

Table 9-12 shows an example resource allocation by role by the accumulated hourly allocation of
tasks. This is a great way to understand how the work is distributed. This is also where “roles” can break
down. Maybe the marketing analyst has 28 hours per week of assigned tasks, but only 20 hours per week of
capacity. There may be tasks the product owner could take off the analyst’s plate to balance the scales. After
all your tasks are defined in a matrix like Table 9-11, summarize them in a format similar to Table 9-12 and
see how the dust settles. Update Table 9-11 if there are over allocations and where it makes sense to move
tasks onto other, perhaps less obvious choices. O, this can be a great way to justify adding additional head
count onto the team to handle the workload.

Table 9-12. Example Governance Resource Allocation Worksheet

Role Hours/Wk of Meeting Hours/Wk Total Hours/Wk Current Capacity Variance
Assigned Tasks

Marketing Analyst 26 2 28 20 -8

Content Approver 8 2 10 10 0

Architect 12 1 13 10 -3

Product Owner 6 4 10 16 6

Governance Committees

So, you have tasks, you have roles, you have assigned resources, but how do you hold those individuals
accountable to getting the work done? Unfortunately, it is all too common to establish a governance plan,
but it peters out over time as people get busy, distracted, reassigned to new priorities, etc. Don’t establish a
governance plan unless you're willing to put structure in place to make it long-lasting.

A great way to enforce governance accountability is through the use of a committee. Everybody assigned
a task needs to report back at each committee. This provides awareness, transparency, and accountability to
getting the work done. It also achieves peer accountability, which is a more reliable way to ensure the right
things get done (versus a top-down approach).

There are three main committees you should consider. You may tailor this to be more or less depending on
the size of your organization, inherit risk, and/or frequency of change. Again, the product owner and technical
lead are the two core team members driving governance adoption, in this case, by facilitating these committees.
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Table 9-13. Example Governance Committess You May Want to Establish

Committee Name  Description Frequency Members
Product Steering This committee provides the Monthly or Product owner
Committee overarching strategic leadership of quarterly, (facilitator)
the product. Over time, the objectives  depending on Key business
of the company may deviate from availability stakeholders (e.g., CMO,
the original goals of the product and CIO, etc.)
the core goal of this committee is to
maintain strategic alignment.
Committee agenda:
¢ Review progress of product
roadmap
o Review monthly KPIs
o Discuss any changes in direction
that may be necessary
Content Marketing  Don'’t think of this committee as your =~ Monthly Product owner
Committee “digital marketing operations” team. It (facilitator)
will be hard for you to keep the day-to- Technical lead (passive
day out of the discussion. Instead, this participant)
committee’s goal is to ensure alignment Anyone else assigned
to content- and marketing-related content- or marketing-
policies as defined in the governance related tasks/audits
plan, as well as a forum to review
findings coming out of the ongoing
tasks (such as analytics trends).
Committee agenda:
o Task/audit owners report back on
findings
o Review progress of content and
marketing campaign roadmap(s)
¢ Discuss needed roadmap updates
based on observed trends
Technology The goal of this committee is to Biweekly or Technical lead
Committee ensure overall health of the product’s  monthly, (facilitator)
underlying infrastructure and dependingon  Product owner
performance, as well as to oversee frequency of Infrastructure
production changes to mitigate change change administrators
risk. Other technology
Committee agenda: stakeholders

o Task/audit owners report back on
findings

e Review progress of technical
roadmap

¢ Change Approval Board (CAB)
reviews change requests, allocates
to change windows, etc.
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Summary

Governance is how you ensure lasting success and value creation of your digital and Sitecore experiences.
The Wicklund Framework for Sitecore Governance attempts to be as pragmatic as possible to make
governance as achievable long term as possible. The framework starts with the rules and defines the work to
ensure those rules are enforced. That work is then laddered up into roles, whereas most start with abstract,
poorly understood roles that create an accountability challenge. Roles, then, are held accountable through
the use of committees. Each role has a duty to summarize their finding since the previous committee
meeting. The product owner keeps the gears turning, ensuring that the committees meet regularly, and has
primary accountability of the overall success/failure of the Sitecore installation over time.

This is the last chapter in this book, and governance is a fitting place to end. It’s a great place to end
because, in a very real sense, governance is really the just the beginning of a much larger journey.

As a signoff, I want to encourage you to look me up on LinkedIn, check out the book’s web site for
updates/errata, or drop me a line for help or consulting opportunities. Good luck, and I look forward to
continuing the discussion with you!

Sincerely,

Phil Wicklund

phil@sitecoreconfig.com
http://www.sitecoreconfig.com
http://www.linkedin.com/philwicklund
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CHAPTER 10

Appendix

This appendix covers topics that go a bit beyond the core audience of this book, but which still are applicable
for those who want to go a bit deeper. These more advanced topics are:

e Data templates—Learn how to create the foundational data structures from which
all content in Sitecore is create (this section provides some foundational concepts
introduced in chapter 2)

e  Standard values—Learn how to set default values for fields, default presentation
and layout settings, and apply workflows to content items through their standard
value settings

e Custom workflows—Learn how to build custom workflows

e Architecture—Learn about server roles, deployment models, authentication options,
e-commerce solution providers, and CRM integration

e  Federated Experience Manager—Learn how to extend your content and analytics into
experiences not built on the Sitecore platform

Data Templates

Data templates are the foundation of your Sitecore deployment. They specify the data fields and many other
settings that can be applied to content upon creation. For example, you might want to feature a promotion
of a given product. Both of these items represent content that a marketer will create, test, and perhaps
personalize based on who the users are and their preferences. Before developers can get started, however,
they need to configure the data templates that represent these content items, and thereafter they must create
the components to render the promotions. Let’s get started with creating the data templates.

Creating Data Templates

We will need two data templates for our promotions example (as discussed in chapter 2). The first data
template will be the definition for a featured product. The second data template will define the fields and
settings for the promotion itself.
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Note You may or may not want to store product information in Sitecore. Product details are often stored in
your ERP or PIM system, SAP. Other times, it can be helpful to store a subset of product information, such as in
this case when all we want to do is featured a product. We only need a few basic fields and data duplication is
kept to a minimum. No doubt, however, this can be a slippery slope, which is why it is so critical to thoroughly
think through your information architecture before construction begins.

For the purposes of demonstration, our Featured Product data template will have the following fields:
e  Product Name
e  Product Description
e  Product Images
e Related Products
e MRSP

Our Promotion data template will have the following fields, several of which are inherited from an
out-of-the-box data template in Launch Sitecore called Promo Spot:

e  Title [from Promo Spot]

e  Text [from Promo Spot]

e Link To [from Promo Spot]

e  Link Text [from Promo Spot]
e Image [from Promo Spot]

e Related Products

e  Discount Percentage

e  Target Persona

Since a featured product is rather generic and be used for many purposes, that data template is separate
from the promotion itself to maximize reusability. This is an important point.

When considering your site’s information architecture, you must pay careful consideration to
opportunities for data reusability. Data duplication is never a good idea, Sitecore included. Notice in this
example how a promotion has a selection of one or more related products. A marketer can, therefore, create
a new promotion and select which products it relates to.

Tip Plan your site’s information architecture accordingly to allow for maximum reusability of data
templates. If you have a very large data template with many fields, you likely are ripe for refactoring.
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PRACTICAL TIPS: SET UP YOUR TREEVIEW FOR MULTISITE SUPPORT

Before we create these data templates we must start by validating the structure of our treeview. Below
Templates, it is a best practice to have at least two custom folders: Global and another, one for each
site. Notice in Figure 10-1 the Global folder. This folder can store all generic templates that do not
pertain to any particular Sitecore site. Oftentimes in multisite situations you will want to reuse templates
and this is a perfect way to do this.

4 [F] Templates Options
» @ App Center Sync
» & Branches
» ) Common New Template | Template Folder
» ) List Manager
» ] Sample i
) Items in the Folder
» @ System
{J User Defined ) .
4 J Global = JJ
» il Content Templates = "
g Article Article Folder
» . Settings Templates 22 usages 1 usage
4 ] Launch Sitecore
» E] Article \
» [ Article Folder
» L Article Group @ 3
» [5) General Page 3
Home Job Function
» & Home 2 usages 5 usages

» A Job Function

» [E Microsite Home

Figure 10-1. When you use global folders, it is easier to share resources should you decide to use Sitecore to
manage multiple sites

By putting them into a Global folder, you can configure permissions on that folder such that marketers

in the different sites can only see their site and the Global folder for their templates. The alternative is a
giant mess. Start using the Global folder pattern from the start, regardless if you think you will never need
multiple instances. If you change your mind down the road, this pattern will save you a ton of rework!

Notice also the Launch Sitecore folder. This folder is for the site instance and its name will be a name
your marketers will easily recognize when differentiating the sites.

Note In general, you will not be putting anything in any of the other folders below Templates besides the
ones you create. If you didn’t create it, don’t touch it!
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To follow best practice, I will be creating both data templates in the Global folder, and the appropriately
named, Content Templates folder, as both are highly reusable in the future should we expand into a multisite
scenario. Use the following steps to configure the two data templates:

1. From the Sitecore Launchpad, click Content Editor.

Select the Templates node in the treeview. If a Global folder or site instance folders do not exist,
create two new folders by clicking the Template Folder item in the Insert Options picker within the ribbon
(Figure 10-2). Type an appropriate name and click OK.

— HOME NAVIGATE REVIEW ANALYZE PUBLISH VERSIONS CONFIGURE PRESENT.

] Template Folder {10f3)

/ [E] New Template (20f3) % Duplicate v Delete «
b d
¢ Message X

4 |=| sitecore w  Enteraname for the new item:
4 & Content
MySiteName|
» & Home

» (B Developing in Sitecore
» @ Global “ Cancel
» @ Layout
» & Media Library
» @ Social
» W3 System

4 [E] Templates _

» 4@ App Center Sync

N B o

Figure 10-2. You want to create custom folders below the main nodes, rather than add your items to the root
of nodes directly

2. Similarly, create a Content Templates folder below Global.

3. Right-click the Content Templates folder you just created and select Insert » New
Template from the drop-down.

4. Provide Featured Product as the template name and leave the base template set
to Standard Template (more on inheritance later).

5. Click Next and confirm the location is Content Templates. Click Close.

6. Lastly, we need to set an icon for the node. Within the Ribbon, click the
Configure tab. In the Appearance ribbon section, you'll notice an Icon
drop-down. Select an icon of your choosing.
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Tip Icons are important! It is very easy to get lost in the Sitecore treeview. Using custom icons with
commonly used nodes helps increase usability and speed of administration.

Repeat these steps for the Promotion data template. The only difference with Promotion is that it
will not inherit from standard template but rather from Promo Spot. This template has some standard
properties and will allow us to tie it into the out-of-the-box promo component that comes with Launchcore.
Inheritance will be discussed in greater detail in a later section. Afterward you'll have two empty data
templates ready for configuration!

Note These steps are continued in the “Completing Our Templates” section later in this appendix.

Data Template Fields

We know what fields we need for our Featured Products and Promotions data templates, but before we
go off the deep end and start creating them, there is some more requirements gathering we need to do.
Much will be said of the myriad of settings that can be applied to data templates throughout this section,
but fundamentally you must consider Sections, the field’s Type, its Source, and Versioning requirements
(ideally) before building (Figure 10-3).

Builder Inheritance Content Q

Unversioned Shared

Product Details|

Product Name Single-Line Text ¥

Product Description Multi-Line Text v

Product Image Image v v
Related Products Multilist with See ¥ Ui

MRSP Number v v

Figure 10-3. Fields have five common properties, including their Name, Type, Source, and versioning
requirements, either Unversioned and/or Shared
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Field Sections

Field sections are a great way to organize your fields by categories. From a Content Editor’s perspective, the
field sections will appear as an expandable/collapsible accordion. Figure 10-4 demonstrates this, where
Home, Menu Item, and Site Root (among others) are that item’s field sections.

“2 Home

Welcome to Sitecore.

Home

Menu tem

Menu Title:

Home

|_| Show Item In Menu

\#| Show Children In Menu

|« Show Item In Secondary Menu [standard value]

Site Root

Site Search

“

Figure 10-4. Field sections allow you to categorize your fields. This makes content administration easier when
you have a lot of fields

Field Types

There are many field types to choose from! A field type establishes the format the data will be stored in. For
example, a Number column requires a number value, whereas a Single-line text column can take any set of
characters, letters, numbers, or otherwise. Table 10-1 shows the various field types explains what they are
and how they work.
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Category Field Type Description

Analytics Profile Card Value  This field type allows the marketer to select a profile/persona that
can be associated to the piece of content. You will almost never
need to use this field as it’s already in the standard template.

Analytics Profile cards Similar to Profile Value, but more robust, accommodating other
settings such as user segment, information type, and score.

Analytics Tracking This is an important field, allowing marketers to associate
campaigns, goals, events, and other settings to a piece of content.

Simple Types  Checkbox Stores a simple Boolean, Yes/No value.

Simple Types  Date Stores a date. You can use the $date token in the standard values
for the replacement of the current date upon a new item creation.

Simple Types  Datetime Stores a date and a time. You can use the $date and $time tokens in
the standard values for the replacement of the current date upon a
new item creation.

Simple Types  File The File field allows users to “attach” files to the content. The user
can select files from the Media Library to attach, or upload new ones.

Simple Types Image Similar to File but specific for images. Images rendered with
FieldRenderer can have a MaxWidth applied. When applied,
Sitecore will cache a resized image according to that width, thus
speeding up download times. This offers a significant advantage
over the File field when working with images.

Simple Types  Integer Only takes a number with zero decimal places.

Simple Types Multi-Line Text Allows for multiple lines of text.

Simple Types =~ Number Takes any number, with or without decimal places.

Simple Types ~ Password Offers the user a text box but blurs the text so onlookers cannot see
the value.

Simple Types  Rich Text Similar to multiline text, except that it offers a rich text editor to aid
content editing. The text is stored as XHTML rather than straight text.

Simple Types Single-Line Text Straight text line with no rich text and no carriage returns.

Simple Types =~ Word Document Allows for a Word document to be attached to the item, with links
for Edit and Download. Inline editing of the document is only
supported on IE.

Social Accounts Multilist  Internal—you probably won't use this.

Social Campaign Tree Internal—you probably won'’t use this.

Social Countable Edit Internal—you probably won’t use this.

List Types Checklist Allows the user to check multiple checkboxes. The datasource can

be set to an item in the tree, and items below that parent item will
appear as selectable options.

(continued)
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Table 10-1. (continued)

Category Field Type

Description

List Types Droplist

List Types Grouped Droplink

List Types Grouped Droplist

List Types Multilist

List Types Multilist with
Search

List Types Name Lookup
Value List

List Types Name Value List
List Types Treelist

List Types TreelistEx

Link Types Droplink

Link Types Droptree

Link Types General Link

Link Types General Link with
Search

Link Types Version Link

Similar to Checklist except it renders a drop-down instead of
selectable checkboxes. The disadvantage is you can only select

one option in this case. Note: Only the item name is stored, not an
actual link to the item in the database. Therefore, use this sparingly
if at all to avoid broken links. As an alternative use Droplink
whenever possible.

Similar to Droplist except that the grandparent is set to the
datasource. In this case, the child items are the “groups” in the
drop-down and their children then become the options. Note:
Droplink stores the ID of the item selected and is a better option
than Droplist.

Similar to Grouped Droplist except only the value is stored. Use
sparingly if at all.

Shows the left/right selector to select multiple items with left/right
arrows. Also allows sorting on the selected items, perhaps making it
preferable to Checklist.

Similar to Multilist but with the addition of a search box to allow
users the ability to search for items instead of trying to find them in
a list. This is helpful for large lists.

Similar to Name Value List in that this field lets you store key/value
pairs, but it also lets you set a datasource from where to allow the
user to pick the key/values from.

This field type helps you store a collection of key/value pairs.

Similar to the Multilist but rendered via a treeview versus a flat list.
There are also many configurations you can set to include/exclude
what shows up in the treeview.

Similar to the Treelist but the tree is collapsed on load, making
load time faster as items are fetched only upon the user expanding
that item.

One of the best, most commonly used types for storing drop-down
values, as it links directly to the item in the database and thus the
solution is safer from broken links.

Similar to Droplink but renders a treeview instead of a normal
drop-down.

Standard linking ability, commonly used for linking to external
sites or if the user needs to add link settings, such as targeting a
new window or calling JavaScript upon click.

Similar to General Link except it also provides the user a search box
to search for items.

Clones use this field to track an item’s ID, language, and version
number when cloning.
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Category Field Type Description

Developer AccountSelector Internal—you probably won't use this.

Types

Developer Icon This field gives the user the ability to select an icon out of the

Types icon library.

Developer iFrame Lets the user specify the path to another application.

Types

Developer Tristate Lets the user select between Yes and No, but also Undefined.

Types

Developer Sitecore User Lets the user select a user stored in the Sitecore database, such as a

Types customer who has a login configured.

System Types  Attachment Internal—you probably won't use this.

System Types  Custom Internal—you probably won’t use this.

System Types  Datasource Internal—you probably won't use this.

System Types  File Drop Area Internal—you probably won't use this.

System Types  Internal Link Internal—you probably won't use this.

System Types  Layout Internal—you probably won’t use this.

System Types  Page Preview Internal—you probably won't use this.

System Types  Query Builder If you need a search query to be the datasource of a control, you
can use this field to help build that query versus having to type it in
manually (error prone).

System Types  Query Datasource  Internal—you probably won’t use this.

System Types  Rendering Internal—you probably won't use this.

Datasource

System Types  Rules Internal—you probably won't use this.

System Types  Security Internal—you probably won'’t use this.

System Types  Template Field Internal—you probably won't use this.

Source

System Types =~ Thumbnail Internal—you probably won't use this. Instead set a MaxWidth on
the ImageField.

Deprecated N/A Deprecated types are in Sitecore for the purposes of backward

Types compatibility with previous versions of Sitecore only and should

not be used for new data templates.

Note There are many very helpful (and free) custom field types you can download and install. Some
examples are a Google Maps location picker, a color picker, and a multiple image selector. See the following
blog post, which summarizes all the cool stuff out there: http://bit.1y/1DxntPv.
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Field Sources

Field sources help you determine where content should be coming from. For example, when you want to
associate an image to a news article you'd expect to be able to browse for images. However, what if you have
hundreds or thousands of images? The source on a field helps you set a destination from where to select
images (really any content; image are just an example). Perhaps there is a specific folder within the Media
Library that you want all news articles to draw from. By putting that folder’s path into the source field, you
are limiting marketers to select just that folder’s items and its descendants. Notice in Figure 10-5 the carousel
item’s images are limited to the Carousel Backgrounds path.

Select Media

n Media Filters ¥

All image files
Media folder: /Carousel Backgrounds

A '/" i

blue chili peppers dandeliion

All video files

My images

Recently uploaded images
Recently uploaded videos

NS
Recently uploaded by me

&sc button grass jelly beans

Hil MW o

Cancel

Figure 10-5. Selecting from thousands of items can be impossible. Use the Source column to limit the selector
to specific locations to make it easier to find the right assets

Note The field source format can vary. Sometimes a GUID is needed, sometimes an URL. Most of the
time, a developer sets up the fields and you’ll want to confirm the technical requirements/limitations of their
configuration.
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Field Versioning

An item in Sitecore can have multiple versions. These versions might be for languages, or perhaps you're
doing some A/B testing and want to test a few options before making a final decision. Some fields you

may want all versions to share the data. Other fields you might want each version to specify its own value.
Language translation would be a good example that, where each field shown to users must be translated, but
other fields used to control logic, such as numeric values or images, you might want shared.

There are two checkboxes on each field: Unversioned and Shared. Shared specifies that this field is
likely numeric or an image, or possible an internal field used for rules and each version across all languages
should share the value when checked. You check unversioned when you want all versions within a specific
language to share a value. In this case, all English versions would share the value, but all Spanish versions
would have a different value. The default is that neither Unversioned nor Shared are checked. In this case,
all values across all versions across all languages will have unique values. Say that five times! For all practical
purposes, however, unversioned is rarely used.

Note You can check both Shared and Unversioned; the two are actually mutually exclusive, and the default
would be Shared in this scenario. Using Unversioned or Shared also means that the field is not subject to
workflow, which is an important consideration.

Field Validation

You can add field validators to enforce data integrity in your solution. For example, you may want to require
all images to have an ALT tag set to get the most out of your search engine optimization. It is simple to add
the Image Has Alt Text field validator to each of your image fields has an ALT tag. There are a few dozen
validators such as this one that comes out of the box. You can also have your developers build custom
validators for unique scenarios.

To add validators to a field, expand the data template’s field section in the treeview that contains the
field you want to modify. Select the field in the treeview. With the field selected you will notice a Validation
Rules section below the Quick Info and Data sections. The Validation Rules section has four fields you can
configure.

®  Quick Action Bar—Used to add the red/yellow notifications in the gutter in the
treeview (Figure 10-6). These can help you spot validation errors even when you are
not actively editing an item.
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4 & Content -
Step 1 ™
» & Home -
4 [ Developing in Sitecore Abstract
- 02 Step 1 Show editor Suggest fix Edit HTML
L] 08 Step 2
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1] _—" Layout
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b & System
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» 4 App Center Sync Show editor Suggest fix Edit HTML
» &k Branches
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» ] ListManager

Figure 10-6. Validators can help you enforce data integrity. There are several places where you are notified
when an item fails its validation: in the gutter (left), in the validation bar (right), and in the validation pop-up
when you try to save it

e Validate button—Used to add the validation feedback in the validation results
pop-up when the Validation button is manually clicked in the ribbon (Review tab,
Proofing section, Validation button).

e Validation bar—When you're on an item, you will notice little red icons to the right
of the item showing how many fields are failing validation (Figure 10-12 shows four
fields failing validation).

e  Workflow—This section can be used to enforce validation rules before a workflow is
allowed to progress from one state to another.

It is simple enough to add the validations to these sections. Simply find the validator you want to
enforce and double-click it to move it to the right. Save the field item and the validator is now in effect for all
item instances created from this template.

Completing the Templates

With a more robust understanding of how data templates works, you can now complete the build-out of the
Featured Product and Promotion data templates. Run the following steps to complete the configuration:

1. Clickinside the Add a New Section text box and add a section called Product
Details or Promotion Details.

2. Add the fields for the Featured product data template (Product name: single-
line text, Product description: multi-line text, Product image: image, Related
Products: multilist with search, MRSP: number) and the Promotion data
template (Related Products: multilist with search, Discount Percentage: integer,
Target Persona: profile cards).

274



CHAPTER 10  APPENDIX

3. The Source field properties were set in Chapter 2.

4. Setthe Image field as Shared, since we want all versions across all languages to
share the same image.

5. Set Related Products and MRSP to Unversioned, as we want to share the value
across all versions within a given language. For example, China/Mandarin will
have a different MRSP than France/French, but Mandarin variations should
maintain the same MRSP.

Note These steps are continued later in this appendix.

Data Template Inheritance

Data template inheritance is a great way to create a hierarchy of information and maximize reusability of
templates. It is a best practice to break your experience’s information architectures down into reusable
pieces and extend from there. Our customer Promotion data template inherits from Promo Spot. This allows
us you use a wider variety of components. A developer can build components for Promo Spot and the
marketer can use those for product promotions, whitepaper promotions, e-mail promotions, and so forth.
Inheritance is what enables this reusability, and in turn, significant cost savings for development time and
maintainability.

Tip Make your inheritance broad, not deep. Breadth tends to beget reusability, whereas depth tends to
beget hierarchy and rigidity. Two to three layers of hierarchy is about all you should allow yourself or you risk
losing the benefits of reusable templates and components.

There are some gotchas to be aware of. For example, you might have a base template that has a Title
field, and then unknowingly you create a Title field in one of the child templates. In this case when the
marketers go to edit that content, they see two separate title fields and are left unsure which one to use.
Developers, likewise, are confused as how to programmatically retrieve what seems like duplicate data,
when in reality the marketer could enter two separate values.

This behavior is also true with section names. The sections of a data template always collapse into their
parentage and appear at the same level as parent sections. It will confuse your end users if your section’s
names are the same as the parent’s names. The best practice for both is to prefix names with the template
name if you are worried about duplicates.

Tip Never duplicate field or section names. If you have a child template, use the same field name as
defined in a parent. You can’t be sure which field will be rendered. It is safest to prefix the field name with the
template name to differentiate fields.

A Data template can inherit more than one item. In this case, the combined fields from all the templates
that the template inherits from will be consolidated in the Content Editor. Template inheritance can also be
circular. For example, a product promotion can inherit from a Promo Spot and a callout. A callout can inherit
from a Promo Spot, too. In this case, again, all the fields are consolidated rather than showing duplicates.
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It is also important to note that data templates can only inherit one set of presentation details. If
a template inherits from two templates and both have presentation details, only the first template’s
presentation details in the inheritance list will be used. This can oftentimes be confusing for marketers who
are unsure as to why their content isn’t displaying as they had assumed it would. A personal best practice
I have come to appreciate here is to have three types of data templates: those containing fields, those
containing presentation details, and those containing a combination. This way you can have the third type
become a compilation of fields and one set of presentation details. A good naming convention can help
distinguish between the two and make it easier to understand what is driving the presentation. Additionally,
this is another way to create a broader, more reusable set of templates, as you may find yourself wanting to
inherit some fields from a parent but not its presentation details.

Tip Use three types of data templates to keep your information architecture broad and reusable:
1) templates containing fields, 2) templates containing presentation details, and 3) templates combining
the two. The first two should never inherit from each other, and the third should never inherit from other
combination templates, if possible.

One way to structure your Templates folder according to this best practice can be seen in Figure 10-7
(using a Hero Image Rotator as an example, such as you'd commonly find on a home page):

Templates

Global

Field Presentation il Combination
Templates Templates Templates

Image Hero Image

Title and Text Background Rotator

Title and Text

Rotator

Figure 10-7. Structure your data templates in three categories: 1) field templates, 2) presentation templates,
and 3) combination templates
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Field Templates

e Title and Text Template (contains a Title and Text fields, plus perhaps other fields to
control formatting)

e  Image Template (contains an Image field, plus perhaps other fields to control
formatting)

Presentation Templates
e Image Background Template (contains components to render a generic image)
e Title and Text Template (contains components to render a generic text and title)

e  Rotator Template (contains components to swap out a DIV with new data)

Combination Templates

e  Hero Image Rotator Template (inherits from Title and Text field template, Image
field template, Image Background presentation template, Title and Text presentation
template, and Rotator presentation template)

PRACTICAL TIPS: COPYING, MOVING, AND SORTING, OH MY!

It's easy enough to copy, move, and duplicate data templates and content (really anything within the
Content Editor). However, there are a few gotchas. You don’t want to be in a position of explaining to
your boss why your actions resulted in data loss!

First, when you change a piece of content’s template to a different template, Sitecore will attempt to
transfer the data stored in the old template to the new template. It does this first by attempting to match
field ID, where the data is moved when there’s a match. Secondly, it attempts this based on field Name,
and likewise moves the data when there is a match. Beware that when a match is not found the data

is permanently lost as a result of the change template action! You should carefully plan the source to
destination mapping before taking these sorts of actions or you risk data loss. In cases where data loss in
anticipated but not acceptable, you will need to perform this administrative action via a PowerShell script.

It should also be noted that the Rich Text Editor does not handle copying content well. If you have a node
in the treeview that needs to be copied, any copied content with links to other copied content below
that node will maintain their link back to the original content, not the copy. One would expect links in the
descendants of the copied content to be updated to point to the newly copied content. Again, PowerShell
might be a way to search for and fix the broken links, or you could tap into the pipeline and watch for
copy or duplication events to handle them accordingly.

Developers often refer to content items or templates by their internal IDs. Be advised that copy
operations result in a new 1D, which may result in existing code not working with the newly copied
content or templates. Again, a more reusable option is to extend and flatten your information
architecture.

277



CHAPTER 10 © APPENDIX

Working with Standard Values

Standard values is an important concept in Sitecore. Some might argue that a better name for it is “default
values” because it’s a way to assign default values to items upon their creation. However, standard values do
a lot more than that, so perhaps that’s why they have a more generic definition.

Tip Asa best practice, each data template should have standard values assigned. Standard values are
typically configured by developers.

Standard values can have the following types of defaults:
e  Default field values
e Insertoptions
e  Presentation details
e Workflow

The rest of this section will cover each of these four types of values that can be applied to data templates.

PRACTICAL TIPS: RESETTING TO STANDARD VALUES

There may be times when you want to revert an item’s settings back to standard values of the template
it was created from. You can revert field values, presentation settings, and insert options back to the
template’s standard values. The following shows where in the ribbon you can find each of these buttons:

Field values—\Vlersions tab » Reset button in the Fields section
Presentation—Presentation tab » Reset button in the Layout section
Insert options—Configure tab » Reset button in the Insert Options section

After you click these Reset buttons, the content items values/settings will again reflect the standard
values of their templates.

Configuring Default Values

A new data template does not have the ability to assign standard values. You first need to add a standard
values item to the data template. One of the most confusing things about standard values is that the data
template item and the standard values item for that data template look identical. It is common to apply
settings to the data template thinking you are applying standard values and you are not.

You can tell if you have a standard values item or not by looking below the data template. Notice in
Figure 10-8 how the Product Promotion data template has a __Standard Values item below it. This child item
is where you will assign your standard values.
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Figure 10-8. You set up default values within a data template's __Standard Values item

To create this standard values item, select the data template and then click the Builder Options tab.
Click Standard Values below the Builder Options tab and you will notice the new standard values item appear.

You can start assigning default field values when you click the standard values item. Notice how
Figure 10-9 shows the standard values item selected with the fields showing. You can set default values by
entering data into those fields and thereafter saving the item. Then, when users create new items from that
data template, those values will be present in the new item by default.

Notice also the $tokens in Figure 10-9. Tokens are replaced during item creation with dynamic values.
For example, $name is replaced with the item name during creation. In Figure 10-10, you'll notice an item
created with the name “Phil test” and the $name token was replaced as expected. The following are the
supported tokens:

e  $name: The name of the item

e  $id: The ID of the item

e  $parentid: The ID of the item’s parent

e  $parentname: The name of the item’s parent
e  $date: The system date (yyyyMMdd)

e  $time: The system time (HHmmss)

e $now: The date and time (yyyyMMddTHHmmss)

Note Developers can create custom tokens. Check out the following blog post: http://bit.1ly/1zf1AW8
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Figure 10-9. Tokens allow your default field values to be somewhat dynamic, such as replacing $name with

the name of the item
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Figure 10-10. Notice how each of the tokens was replaced with its dynamic value at creation time
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Note Layout deltas are an important concept in template inheritance. When an item receives its values
from its template’s standard values and those values are changed, the link back to the standard values is not
broken. Rather, a “layout delta” is created to track just the delta from the standard values. If the standard values
are updated later, all item field instances will be updated where there is no delta.

Configuring Insert Options

Only administrators can add content or folders in the content tree, unless you specify insert options that
allow non-admins to create content specifically permitted within that folder. The Insert From Template
option allows an admin to select from all data templates that exist, but that option is only available to
admins. It is important, then, to specify insert options, since marketers can’t create content if you don'’t.
Additionally, you want to control what content goes where. Insert options become your way to enforce an
information architecture and prevent the “wild, wild, west” where users are adding content in places they
shouldn’t or simply wouldn’t make sense.

It is very simple to set up Insert options on a data template’s standard values. Simply click the __ Standard
Values item below the data template and click the Assign button in the Configure tab below the Insert Options
section. You can then use the selector to select which data templates should appear as insert options when
users are creating new items.

When complete, the Insert drop-down menu should look something like Figure 10-11 (note again that
only admins will see the Insert from Template option).

» ¢ Featured Products
# Product Pr
Insert » # Product Promotion
» % Promo Spc =
Search L] Insertfrom template
» i) Quotations _
11 Duplicate
b i Sticky Note
. ®  Delete
» &) TextWidge
= Rename

Figure 10-11. Insert options allow you to control your information architecture by limiting which types of
items can be created where

Presentation and Applying Layouts

It was previously mentioned that everything below the Home node within the Content tree is URL
accessible. It is important to note, therefore, that everything below the Home node needs a layout assigned
that will tell Sitecore how that piece of content (such as a page) should be rendered when a user navigates
to it. A layout has placeholders where users can add/remove/configure components. Components render
content. Figure 10-12 shows this hierarchy.
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Main Layout

..Static content hardcoded within the Layout...

PlaceholderTopleft

_ PlaceholderTopRight

PlaceholderMiddie

PlaceholderBottomA PlaceholderBottomB PlaceholderBottomC

...More static content hardcoded within the Layout...

Figure 10-12. Layouts contain placeholders with components that render content items

Note This section is where the target audience for this book is stretched a bit. Creating layouts and
applying placeholders in the code is a development topic covered elsewhere, most notably Sitecore official
developer training. The goal of this section is to give marketers and admins a basic understanding of layouts
and placeholders so they can be empowered to do basic administration of them, as well as provide better
instruction to developers regarding their requirements for their layout and placeholder needs.

For those who want a primer into Sitecore development, to build layouts, components, etc. as described next,
check out this helpful video tutorial on YouTube: http://bit.1ly/1IjI1LI

Notice how this layout example has some hard-coded content at the top and bottom. A layout is
basically an HTML file with HTML code in it and placeholders for marketers to administer components.
You may opt to hard-code basic things, such as the company logo or the footer. However, it is a best practice
to build as much as possible as components within placeholders to give marketers as much freedom as
possible to control the presentation of the site.

Below the static content there are several placeholders. A developer can put as many placeholders on
the page as they want or you ask them to. They can orient those placeholders in any configuration you may
want, such as one column, two column, or whatever. An empty placeholder will collapse, so there’s not
worry about having more than necessary. However, some prefer the simplicity of many layouts with different
configurations to, say one single layout with endless possibilities. A marketer may understand what “Layout
with 2 Columns” versus, say a layout named “Main” with 15 columns/row combinations.
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Notice also in Figure 10-12 how each placeholder has a unique key. End users and marketers will not
need to know this key if they are administering the page through the Experience Editor. However, they will
need to know the key if they administer the page through the Content Editor. So, it helps to have placeholder
key names that make sense. Notice in Figure 10-13 a real-world example (Launchcore example) of a slew of
placeholder orientations, each with common sense names.

4 B Layout
] Controllers
» & Devices
» B Layouts
» ] Models
4 ] Placeholder Settings
» & App Center Sync
4 ';J Launch Sitecore
[ Hero Image
(& imageheaderedcontent
» ] One Column Placeholders
Page Sections
4 ] Four Column Equal Placeholders
[® fourcolumnequalfarieft
[® fourcolumnequalfarright
fourcolumnequalmiddieleft
[ fourcolumnequalmiddieright
4 ] Three Column Equal Placeholders
threecolumnequalleft
[ threecolumnequalmiddie

[® threecolumnequalright

v

] Three Column Equal Row Placeholders
» {J Two Column 25 75 Placeholders

» ] Two Column 50 50 Placeholders

» 2] Two Column 60 40 Placeholders

» ) Two Column Row 40 60 Placeholders

» ] Two Column Row 50 50 Placeholders

Figure 10-13. Your placeholder design is very important. You want to empower marketers with flexibility to
meet changing presentation demands

You can create new placeholders by simply right-clicking the folder below Layout » Placeholder
Settings, and choosing the new Placeholder insert option. However, it will require a developer to add that
placeholder either onto a layout or within a component (see sidebar “Use Nested Placeholders”) before a
user or marketer can add components into it on a page. Additionally, you can configure allowed controls
on a placeholder from the Content Editor, as can be seen in Figure 10-14. It was previously shown how you
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can configure allowed controls (components) from the Experience Editor. Here is an alternative location to
perform the same configuration. As a reminder, the allowed controls setting controls which components
can be added to a placeholder. You can use this to enforce an information architecture on your site, such as
keeping wide controls out of the right rail, or keeping tall controls out of the footer.

»
4 |=| sitecore

4 & ot @ Placeholder
» & Home =
» [ Developing in Sitecore
» @ Global
4 @ Layout
- Controllers
» B Devices Placeholder Key - apply these settings to all placeholders with matching placehold
P B Layouts Placeholder
» ) Models
4 {J Placeholder Settings Allowed Controls
b 5@ App Center Sync Edit
4 1 Launch Sitecore
Fl ;_:- Content

[® content-primary
[® content-secondary
[® Placeholder

» o Full

Figure 10-14. Placeholder allowed controls lets you configure which components are permitted to be added to
which placeholders. Yet another way to enforce your information architecture

PRACTICAL TIPS: USE NESTED PLACEHOLDERS TO ENABLE
ULTIMATE LAYOUT FLEXIBILITY

Imagine a moment that Component A as seen in Figure 10-12 has placeholders in it. Can a component
render placeholders? Yes! Let your imagination run wild for a minute—this enables infinite flexibility for
marketers!

Instead of creating 12 layouts, each with different patterns for placeholder orientation, you should create
one single layout with one single placeholder: A “Main” layout with a “Main” placeholder.

Sounds limiting? Not if you have components that render placeholders. Perhaps you had three
components called “Two Column,” “Single Column,” and “Three Column”. You could simply add these
three components to the “Main” placeholder within the layout. Then, within those components you have
child placeholders you could then add your child components to.

This pattern gives unlimited freedom to marketers to design a page however they might wish. They can
add as many “placeholder components” as they like, without needing to go back to a developer to ask
for yet another one-off layout design to meet the needs of a specific use case.
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While this seems like dream land, it does come with a cost. The cost is that the marketer will only be
able to design these pages in the Experience Editor. The reason is the placeholder keys need to be
dynamic (GUIDs). Imagine you have two of the same components on the page each rendering the same
placeholders. Since a layout cannot have more than one of the same placeholder key, the code needs to
create a dynamic key name using a GUID. A market won’t know what this value is and therefore cannot
administer the layout in the Content Editor. This is likely not a problem since most users will opt for the
Experience Editor anyway.

It’s a bit of a trick to setup dynamic placeholders. Check out this popular blog post for more details:
http://bit.1ly/1jUMo2P. Alternatively, the SCORE framework from Brainjocks also enables this.
See http://brainjocks.com/company/score.

Layouts, like placeholders, can also be created in the Content Editor. Again, however, you will need a
developers help before they can be used. You can create layouts below the Layout » Layouts folder by
right-clicking and adding the new layout (preferably below a custom folder). Notice the Path property,
as seen in Figure 10-15. This needs to be set to the relative path of a HTML file on the server, in the
inetpub\wwwroot\[site] folder specifically. A developer can create and publish this HTML file, with
placeholders, etc. coded therein.

4 [3] sitecore
4 & Content

» & Home

Main

» (B Developing in Sitecore

» @ Global l C

- reci
) Controllers
» @ Devices Path
4 @ Layouts

Niews/LayoutsMain.cshiml

) sample Layout
4 ) LaunchSitecore Model -
[ main Insert link Clear

» ) System

» L Models

Figure 10-15. A Layout within Sitecore is a pointer to a file on the file system that controls where placeholders
are rendered

The Experience Editor can be used to add/remove/configure components on a page. However, that
page first needs a layout or you won’t even be able to browse to it to launch the Experience Editor in the
first place. Notice in Figure 10-16 how the Glossary page was assigned to use the Main layout to control its
rendering behavior. You can check which layout a page is assigned by clicking the content item (page), and
then selecting Details from the Presentation tab’s Layout section. The Layout Details settings box is often
called the PLD (pronounced plyd). Within the PLD you can also notice which controls are added onto the
page, as well as what placeholders on the layout. You can click on a control to change its placeholder. You
can also click the placeholder to update its settings, such as the placeholder ID.
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Figure 10-16. You can still manage a page's settings from the content tree if you don't want to use the
Experience Explorer

You can similarly add/remove/configure components in this setting pop-up (Figure 10-17) much like
you can in the Experience Editor. By clicking Edit below the device, such as the default device, you can select
which components you want on that page, as well as assign a layout to that device. Notice the
Layout, Controls, and Placeholder Settings tabs in the Edit pop-up (Figure 10-17). The Layout tab shows
a drop-down from which you can select the layout for the device. The options are selected from the items
below the Layout » Layouts path in the content tree.
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Figure 10-17. You can edit which components are in which placeholder on which layout from the content tree

Figure 10-17 shows the Controls tab, allowing you to select which controls you want on the layout and
which placeholders they will slide into. Here is where you need to know the placeholder key, whereas in the
Experience Editor knowing the key is unnecessary. When you click a component you can edit its settings,
much the same as from the Experience Editor.

The Placeholder Settings tab shows all the placeholders assigned to the layout. You can add/remove/
configure placeholders. By clicking Edit on the placeholder you are essentially loading the same settings
menu that would appear if you can selected it from the content tree. This essentially is just a shortcut as well,
but it is also how you can override global placeholder settings in a particular item or its Standard values.

One thing you may have noticed in Figure 10-16 are the two tabs at the top of the PLD settings pop-up:
Shared Layout and Final Layout. This is when we start to segue back into the standard values conversation.
The Shared Layout tab shows the settings for that page, which are shared across all versions, likely deriving
their settings from the page’s data template’s standard values if they hadn’t yet been changed. The Final
Layout reflects the selected version’s modifications. For example, the China/Mandarin version might have
additional components than the US/English version. Likewise, if you have a weekend promotion, the page
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version that will be published just Friday through Saturday may have a delta from its standard values. The
Final Layout tab shows what that version’s unique configuration is apart from the default configuration. If
you need a refresher on versioning, refer back to an earlier part of this appendix: Data Templates » Field
Versioning. The concept of field versioning likewise applies to the PLD.

Now that we have a bit of an overview of layouts and placeholders under our belt, let’s configure some
settings on our data template’s standard values so that all new instances not only receive default field values,
but also default presentation settings. You configure the PLD on a data template’s standard values much in
the same way as it’s configured on a content item. Simply click the Data Template, and expand it to show
the __Standard Values item. With the standard values selected, click Details from the Presentation tab’s
Layout section (hence again the plyd). From there you can configure all the aforementioned settings, and
upon new item creation the new items will take these settings as their defaults. Once again, as with standard
values, if the standard values are updated later all instances will receive those updates. It’s a great way to get
reusability out of your PLD settings.

Creating a Custom Workflow

The out-of-the-box regular workflow has three states, but the custom workflow created in this section will
have four. Our goal is to add a fourth state allowing for a gated publish, so that a publisher is notified when
new items are awaiting publishing. They at that time may opt to publish immediately, or perhaps bulk up a
series of items that are all published at once. The publisher will benefit from having a workbox full of items
waiting for publishing, versus a “Publish Site” bucket where they are not quite sure what will be going to
production (content delivery servers). The following steps configure this workflow. The steps are continued
in Chapter 8 where we apply security for the editor, approver, and publisher roles.

1. Start by creating a new workflow. Within the Content Editor, expand the System
node and right-click Workflow » Insert Workflow.

2. Name the workflow Standard Publishing Workflow.

3. Nextlet’s add our four states. Right-click Standard Publishing Workflow and
choose Insert » State. Do this four times, naming the states Draft, Awaiting
Approval, Awaiting Publishing, and Published. Set a helpful icon for each state.

4. Ifyouselect the Standard Publishing Workflow node you'll notice it requires an
Initial State value. Set the initial state to Draft and click Save. Additionally, the
workflow needs to be aware of which state is the final state. Select the Published
state and ensure the Final checkbox is selected.

5. Next add some commands to the states. Below Draft create a new command
called “Submit for Approval” with the Next state value set to the Awaiting
Approval state. Below Awaiting Approval, create two states: “Approve and Submit
for Publishing” and “Reject and Return to Editor,” with the Next State values
being set to Awaiting Publishing and Draft respectively. Below the Awaiting
Publishing state, add a command called Publish with the Next State set to the
Published state. Set helpful icons for each command.

6. On the Publish command, select the Suppress Comment checkbox. This way,
the approvers don’t have to enter a comment when they click the command.
Since the Publish command is publishing approved content there shouldn’t be a
reason to enter more comments.
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7. Next add some actions into the workflow commands. Before a piece of content
is submitted for approval we want to ensure it passes all of our validation tests.
Below Submit for Approval, select Insert from Template. Browse to System »
Workflow » Validation Action and provide Validation as the name. Fill out the
field values as seen in Figure 10-18.

Note The Validation action will simply execute any field validators you have configured on the data
template. See the “Field Validation” section in this appendix for a refresher. The point here is simply that an item
shouldn’t progress in the workflow if it doesn’t satisfy our validation rules.

Type

Sitecore Workflows.Simple. ValidatorsAction, Sitecore Kernel

Max Result Allowed

Warning

Unknown Result

An unknown error has occurred

Warning Result

You cannot approve an item with validation errors

Error Result

You cannot approve an item with validation errors

Critical Error Result

You cannot approve an item with validation errors
Fatal Error Result

You cannot approve an item with validation errors.

Figure 10-18. Workflow validators are helpful when you don’t want a workflow to advance to the next state
when the content doesn’t meet your standards or policies

Note Max Result Allowed lets you set when the workflow will permit the item being sent for approval to
move forward. Other value options are Unknown, Valid, Suggestion, Warning, Error, CriticalError, and FatalError.
Perhaps you only want errors to prevent the workflow from progressing, or perhaps suggestions are not
suggestions at all, but requirements. By changing this value, you can control how strict the validation is.
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8. Younow need to go to your data template’s fields and specify which validators
you want to enforce within the workflow. With Standard Fields selected under
the view tab, expand the Validation Rules section and edit the rules for each
field you want validators for. Select which rules you want to apply. There are
many helpful out-of-the-box rules, and you can create your own. The example in
Figure 10-19 shows us adding a required field validator on the product image, as
well as requiring ALT text for SEO purposes.
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» B Anicle -

Figure 10-19. Workflow validation rules need to be configured on the data template’s fields to tell the
Validator which validations you want the workflow to concern itself with

9. Next we want to send an e-mail to notify the approvers that a new piece of content
was submitted for their approval. Insert a new action from template below Submit
for Approval again, but this time select the E-mail action and name it “Notify
Approvers”. Fill out the values and click Save. By default this E-mail action is placed
above the Validation action; this means the e-mail will be sent before validation
occurs, which is bad! Click the Notify Approvers action and drag it above the
Validation action so it won't send the e-mail if the validation doesn’t pass.
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Note A best practice here would be to use a custom action that points to users in an Approvers role in
Sitecore and/or Active Directory. The out-of-the-box action requires you to enter an e-mail address for the
To/From lines (such as a distribution list for an approvers group) and it would be preferred to have these as
centralized configuration values in case they change over time.

You can add tokens into the e-mail text to help those notified find the item in question. Supported tokens

are $itemPath, $itemLanguage, and $item Version. These tokens are limited in their helpfulness as they
don’t provide the author’s name, their comments, or a link to preview the item (the path isn’t that helpful). An
enhanced e-mail action module exists that is easy to install and configure (http://bit.1ly/1GC2UwV). Using
this module will greatly increase the helpfulness of e-mails sent by Sitecore’s workflow engine.

CONFIGURE INTERNAL PUBLISHING TARGET FOR BROADER REVIEWS

The previous note mentioned the fact that you can use tokens in a workflow e-mail to help approvers
quickly get access to the item to review it. However, what if the approvers are not Sitecore users? There
are times when you do not want people in Sitecore. Just because someone needs to approve something
doesn’t mean you want them in there poking around and possibly breaking things (take your CMO for
example, who may need to approve the new home page, but won’t want to learn Sitecore).

One option is to create a multitude of roles to accommodate every possible security scenario. But

that is not always palatable. A second option is to create an internal publishing target so non-Sitecore
users can see items in a draft state before they are published, but yet without needing to know how to
navigate around within Sitecore.

Dan Cruickshank has a very helpful blog post on how to configure a read-only internal publishing
target to accommodate scenarios just like this. For larger organization with more complex approval/
governance policies, this pattern may be exactly what you need.

Read more at: http://bit.1ly/1zjULjn

10. Let’s add an auto publish action below the Published state, so that when the
publisher clicks the Publish command and the state is changed to Published, the
item is automatically sent to the Web database and published. Below the Publish
command, insert from template and choose generic Action. Enter Sitecore.
Workflows.Simple.PublishAction, Sitecore.Kernel forthe Type, and deep=1
for the Parameters.

Note A generic action is how you can create custom actions for your workflows. Simply add a generic
action to the workflow and specify the assembly and class name for your action. See the following for more
details on creating custom actions: http://bit.1ly/1EVwVgu.

deep=1 tells the publish action to publish all child items as well. If you don’t want children to be published,
change this to deep=0. Additional parameters include related, targets, alllanguages, and itemlanguage.
Go here for more information on these parameters: http://bit.1ly/1KzUoEo.
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11.

Lastly we need to accommodate when a user edits an item while the workflow

is running. Typically when the item is edited we want the workflow to restart, or
unapproved changes may inadvertently get published. Notice in Figure 10-20

the __OnSave command. This auto-magical command runs whenever an item

is edited (versus requiring the user to click the command manually) and is
hidden. Add a new command under each Draft, Awaiting Approval, and Awaiting
Publishing states to reset the workflow when edited. For each “__OnSave”
commands, you need to create an action using the Auto Submit Action template,
setting that action’s Next state value to Draft. The Type for this action is Sitecore.
Workflows.Simple.AutoSubmitAction,Sitecore.Kernel. The role field can be
used to limit who can perform this action. Leave it blank since the action should
reset the workflow regardless of who edits the item.

Note
Publishing states, you can remove the “Workflow State Write” and “Workflow State Delete” roles on those
states. This tends to slow progress down however, if, for example, an approver is not accessible to reject the
item, so it’s really up to your process and governance policies.

if you would prefer people not be able to update an item while in an Awaiting Approval or Awaiting

That’s it for now. Actually there’s nothing stopping you from using this workflow immediately, but it

won'’t be that helpful without the proper security applied. Since security in and of itself is a massive topic
with a lot of context needed, these steps will be continued after that context can be established in Chapter 8.
All said and done, your workflow may look something like Figure 10-20.
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Figure 10-20. A custom workflow©

Sitecore Architecture

In this section, we discuss a topic that’s more geared toward the administrator or developer, but that still has
some relevance to the marketer or the power user.

Infrastructure and Services Architecture Options

The goal of this section is to give the marketer a high-level understanding of Sitecore’s infrastructure
services and deployment options. There are innumerable options when considering a deployment and each
company should go through an exercise to determine what architecture best meets their needs; however,
there are a few core concepts that apply to everyone or are common points to extend into your unique
needs. First we'll discuss the five types of services/roles that Sitecore requires, and then we’ll discuss three
common deployment options worth considering.
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Content Management Server—This server is where authors and marketers go to edit
content and view the Launchpad. It is common to put this server out of rotation
(even behind a firewall) to ensure that external users can never get to Sitecore
administrative interface.

Content Delivery Server—This server serves up approved and published content to
your customers.

SQL Server Database Server—You need one or more SQL Servers for the web, master,
core, and analytics databases.

MongoDB Database Server—Every interaction is dumped into a MongoDB database
to be reported on later. Given the high velocity of data, MongoDB is used for
performance and scalability needs.

xDB Processing Server—This server pulls data out of the MongoDB database and
stores the data in a relational database optimized for reporting.

Note There are many other infrastructure considerations, such as cloud vs. on premise, physical vs. virtual,
laaS vs. Paa$S, capacity needs, networking and security, etc. that should be considered but they are far beyond

the scope of this book.

Basic Deployment

Figure 10-21 shows a common deployment for small to medium sized Sitecore installation. It features
two content delivery servers and a SQL cluster to ensure high availability of the web site, one content
management server for authors that doubles as the xDB processor, and a MongoDB server for the database.

Note

new with Sitecore 8.1 is the ability to deploy Sitecore without MongoDB. It simplifies this

architecture, but at the cost of analytics and most of the cool marketing features.
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-

Site Users

Figure 10-21. A basic deployment minimizes licensing costs but doesn’t sacrifice high availability for the more
critical services

Pros:

e Minimal licensing needs but still achieving high availability for web traftic
(assumes low traffic volumes)

e Isolated content authoring experience, security best practice

¢  No high availability for MongoDB (could take the site down if the log piles up)

¢  No high availability for xDB processing (analytics would be delayed during an
outage, possibly impacting the customer experience, such as personalization,
testing, etc., if it’s using old data)

¢ No high availability for content management (you won'’t be able to make web site
updates, view reports, etc. while the CM server is down)

e The CM server will need to be a pretty big box to ensure that marketers can do their job

Note SQL won't need a cluster if you’re using a Paa$S cloud model, otherwise a cluster and/or mirror or SQL
availability group is strongly recommended.
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Highly Available Deployment

This option (Figure 10-22) extends the previous option by adding some high-availability for the backend
systems. Front-end services such as content delivery and SQL Server are table stakes; hardly anyone
would be willing to risk the site going down, but there may be more room to discuss tolerance for some of
the backend MongoDB and xDB processing to go down. If you don’t want to risk it at all spinning up an
MongoDB replica set and a pair of xXDB processing servers will create the confidence you're looking for
(again, not taking capacity into account—you may need more).

¥

Site Users

Authors

B8N £

Figure 10-22. Option 2 features high availability through the solution except for the management server

Pros:
e Isolated content authoring experience, security best practice
e  High availability for MongoDB
e  High availability for xDB processing

e No concern that xDB processing will negatively impact a marketer’s need to update
content, etc.

¢ Spending more on Sitecore licensing for the separate xXDB processing servers and
server costs to support a MongoDB replica set

e No high availability for content management

296



CHAPTER 10  APPENDIX

Cloud-Based xDB Deployment

This third option (Figure 10-23) is similar to the previous two but with the exception that you're using Sitecore’s
xDB cloud server. The main benefit is you've outsourced all xDB/MongoDB processing to Sitecore’s cloud. This
can be significant for companies that don’t want to learn/support MongoDB, a rather new technology. The
content delivery and content management servers are configured just as the previous deployment options, but
they point to Sitecore’s cloud rather than to your instances of Mongo or xDB processing.

@ ’
F -
i

Site Users

Figure 10-23. This option removes the worry about xDB and MongoDB altogether by outsourcing to
Sitecore’s cloud

Pros:

e  Same as previous

¢ Youlliterally never have to worry or think about MongoDB or xDB; it just works!
Cons:

e xDB cloud annual licensing costs are significant especially for B2C deployments
(if you have >2.5 million contacts this option doesn’t make any sense financially)
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Authentication Options

It is common for web sites to require users to log in. You might have an e-commerce site, a customer
portal, or premium content that requires secure access. There are five main ways you can authenticate your

customers securely to Sitecore:

Sitecore User Management/User Profiles—One of the easiest ways is to simply use
Sitecore to manage your users. Each user setup in the user manager can be given
a password. You'll want to set up different “domains” for your customers and your
employees to help ensure you don’t get your wires crossed.

CRM users—Sitecore’s crm integration modules support two-way contact
synchronization. These CRM contacts can also be given a password that Sitecore
manages, thus allowing their authentication.

Identity Federation, such as Sitecore Social Connected—Federating with Facebook
or Twitter, for example, is supported through Sitecore’s Social Connected module.
Additionally, since Sitecore is just another ASP.NET site at its core, you can easily
set up Sitecore to authenticate with SAML providers (like ADFS or Siteminder) for
single-sign or for identity federation with partners.

Active Directory (AD), Active Directory 1.2 for AD integration—If you use Active
Directory to authenticate your employees, you'll likely want to configure Sitecore to
accept AD credentials so you don’t have to maintain two users for your employees.

Custom providers—You can always write a custom ASP.NET membership provider
should the previous options not meet your requirements.

Tip You can specify a custom, on-brand login page by updating the loginPage setting in web.config

(configuration/Sitecore/sites/site).

Sitecore Commerce Solutions

Sitecore supports commerce integration through its Commerce Connect interface. You can write your
own connector, or more likely, you'll purchase a third-party commerce solution that uses the connector to
integrate the two platforms. There are many reputable e-commerce solutions, but for Sitecore there are

three standouts:

Sitecore Commerce 8 provided by Sitecore and Microsoft leverages Microsoft
Dynamics AX or Commerce Server as a backend. Sitecore + AX is most common for
large, enterprise-scale B2C retailers.

Active Commerce is an e-commerce solution built right on top of Sitecore itself.
Active Commerce is common for B2C scenarios but also has a strong B2B customer
base as well.

Insite provided by Insite Software is a common B2B solution, but also supports B2C
scenarios.

Note Sitecore has a commerce connector called Sitecore Commerce Connect. This connector enables

integration with any compliant 3rd party that implements the interface, allowing for a fully integrated
commerce/Sitecore user experience. Insite, for example, integrates through the connector.
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CRM Integration

Sitecore and CRM are better together. There are three core business reasons to consider integrating your
CRM with Sitecore:

Better Sales/Marketing Alignment—Let’s face it, sales and marketing are rarely in lock
step. Marketing has their campaigns, and sales has their relationships. Marketing uses
Sitecore, and sales uses their CRM. Unfortunately, there is often a chasm between
these two products. With Sitecore’s ability to track every interaction, it is very easy to
keep a score and send hot leads over to CRM when certain criteria is met.

Better Personalization—CRM is typically the source of truth about a customer.
However, what good is all that data if it can’t be used to influence your digital
experiences? You can segment your lists for an e-mail blast, but should your home
page also look different based on data in your CRM? Don’t let your CRM data sit on
an island; let it enhance every customer’s experience with your digital properties.

360 view of your customer—With Sitecore’s experience profile there is a strong case
to be made to make Sitecore the center for everything about a customer (whereas
CRM typically has this role). In an integrated scenario, both CRM and Sitecore share
insights so there doesn’t need to be a tit for tat; let marketers use Sitecore and let
sales use CRM but both will have the same data.

Fortunately for us, Sitecore has written free modules to help integrate Sitecore and your CRM. There
is an integrator for Microsoft Dynamics CRM as well as one for Salesforce. These modules are help get you
started, but you still may find yourself writing a bit of custom code to create the end-to-end integration
you're looking for. There are three main ways to integrate CRM into site, as is seen in Figure 10-24:

1.

The modules support two-way contact synchronization. Contacts in CRM are
pulled into Sitecore along with any CRM fields you deem appropriate. You
can even pull in custom fields. For example, maybe you want a contact field
for “Persona” so your sales team can understand what behaviors this contact
exhibits on your digital experiences. These insights might help them create a
more personalize message. The opposite is also true; data in CRM can drive
personalization in Sitecore.

Code in CRM can call back into Sitecore through Sitecore’s API. Perhaps
you create a campaign in CRM and you want a corresponding campaign
automatically set up in Sitecore to ensure both tools are working in tandem.

Chapter 6 described custom actions you can add to your Web Forms for
Marketers forms. These actions can create CRM records, such as leads, contacts,
or activities.
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Contact / User Sync

] * @ ] .
API Custom Service

System based events / Custom

Figure 10-24. There are three main ways to integrate a CRM: 1) user sync, 2) return service call, and 3) CRM
API calls or through WFFM

Federated Experience Manager

Sitecore’s Federated Experience Manager (FXM) has been heralded as a game-changer in the Sitecore
world. FXM enables a marketer to see customer behavioral data and share Sitecore content across all their
experience properties regardless of whether they are on the Sitecore platform or not. This enables you to
maintain a single view of the customer and a single source of content no matter if you've upgraded/migrated
all your digital properties to Sitecore, or if you plan to take a more gradual approach to your migration.
Examples include Sitecore sites, non-Sitecore sites, and native mobile apps.

Additionally, FXM enables better collaboration with partners. You and your partners may want to
collaborate on customer data. You can ask your partners to deploy the necessary page scripts on their
properties to send a feed of customer data back to your xDB instance to create a consolidated view. Here are
a few more examples where FXM can create value for your marketers:

e A company hosts sites that cannot be managed by Sitecore (e.g. non-.NET sites or
apps, such as WordPress or PHP sites)

e A company wants to better collaborate with their partners

e Acompany is in the process of migrating their properties; however, they don’t want
to wait until they are all migrated before taking advantage of xDB'’s capabilities

e  You may be in acquisition mode and need to take control of new properties and
quickly integrate them into your overall marketing objectives

To get started using FXM, open FXM from the Launchpad » Federated Experience Manager tile. The
page by default looks pretty empty. Click on Add External Website to get started.

Figure 10-25 shows the new site form. There are basically two pieces of information you need to add:
1) the site name and 2) the URL to the site. They name is just a token and can be anything that make sense
and is descriptive. The URL needs to be the root path to your site. Fill in this data and click Save.

300



CHAPTER 10  APPENDIX

| Administrator &

Edit External Website

Fa Open in Experience Editor Delete

; Summary
WEBSITE MANAGE FXM FUNCTIONS

Name RBA WordPress
Blog
General website information

‘

Website  blog.rbaconsulting.com

Name domain
Created sitecore\admin
Website by
¥
domain
Published Yes

Tracking script

‘

Modified 08:55 08/09/2015

o Java Script beacon found on external website

This is the website's racking script. Make sure you have applied this script to every page you want to track. By default, all
pages you add the script to will be tracked in Experience Analytics

Generated

<script sre="Maunchcon ndl n"=</script
script SCnplsrc aunchcore/bundle/beacol SCrp!

Figure 10-25. You can add a site to FXM from the FXM button on the Launchpad

After you click Save you'll notice the Save button is updated and now shows Publish. Before you publish,
however, there are a couple more steps to take. First, you need to paste the script tag into the head of your
remote site (found in the Generated Script text box). Second, you need to enable cross-site scripting for your
remote site.

Figure 10-26 shows an example of pasting in the script tag into a WordPress site. Simply paste it in
directly before the </head> tag, wherever that might be in your remote site’s solution.

301



CHAPTER 10 © APPENDIX

) @ rREABlog © 13 B 207 + New Howdy, Phil wickiund |

@ Dashboard RBA Consulting: head.php (templates/head.php) Select theme to edit: RBA Consulting ¥

€ Analytics Templates

A Posts

<meta charset=

i <meta hitp-equ ompatible” content="IEsedge”>
07 Media eta htfp-equiye® g
<title><?php wp titl

*y true, 'right
width=devi

<meta name="yiewport"

L. Pages <?php wp _head(); ?»
¥ Comments (&6 ¢scripts
(function (i, 5, o, g, r, a, m) {
Calls to Action i[ 'GoogleAnalyticsObject'] = r; i[r] = i[r] function () {
.push(arguments)

(ifr].q = ifrl.q || [
}, i[r].1 = 1 * new Date(
m = 5.getEl

s.createElement(o),

M Appearance

tsByTaghame(o)[@]; a.async =

2L " BS

(a, m)
3 14 dow, document, 'script', °//www.google-analytics.com/analytics.is’

ga( create’, ‘UA

lting.com’);

ga( require’, '1
ga('send’, ‘page

fseript>
Editor c=r

* title="<?php echo
1({get_feed_link()); ?>">

link rel="alternate” type="application/
blogi name'); ?» Feed” href="<?php ech
/bundle/beacon™></scrip

K¢ Plugins 8

S t.ph
aa Users e F
& Tools hav.php
elative- 5. P
B Settings
Documentation: Fynction Name... v Look Up scripts.php
HubSpot 5

Redirect Options

Figure 10-26. After you add a new FXM site you'll need to publish the script tag into the head of the remote site

Secondly, you need to enable cross-site scripting for the remote site; otherwise, all the JavaScript
callbacks will be prevented and FXM won’t work. Navigate to the site’s node in the Marketing Control Panel
» Federated Experience Manager. Add a rule similar to what you see in Figure 10-27 by clicking Edit Rule
below Matching Rule. When this is complete you can go back to the site in FXM and click the Publish button.
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Select the conditions and acions for your rule first. Then, specify the values in the Rule

Descriplion field

Select the conditions for the rule; Select the actions for the rule

Primary Domain
blog rbaconsulting ¢

Federated Experience Manager - Domain
Matching
where request domain is dom.
where request path starts with p

Matching Rule

Edit rule

Rule description (click an underlined value to editit)

Ruile 1

where request domain is hitp /blog r

Add a new rule

Language Rules

Edit rule

Figure 10-27. Because of cross-site scripting rules, you'll need to explicitly grant access to allow scripts from
the remote site

All remote sites hosted in FXM are managed very similar to other Sitecore sites. Namely, they are
managed through the Experience Editor. This is nice because it provides a familiar look and feel for
marketers, thus minimizing a lot of training. However, you need to launch the Experience Editor from FXM.
Notice the Open in Experience Editor button found in Figure 10-28. Simply select the site you want to launch
and then click the button.
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| Administaior

Federated Experience Manager

[ Dashbaard

Al websites.

My websites

Recently created websites
| e -

| Creamaby

dFress Blog silecore\admin hitip iblog Maconsuling com’ Yes 0857 0092015 o

sitecoreadmin tecoraconhig com - 0853 08092015 o

Figure 10-28. With all the plumbing complete, you can launch the Experience Editor on the remote site

There are several unique ribbon actions in the FXM Experience Editor you should be aware of. Here is
the list of new buttons:

e Assign Marketing Attribute—By clicking this button you'll see a view of the page with
all the FXM-aware elements highlighted, such as click actions and placeholders.
It just helps you see what you've already configured.

e Manage FXM Functions—This pop-up provides a way to manage configurations for all
the elements you've added to the page, such as placeholders or actions (Figure 10-32).

e Add Page Filter—A page filter is a way to add personas, goals, or events at a
page-level and/or all of a page’s descendants.

e Capture Click Action—You can register a click action on any element on the page you
want Sitecore analytics to be notified of when clicked.

e  Add Placeholder—You can add placeholders to the page and then add Sitecore
content to those placeholders.

I'm going to walk you through creating a click action and a placeholder to demonstrate some of the
coolest FXM capabilities. This example shows integration with a Sitecore site and a WordPress blog. The
marketing director wants to see an integrated view of analytics across both platforms, as well as enable
shared “calls to action” promotions between the two. By default, any page with the script tag in the head
will send basic visit data to Sitecore, so our basic analytics are covered. However, what about more granular
actions? For example, the director wants to record a blog search as 5 value points. To do this, you simply click
the Capture Click Action button and select the search box, search button, as can be seen in Figure 10-29.
Thereafter you'll be prompted to enter an ID for the action and its parent (Figure 10-30).
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i

Capture Click Action

Lfa fa-search

e Q-

S

ﬁ Add a new aclion

Figure 10-29. You can register different page elements as "actions”

Capture Click Action

Capture click action assigns a click action to the selected component. This allows you to assign
Sitecore functionality, such as marketing attributes, to the component. A click action can be
associated with the website or with specific Page Filters. Only Page Filters that are assigned to this
page can be selected.

Name

Search|

Parent
4 ! RBA WordPress Blog

Figure 10-30. Register the page click action

After the search button is made into a click action, you can wire up that click action to a Sitecore goal
(Figure 10-31). Each time there’s a search, that goal will be triggered and the associated engagement value
will be tallied. At this point you’ll also see the search click action appear in the Manage FXM Functions
dialog (Figure 10-32).
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Goals

Select the goals that you want to associate with the selecied item

Add a Favorite

« Blog search
Brochures Request
Click Email Link

Download brochure

Downloads whitepaper

Event Registration

+

Google +1

+
+

Figure 10-31. Page actions can be tracked back to goals set up in Sitecore

Manage FXM Functions

All FXM functions applied to the website are displayed here. Select an FXM function to edit its properties

4 @ RBAWordPress Blog
s DETAILS CAMPAIGNS EVENTS
O Search
Assign goals
Available \d 2 Favort
orite v
goals Add a Favorite
Current goals Blog search ﬁ

Save and Close Cancel

Figure 10-32. The Manage FXM Function menu shows all the actions set up on the remote site, such as the
goal we registered earlier
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Adding placeholders is a similar process to adding click actions. Simply click the Add Placeholder
ribbon button and then click somewhere on the page. Thereafter you'll notice different places you can add
a placeholder. Notice how in Figure 10-33 I clicked on the right navigation pane. FXM recognized a DIV
element that I clicked on. FXM can either replace that DIV with a placeholder or add a placeholder above
or below it. In my example I want to add a call to action stored in Sitecore above the archives content that is
part of WordPress, so I clicked Add Before. Like before, I need to add a placeholder ID (Figure 10-34).

i+
Add Placeholder

DIV grid__item.one-third palm-one-whole ..

+ Add before .
‘ Categories

Arrhjyes
+ Replace

‘ Recent Posts

ve Information A st

Figure 10-33. You can also add placeholders to a remote site. Simply click Add Placeholder and then click on
the page where you want the placeholder to go
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Add Placeholder

This replaces the external website item with a placeholder for a Sitecore component or
components. Once you add a Sitecore component, you can implement personalization on
the component. You can associate a placeholder with the website or with specific Page
Filters. Only Page Filters that are assigned to this page can be selected.

Name

Right nav content

Parent
» @ RBAWordPress Blog

Figure 10-34. Similar to a click action, placeholders also need an ID and must be registered with Sitecore

After the placeholder is registered with FXM, you can add components into the placeholder much
like you would on any other ordinary Sitecore page. Simply click Add Here (Figure 10-35) and then click
the component you want to add. After you've added a component, you'll need to select the content that
component is associated with, much, again, like you would on any Sitecore page. Figure 10-36 shows a
placeholder with Launchcore’s Promo Spot component added to a WordPress blog page.
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Right top

'+ Add here

Categories
Archives

Recent Posts

Figure 10-35. After the placeholder is registered, it should look very familiar, just like your other Sitecore
sites—but in this case it isn't Sitecore!

B e 2R %L Moe~r

DAt inm Q+tartad +h
Getling Started with
Launch Sitecore

Categories +
Archives

Recent Posts

Figure 10-36. FXM enables you to browse to your Sitecore content and add it to your remote experiences

When you've completed your changes in FXM and the Experience Editor, simply publish those changes
like you would any other Sitecore page. Thereafter, your changes will be live on the site and all analytics data,
such as visits and goals, will be sent to Sitecore just as if it were a Sitecore native site!

Summary

If you're reading this, I applaud you. You're definitely an overachiever!
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active tests button, 117-118 See Predictive personalization
multivariate page-level test, 120-125 Behavior analytics, 208
new page test, 116-117 Business Process Management (BPM) system, 73
page test, 116-120
review and start tab, 117-118 C
summary screen, 119-120
test results page, 119 Campaign analytics, 207
types, 107 Campaign Creator, 139
Access rights Cloning
access viewer, 233-234 content inheritance, 70
out-of-the-box, 232-233 original item, 70
overview, 232 results, 71
Acquisition analytics, 206 scenarios, 71
Active Directory (AD), 298 Cloud-based xDB deployment, 297
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self-service Business debug mode, 55
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commerce solutions, 298 experience editor, 36, 47
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Audit task, 256 featured product placeholder, 56-57
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governance, 38 search engine optimization, 5
hierarchy, 32 single view, 5
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strategies, 36 inheritance, 275
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CRM Integration, 8, 165, 211, 299-300 Email channels, 10

CRM system Email Experience Manager (EXM), 22-23
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developers, 8 components, 150
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PowerPivot manager, 217
switch visualization options, 219
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security, 253
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Email experience manager (EXM), 156
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KPIs identification, 196
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progress, 195
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variation button, 121
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Proactive administration, 256
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error message, 190
event registration data, 182
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Security
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